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OneWorld Overview

OneWorld provides a flexible, configurable solution in the face of constantly
changing technology and enterprise practices. OneWorld is the first
network-centric software that separates business rules from the underlying
technology. With OneWorld, as new technologies emerge, you can easily add
them to the framework of your enterprise.

OneWorld Features

In addition, OneWorld offers the following features:

e Multiplatform computing. OneWorld has the ability to run on different
platforms. This versatility allows for easy maintenance of information
across a network.

e Integrated supply chain. OneWorld provides the ability to use the Internet
and an intranet to allow you to communicate and share information with
your employees, customers, and suppliers.

e Interoperability. OneWorld lets you leverage your existing investments in
hardware, databases, and software, and integrate them with legacy and
third-party products.

e Adaptability. OneWorld adapts easily to different languages, currencies,
reporting provisions, and technology standards.

e User-friendly. OneWorld lets you point and click, drag and drop, and use
fill-in-the-blank forms to easily complete your tasks.

System Integration

OneWorld combines enterprise applications with an integrated toolset to tailor
those applications to the needs of your business.

J.D. Edwards refers to each group of its software products as an application
suite. OneWorld’s application suites support manufacturing, financials,
distribution or logistics, and human resource operations for multisite and
multinational organizations. Your business needs determine what application
suites are installed for your enterprise system. For complex business situations,
you might use several application suites to achieve a comprehensive solution.

Each application suite is made up of systems. For example, the Financial Suite
contains systems such as Accounts Receivable - System 03B, Accounts Payable -

OneWorld Xe (9/00) 1-1
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1. Credit check

System 04, General Accounting - System 09, Fixed Assets - System 12, and
others.

Each system consists of applications, forms, reports, and database tables that are
designed to handle specific business needs.

Because the functions and features of all the systems are similar and integrated,
you are not necessarily aware of moving from one system to another when
working with various applications. The following illustration shows data and
logic that is shared between applications such as Sales Order Detail File,
Customer Ledger, and Account Ledger. The illustration shows how a sales order
entry application shares customer data, such as balances and total order
amounts, with an accounts receivable (A/R) application. As orders are taken, the
sales order application passes the information over to the A/R application, which
then posts the entries to the general ledger. Also, the order entry application can
request credit checks from the A/R application.

Sales Order
Detalil File
(F4211)
) Database
2. Adjust customer _—
balance ~
Customer [~
Ledger >
(FO3B11)
3. Post to
Account Ledger
N~
Account
Ledger
(FO911)

This guide often refers to Address Book - System 01 to illustrate the OneWorld
foundation concepts. Address Book, an online version of a traditional card file, is
a database of names, addresses, and phone numbers that:

e Provides easy access to all addresses for searching and reporting purposes

OneWorld Xe (9/00)
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e Reduces the need for duplication of records

e Provides security through Business Unit assignment or Search Type
authorization

e Interfaces with other OneWorld systems
Because it is fundamental to business solutions, Address Book provides a
realistic subject for learning OneWorld foundation concepts. Many of the tasks
that you perform use Address Book examples.

Address Book interfaces include, but are not limited to, the following systems:

General
Ledger Job Cost

Distribution

<+—— Customers

Manufacturing \

<+— Suppliers

Payroll/ <+—— Employees
Human <——
Resources <+— Jobs
<+—— Tenants
Property /
Management

Accounts Accounts
Payable Receivable

See Also

o Appendix C - OneWorld Systems for a list of systems and their codes
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OneWorld Foundation Overview

OneWorld Foundation introduces you to the integrated environment of
OneWorld. Through overviews, illustrations, procedures, and examples, this
guide describes the operations and functions that are common to all
applications. OneWorld Foundation comprises the following sections:

OneWorld Access

Application
User Interface

User Overrides

Records

Messages and Queues

Media Object
Attachments

MailMerge Workbench

Interactive Versions for
Applications

Batch Versions for
Reports

Processing Options

Learn about the different applications that can each be
used as an entry point for accessing other OneWorld tools
and applications.

Learn about the operating environment, including menus,
forms, and the grid.

Learn to change the appearance of an application to fit the
needs of your business.

Learn how to locate, add, and work with database
records, add objects, and format and move around on a
record-entry form.

Learn to use Work Center to send, receive, and work with
messages that you send and receive from OneWorld users
and recipients outside of the OneWorld environment.

Learn how to attach objects (text, images, OLE objects,
and OneWorld shortcuts) to rows and forms.

Learn about merging OneWorld records with third-party
word processing documents for automatic creation of form
letters by using certain application workflows.

Learn to modify the behavior of applications through
changing processing options and interactive version detail.

Learn how to create, modify, and print your own report
versions.

Learn key functions, types, and how to access and use
processing options.

OneWorld Xe (9/00)
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Menu Word Search Learn how to find and open OneWorld menus and
applications, and customize search lists.

User Defined Codes Learn how to tailor valid values of a field to meet your
business needs.

Configurable Network Learn some key concepts and fundamentals about the
Computing Foundation technical architecture that makes OneWorld possible.

OneWorld Xe (9/00)
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OneWorld Access

OneWorld provides several different applications that can each be used as an
entry point for accessing other OneWorld tools and applications. The following
table summarizes the difference between these applications:

Solution Explorer

OneWorld Explorer - Windows

ActivEra Portal

OneWorld HTML

OneWorld Java

A Windows-based explorer that provides
the ability to navigate menus and launch
Windows versions of OneWorld
applications. It also provides tools for
quickly implementing J.D. Edwards
software and making changes after
implementation. See Solution Explorer for
more information about this application.

A Windows-based explorer provided with
OneWorld. See OneWorld Explorer -
Windows for more information about this
application.

A fully configurable Web-based portal.
The ActivEra Portal requires a OneWorld
web server, and it also can launch an
HTML version of OneWorld applications.
See ActivEra Portal for more information
about this application.

An HTML-based menu system that
provides the ability to navigate OneWorld
menus and launch an HTML version of
OneWorld applications. See OneWorld
HTMIL for more information about this
application.

A Java-based menu system that provides
the ability to navigate OneWorld menus
and launch Java versions of OneWorld
applications. See OneWorld Java for more
information about this application.

OneWorld Access contains the following: EEE

OneWorld Xe (9/00)
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L] Solution Explorer

[ OneWorld Explorer - Windows
L] ActivEra Portal

L] OneWorld HTML

] OneWorld Java
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Solution Explorer

Solution Explorer is a collection of tools and technologies that provides a
gateway to J.D. Edwards OneWorld enterprise software and enables
organizations to easily adapt their enterprise software both before and after
implementation in order to meet changing business conditions.

Key attributes that distinguish Solution Explorer from other Enterprise Resource
Planning (ERP) systems include:

e FEase of navigation. The Solution Explorer offers a convenient,
web-browser-based, customizable gateway to all features and to any
internal or external Web site. You can create and use links between and
within task views to further speed your navigation and shorten your work
time. Find It! allows you to quickly search for the programs that you need
to do your work.

e Flexibility. Reusable units of work called tasks are at the core of the
Solution Explorer. You can use these tasks as building blocks to model
and create business and technical processes that can be modified without
costly changes to the system.

e Configurability. You set up the system so that it displays only the tasks and
processes that you need for your daily work. You can enable and disable
tasks and create variations on processes to reflect the needs of the
system’s users.

e FEase of use. Solution Explorer allows you to create special tasks called
activators, which you use to build key business and technical processes
without hard-coding form interconnections. Activators launch the
Universal Director, which provides a graphical “wrapping” for the entire
process that you create and facilitates passing data between forms. The
Universal Director also presents process steps in an easy-to-read format.

e Compatibility. Solution Explorer’s architecture permits software developers
and integration partners to produce custom activators that are compatible
with both third-party software applications and OneWorld.

e Accountability. Documentation exists for most tasks in Solution Explorer,
which eliminates guesswork when you encounter a task. You can also
create your own documentation for new tasks. Documentation means that
information about tasks is readily accessible, even if people come and go
within your organization.

Solution Explorer fulfills the promise of a system that allows you to quickly
transform ideas that will better your business into actions that make those ideas
into reality. Not only does Solution Explorer provide your business with the
power to build a highly customized, fully integrated enterprise solution, but

OneWorld Xe (9/00) 3-1
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Solution Explorer also allows the system to be altered smoothly as business
conditions warrant change in a rapidly evolving world.

Solution Explorer discusses the following topic:

L] Working with Solution Explorer
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Working with Solution Explorer

Solution Explorer is the gateway to OneWorld applications, reports, menus, and
external objects such as related documents and spreadsheets. You access these
items using different task views provided by the Solution Explorer. Task views
contain menus composed of these various OneWorld items. Different task views
only display specific items arranged in their menus and based on varying
criteria. Depending on what you want to do, you select the task view that best
supports your task. The Solution Explorer also offers access to the Internet or
an intranet through its web browser.

Solution Explorer offers the ability to change display options, user options, and
open menus using various methods.

Working with Solution Explorer discusses the following topics:
L] Understanding the Explorer interface
] Changing your user options

Working with the web browser

Opening menus and applications

Working with task views

Working with task documentation window content

Understanding task properties

I T N I Iy I

Running the Universal Director

Understanding the Solution Explorer Interface

The overall appearance of the Solution Explorer can vary dramatically
depending on whether you are using the web browser, working with a task
view, or displaying or hiding certain features. However, some features of the
Explorer interface are available at all times, such as the menu bar. Additionally,
other features, such as the Toolbar and the status bar, remain constant in how
you can interact with them, although you have the option of turning them on
and off.

Understanding the Solution Explorer interface describes the following topics:
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e Windows and forms
e Menu bar

e Toolbars

e Status bar

e TFast Path

e Favorites bar

Windows and Forms

Depending on how you interact with the Solution Explorer, it can display
several panels of information. These different panels are referred to as
windows. For example, you might display a task view, choose to display task
properties and documentation, and then use Find It! to open a menu. Your task
view, the task properties, the menu displayed by Find It!, and the
documentation each appear in its own window on the Explorer form.
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Notice how the windows are separated by thick, “raised,” dividers. If you hover
your cursor over one of these lines, the cursor changes to two parallel lines
with two outward pointing arrows. By clicking on the line while at this point,

you can drag the divider and resize the windows it separates.

The task view window cannot be closed.

To access English documentation updates, see
https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf
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Menu Bar

Within the Solution Explorer, the word “menu” can be used in two different
ways. A menu can be a drop-down or pop-up list of options. This type of menu
is common to Windows applications. In the Explorer, a menu can also be a
hierarchical list of OneWorld tasks, such as applications and reports, organized
in a tree structure. Menus of the latter type are available only in task views.

The menu bar at the top of the Explorer provides pull-down menus that display
options for a task view, menu, or an application. Some of the menus that you
can access from the menu bar are File, Edit, and View.

To choose menu options, either use your mouse to single-click on an option or
use the keyboard. Whenever a single, underlined letter appears in an option,
you can press the Alt key plus the key that corresponds to the underlined letter
to access the option. For example, the letter F is underlined in the word File on
the menu bar so that you can access the File pull-down menu with your
keyboard by first pressing the Alt key and then the F key.

The following list describes each menu option found on the menu bar:

File Use this option to access printer controls and exit the
system.
Edit Use this option to create shortcuts and define prompting

options when available.

View Use this option to access the web browser, turn toolbars
on and off, bring up task views, and access a menu for
changing user preferences.

Tools Use this option to access the following:

Find It!

Work Center

Object Management Workbench
Report Design and Report Versions
Calendar

Calculator

Applications This option displays a list of all OneWorld applications
that are currently open.

Help Use this option to access online help.
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Depending on how your system administrator has configured your account,
your ability to access some menu options might vary from what is described
here.

Toolbars

The Toolbars provide shortcuts for accessing frequently used commands. The
Toolbar buttons vary, depending on whether you are using the web browser, a
task view, the Find It! utility, and so on. Your system administrator can
configure the Toolbar, so the buttons on the Toolbar might vary from those
described in this section. The Toolbar appears at the top of the window directly
beneath the window’s banner. If more than one window is displayed, each
window has its own Toolbar, if applicable (not all windows have Toolbars).

To toggle the Toolbar on and off, choose Show from the View menu and then
choose Toolbar. To toggle text descriptions on and off under each button,
choose Show from the View menu and then choose Toolbar Text.

When you move the cursor over a button, the button is highlighted, and the
system provides a brief Hover Help description in a yellow box below your
Cursor.

The following list provides information about the functions available on the

various Toolbars. Most Toolbars do not provide all of the functions on the list.

Back button The Back button displays the previous web page.

Edit button The Edit button allows you to add or change the
documentation for a task.

Find It! button Web browser or task view. The Find It! button
launches the Find It! utility.

Find It!. The Find It! button executes a search of
OneWorld items based on the criteria that you
entered.

Font down button The Font down button displays the text in the
documentation window with a smaller text size.

Font up button The Font up button displays the text in the
documentation window with a larger font size.

Forward button The Forward button displays the next web page in
the queue.

OneWorld Xe (9/00)
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Go button

Home button

Idea to Action button

Internet button

Link button

New Search button

Print button

Refresh button

Search button

Stop button

OneWorld Xe (9/00)

The Go button displays the web page at the address
that you enter in the field next to the button.

The Home button displays the web page that your
system administrator has configured to be your
home page. This page might not be the same as the
Solution Explorer Home Page.

The Idea To Action button launches the selected
task.

The Internet button displays the most recently
accessed web browser location. To access the
Solution Explorer Home Page, click the Internet
button twice.

The link button launches the linked task in a second
window.

The New Search button clears all of the fields in
Find It! so that you can perform a search based on
different criteria.

Web browser. The Print button sends the current
web page to your default printer.

Documentation window. The print button sends the
current documentation to your default printer.

Web browser. The Refresh button reloads the
current web page.

Task view. The Refresh button updates the Explorer
with any changes made to your menus.

Documentation window. The Refresh button

updates the documentation window to reflect any
changes made to the documentation.

The Search button accesses a web site determined
by your system administrator.

The Stop button halts the system’s efforts to load a
web page.
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Task View button The Task View button displays the most recently
accessed task view. To select a specific task view,
click the down arrow next to the Task View button
and choose one from the drop-down menu.

Status Bar

The Status Bar offers quick looks at the meaning of a function, the security for
your system, and the OneWorld environment in which you are operating.
Typically, it appears at the bottom of the Explorer screen.

To display the Status Bar, select Show from the View menu and then click Status
Bar.

Hovering your cursor over the Status Bar components activates hover help for
each item.

The following information appears on the Solution Explorer status bar:

e A description of a highlighted menu bar item

e Error messages

e A message that contains the status of ongoing processes in OneWorld
e Solution Explorer copyright information

e Fields that notify you whether Caps Lock, Num Lock, or Scroll Lock is
activated

e Your user ID and the environment that you are logged into

Fast Path

Fast Path is a dockable toolbar. You use Fast Path to quickly move among
menus and applications using fast path commands. A fast path command can be
any of the following items:

e An abbreviation that is either shipped with J.D. Edwards demo data or
which you define to suit your business environment. For example, the
fast path OMW might take you to the Object Management Workbench
application so you can work with OneWorld objects.

e A task’s ID.

e A program’s name.

To display the Fast Path toolbar, select Show from the View menu, and then
click Fast Path. To use it, enter a fast path code in the toolbar and push the
Enter key on you keyboard.

3-8 OneWorld Xe (9/00)
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In Solution Explorer, you can use fast path commands to launch Windows
executables, task views, OneWorld applications, and so on. If you use Fast Path
to open a menu, the Explorer switches to a task view (if you were using the
web browser) and displays the menu that you selected in a window (the Link
Window) to the right of the task view window. To specify a task view, enter its
Internal Task ID followed by a colon in front of the menu that you want to
launch. For example, 91:DDRP will not only display the DRP Daily Operations
menu in the Link Window, but it will also display the OneWorld Menus task
view in the task view window as well. You can determine a task view’s Internal
Task ID by clicking on the uppermost item in the task view and then clicking
on the Advanced tab in the Task Properties window. To display the Task
Properties Window, select Show from the View menu and then click Task
Properties.

To specify a form, enter the application’s ID followed by a | and then enter the
form ID. For example: P01012 | W01012B displays the Work with Addresses form
in the Work with Addresses application. You can specify a version of a form to
open by adding the version number after the form name with a |, such as
P01012 | W01012B | ZJDE00O3.

Not all objects have fast path commands.

Favorites Bar

The Favorites Bar, a dockable toolbar, displays the tasks and folders that you
have placed in your Favorites. You can launch applications by double-clicking a
task in this toolbar. For more information on setting up Favorites, see Working
with the Favorites Task View.

To display the Favorites Bar, select Show from the View menu and then click
Favorites Bar.

Changing Your User Options

You can access user option information from Solution Explorer. From the View
menu, choose User Options. The User Default Revisions form appears.

The following list describes the associated application for each button on the
User Default Revisions form:

User Profile Revisions This button accesses the User Profile Revisions
application. Only system administrators should change
user profiles. See the User Profiles section in the System
Administration Guide for complete information.
However, you can use this button to view your current
profile.

OneWorld Xe (9/00) 3-9
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View Local Output This button accesses the PrintQueue directory on the
machine that is running OneWorld. This queue contains
the Adobe Acrobat Portable Document Format (PDF)
version of any reports you have run. For more
information, see 7o view report output later in this topic.

Submitted Reports This button accesses the Work With Servers application,
which you can use to check the status of a submitted
report/job, change your report/job priority, work with the
report output, and review errors. For complete
information, see the Submitting a Report section of the
Enterprise Report Writing Guide.

Menu Revisions This button accesses the Work With Menus application,
which you use to modify the appearance of menus in
OneWorld.

Change Password This button accesses the User Password Revisions

application, which provides a means for you to change
your own OneWorld password, as explained later in this
topic.

Default Printer This button accesses the Work With Default Logical
Printers application. Only system administrators should
change default printer settings. See the Working with the
Printers Application topic in the System Administration
Guide for complete information.

With the Work With Default Logical Printers application,

you can add or change a OneWorld default printer, or
change the status of a default printer.

This topic contains the following tasks:

e Changing your password

e Viewing report output

4 To change your password

1. On Solution Explorer, from the View menu, choose User Options.

2. On User Default Revisions, click the Change Password button.

3-10 OneWorld Xe (9/00)
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3. On User Password Revisions, complete the following fields, and click OK:

e Old Password

e New Password

e New Password Verify

Field

Explanation

Old Password

Identifies the current value for the user password that
OneWorld uses to validate during the sign on process

New Password

Identifies the new value for the user password that
OneWorld will use to validate during the sign on process.
When a user creates a new password, certain rules must
be followed. They include:
The new password cannot be the same as the
old password.
The new password cannot be the same as the
user ID.
The new password must be at least six
characters in length.

System administrators using Administrative Password
Revisions to reset a user’s password are not restricted by
these rules. Often, standards exist for resetting a forgotten
password. For example, a new password reset by a
system administrator may need to be the same as the user
ID or it may simply be the word “password” each time.
Regardless, the new value specified in this field will
become effective the next time the user signs on to
OneWorld.

New Password Verity

Identifies a duplicate of the value you specified in the
New Password field. The value you enter here must
exactly match the value you enter in the New Password
field.

OneWorld Xe (9/00)
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> To view report output

Before you can view your report output online, you must run a report version.
See Batch Versions for Reports for information on how to run a report.

1. On Solution Explorer, from the View menu, choose User Options.
2. On User Default Revisions, click the View Local Output button.

3. On the Open form, choose a file and then click the Open button.

A PDF version of the report appears. You can also view log files, such as
error logs. On the Open form, choose “UBE Log Files” from the Files of
Type field to view a list of any log files.

Working with the Web Browser

With the Solution Explorer, you can access the Internet through its web
browser. To access the web browser, choose Internet from the View menu or
click the Internet button on the Toolbar. If you know the address of the web
page that you want to view, enter it in the field on the Toolbar and then click
the Go button. Otherwise, click the Search button to locate one or more Web
sites.

Additionally, your system administrator can configure a special page called the
Solution Explorer Home Page. The Home Page can contain OneWorld and
company-related links and data. Typically, you see the Home Page when you
first log on to OneWorld. If you have been using the web browser to view other
pages and web sites and would like to return to the Home Page, click the
Internet button on the Toolbar twice in succession.

See Also

o Understanding the Toolbar for a complete description of the buttons on
the Toolbar

Opening Menus and Applications

Within the Solution Explorer, the word “menu” can be used in two different
ways. A menu can be a drop-down or pop-up list of options. This type of menu
is common to Windows applications. In the Explorer, a menu can also be a
tree-structured list of various OneWorld items such as applications and reports.
Menus of the latter type are available only in task views.

In task views, you navigate through menus to locate and perform tasks such as
launching an application, processing a report, and so on. OneWorld provides
several methods of finding and displaying menus.

3-12 OneWorld Xe (9/00)
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Opening menus consists of the following topics:

e Understanding the task view menu tree structure
e Launching applications in a task view

e Opening menus and applications using Find It!

You can also open menus and applications using Fast Path. See Using Fast Path
for more information.

Understanding the Task View Menu Tree Structure

OneWorld items such as applications and reports are grouped in menus that are
arranged in a tree structure. If a plus (+) sign appears to the left of a menu
item, you can expand that item to show the items that have been grouped
under it. Menu items under which other items have been grouped are called
nodes. Any OneWorld item, even other nodes, can be grouped in nodes. If a
minus (-) sign appears to the left of a menu item, that item is expanded as far
as it goes. You can expand and contract menus in two ways.

In any task view, from the tree structure in the left pane:

e Use your mouse to single-click directly on the plus (+) or minus (-) sign.

e Use your mouse to double-click on the text of the menu. For example, if
you double-click directly on the “Foundation Systems” text, that menu
will either expand or contract.

Launching Applications in a Task View

Many menu items, also known as tasks, launch an application or submit a
report when you activate them. To activate a software task, perform one of the
following:

e Double-click the task’s icon or text.

e Single-click the task and then click the Idea To Action button on the
Toolbar.

Some tasks allow you to set values, select a version, or define data selection. To
set these variables, right-click the task, choose Prompt For from the pop-up
menu, and then select the option that you want. Options that cannot be set for
that task will be disabled.

Opening Menus and Applications Using Find It!

Find It! is a utility that you can use to search for any OneWorld item including
applications, menus, and reports. You do not need to know the full name of an
item to locate it with Find It! You can use Find It! to perform a word search or
an advanced search. Use word search to find tasks based on their name
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(description). Use advanced search to find items based on their object name,
object code, date and time of last update, or any combination of these criteria.

Using Find It! consists of the following tasks:
e Using Find It! to perform a word search

e Using Find It! to perform an advanced search

P Touse Find It! to perform a word search

1. From the Tools menu, choose Find It!
2. Click the Word Search tab.

3. Enter the name of the item that you want to find in the Search Words
field and then click the Find It! button on the Toolbar.

If the item that you want to find is an activator and if you know its type
(business or technical), you can limit the search by selecting the activator
type in the Activator Type field.

If you do not know the item’s exact name, enter a single word or a string
of words to display all menus and applications that match. For example,
if you enter ADDRESS BOOK, Menu Word Search displays menus and
applications that contain the words address book, such as the Address
Book Category Codes menu and the Customer Address Book Revisions

application.
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4. On Find It!, double-click the item that you want to launch.
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Double-clicking an application launches the application. Double-clicking
a report starts the report processing. You can also single-click the task
and then click the Idea To Action button. To set processing options
(when available), right-click the task, choose Prompt For from the
resulting pop-up menu, and then choose the option you want.

Double-clicking a menu launches the OneWorld task view. The menu that

you double-clicked appears in a window (the Link Window) to the right
of the OneWorld task view window.

P To use Find It! to perform an advanced search

1. From the Tools menu, choose Find It!
2. Click the Advanced Search tab.

3. Complete one or more of the following fields, and then click the Find It!
button on the Toolbar:

e Object Name
e Product Code
e Last Updated
4. Double-click the item that you want to launch.
Double-clicking an application launches the application. Double-clicking
a report starts the report processing. Depending on its processing options,

you might be prompted to choose a version of the report or to set other
parameters.

Double-clicking a menu launches the OneWorld task view. The menu that
you double-clicked appears in a window (the Link Window) to the right
of the OneWorld task view window.

Working with Task Views

With the Solution Explorer, you can access OneWorld menus and applications
through different task views. Task views in Solution Explorer contain particular
kinds of task relationships that represent processes that you follow to complete
essential jobs in the system. Tasks in a task view might launch an application,
display a series of child tasks, or link to another task view.

To launch a particular task view, choose Task Views from the Views menu, and
then choose the task view that you want from the resulting list.

This topic defines some of the task views in the Explorer:

e Using the OneWorld Menus task view
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Using the End-User Tasks task view
Using the J.D. Edwards Education task view
Using the Favorites task view

Working with variant task views

Note: Depending on how your system administrator has configured your
account, some of these task views might be unavailable to you, or you might be
able to access other views not described here.

See Also

Solution Accelerator Suite Implementation guide for a description of other
administrative views

Opening Menus and Applications for instructions on manipulating the
menus and launching applications in task views

Using the OneWorld Menus Task View

The OneWorld Menus task view contains the suite of OneWorld applications
arranged in a tree structure.

Using the End-User Tasks Task View

The End-User Tasks task view contains menus based on the role or roles of the
particular user. For example, a user might be assigned to the role of purchasing
clerk. The role-based menu associated with this role would contain only those
menu items associated with making purchases.

Your role (or roles) and, therefore, the tasks that you can see in this view are
set by the system administrator.

» 10 apply a role

In the Solution Explorer End-User Tasks task view, right-click any task in
the task view menu and then select Apply Role from the resulting pop-up
menu.

The Apply Role form appears. All of the roles to which you have access
are listed in the grid.

In the grid, click the new role that you want to apply and then click
select.

OneWorld Xe (9/00)
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Using the J.D. Edwards Education Task View

The J.D. Edwards Education task view displays courses available at J.D. Edwards

training centers. Training paths and course descriptions for each product vertical
are also available.
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Using the Favorites Task View

Those tasks that you use most frequently are placed in the Favorites task view,
which provides quick and easy access to these tasks from one convenient
location. Doing so provides you with quick and easy access to these tasks
because you house them in one convenient location. You can create tasks that

quickly identify your favorite tasks and then arrange those favorites as children
of the identifying task.

Any items that you place in your Favorites appear in your Favorites Bar, so you
do not need to return to the Favorites view to access an item. To display the
Favorites Bar, select Show from the View menu and then click Favorites Bar.

You can add existing tasks either by clicking on the task and using the Send To
function, or by inserting the task directly into your Favorites if you know the
name of the task. You can also create tasks for your Favorites. For example, if
you created your own version of a report, you could create a task in your
Favorites so that you could access your report version easily. In addition to
creating tasks for launching OneWorld objects, you can create placeholder tasks
under which you can place other tasks. These non-software tasks become
nodes when you place child tasks under them. Placeholder tasks help you
organize the tasks in your task view.

This topic contains the following tasks:
e Adding a task to Favorites with Send To
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Adding a task to Favorites with Insert Existing
Creating a new task for Favorites
Creating a placeholder task

Reorganizing Favorites

To add a task to Favorites with Send To

Right-click the task that you want to add and then select Send To from
the resulting pop-up menu.

Remember that a task can be an item that performs a function such as
launching an application, or that acts as a node holding several tasks
below it. If you add a node to your favorites, all of its children are added
as well.

Ensure that Favorites is selected, and then choose to copy only the task
or the task and all of its subtasks to your Favorites.

Click OK.

The system adds your selection to your Favorites.

To add a task to Favorites with Insert Existing

In your Favorites task view, select the task under which you want to
insert the task that you are adding to your Favorites.

Right-click the task that you selected and then choose Insert Existing Task
from the resulting pop-up menu.

On Task Relationship Revisions, enter the ID of the task that you want to
insert in the Child Task ID cell.

OneWorld Xe (9/00)
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Click the Find button to bring up the Task Search & Select form.

You can enter more than one task in the grid if you want to add more
than one task to your Favorites at the same time.

Click OK.

If you added more than one task to the grid, all of the tasks that you
added will be added to your Favorites.

Note: If you are adding a task under a task that has no children, when
you click OK, the grid on the Task Relationship Revisions form clears and
the form remains open. Click Cancel to close the form. The tasks that you
added will appear in the task view menu.

To create a new task for Favorites

OneWorld Xe (9/00)

Create the object for which you want to make a task, for example, your
own version of a report.

In the Favorites view of the Solution Explorer, select the task under which
you want to add the new task.

Right-click the task that you selected and then choose Insert New Task
from the resulting pop-up menu.

On Task Revisions, enter a name for the task in the Task Name field.
Click the Common tab and enter a product code in the Product Code
field.

Leave the Activator Field blank. Ensure that the Required checkbox is not
checked and that the Active checkbox is checked.
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6. Click the Executable tab and indicate the type of object that your task will
launch when it is executed.

You will then be prompted to identify which object to launch along with
any applicable processing options.

Note: Many of the task type options require that you enter additional
information. For example, if you choose Interactive as a task type, you
supply the object name for the application, the version, and form names,

and set up processing options, if any.

e Interactive

Application
Version
Form

Option Code

Form Mode

Leave this field blank.

e Batch

Application

Version

No Processing Options
Blind Execution
Prompt for Version
Prompt for Values
Data Selection

Data Selection and Values

e Windows

Windows Executable
Working Directory

Executable Parameters

Application
Version
Form

Option Code

To access English documentation updates, see
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Leave this field blank.

Form Mode

Leave this field blank.

e Constant

Application
Version
Form

Option Code
Leave this field blank.
Form Mode

Leave this field blank.

7. Click the Resources tab and then complete the following fields, if desired:

e Base Resource

e Base Units

e Unit of Measure

8. Click OK.

Field Explanation

Task ID Tasks are user defined objects that can initiate an activity,
process, or procedure. Task relationships are parent-child
relationships that represent business processes.

Task Name Descriptive name for a Task ID.

Product Code The Product Code for the task that is of type Rough Cut
Question.

Required Marking a task as being required ensures that it will run
when it is used in a Task Relationship.

Interactive Tasks represent different kinds of functions that occur in

a business process. For example, a task can be an
Interactive Application to enter or maintain data through,
a Batch Application to process or report on data, or a non
software event such as answering the phone. The system
will perform differently based on the type of task that is
executed.

OneWorld Xe (9/00)
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Field Explanation
Application The OneWorld architecture is object-based. This means
that discrete software objects are the building blocks for
all applications, and that developers can reuse the objects
in multiple applications. Each object is tracked by the
Object Librarian. Examples of OneWorld objects include:
e Batch Applications (such as reports)
e Interactive Applications
e Business Views
e Business Functions
e Business Functions Data Structures
e Event Rules
e Media Object Data Structures
Version Identifies a specific set of data selection and sequencing
settings for the application. Versions may be named using
any combination of alpha and numeric characters.
Versions that begin with ‘XJDE’ or ‘ZJDE’ are set up by
J.D. Edwards.
Form The unique name assigned to a form.

Option Code

For World, this code specifies the function of a menu
selection using the DREAM Writer when F18 is pressed.
F18 may be locked out by simply replacing code 1 with 3
or code 2 with 4. This code, in conjunction with the
version number and the option key, provide the
following functions:

Code

1 version — mandatory; option key — form i.d.
F18 displays processing options. Selection =
blind DREAM Writer execution.

2 version — blank; option key — form i.d. F18
displays DREAM Writer versions list. Selection =
DREAM Writer versions list.

2 version — not blank; option key — form i.d.
F18 displays DREAM Writer versions list.
Selection = blind execution, batch.

Review the HELP instructions for Menu Information
(Menu Locks) (P0090) for a detailed explanation of codes
related to job submission and control.

For OneWorld, this code specifies whether the user will
be prompted for additional information prior to running
the application. Available values are:

No processing options

Blind execution (no prompt)

Prompt for version

Prompt for values

JONEN R )
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Field

Explanation

Batch

Tasks represent different kinds of functions that occur in
a business process. For example, a task can be an
Interactive Application to enter or maintain data through,
a Batch Application to process or report on data, or a non
software event such as answering the phone. The system
will perform differently based on the type of task that is
executed.

Windows

Tasks represent different kinds of functions that occur in
a business process. For example, a task can be an
Interactive Application to enter or maintain data through,
a Batch Application to process or report on data, or a non
software event such as answering the phone. The system
will perform differently based on the type of task that is
executed.

Windows Executable

The command path describes where the application is
located on your computer or network. A path includes
the drive, folders, and subfolders that contain the
application to be.

Working Directory

The working directory describes where the application is
located on your computer or network. The path should
include the drive, folders, and subfolders that contain the
application to be.

Tasks represent different kinds of functions that occur in
a business process. For example, a task can be an
Interactive Application to enter or maintain data through,
a Batch Application to process or report on data, or a non
software event such as answering the phone. The system
will perform differently based on the type of task that is
executed.

Constant

Tasks represent different kinds of functions that occur in
a business process. For example, a task can be an
Interactive Application to enter or maintain data through,
a Batch Application to process or report on data, or a non
software event such as answering the phone. The system
will perform differently based on the type of task that is
executed.

Base Resource

The individual who is responsible for performing the
task.

Base Units

The estimated amount of time it will take to complete a
task

Unit of Measure

Indicates the unit of measure that the estimated units is
entered in.

OneWorld Xe (9/00)
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P 1o createa placeholder task

1. In the Favorites view of the Solution Explorer, select the task under which
you want to add the placeholder task.

2. Right-click the task that you selected and then choose Insert New Task
from the resulting pop-up menu.

The Task Revisions form appears.

Enter a name for the placeholder task in the Task Name field.

Click the Common tab and enter a product code in the Product Code
field.

Leave the Activator Field blank. Ensure that the Required checkbox is not
checked and that the Active checkbox is checked.

Click the Executable tab and then select the Non-Software option.

Click OK.

> To reorganize Favorites

From the Favorites view, after adding tasks and folders to your Favorites,
perform any of the following:

e To delete a task from your favorites, right-click the task you want to
delete, and then choose Delete Relationship from the resulting pop-up
menu. The system will confirm that you want to delete the relationship. If
you delete a parent object, all of its children will be removed from your
favorites as well. Deleting a relationship in this manner will not delete the
task from the system; only your Favorites is affected.

e To make a task or folder into a child (that is, a subtask or subfolder) of
another task or folder, drag that task or folder and drop it on the task or
folder that you want to use as a parent. The Explorer modifies the tree
structure of your Favorites accordingly.

Working with Variant Task Views

Your system administrator can create versions of different task views that you
can use to easily access the tasks you need. Applying a variant applies a
pre-defined filter to part of the task view’s menu. For example, if a menu in
your task view showed tasks related to both customers and suppliers, you can
have a choice of viewing either of two variants: customer-related tasks or
supplier-related tasks.

3-24 OneWorld Xe (9/00)
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While a task view can have many variants, each variant is actually referenced by
the parent task in the tree under which the tasks are filtered. The parent task in
the tree that you select before applying a variant is known as the root.

You can clear the variant and return to the original view of the menu at any
time.

Note: The variant does not permanently override the relationships that you
originally see in a task view before you apply the variant, which is simply an
alternate way to view the data. Switching between the original view and the
variant view does not affect the tasks within the view.

Not all task views have variants.

Working with variant task menus consists of the following tasks:

e Applying a variant task view

e C(Clearing a variant task view

> 1 apply a variant task view

1. In a task view of the Solution Explorer, right-click a task and then choose
Apply Variant from the pop-up menu.

2. On Variant Selection, choose the variant that you want to apply and then
click Select.

Use the Only Show Root Variants option to display only those variants
that will affect the child tasks of the parent task (the root) that you
right-clicked.

The system applies the variant to the task view and collapses the parent
task.

3. Expand the parent task to see the variant.

» To clear a variant task view

1. In a task view of Solution Explorer, select the parent task (the root) with
child tasks that are currently being affected by the variant.

2. Right-click and choose Clear Current Variable.

The system removes the variant, returning that portion of the menu to its
original state so that the parent task collapses.

3. Expand the parent task to verify that the variant has been cleared.

OneWorld Xe (9/00) 3-25

To access English documentation updates, see
https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



OneWorld Foundation

Working with Task Documentation Window Content

The documentation window contains information that you select on tabs that
classify the documentation type. Much of the task documentation in Solution

Explorer comes preloaded. However, you can write your own documentation
for tasks.

This topic defines the following tabbed documentation instruction types:

e Summary tab

e Detail tab

e Before You Begin tab
e Notes tab

e Deliverables tab

e Custom tab

Note: Some of the instruction type tabs are not used for some tasks and,
therefore, do not appear.

See Also

o Documenting Tasks in the Solution Accelerator Suite Implementation
guide on writing your own documentation

Summary Tab

The Summary tab provides a comprehensive abstract of the task, including its
business purpose, how it integrates into your system, and the processes
contained within the system. Summary documentation might also include
general examples of what you use the task for.

Detail Tab

The Detail tab provides instructions on the steps that are required to complete a
task. Such documentation might also include general comments about a
particular step in the instructions and specific examples that relate directly to
completing the process.

Before You Begin Tab

The Before You Begin tab provides documentation about the task’s influence on
other processes, programs, and systems, and includes steps that you might be

required to complete before you begin a task. Before You Begin documentation
might also describe possible outcomes when you complete a task. For example,

3-26 OneWorld Xe (9/00)
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you might learn about the consequences of failing to complete a step in the

process.

Notes Tab

The Notes tab provides explanatory information to a user about a task. For
example, if you have changed the purchase order process, you might write
Notes documentation that explains why you made the change.

The following graphic is an example of what might appear on the Notes tab:
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Deliverables Tab

The Deliverables tab provides links to documentation associated with a task. For
example, if you use a task to create an engagement letter, you might create a
link to the engagement letter so that the user can see what it looks like in its
completed state.

Custom Tab

OneWorld Xe (9/00)
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Understanding Task Properties

While in a task view, you can display a window that shows system information
about any item that you select in the task view window or the Link Window. To
display the Task Properties window, choose Show from the View menu, and
then click Task Properties.

The Task Properties window contains three tabs: Basic, Intermediate, and
Advanced. Based on the item currently selected, the information in the Task
Properties window will vary. Some of the information on the tabs is described
below:

e Activator Type resides on the Basic tab, and is useful if you want to use
the Activator task view or want to search by Activator type with the Find
It! utility.

e Version resides on the Intermediate tab.
e Object Name resides on the Intermediate tab.

e Links are detailed on the Intermediate tab. If an object is linked to
another object, you can launch the second object with the Link button on
the Toolbar.

e Task ID resides on the Advanced tab. If you know an object’s task ID,
you can launch it directly from the Fast Path Bar.

Running the Universal Director

3-28

Some Solution Explorer tasks have a light bulb next to their icons. Launching
these tasks automatically launches the Universal Director. The Director provides
a single interface that leads you through completing the steps of major tasks.
The following graphic shows the applications that you can access by expanding
Foundation Systems, and then address book.
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For example, you might have a task called New Customer that you could use to
enter new customers into the system. As a Universal Director task, the task
might first walk you through adding an address book record for the customer,
then adding a customer master record, and then creating a sales order. For each
step, the Universal Director launches the application that you need to do your
job.

The Universal Director displays a list of steps required to complete the task. As
you complete the steps, the Universal Director marks them as complete. You
can choose to move backwards and forwards through the list, or to skip steps
altogether. You can also display the documentation window for help with steps,
as follows:
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The buttons at the bottom of the Universal Director form have the following

functions:

Tree The Tree button toggles between hiding and showing the
window that displays the steps in the process that you are
currently performing.

Documentation The Documentation button toggles between hiding and
showing the documentation window.

Previous The Previous button moves you to the previous task in
the process.

Skip The Skip button allows you to skip the current task and
move to the next task in the process. Steps that you skip
are marked with a red dash in the tree window.

Next The Next button allows you to move to the next task in
the process. Typically, you use this button in conjunction
with the Previous button.

Cancel The Cancel button halts the Universal Director and closes

the Universal Director form.

> To run the Universal Director

1. From any task view of the Solution Explorer, select a task marked with
the light bulb icon.

2. Click the Idea To Action button on the Toolbar.
The system launches the Universal Director.

3. Proceed through the tasks in the activator, clicking the Next button after
you complete each task.
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OneWorld Explorer is the name of the graphical user interface to OneWorld
itself. OneWorld Explorer:

e Uses menus as the basis of navigation throughout OneWorld. These
menus display icons with text to represent OneWorld (and third-party)
applications, reports, and other menus.

e Displays menus in a tree structure. You can use the structure to open a
menu to display additional menus, and the applications or reports
associated with the menu.

e Includes a status bar, menu bar, toolbar, and menu selections that provide
access to additional features, including user preferences and display
settings.

This section contains the following:
[] Signing on and off OneWorld
[ Understanding OneWorld Explorer

] Working with OneWorld Explorer
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Signing On and Off OneWorld

To sign on to OneWorld, you must enter a user ID and password on the
OneWorld Sign On form. User IDs define the following types of information for
each user:

e Security and permissions

e Initial menu

e lLanguage and currency symbol

e Display preferences
On this form, you also have the option to choose the OneWorld environment in
which you work. The system administrator will set up your environment for you.
Typically, you will need only one environment in which to work.
This topic consists of the following:

[ Signing on to OneWorld

] Signing off of OneWorld

Signing On to OneWorld

You must sign on to OneWorld to use the system.

» 10 sign on to OneWorld

1. To access the OneWorld Sign On form from Windows 95 or Windows NT
4.x, choose the OneWorld icon.
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a Oneworld Sign On
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2. On OneWorld Sign On, complete the following fields and then click OK:
e UserID
e Password

e Environment Name

For a list of environments, place your cursor in the Environment
field and click the visual-assist flashlight button that appears to the
right of the field. The Select User Environment form appears.
Choose the appropriate environment and then click Select. The
Select User Environment form disappears and the environment you
selected appears in the Environment field on the OneWorld Sign On
form.

After you choose an environment, that environment defaults each
time you sign on to OneWorld. To use a different environment,
access the Select User Environment form again and select a different
environment. Your authorization might allow you to access a
number of environments. However, only the environments loaded
onto the workstation you are using, and to which you have access,
appear on the Select User Environment form.

3. From OneWorld Sign On, click OK.

The OneWorld Explorer appears.
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Field Explanation

User ID For World, the IBM-defined user profile.

For OneWorld, the identification code for a user profile.

Password The password used to sign on the user to the OneWorld
menu driver.

Environment The name associated with a specific list of libraries. The
JOBINITA initial program uses these library list names to
control which environments that a user can sign on to.
These configurations of library lists are maintained in the
Library List Master table (FO094).

For OneWorld, this field represents a valid environment
that can be used to run OneWorld. The environment
encompasses both a path code (objects) and a data source
(data). When both are put together, users have a valid
workplace within OneWorld.

Signing Off OneWorld

When you finish your work in OneWorld, you must sign off the system. When
you exit OneWorld, you exit both the OneWorld application and the database.

> 1 sign off OneWorld

From any OneWorld menu, choose one of the following methods to sign off:

e Choose Exit from the File menu
e (lick the X button at the right of the Title bar
e Press ALr + F4

If there is a check mark next to the “Save Settings on Exit” selection on the File
menu, OneWorld saves any changes that you made to your display.
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Understanding OneWorld Explorer

As a graphical user interface, OneWorld Explorer has a look and feel that you
are probably familiar with. It comes equipped with a tree structure of menus,
menu selections (icons and descriptive text) for accessing applications or
additional menus, a menu bar with pull-down menus that provide you options
for applications and menus, a toolbar for fast access to helpful commands, and a
status bar that displays additional information, such as error messages or even
the time of day.

This topic explains the following:
[] Tree structure
[l Menu selections
(1 Menu bar
] Toolbar

[] Status bar
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Tree Structure

The tree structure appears in the left pane of the OneWorld Explorer window.

Each item in this tree structure is a menu. If a plus (+) sign appears to the left of
a menu, you can expand that menu to show additional menus. If a minus (-)
sign appears to the left of a menu, that menu is expanded as far as it goes. You
can expand and contract menus in two ways:

e Use your mouse to single-click directly on the plus (+) or minus (-) sign.

e Use your mouse to double-click on the text of the menu. For example, if
you double-click directly on the “Foundation Systems” text, that menu will
either expand or contract.

You can have a menu in the tree structure display its contents (called menu
selections) in the right pane of the OneWorld Explorer window. Choose any
menu in the tree structure (choose a menu by single-clicking directly on the
menu text) and its menu selections display in the right pane. The menu
selections are either applications, additional menus, or a combination of
applications and menus. The tree structure, however, only displays menus. For
more information about navigating menus, see Opening Menus.

The menus directly under the Master Directory menu reflect the application
suites installed to your business environment. The suites can differ not only
between enterprises, but between departments within an enterprise. The
application suites might include financials, human resource management,
distribution/logistics, and manufacturing. For more information about application
suites, see System Integration in the Introduction to OneWorld section of this
guide.

Menu Selections

Menu selections appear in the right pane of the OneWorld Explorer window.
Each menu selection is an icon followed by descriptive text.

Use menu selections to access:

e OneWorld interactive and batch applications

e Third-party applications, including WorldSoftware programs accessed
through the WorldVision interface

e Other menus

You can display menu selections in a variety of ways, for example, as large
icons, small icons, a detailed list, or even as a Web page. For information on
changing the menu selection view, see Changing the Appearance of OneWorld
Explorer.
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When you sign on to OneWorld, the same initial menu appears in the right pane
of the window. Your system administrator sets this initial menu in the Menu
Identification field of your user profile. This menu should be appropriate to the
type of work that you do. For example, if you typically enter invoices, you
should probably start out in the appropriate Accounts Receivable menu.

Menu Bar

The menu bar provides pull-down menus that display options for a menu or an
application.

To choose menu options, either use your mouse to single-click on an option or
use the keyboard. Whenever a single, underlined letter appears in an option,
you can press the Alt key plus the key that corresponds to the underlined letter
to access the option. For example, the letter F is underlined in the word File on
the menu bar, so you can access the File pull-down menu with your keyboard
by first pressing the Alt key and then the F key.

The following list describes each menu option found on the menu bar:

File Use this option to create tabs, open menus, save display
settings, and exit the system.

Edit Use this option to remove tabs, access processing options,
and locate versions.

View Use this option to change the appearance of the menu
selections in the right pane of the OneWorld Explorer
window; turn on and off the menu tree structure, menu
bar, and status bar; and access a menu for changing user
preferences.

Tools Use this option to access the following:

e Calendar
e (Calculator
e Internet

Applications This option displays a list of all applications that are
currently open.

Help Use this option to access online help.
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Toolbar

4-10

The toolbar options provide shortcut methods for accessing frequently used
commands. You can turn the toolbar on and off from the View menu.

When you move the cursor over a button, the button becomes highlighted and
the system provides a brief Hover Help description in a yellow box below your
cursor and a complete description in the status bar of the form.

The following list provides information about the functions available on the

toolbar:

New Tab button

Open button

Save Object button

Show/Hide Menu Tree

button

Refresh button

Remove Tab button

Large Icons button

Small Icons button

List button

Detail button

Web button

Home button

Accesses a form that allows you to add new tabs in the
right portion of OneWorld Explorer.

Accesses a form that allows you to enter search criteria
about a menu when you are not sure about the menu title.

Allows you to save an object that you insert on an object
tab.

Toggles the tree structure in the left portion of OneWorld
Explorer on and off.

Updates OneWorld Explorer with any changes that are
made to your menus while you run OneWorld.

Removes any tab that you add to OneWorld Explorer.
However, you cannot remove the first tab.

Switches to a view that displays large icons.

Switches to a view that displays small icons.

Switches to a view that displays items in a column format.

Switches to a view that displays items in a list with
information about the menu selection.

Switches to a view that displays items in the format of a
Web page .

Takes you back to the menu that you set when you
created the tab.
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Back button

Forward button

Word Search button

Fast Path

Status Bar

Moves you to the previous menu accessed from the
current tab .

Moves you to the next menu accessed from the current
tab. You can only use this button after you use the Back
button to move to a previous menu.

Provides access to the Menu Word Search application. This
application allows you to enter search criteria to locate
and access menus and applications.

Allows you to enter a menu ID to open a particular menu.

The Status bar appears at the bottom of OneWorld Explorer. You can turn the
Status bar on and off from the View menu.

The following information appears on the OneWorld Explorer status bar:

e A description of a highlighted menu bar item

e A description of a toolbar item over which you place the cursor

e Error messages

e A message that contains the status of ongoing processes in OneWorld

e OneWorld Explorer copyright information

e Fields that notify you whether Caps Lock, Num Lock, and Scroll Lock are

activated

e A clock

OneWorld Xe (9/00)
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OneWorld Explorer is the gateway to J.D. Edwards applications, reports, menus,
external objects such as attached documents and spreadsheets, and the Internet
or an intranet through attached Web pages.

OneWorld Explorer offers the ability to change display options, change user
options, access applications through custom tabs, and various methods of
opening menus.
This topic consists of the following:

[[] Changing the appearance of OneWorld Explorer

] Changing your user options

[] Creating tabs

L] Opening menus

L] Opening applications

[l Accessing the Internet

Changing the Appearance of OneWorld Explorer

You can change the appearance of OneWorld Explorer. You can use the View
menu from the OneWorld Explorer menu bar to adjust the following settings:

e Toggle on or off the menu tree structure, the toolbar, and the status bar.

e Change how OneWorld displays menu selections (which are applications
and menus) in the right pane of OneWorld Explorer. You can set the
menus and applications as either large icons, small icons, a simple list, a
detailed list, or a Web page.

e Refresh your view if changes occur, such as the addition of a new menu
selection.

You can also manually adjust the toolbar and change the widths of the left and
right panes of the OneWorld Explorer window.
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You can save any display changes to OneWorld Explorer. From the File menu,
ensure that the “Save Settings on Exit” selection is turned on (a check mark
displays next to it).

This topic covers the following tasks:
e Toggling on or off the tree, the toolbar, and the status bar
e Changing the menu selection view
e Refreshing your view

e Adjusting the appearance of the toolbar

e Adjusting the width of the left and the right panes

» 1o toggle on or off the tree, the toolbar, and the status bar

On OneWorld Explorer, from the View menu, turn on or off the following

options:
e Tree
e Toolbar

e Toolbar Text

e Status Bar

4-14 OneWorld Xe (9/00)
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> 1o change the menu selection view

On OneWorld Explorer, from the View menu, choose one of the following:
L]

Large Icons. This style displays a large icon along with the name of
the application or menu from left to right.

Tools Applica

EEEIEER
= % Master Directory

=) Foundation Systems
= Financials

| ] 4= = o4

Waster Drectiey (%) |

H Fast Path =
uman Resources and Payol EEEH LB H FEH FEEH FEEH
istribution / Logisfics Foundation  Financials Human  Distribution ! Manufacturing
anufactuing Systems Resoure..  Logistics

1D, Edwards OnsWorld Explorer, Copyright @ 1D, Edwards Wodd Source Company, 1996-2000

[ | mem
[ ]

Small Icons. This style displays a small icon along with the name of
the application or menu from left to right.

Appliatio

ozl B x|

=Lz} Master Directary

Mester Directory (G) |
= Financials

jFuundalmn Systems jFinanma\s
=) Human Resources and Paol |~ Manufacturing

H Fast Path [

|30 Human Resources and Payroll |5 Distribution J Logistics:

1D, Edwazds OneWadld Explorer, Copyright @ J.D. Edwazds Wodd Source Company, 1996-2000

[ [ s Ee
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application or menu as a list from top to bottom.

@ J.D. Edwards OneWorld Explorer

List. This style displays a small icon along with the name of the

[

File Edit View Tools Applications Help

|2 E|E B x| %

B e

H Fast Path [

) Master Directory

Human Resaurces and Payroll
Distribution # Logistics
() Manufacturing

Master Dirsctory (3) |

|7+ Foundation Systems
| HFinancials

| T Human Resources and Payroll
| Distribuion  Logistics

| SMsnufacturing

1.D. Edvwards One#World Explorer, Copyright @ 1. D. Edwards World Soures Company, 1996-2000

[ ha| e

Details. This style displays a small icon along with the name of the
application or menu, its program ID, and, if applicable, the report

version associated with the application. For example, the program
ID for Word Search (an interactive application) is POIBDWRD, and
the program ID for Reports by Address (a batch application) is

R014021.

@ J.D. Edwards OneWorld Explorer
File Edit WView Tools Applications Help

|a&H (= B x|

B &=

H Fast Path [ =

- Master Directory

Composer
Werkflow Management

#1-(=) Repart Writer
(5 Business Intelligence

1 () Financials
.= Human Resaurces and Payroll

3} Distribution / Logistics
o1 Marufacturing

Master Directory (5)

[ wersion

| Manufacturing

£ (&) Foundation Systems
=) Adhess Book Descrigtion Joh To Execute
H (5 Daily Processing | TIFoundation Systems G0
(=) Perindic Processing | TiFinancials ]
Advanced & Technical Operations | THuman Resources and Payrol 3058
System Setup | SDistribution J Logistics 2]
@3

1.0, Edwazds OneWeadld Exploser, Copyright © 1.D, Edwards Warld Souses Company, 1996-2000
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e Web. This style displays icons along with the name of the
application or menu as an Web page.

@ J.D. Edwards OneWorld Explorer
File Edit View Tools Applications H

EEEIE R ElH & || Fast Path 7|

1=+ [ Master Diectory Master Directary (G)
cundalion Systems
nancials |
uman Resources and Papal .

isrbution / Lagistics Master Directory
Manufactuing

= a afl Foundation Systerns & .a alf Distribution / Logistics
444 a444d

@4 all Financials a.a alf Manufacturing

444 444

& a afl Human Resources and Payroll

444

Copyright @ J.D. Edwarde World Source Company 1986-2000

|
1D, Edwateds OneWold Explorer, Copyright @ 1D, Edwatds Woild Source Company, 1996-2000 HUM 141 PM

P 1o refresh your view

On OneWorld Explorer, to refresh changes to menus and icons, click the
Refresh button on the toolbar.

> 10 adjust the appearance of the toolbar

1.  On OneWorld Explorer, move the cursor over the pair of vertical lines on
the left edge of the toolbar. The cursor changes to a double arrow or a
pointing finger. For example, the Fast Path toolbar has a pair of vertical
lines to the left of the words “Fast Path.”

2. Click and hold the left mouse button, and then do one of the following:

e Move the cursor left or right to display more or less of the selected
toolbar.

e Move the cursor down to display the selected toolbar below the
other toolbar.
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» 1o adjust the width of the left and the right panes

1. On OneWorld Explorer, place your cursor over the divider between the
two panes until the pointer changes to a double arrow.

2. Click and hold your left mouse button and drag the pane either to the
right or to the left until you reach the desired size.

3. Release the mouse button.

Changing Your User Options

You can access user option information from OneWorld Explorer. From the
View menu, choose User Options. The User Default Revisions form appears.

ﬂ User Default Revisions =
File Edit Preferences Form  Help
A . B ] J .
Links
oK can.. Dis.. Abo w Purge... [@)Internet
User Profile Revisions Wiew Local Output Submitted Reports
Lk
m + ' )
T ) &
Menu Bevisions Change Password Diefault Printer
Cancel farm lﬁ v
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The following list describes the associated application for each button on the
User Default Revisions form:

User Profile Revisions

View Local Output

Submitted Reports

Menu Revisions

Change Password

Default Printer

OneWorld Xe (9/00)

The User Profile Revisions application allows you to
change user profiles. Only system administrators should
perform this function. See User Profiles in the System
Administration guide for complete information.

With the User Profile Revisions application, you define a
specific user or group to OneWorld with such information
as the deployment location of a package, the list of
packages a user or group can install, the list of
environments that a user or group can choose from when
signing on to OneWorld, and the language preference of
the user or group.

This button accesses the PrintQueue directory on the
machine that is running OneWorld. This queue contains
the Adobe Acrobat Portable Document Format (PDF)
version of any reports that you have run. For more
information, see 7o view report output.

This button accesses the Work With Servers application,
which you can use to check the status of a submitted
report/job, change your report/job priority, work with the
report output, and review errors. For complete
information, see Submitting a Report in the Enterprise
Report Writing guide.

This button accesses the Work With Menus application,
where you can create, change, delete, copy, and filter
both menus and menu selections. For complete
information, see Menu Design in the System
Administration guide.

This button accesses the User Password Revisions
application, which provides a means for you to change
your own OneWorld password, as explained later in this
section.

This button accesses the Work With Default Logical
Printers application. Only system administrators should
change default printer settings. See Defining a Default
Printer in the System Administration guide for complete
information.

With the Work With Default Logical Printers application,

you can add or change a OneWorld default printer, or
change the status of a default printer.
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This topic contains the following:

e Changing your password

e Viewing report output

» 10 change your password

1. On OneWorld Explorer, from the View menu, choose User Options.

2. On User Default Revisions, click the Change Password button.

@ User Password Revisions =] E3

File Edit Preferencez Help

v x o .‘@JL'k _ .
oK Can. Dis. Apn| e ¥ Disel. [

User 1D IKDE14D34E

2ld Password

Mew Fassward

Mew Passwoard - Yerify

) —— —

i

A

3. On User Password Revisions, complete the following fields and click OK:
e Old Password
e New Password

e New Password Verify

Field Explanation

Old Password Identifies the current value for the user password that
OneWorld uses to validate during the sign on process
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Field

Explanation

New Password

Identifies the new value for the user password that
OneWorld will use to validate during the sign on process.
When a user creates a new password, certain rules must
be followed. They include:
The new password cannot be the same as the
old password.
The new password cannot be the same as the
user ID.
The new password must be at least six
characters in length.

System administrators using Administrative Password
Revisions to reset a user’s password are not restricted by
these rules. Often, standards exist for resetting a forgotten
password. For example, a new password reset by a
system administrator may need to be the same as the user
ID or it may simply be the word “password” each time.
Regardless, the new value specified in this field will
become effective the next time the user signs on to
OneWorld.

New Password Verity

Identifies a duplicate of the value you specified in the
New Password field. The value you enter here must
exactly match the value you enter in the New Password
field.

> To view report output

Before you can view your report output online, you must run a report version.
See Batch Versions for Reports for information on how to create and run a

report.

1.  On OneWorld Explorer, from the View menu, choose User Options.

2. On User Default Revisions, click the View Local Output button.

OneWorld Xe (9/00)
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Open ——— HEH|
Look jr: Ia FrintCueLe j gl

RO77021 _<JDED0DT_D1000717_T135920155. pdf
RO77P021 _<JDEDDDT_D1000717_T180310870. pdf
R43530_«<IDEDOCT_D1000508_T 13010681 7. pdf
F43535_+JDEDOCT_D1000508_T 133635467 pdf

File: rarme: || Open I
Files of twpe: |LIBE Cutput Files j Cancel |

[ Open az read-only

3. On the Open form, choose a file and then click the Open button.

A PDF version of the report appears. You can also view log files, such as
error logs. On the Open form, choose “UBE Log Files” from the Files of
Type field to view a list of any log files.

Creating Tabs

You can create tabs in the right pane of the window for menus, objects (such as
spreadsheets and documents), and Web pages. You cannot delete the initial
menu tab, but you can delete any additional tabs you or others created.

When you open a menu that is different from the one for which you initially
created the tab, the new menu replaces the initial menu on the tab. Each
subsequent menu you open in the tab also replaces the previous menu.

This topic contains the following:

e C(Create a new menu tab
e Create a tab for an object
e Create a Web browser tab

e Delete a tab

> To create a new menu tab

1. On OneWorld Explorer, perform one of the following:
e Click the New Tab button on the toolbar.

e From the File menu, choose New Tab.
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@ Mew Tab M=] E3

Fil= Edit Preferences Help

v X . . .
H 0K Cancel Displ.. Links wr Digplay ... @Intemet

— Tah Format Type

" Object

Wb

=

E

4

2. From the New Tab form, click the Menu option, then click OK.

3 Menu Select M=] E3

File Edit Preferences Help

v B x I L & l@JLinks w Digpl..  [@]Interne

Select Find Close Sed.. Mew.. Dis.. Abo

Product Code Ii ﬂ
Language I Domestic Language

Menu Id Menu Text Disp Produc
Lev Code
G Master Directary A na
GHa0 Tools 1 Ha0
GHY01 Application Development Toals 1 Han
GHA011 System Administration Tools 1 Ha0 | |

GH9012 Advanced Operations a3

GHY013 Printers 2 Had -
«| | o

=22

#

3. From the Menu Select form, complete one or both of the following fields
to narrow your search, and then click Find:

e Product Code
e Language

4. Choose a menu title and then click Select to open the menu as a new tab.
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The new tab appears.

@ J.D. Edwards OneWorld Explorer

File Edit View Tools Applications Help

|[azE @ B X% B o« || Fast Patn | A
() Master Directoy Master Directory (G) Faundation Systems (G0) |
= Foundation Systems
Financials Deseription [ ok To Execute [ wersion [
Hurnan Resources and Payroll | Address Book G010
Distribution / Logistics T Composer G021
Manufacturing | TEWorkflow Management G2
Tools GHao
| HReport Wiriter GHIT1
| Business Inteligence G0
1. Edwards OneWarld Explarer, Copyright @ 1.0 Edwards World Souree Company, 19963000 [ oM 147 FM
Field Explanation
Product Code A user defined code (98/SY) that identifies a J.D. Edwards
system.
Language A user defined code (01/LP) that specifies a language to

use in forms and printed reports.

Before specifying a language, a language code must exist
either at the system level or in your user preferences.

> To create a tab for an object

1. On OneWorld Explorer, perform one of the following:
e Click the New Tab button on the toolbar.
e From the File menu, choose New Tab.

2. From the New Tab form, click the Object option and then click OK.
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Insert Object H

Object Type:

% Create Hew
Bitrap Image Cancel |

 Create from Fil Image Diocument
reate fram File JDE Design Cantral

Media Clip

Microsoft Clip Gallery

Microsoft Excel Chart

Microzoft Excel Workshest ﬂ

Result
Inserts a new Adobe Acrobat Document object

L -
inta pour document.

3. From the Insert Object form, to create a new obiject, choose an Object
Type and then click OK.

The products installed on your workstation determine the types of
selections available.

4. To create an object from an existing file, click the Create from File option.

Inzert Object [ 2] x|

" Create Hew |

- Cancel
' Create from File |Ci"-

Browse.. [ Link

Rezult
Irgerts the contents of the file a8 an object into

P M your document 5o that you may activate it using
E the program which created it

5. Under File:, enter the path and name of the desired file, and then click
OK to create a new tab.

6. Click inside the tab to access all the controls in the selected application.

See Also

o Working with Media Objects for information about attaching media objects
to forms and rows instead of to a tab. See the System Administration
guide for complete information about media objects.
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> To create a Web browser tab

When you create a tab for a Web browser, you need to identify a universal
resource locator (URL). For example, the URL for the J.D. Edwards home page
is www.jdedwards.com. In addition to URL addresses, you can also enter path
and file names for HTML pages on your computer or on your network.

1. On OneWorld Explorer, perform one of the following:
e Click the New Tab button on the toolbar.
e From the File menu, choose New Tab.

2. From the New Tab form, choose Web, then click OK.

3. From the New Web Address form, enter the URL address (you do not
need to enter http://), and then click OK.

@ New Web Addiess [ (O] ]

File Edit Preferencez Help

v xS R@J. :
J OK Can.. Dis.. Abs Links w Displ.. [#]Internet

Enter the weh address you wish to open.

Hitp Address: Iwww.jdedwards.wm

&

| | # 4
The Web site appears in the tab.
Field Explanation
Http Address: Enter the http address in the format:

www.<address>.extension. For example, to access the
J.D. Edwards home page, enter www.jdedwards.com
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> To delete a tab

1.  On OneWorld Explorer, choose the tab that you want to remove.
2. Perform one of the following:
e On the toolbar, click the Remove Tab button.
e From the Edit menu, choose Remove Tab.
Remove Tab is not available from the menu bar for object tabs because
the menu bar changes to support the application for the embedded

object. To delete an object tab, you can only use the Remove Tab button
on the toolbar.

Opening Menus

There are various ways that you can navigate through the OneWorld menus,
such as using the tree structure in the left pane, using the menu ID in the Fast
Path field, or even setting up menus as shortcuts on your workstation’s desktop.

This topic explains the following tasks:

e Opening menus using the tree structure

e Opening menus using Menu Select

e Opening menus using Menu Word Search
e Opening menus using Fast Path

e Opening menus from a desktop shortcut

> To open menus using the tree structure

Each item in the tree structure is a menu. If a plus (+) sign appears to the left of
a menu, you can expand that menu to show additional menus. If a minus (-)
sign appears to the left of a menu, that menu is expanded as far as it goes. You
can expand and contract menus in two ways.

On OneWorld Explorer, from the tree structure in the left pane

e Use your mouse to single-click directly on the plus (+) or minus (-) sign.

e Use your mouse to double-click on the text of the menu. For example, if
you double-click directly on the “Foundation Systems” text, that menu
will either expand or contract.
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> To open menus using Menu Select

The Menu Select form can display every menu available in OneWorld. You can
narrow your search by product code and language.

1.  On OneWorld Explorer, from the File menu, choose Open.

Q Menu Select M[=] E3

File Edit Preferences Help

v B x I &g & R@JLinks w Displ..  [#)Interne

Select Find Close Sed.. Mew.. Dis.. Abo

Product Code Ii ﬂ
Language I Domestic Language

Menu Id Menu Text Disp Produc -
Lev Code
G Master Directary A ili]
GHa0 Tools 1 Ha0
GH&01 Application Development Tools 1 Han
GHB011 System Administration Taols 1 H40
GHB012 Advanced Operations 93 E

GHE013 Printers 2 Ha4 -
«| | 3

%
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2. On Menu Select, to narrow your search, complete one or both of the
following fields, then click Find:

e Product Code
e Language

3. Choose a menu title, then click Select to open the menu.

Field Explanation

Product Code A user defined code (98/SY) that identifies a J.D. Edwards
system.

Language A user defined code (01/LP) that specifies a language to

use in forms and printed reports.

Before specifying a language, a language code must exist
either at the system level or in your user preferences.
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> 1o open menus using Menu Word Search

Menu Word Search is an application that you can use to find and open menus
and applications. If you do not know its exact name, enter a single word or a
string of words, and Menu Word Search displays all menus and applications that
match. For example, if you enter ADDRESS BOOK, Menu Word Search displays
menus and applications that contain the words “address book,” such as the
Address Book Category Codes menu and the Customer Address Book Revisions
application. You can also enter the object name of the menu or application,
such as GO1. See Menu Word Search for complete information about searching
for menus and applications.

> 1o open menus using Fast Path

Fast Path must be activated in your User Profile for you to use this method.

Every menu in OneWorld has its own unique ID. For example, the Master
Directory has an ID of G, and the Address Book menu ID is GO1. The menu ID
appears on the tabs in the right pane of the OneWorld Explorer window, and it
appears next to menus in the right pane if you are viewing the menu selections
as a detailed list. In addition, you can define your own Fast Path IDs, which
could include applications. OneWorld provides a list of Fast Path IDs, which
you can access by single clicking on the down arrow to the right of the Fast
Path field. Fast Path also remembers up to 15 paths that you used since you
signed on.

1. On OneWorld Explorer, do one of the following to move the cursor to
the Fast Path field:
e Press F4
e Press Ctul + F
e (lick in the Fast Path field,

2. In the Fast Path field on the toolbar, enter the menu ID of the menu that
you want to open. For example, enter GO1 to open the Address Book
menu. You can also click the down arrow button to display previously
entered fast paths.

> 1o open a menu from a desktop shortcut

If you have an application, report, or menu that you use often, you can create a
shortcut on your workstation’s desktop. This feature is available to users with
Windows 95 or Windows NT 4.x.

1. In the right pane of OneWorld Explorer, click the right mouse button on
an icon for an application, report, or menu.
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2. On the pop-up menu, choose Create Shortcut.

3. On the desktop, double-click on the shortcut icon to open the
application, report, or menu.

Opening Applications

You can open OneWorld applications in various ways, such as double-clicking
on its menu selection icon/text in the right pane of the window or setting up
the application as a shortcut on your workstation’s desktop.

This topic explains the following tasks:

e Opening an application from a OneWorld Explorer menu
e Opening an application using Menu Word Search
e Opening an active application from the Applications menu

e Opening an application from a desktop shortcut

» 1o open an application from a OneWorld Explorer menu

You can open applications by selecting their menu selection icon/text that
appears in the right pane of the OneWorld Explorer window. Menu selections
can be interactive applications, batch applications, and other menus.

On OneWorld Explorer, double-click an application icon.

The initial form for the application appears. For example, if you double-click on
the Name Search application, then the Work With Addresses form appears.

» 1o open an application using Menu Word Search

Menu Word Search is an application that you can use to find and open menus
and applications. If you do not know its exact name, enter a single word or a
string of words, and Menu Word Search displays all menus and applications that
match. For example, if you enter ADDRESS BOOK, Menu Word Search displays
menus and applications that contain the words address book, such as the
Address Book Category Codes menu and the Customer Address Book Revisions
application. You can also enter the object name of the menu or application,
such as P0101. See Menu Word Search for complete information about
searching for menus and applications.
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» 10 open an active application from the Applications menu

You can access a list of open applications from the Application menu on the
OneWorld Explorer menu bar. When you select an application from this list, the
application comes to the front of the display.

1.  On OneWorld Explorer, choose the Applications menu.

A list of running applications appears.

2. Click on an application to bring it to the front.

> 1o open an application from a desktop shortcut

If you have an application, report, or menu that you use often, you can create a
shortcut on your workstation’s desktop. This feature is available to users with
Windows 95 or Windows NT 4.x.

1. On OneWorld Explorer, in the right pane of the window, click the right
mouse button on an icon for a frequently used application, report, or
menu.

2. On the pop-up menu, choose Create Shortcut.

3.  On the desktop, double-click on the shortcut icon to open the
application, report, or menu.

Accessing the Internet

OneWorld Explorer provides access to the Internet through a link in the Tools
menu.
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P To access the Internet from OneWorld Explorer

1. On OneWorld Explorer, from the Tools menu, choose Internet.

2. On the Internet browser, complete the Address line to access a World
Wide Web site.
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The ActivEra Portal is a gateway for communicating information to a user over
the World Wide Web in a convenient and consistent manner. Your system
administrator can configure the Portal to support your company’s needs, and
you can configure your own Portal workspace to suit your preferences.

With the Portal, you can easily organize and access a variety of internal and
external Web sites and applications. Because of its configurability, you can do
your work in your own way.

ActivEra Portal discusses the following topics:

[ Working with the ActivEra Portal

[L] Using the ActivEra Task Explorer Component
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Working with the ActivEra Portal consists of the following topics:
[l Understanding the ActivEra Portal interface
L] Accessing the ActivEra Portal
[L] Changing the appearance of the ActivEra Portal
[ Creating a new workspace

Note: Because you and your system administrator can greatly affect the contents
of the Portal’s toolbars and workspace, your Portal might not conform exactly to
the information described in this topic.

Understanding the ActivEra Portal Interface

The ActivEra Portal provides a web-based framework in which you can
manipulate components. A component is any element in the workspace of the
Portal and can include a calendar, your e-mail, your work center, national news
headlines, and so forth. To understand the Portal interface, you should be
familiar with the following topics:

e Toolbars
e Workspace

e Components

Toolbars

The top area of the Portal contains two toolbars. The upper toolbar is the
Enterprise Navigation toolbar, and it contains buttons that are configured by
your system administrator for enterprise-wide navigation. For example, the
buttons can provide access to different areas of your company’s Web site, other
areas within the Portal, or other sites on the World Wide Web. The lower
toolbar is the Secondary Navigation toolbar. It can contain the name of the
current workspace, a set of workspace-related links, and a drop-down box from
which you can select different workspaces. This toolbar can change, based on
the current workspace and on how your system administrator configures it.
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Workspace

The bulk of the Portal is devoted to the workspace, the area that displays
various Portal components. You can create several workspace layouts, which
allows you to logically group components. For example, you might have one
workspace for a variety of news feeds and stock information, and another
workspace for accessing your company’s accounting systems. You switch
between workspaces by selecting the workspace that you want to see from the
drop-down menu on the Secondary Navigation toolbar.

Workspaces that you create are private; only you will be able to see them. Your
system administrator can create system-wide workspaces. You might not be able
to modify these system-wide workspaces. Furthermore, if your system
administrator has assigned one or more roles in the system to you, the
components you can access and see might be based on only your role. Your
private workspaces can be configured to show one or more components
arranged in one to five columns.

Components

Most workspaces display several components at once. Components have their
own properties and can be viewed in several modes. Buttons on each of the
components’ title bar allow you to change the component’s mode. The
component modes are:

Normal In normal mode, the component can be viewed in a box
in the workspace. Other components (if they exist) can
be viewed in the workspace as well. Normal mode
usually provides a small amount of content that fits into
its portion of the workspace. For example, an e-mail
component might display the subjects of your first five
pieces of new mail, and a weather component might
display a map with temperatures.

Normal mode is the default mode of all components. If a
component is in another mode, you can return it to
normal mode by clicking the double-box icon on the title
bar.

Minimized In minimized mode, only the component’s title bar is
visible. If you have a large number of components in
your workspace, you might want to minimize some to
give others more space. To view a component in
minimized mode, click the line icon on the title bar. To
return to normal mode, click the double-box icon on the
title bar.
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Maximized In maximized mode, the component expands to fill the
entire workspace. If the component contains a large
amount of content, it might be easier to work with it in
this mode. Not all components have this mode available.
To view a component in maximized mode, click the
single-box icon on the title bar. To return to normal
mode, click the double-box icon on the title bar.

Help In help mode, the component expands to fill the entire
workspace, displaying information about the component.
Not all components have this mode available. To view a
component in help mode, click the question mark icon.
To return to normal mode, click the double-box icon on
the title bar.

Personalize In personalize mode, the component expands to fill the
entire workspace. The tasks that you can perform in this
mode vary based on the component. You might be able
to add or remove links from the component, for example.
Not all components have this mode available. To view a
component in personalized mode, click the arrow icon.
To return to normal mode, click the double-box icon on
the title bar.

All components have a normal and minimized mode. Maximized, help, and
personalized modes are available only if the designer of the component enabled
one or more of those modes.

See Also
e ActivEra Portal Design in the OneWorld Development Tools guide for more

information about configuring Portal toolbars and components

Accessing the ActivEra Portal

Accessing the ActivEra Portal describes the following tasks:

e Logging onto the ActivEra Portal

o Logging off of the ActivEra Portal

Note: If you use the ActivEra Explorer, your system administrator can create a
one-click link between the ActivEra Explorer and the ActivEra Portal. If this is
the case, then you need only log on to one to access the other.
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» 1o log on to the ActivEra Portal

1. TLaunch a web browser such as Netscape or Microsoft’s Internet Explorer.

Note: Your company may have its own method for users to access the
portal, such as a desktop shortcut.

2. Search for the Portal’s URL.
The OneWorld logon form appears.
3. Enter your user ID, password, and environment.

Click OK.

» 1o log off of the ActivEra Portal

1. Click Logoff in the Secondary Navigation toolbar.
The OneWorld logon form appears.

2. Click Cancel.

Changing the Appearance of the ActivEra Portal

You can change how a workspace looks by changing its name or its colors. You
can change the layout of a workspace by adding or removing components, and
altering the number of columns. The workspace can contain one or more
components that can be arranged in one to five columns.

Note: You might not be able to change system-wide workspaces.

Perform the following tasks:

e Change how a workspace looks

e Change the layout of a workspace

» 1o change how a workspace looks

1. From the Portal, click Personalize on the Secondary Navigation toolbar,

2. Choose a workspace from the drop-down menu on the Secondary
Navigation toolbar.
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3.

To change the name of the workspace, change any of the following fields
in the Current Workspace section of the form:

e  Workspace Description

This description is the name of the workspace as it appears in the
drop-down list on the Secondary Navigation toolbar.

e Page Greeting

This greeting is the name of the workspace as it appears on the
Secondary Navigation toolbar when the workspace is active.

To change the colors of different Portal elements, perform one of the
following actions in the Workspace Look & Feel section of the form:

e Seclect a color scheme from the drop-down menu.

e Click a color on the Color Palette, click the checkbox next to the
element that you want to change, and then click the paintbrush
icon under the Color Palette to apply the color to the selected
element.

You can use different images for the workspace’s background, logo, and
toolbars. To do so, enter an appropriate URL in the applicable fields in
the Additional Personalization section of the form.

When finished, click Save Workspace.

If you make changes to several areas of the form, clicking Save
Workspace in any section saves the changes made to all sections.

» 10 change the layout of a workspace

OneWorld Xe (9/00)

Select the workspace that you want to change.

Click Personalize on the Secondary Navigation toolbar.

The Portal Personalization form appears. Layout controls reside in the
Work with Components section of the form.

To add a column to the workspace, click the Col + button.

New columns are added to the right.

You can change the width of a column by dragging the column dividers
to the right and left. Note, however, that if a component’s width is wider
than the column width that you set, the system overrides your column

settings to accommodate the component.

To delete a column from the workspace, click the column that you want
to delete, and then click the Col - button.
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If you delete a column with components in it, the components are
removed from the workspace only. You cannot use the Portal
Personalization form to delete components from the system.

To add a component to a column, click the column that you want to
change, and then click the component that you want to add.

Note: Even if your workspace has just one column (that is, the column
takes up the entire workspace), you must click the workspace area before
you can add components to it.

Components appear as the last component in the list. If you want to
rearrange the order of the components in a column, you must remove the
components from the column and then add them again in the order that
you want. Click Reset Layout to remove all components from all columns.

To remove components from a column, click the component you want to
remove, and then click Remove Component.

If you delete a column with components in it, the components are
removed from the workspace only. You cannot use the Portal
Personalization form to delete components from the system.

When finished, click Save Workspace.

If you make changes to several areas of the form, clicking Save
Workspace in any section saves the changes made to all sections.

Creating a New Workspace

You can add new workspaces to the ActivEra Portal. When you first create a
workspace, it is identical to your default workspace. Personalize your new
workspace as described in Changing the Appearance of the ActivEra Portal.

You can delete any workspace that you create. When you delete a workspace,
you do not delete its components from the system, however. You cannot delete
a system-wide workspace.

Perform the following tasks:

See Also

Create a new workspace

Delete a workspace

Setting Workspace Permissions in the OneWorld System Administration
guide for information about providing workspace access to other system
users
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P To create a new workspace

1. Click Personalize on the Secondary Navigation toolbar.
The Portal Personalization form appears.

2. If desired, choose a workspace from the drop-down menu on the
Secondary Navigation toolbar, and then click Copy Workspace.

This step allows you to create a new workspace based on an existing
one. If you want to create a completely new workspace, skip this step

and go to step 3.

3. Complete the following fields in the Current Workspace section of the
form (you will be overwriting the text in the fields):

e  Workspace Description

This description is the name of the workspace as it appears in the
drop-down list on the Secondary Navigation toolbar.

e Page Greeting

This greeting is the name of the workspace as it appears on the
Secondary Navigation toolbar when the workspace is active.

e Workspace Name
This name is the system name for the workspace.
4. Format the workspace as desired by adding or removing columns and
components, changing colors, and defining different URLs to use for

Portal elements.

See Changing the Appearance of the ActivEra Portal for instructions for
making these changes.

5. Click Save Workspace.

If you make changes to several areas of the form, clicking Save
Workspace in any section saves the changes made to all sections.

To create another workspace at this point, click Refresh and then repeat
steps 2-5.

P  Todeletea workspace

1. Select the workspace that you want to delete.
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2. Click Personalize on the Secondary Navigation toolbar.
The Portal Personalization form appears.

3. In the Current Workspace section of the form, click Delete Workspace.
The system confirms the deletion.
Caution: You cannot undo a workspace deletion. After you confirm that

you want to delete a workspace, the workspace is permanently deleted
from the system and cannot be retrieved.
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Depending on your ActivEra Portal configuration, you might have the ActivEra
Task Explorer component. This component displays the ActivEra Solution
Explorer task views to which you have access. Additionally, the component
includes Fast Path, which is a utility that lets you move quickly among task
views and tasks using fast path commands.

Note: The ActivEra Task Explorer component uses the same set of tables as the
ActivEra Solution Explorer. If you have used or are using the OneWorld
Explorer, your system administrator must run the R9000c batch application
before the component will work properly. See the ActivEra Solution Explorer
Suite Installation guide for more information.

Using the ActivEra Task Explorer component is composed of the following
topics:

[ Opening Menus and Applications
] Working with Task Views

[L] Using Fast Path

Opening Menus and Applications

In the ActivEra Task Explorer component, a menu is a tree-structured list of
various OneWorld items such as applications and reports. Menus of the latter
type are available only in task views.

In task views, you navigate through menus to locate and perform tasks such as
launching an application, processing a report, and so on. OneWorld provides
several methods of finding and displaying menus.

Opening menus consists of the following topics:

e Understanding the task view menu tree structure
e Launching applications in a task view

You can also open menus and applications using Fast Path. See Using Fast Path
for more information.
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Understanding the Task View Menu Tree Structure

OneWorld items such as applications and reports are grouped in menus that are
arranged in a tree structure. If a plus (+) sign appears to the left of a menu
item, you can expand that item to show the items that have been grouped
under it. Menu items under which other items have been grouped are called
nodes. Any OneWorld item, even other nodes, can be grouped in nodes. If no
plus sign appears to the left of a menu item, that item is expanded as far as it
goes. Click Back to return to the previous menu level. Click Top to return to the
top of the task view.

Launching Applications in a Task View

Many menu items, also known as tasks, launch an application or submit a
report when you activate them. To activate a software task, click the task’s text.

Some tasks allow you to set values, select a version, or define data selection. To
set these variables, hover over the flower icon to the left of the task, and then
select the option that you want. Options that cannot be set for that task are
disabled.

Working with Task Views

5-12

With the ActivEra Task Explorer component, you can access OneWorld menus
and applications through different task views. Task views in the ActivEra Task
Explorer component contain particular kinds of task relationships that represent
processes which you follow to complete essential jobs in the system. Tasks in a
task view might launch an application or display a series of child tasks.

To launch a particular task view, choose a task view from the Task View field.

Additionally, some nodes of a task view might have a variant view. A task view
node with an available variant has a red link icon on top of its regular task icon.
To view the variant, click the link icon.

This topic defines some of the task views:

e Using the OneWorld Menus task view
e Using the End-User Tasks task view
e Using the J.D. Edwards Education task view
e Using the Favorites task view
Note: Depending on how your system administrator has configured your

account, some of these task views might be unavailable to you, or you might be
able to access other views not described here.
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See Also

e ActivEra Solution Explorer Implementation guide for a description of other
administrative views

o Opening Menus and Applications for instructions on manipulating the
menus and launching applications in task views

Using the OneWorld Menus Task View

The OneWorld Menus task view contains the suite of OneWorld applications
arranged in a tree structure.

Using the End-User Tasks Task View

The End-User Tasks task view contains menus based on the role or roles of the
particular user. For example, a user might be assigned to the role of purchasing
clerk. The role-based menu associated with this role would contain only those
menu items associated with making purchases.

Your role (or roles) and, therefore, the tasks that you can see in this view are
set by the system administrator.

» 1o apply a role

1. In the End-User Tasks task view, click Apply Role.

The Apply Role form appears. All of the roles to which you have access
are listed in the grid.

2. In the grid, click the new role that you want to apply and then click
select.

Using the J.D. Edwards Education Task View

The J.D. Edwards Education task view displays courses available at J.D. Edwards
training centers. Training paths and course descriptions for each product vertical
are also available.

Using the Favorites Task View

Those tasks that you use most frequently are placed in the Favorites task view,
which provides quick and easy access to these tasks from one convenient
location. You can add existing tasks to your Favorites task view by clicking the
heart icon to the left of any task. To remove a task from your Favorites view,
click the X to the left of the task. Deleting a task from your Favorites view does
not delete the task from the system.
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Using Fast Path

You use Fast Path to quickly move among menus and applications using fast
path commands. A fast path command can be any of the following items:

e An abbreviation that is either shipped with J.D. Edwards demo data or
which you define to suit your business environment. For example, the
fast path OMW might take you to the Object Management Workbench
application so you can work with OneWorld objects.

e A task’s ID.

e A program’s name.

You can use fast path commands to launch Windows executables, task views,
OneWorld applications, and so on. If you use Fast Path to open a menu, the
component displays the menu that you selected.

To specify a task view, enter its Internal Task ID followed by a colon in front of
the menu that you want to launch. For example, 91:DDRP displays the DRP
Daily Operations menu as it appears in the OneWorld Menus task view.

To specify a form, enter the application’s ID followed by a | and then enter the
form ID. For example: P01012 | W01012B displays the Work with Addresses form
in the Work with Addresses application. You can specify a version of a form to
open by adding the version number after the form name with a |, such as
P01012 | W01012B| ZJDE00O3.

Not all objects have fast path commands.
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OneWorld Master Directory is the name of the graphical user interface to
OneWorld. OneWorld Master Directory does the following:

e Uses menus as the basis of navigation throughout OneWorld. These
menus display icons with text to represent OneWorld

e Allows you to use fast path commands to quickly access a menu or
application

e Includes a Tools pulldown menu that provides access to additional
features

This section contains the following topics:
[] Signing on and off OneWorld

] Working with OneWorld Master Directory

OneWorld Xe (9/00)
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The first time that you access the Web Server, the system caches files into the
browser’s cache directory on your workstation. Therefore, the next time that you
log on using the same workstation, many files are already loaded.

To sign on to OneWorld, you must enter a user ID and password on the
OneWorld Sign On form. User IDs define the following information for each
user:

e Security and permissions
e Initial menu
e Language and currency symbol

e Display preferences
On this form, you can also choose the OneWorld environment in which you
work. The system administrator sets up your environment for you. Typically, you
will need to work in only one environment.
This topic contains the following information:

[] Signing on to OneWorld

] Signing off of OneWorld

Signing On to OneWorld

You must sign on to OneWorld to use the system.

» 10 sign on to OneWorld

The system administrator has several choices of how your system is set up for
signing on to OneWorld. For example, the system administrator might have you
sign on using an URL, clicking on an icon, or using a favorites folder in your
browser.
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1. To sign on to OneWorld, choose one of the following options:

e From your browser, enter the appropriate URL. For example,
HTTP://Servername/Environment/ OWHTML

e From your desktop, click the icon assigned to OneWorld

e From your browsers favorite list, choose the OneWorld option set
up for your system

User ID: l—
Password: l—
Environment: l—

Sign On Clear

|£&] Dane || [z Local innaret

2. From OneWorld Sign On, complete the following fields, and then click
Sign On:

e UserID
e Password
3. From Select User Environment, click the appropriate environment.
Your authorization might allow you to access a number of environments.

However, only the WAN environments that are loaded onto the
workstation that you are using, and to which you have access, appear.
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The OneWorld Master Directory appears.

2 J.D. Edwards OneWorld - Microsoft Internet Explorer provided by J. D. Edwards
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Field Explanation
User ID For World, the IBM-defined user profile.

For OneWorld, the identification code for a user profile.

Password The password used to sign on the user to the OneWorld
menu driver.

Environment The name associated with a specific list of libraries. The
JOSINITA initial program uses these library list names to
control which environments that a user can sign on to.
These configurations of library lists are maintained in the
Library List Master table (F0094).

For OneWorld, this field represents a valid environment
that can be used to run OneWorld. The environment
encompasses both a path code (objects) and a data source
(data). When these two are put together, users have a
valid workplace within OneWorld.
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Signing Off OneWorld

6-6

When you finish your work in OneWorld, you must sign off the system. When
you exit OneWorld, you exit both the OneWorld application and the database.

> To sign off OneWorld

From the main OneWorld banner, choose one of the following methods to sign
off:

e TFrom the Tools pull-down menu, choose Log Off.

e From the OneWorld banner, click Logoff.

e Allow the system to expire. The system expires when unattended for a
predetermined amount of time.
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Working with OneWorld Master Directory

OneWorld Master Directory is the gateway to J.D. Edwards applications and
reports. The Master Directory comes equipped with menu selections (icons and
descriptive text) for accessing applications, reports, or additional menus.
This topic contains information on the following subjects:

] Using the OneWorld Master Directory

L] Using OneWorld Fast Path

] Working with the Toolbar

] Working with Row Exits
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Using the OneWorld Master Directory

6-8

Menus are the entry point to J.D. Edwards OneWorld applications and reports.
Use the OneWorld Master Directory to navigate the OneWorld applications. The
menus selections reflect the application suites installed to your business
environment. The suites can differ not only between enterprises, but between
departments within an enterprise. The application suites can include foundation,
financials, HR and payroll management, distribution/logistics, and
manufacturing, or combinations of these suites.

» 10 navigate through the OneWorld Master Directory

From the Master Directory, choose a menu to continue to the next
submenu.
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Continue with step 1 until the application or report that you want to run
is visible.

Click the application or report.

Some objets allow you to set values, select a version, or define data
selection. To set these variables, hover over the icon to the left of the
task, and then select the option that you want. Options that cannot be set
for that object are disabled.
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Using OneWorld Fast Path

Fast Path must be activated in your User Profile for you to use this method to
access OneWorld menus.

OneWorld Web application tools allow you to use fast path commands to
quickly access a OneWorld menu or application. A fast path command is:

An abbreviation that is either shipped with J.D. Edwards demo data or
which you define to suit your business environment. For example, the
fast path OMW takes you to the application Object Management
Workbench so that you can work with OneWorld objects.

A combination of menu selection and menu number. For example, 2/G01
(menu selection number 2 on menu G01) takes you to Work With
Addresses in Address Book.

You can set up your own fast path abbreviations to access frequently used
applications using the Menu Design application.

> 1o open menus using Fast Path

OneWorld Xe (9/00)

From the OneWorld banner, in the Fast Path field, enter either an
application or menu abbreviation, or a combination of a menu selection
and menu number that you want to open. For example, enter GO1 to
open the Address Book menu. You can also double-click in the fast path
field to display previously entered fast paths.

The system displays the menu or accesses the application of the fast path
command that you entered.

From OneWorld Master Directory, you can open application workspaces
that provide access to OneWorld applications through the use of forms.
The application workspace is the area in which all related forms within
an application appear.

The following form provides an example of an application workspace
with an open form:

To access English documentation updates, see
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Working with the Toolbar

OneWorld provides features and a viewing format for the banner on each form.
You must be familiar with the use of the buttons on the toolbar to operate the

OneWorld system. The following describes the functions of the standard toolbar
buttons:

This topic explains the following:
L] Toolbar
[ Row Exits
[] Visual assists

[L] Error messages

Toolbar

The Toolbar options provide access to specific tasks within OneWorld.

The following provides information about the functions available on the
toolbar:

6-10
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Field

Explanation

Select

The Select button chooses one or more records and
opens corresponding forms.

Search

The Search button displays all the entries from your
database that match the search criteria that you
specify.

Add

The Add button opens a new form where you can
add a new record.

Copy

From a Browse form, the Copy button copies the
entire record. The system copies all fields into a
new record, except those fields that are unique to
the existing record.

From a Revision form, the Copy button selects the
fields for the new form. You must enter data in all
other fields. You can modify on the new form those
fields that you copied from the existing record.

Delete

From a Browse or Revision form, the Delete button
deletes the entire record.

Depending upon the application that you are using,
the Delete button may also remove related informa-
tion. For example, if you delete an Address Book
record, the system also deletes the phone numbers
for that record. See your application user guide for
information about deleting child records.

Close

The Close button closes the form.

Errors

The Error button displays a full description, the er-
ror identification number, and the functions that the
error impacts in the Error Window.

Refresh

The Refresh button updates your current OneWorld
screen and populates the appropriate information
based on the information entered into the dialog
boxes.

Working with Row Exits

When you move the cursor over Row Exits, a pulldown menu provides a list of
options relating to the active form. The functions on the Row Exits vary from
form to form. For example, an option might open a data entry form or a form
that allows you to attach objects to a record.

OneWorld Xe (9/00)

6-11

To access English documentation updates, see

https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



OneWorld Foundation

< J.D_ Edwards OneWoild - Microsoft Internet Explorer provided by J_ D. Edwards
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Visual Assists

You can use the visual assist button to access valid values available on your

forms.

The visual assist helps you search for specific items by providing lists of valid
values, such as address numbers and lists of codes that categorize your records.
The visual assist button is available in appropriate fields on certain forms.

Error Messages

6-12

Errors occur in OneWorld for several reasons. For example, if you enter a value
that OneWorld does not recognize, the system highlights the field in red. The
description of the error or warning appears in the Errors and Warnings Window.
You can also access an error message window to review error messages.

P 1o review error messages

1. On any form that displays an error, perform the following:

e From the OneWorld Banner, Click Errors

The cause of the error or warning appears.
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Emors and Warnings - Microsoft Internet Explorer provided by J. D. Edwards

Errors and Warnings

P Error: 4 not found in User Defined Code 01 5T
P Error: No Grid Record Selected
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2. To close the Errors and Warnings Window, from the OneWorld banner,
click close.
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OneWorld Menu Console is the name of the user interface to OneWorld itself.
OneWorld Menu Console does the following:

e Displays menus in a tree structure. You can use the structure to open
additional menus and the applications or reports associated with the
menus.

e Allows you to use fast path commands to quickly access a menu or
application.

e Allows you to use Keyword Search commands to search and access menus
and applications.

e Allows you to create and manage bookmarks that function in a similar
way to those of a browser to help you access OneWorld applications.

This section contains the following:
[] Signing on and off OneWorld

L] Understanding OneWorld Menu Console

OneWorld Xe (9/00) 7-1
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Signing On and Off OneWorld

To sign on to OneWorld, you must enter a user ID and password on the
OneWorld Sign On form. User IDs define the following types of information for
each user:

e Security and permissions

e Initial menu

e lLanguage and currency symbol

e Display preferences
On this form, you also have the option to choose the OneWorld environment in
which you work. The system administrator will set up your environment for you.
Typically, you will need only one environment in which to work.
This topic contains the following:

[ Signing on to OneWorld

[ Signing off OneWorld

Signing On to OneWorld

You must sign on to OneWorld to use the system.

» 10 sign on to OneWorld

The system administrator has several choices of how your system is set up for
signing on to OneWorld. For example, the system administrator might have you
sign on using an URL, clicking on an icon, or using a favorite in your browser.
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1.

To sign on to OneWorld, choose one of the following options:

e From your browser, enter the appropriate URL. For example,
HTTP://Servername/Environment/ OWHTML.

e From your desktop, click the icon assigned to OneWorld.
e From your browsers favorite list, choose the OneWorld option set

up for your system.

The OneWorld Sign On form appears.

& OneWorld Sign On

Copyright@ 1999 J.0. Edwards World Source Company. All rights reserved.

JDEdwards

Encerprise Software

Usger ID ICMST%BEQ
Passward I
Enviranment IADEVCLA

& oK @ Legal | ¥ Cancel |

From OneWorld Sign On, complete the following fields.
e UserID
e Password
From OneWorld Sign On, place your cursor in the Environment field and

click the visual assist that appears to the right of the field.

Your authorization might allow you to access a number of environments.
However, only the WAN environments loaded onto the workstation you
are using, and to which you have access, appear.

From Select User Environment, double-click the appropriate environment.

To use a different environment, access the Select User Environment form
again and double-click a different environment.
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The OneWorld Menu Console appears.
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Field Explanation
User ID For World, the IBM-defined user profile.
For OneWorld, the identification code for a user profile.
Password The password used to sign on the user to the OneWorld
menu driver.
Environment The name associated with a specific list of libraries. The

JO8INITA initial program uses these library list names to
control environments that a user can sign on to. These
configurations of library lists are maintained in the Library
List Master table (F0094).

For OneWorld, this field represents a valid environment
that can be used to run OneWorld. The environment
encompasses both a path code (objects) and a data source
(data). When these two items are put together, then users
have a valid workplace within OneWorld.

OneWorld Xe (9/00)
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Signing Off OneWorld

When you finish your work in OneWorld, you must sign off the system. When
you exit OneWorld, you exit both the OneWorld application and the database.

> To sign off OneWorld

From the OneWorld View menu, choose Log Off.

7-6 OneWorld Xe (9/00)
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Understanding OneWorld Menu Console

OneWorld Menu Console is the gateway to J.D. Edwards applications and
reports. It provides you with a tree structure of menus and menu selections,
allows you to use fast path commands to quickly access a OneWorld menu or
application, allows you to search for and display menus and applications, and
allows you to create bookmarks that function in a similar way to those of a
browser to help you access OneWorld applications.

Note: This section refers to menus from the OneWorld toolbar and not the
browser’s toolbar.

This topic explains the following:
[L] Using the Tree structure

Launching applications

Using the Fast Path

Using Keyword Search

Using the Visual Assists

I TN I N A I

Using Web Bookmarks

Using the Tree Structure

The Master Directory comes equipped with a tree structure of menu selections
(icons and descriptive text) for accessing applications and reports.

OneWorld Xe (9/00) 77
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The tree structure appears in the Master Directory window of the Menu Console:

Wiew Tools Bookmarks Help
o] Menu Console

Master Directory | Fast Path Keyword Search
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+ [0 Human Resources and Payroll
+— [ Distribution / Lagistics

+ [0 Manufacturing

D]
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Each item in this tree structure is a menu. If a plus (+) sign appears to the left of
a menu, you can expand that menu to show additional menus. If a minus (-)
sign appears to the left of a menu, that menu is expanded as far as it goes. You
can expand and contract menus in two ways:

e Use your mouse to single-click directly on the plus (+) or minus (-) sign.

e Use your mouse to double-click on the text of the menu. For example, if
you double-click directly on the “Foundation Systems” text, that menu will
either expand or contract.

Launching Applications

Many menu items launch an application or submit a report when you activate
them. To activate a software task, perform one of the following:

e Double-click the task’s icon or text.

e Right-click a task and the choose Open.

Some tasks allow you to set values, select a version, or define data selection. To
set these variables, right-click the task, choose Prompt For from the pop-up
menu, and then select the option that you want. Options that cannot be set for
that task will be disabled.
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Using the Fast Path

Fast Path must be activated in your User Profile for you to use this method.

OneWorld Web application tools allow you to use fast path commands to quickly
access a OneWorld menu or application. A fast path command can be:

e An abbreviation that is either shipped with J.D. Edwards demo data or
which you define to suit your business environment. For example, the fast
path OL takes you to the application Object Librarian so that you can
work with OneWorld objects.

e A combination of menu selection and menu number. For example, 2/G01
(menu selection number 2 on menu GO01) takes you to Work With
Addresses in Address Book. As you become more familiar with OneWorld
menu abbreviations, you might find fast path a quicker way to navigate to
an application.

You can set up your own fast path abbreviations to access frequently used
applications using the Menu Design application.

> 1o open menus using Fast Path

1.  On Menu Console, do one of the following to move the cursor to the Fast
Path field:

e From Menu Console, choose the Fast Path tab.
e From the Tools menu, choose Fast Path.

2. In the Enter Fast Path Key Here field, enter the menu ID or the application
that you want to open. For example, enter GO1 to open the Address Book
menu.

OneWorld Xe (9/00) 7-9
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Using Keyword Search

Keyword Search is an application that you can use to find and open menus and
applications. If you do not know the exact name, enter a single word or a string
of words, and Keyword Search displays all menus and applications that match.
For example, if you enter ADDRESS BOOK, Keyword Search displays menus and
applications that contain the words “address book,” such as the Address Book
Category Codes menu and the Customer Address Book Revisions application.
You can also enter the object name of the menu or application, such as GO1.
You can also specify if the item for which you are searching is an application or
report.

> To open menus using Keyword Search

1. On Menu Console, do one of the following to move the cursor to the
Search field:

e From the Tools menu, choose Search Menu.

e Click the Keyword Search tab.
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2. On the Menu Console, from the Keyword Search tab, choose either All,
Applications, or Reports.

3. Type your search criteria in the following field and then press Enter:
e Enter keyword here

Enter a specific system code, such as 01 for Address Book or 00 for
the Foundation Environment.

You can enter a single word, such as ADDRESS, or multiple words,
such as ADDRESS BOOK, or a word equivalent, such as UDC for
user defined codes. You can also search using object names (such
as P0101) and menu IDs (such as GO1).

To eliminate ambiguity, the search is not dependent on case.
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4. From the list in the detail area, choose the appropriate list item, and then
perform one of the following:

e Right click on the item and choose Open.
If you choose an application, OneWorld starts that application.

If processing options are available, choose prompt for values. Enter
the appropriate items and choose OK. OneWorld starts that
application.

e Double-click on the item. If you choose an application, OneWorld
starts that application.

Caution: If you double-click on an application that uses processing
options, you will not be prompted for values. OneWorld starts that
application with default processing option values.

Using the Visual Assists

You can use the visual assist button to access valid values that are available on
your forms. The visual assist helps you to search for specific items by providing
lists of valid values such as address numbers and lists of codes that categorize
your records.

The visual assist button is available in appropriate fields on certain forms.
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Using Web Bookmarks

Each user (not based on client or browser) can add bookmarks to OneWorld
applications. Just as with a browser, you use the bookmark to mark your favorite
OneWorld applications. Then you can choose the bookmark to access the
application instead of navigating through the OneWorld Master Directory. The
bookmark facility also includes a bookmark manager that allows you to organize
your bookmarks into folders.

Using Web bookmarks consists of the following tasks:
e Adding a bookmark

e Modifying a bookmark

> To add a bookmark

1. From the Bookmarks menu, choose Bookmark Manager.
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2. On the menu console, from the Master Directory tab, navigate to a
OneWorld application for which you want to make a bookmark.

3. Choose the application, or directory (if you want all applications within
the directory), that you want to bookmark and drag it to the Bookmarks
folder within the Bookmarks window.
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> To modify a bookmark

1. From the Bookmarks menu, choose Bookmark Manager.

2. On Bookmarks, you can save a bookmark, revert to previous bookmark
selections, delete a bookmark, rename a bookmark, and create directories
to organize your bookmarks. You can also double-click an application to
access it. Use the following options to manage your bookmarks:

e Save
e Revert
e Delete

e Rename

e New Fldr
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Application User Interface

OneWorld applications have a user interface that is similar to OneWorld
Explorer, using the same look and feel of menus bars, toolbars, and a status bar.
Applications, however, have their own additional features, which include:

e Visual assists, which display specific values for a given field on an
application form

e Exit bar, which provides icon-based access to areas within OneWorld, such
as messaging, media objects, and forms related to the application

e Task-level online help, which provides step-by-step procedures for
completing a given task

e Form types, which establish how each form functions

e Grids, which display records

This section contains the following:
L] Understanding the application user interface
L] Working with the application user interface

] Working with the grid
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Understanding the Application User Interface

The OneWorld user interface includes OneWorld Explorer and application forms.
From OneWorld Explorer, you can open application workspaces that provide
access to OneWorld applications through the use of forms. The application
workspace is the area in which all related forms within an application appear.

The following illustration provides an example of an application workspace with
a number of open forms:
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Within certain applications, you can use the modeless processing feature.
Modeless processing refers to the ability to move between open forms in an
application by choosing the form with a mouse click. For example, from Address
Book, choose Daily Processing, and then choose Address Book Revisions.
Address Book Revisions allows access to Work with Addresses. After choosing a
record, you can open the Phones and Who’s Who forms from the Row menu.
You can move back and forth between these forms by clicking the appropriate
form. In addition, tabs appear at the bottom of the application workspace. You
can activate a form by clicking its tab. Within an application, you can move
between forms and display information related to the form in order to assist you
with your daily business needs.

This topic explains the following:

L] Menu bars
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Toolbars

Exit bars
Pop-up menus
Scroll Bar
Visual assists
Status bars
Online help
Error messages

Form types
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Tab controls for forms

Menu Bars

The menu bar that appears on the application workspace corresponds to the
active form. Menu bars provide pull-down menus to display options for an
application. Use your mouse or the keyboard to choose menus and options on
these menus. Depending on the type of form, the menus and options will
change.

The functions that are available on the menu bar are defined as follows:

File From the File menu, you can Select, Find, Add, Copy, and
Delete records, Print Screen, Print Setup, and Close the
form.

Edit From the Edit menu, you can Cut, Copy, and Paste

information to and from the Clipboard and choose to
Undo the last action.

Preferences From the Preferences menu, you can view the Exit Bar,
attach external objects, customize the display of a form,
and change the grid.

Form From the Form menu, you can access other forms that
relate to your current form.
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Row

Report

Window

Help

Toolbars

From the Row menu, you can access information that is

specific to a row chosen in the detail area. For example,
you can attach and view objects to a chosen record from
the Row menu.

From the Report menu, you can access reports associated
with the application.

From the Window menu, you can choose alternate views
to display the open forms in an application.

From the Help menu, you can access online help for
specific applications.

The toolbar provides you with buttons for executing frequently used commands.
When you move your cursor over a button, the system provides a brief
description in a yellow Hover Help box below your cursor and a complete
description in the status bar of the form.

OneWorld provides standard toolbar features and toolbar display formats for
each form. However, you can customize the features and the display of the
toolbar to suit the functionality for each individual form. You must be familiar
with the use of the buttons on the toolbar to operate the OneWorld system. The
following list describes the functions of the standard toolbar buttons:

Select

Find

Add

Copy

OneWorld Xe (9/00)

Selects one or more records, and opens corresponding
forms.

Displays all the entries from your database that match the
search criteria that you specify.

Opens a new form where you can add an new record.

From a Browse form, the Copy button copies the entire
record. The system copies all fields except those that are
unique to the existing record into a new record.

From a Revision form, the Copy button selects the fields
for the new form. You must enter data in all other fields.
You can modify those fields that you copied from the
existing record on the new form.

8-5
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Delete From a Browse or Revision form, the Delete button
deletes the entire record.

Depending upon the application that you are using, the
Delete button may also remove related information. For
example, if you delete an Address Book record, the
system also deletes the phone numbers for that record.

See your application user guide for information about
deleting child records.

Close Closes the form.
OK Accepts the data in the current form.
Cancel Ignores any additions, revisions, or deletions that you

made to the current form, closes the form, and moves to
the previous form.

The Links toolbar supplies buttons that provide access to other areas in
OneWorld and the Internet. The hyper-button displays a down arrow. When you
click on the down arrow, the pop-up menu displays the same options that exist
on the menu bar, as well as a Tools menu that has a link to other features,
including the Internet.

The function of the hyper-button varies from form to form. For example, the
hyper-button could open a data entry form or open a form that allows you to
attach objects to a record.

When you click the down arrow on the hyper-button, a pull-down menu
appears that provides a list of various options relating to the active form.

The default form that you open when you click the hyper-button changes to the
last form that you accessed using the down arrow. This feature allows you to set
the hyper-button with a link to the form that you use most frequently.

OneWorld Xe (9/00)
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Exit Bars

The Exit bar is a movable and dockable toolbar that provides quick access to
other applications and forms within the current application. The Exit bar also
accesses an online calculator and calendar, messaging, and the Internet. You can
choose Exit Bar from the Preferences menu to turn the Exit bar on and off.

The following illustration provides an example of an application with an active

exit bar:
@Wolk with Addreszes - [Work With Addresces] [_ O[]
C] File Edit Preferences Bow Report 'Window Help =181 x|
=l
«Iﬁ+aamx§£’€3'@Jums -
Displ... OLE .. |[4
Tools Select Find Add Copy Del.. Close Seg.. Mew.. Dis.. Abo B @ la
Row
Report #lpha Name I [~ Display Phone
9] )
Search Type [+ I~ Display Address
One Line
[#]
i Address Alpha Long Industry Sc
- . Number Name Address Class Tv
[#]
Full AB
Codes
[#]
Full AB
Who'..
4 I
< i Bl

1 wark with Addresses I

The following categories appear on the Exit bar:

e Tools

e Menus that appear between the Preferences and the Help menu (except
for the Window menu)

The Row and Form categories on the exit bar provide the same options as the
corresponding Row and Form menus on the menu bar. The options for these
buttons appear on the Exit bar if the corresponding menu bar option is
available. The Tools category on the exit bar is not represented on the menu bar.
However, you can access the Tools category by clicking the down arrow located
on the Links bar and choosing Tools.

The Tools category provides the following standard buttons:
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Calendar

Calculator

Work Center

Internal Mail

External Mail

Internet

Create Shortcut

Send Shortcut

8-8

Displays a calendar. If you select a date and click OK, the
date displays in the upper left corner of whatever form
you are on.

Displays a calculator. On the calculator, use the mouse or
keyboard to perform the calculations and then click OK.

The system inputs the calculated value into the selected
field.

Accesses the Employee Work Center, which is the
application that you use for OneWorld messages. For
complete information on messaging and the Employee
Work Center, see Messages and Queues.

Displays the Send Internal Mail form, which you can use
to send messages to OneWorld users within your
enterprise. For complete information on messaging and
the Employee Work Center, see Message and Queues.

Displays the Send External Mail form (if you previously set
up your messaging for external mail), which you can use
to send messages to people outside of your OneWorld
enterprise. For complete information on messaging and
the Employee Work Center, see Messages and Queues.

Provides a link to the Internet. Click this button and your
Internet browser opens.

Creates a shortcut on your local machine’s desktop of the
form that you are viewing. For example, if you are in the
Work With Addresses form and you click the Create
Shortcut button, a shortcut appears on your desktop that
will open the Work With Addresses form.

Displays the Send Internal Mail form with a shortcut
attached to the message of the form you are viewing. You
can then send the shortcut to another OneWorld user in
your enterprise. For complete information on messaging
and the Employee Work Center, see Messages and
Queues.

OneWorld Xe (9/00)
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Pop-up Menus

You can access certain information directly on the form through a pop-up menu.
When you click the right mouse button in certain areas on the form, such as the
grid, you can display a menu that provides options that are specific to that area
of the form. For example, when you customize the grid, you can display this
pop-up menu to choose options that allow you to change the features of the
grid, such as the font and background color.

The following illustration is an example of a pop-up menu for the grid:

@Wulk with Addiesses - [Work With Addresses] 9= E3
{:\l File Edit Preferences Row Repot Window Help =8|

v B o+ Bo@ x I L F

Select Find Add  Copy Del.. Close Seq.. Mew.. Dis.. Abo

JLinKS w Displ.. [#]OLE.. []internet

Alpha Mame
g I ™ Display Fhone
Seatch Type IE Ermployees [~ Display Address
i Address Alpha Long Industry Sch =
Number Name Address Class Tvp

“iew System Log =
2006iVyalters, Annette Conterts E 52378
2049 MeLind, Rod Haw To E 204921
2111 tIngram, Paul ‘what's This? E 21112
2275iMguyen, Daniel Giid » E 237521
2438iEscalante, Gearge ﬁ E 24283,
2479iEllis, Jody A. Column 5 E 24792,
4800 Josephson, Michael Fiavs E 54788
E

4801 iBreton, Josephine Export 3

oo 85877,

Tl— Import 4 E
Farrmat 4 & |

£ warkwith Addresses |

Scroll Bar

A scroll bar appears on the right side or bottom of a form when more
information is available than will fit into the viewing area of the form. You can
use this bar to scroll to the additional information. Single-click these buttons to
move up or down one record at a time. Click and hold the mouse button down
to scroll through more than one record.

Within the scroll bar is the scroll box, which shows the position of information
visible in the form. Either click and hold the scroll box and move it, or
single-click in the area on either side of the box.
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Visual Assists

Visual assists provide you with a predetermined list of selections that are
available for a certain field. Visual assists also allow you to access supplemental
tools available on your forms, such as the Search button, Calculator button, and
the Calendar button. These tools automate the process of inputting information
into fields. The calculator and the calendar are also available from the Tools
menu. Examples of visual assists include the following:

e Search

e Calculator

e (Calendar

Search

The search button is available in appropriate fields on certain forms. It helps you
search for specific items by providing lists of valid values, such as address
numbers and lists of codes that categorize your records. This button may also be
represented by other icons.

For example, suppose one of your job requirements is to perform standard
invoice entry. When you enter the Standard Entry Form, you are not sure of the
customer number. Clicking in the Customer Number field causes the visual assist
to appear. Clicking the visual assist brings you to a search form from which you
can search on the customer name to find the customer number.

Calculator

The calculator visual assist displays a calculator to use for arithmetic operations.
As you continue the standard invoice entry, you can use the calculator to assist
you in calculating the Gross Amount for a particular Pay Item.

Calendar

The calendar visual assist displays a calendar. As you continue the standard
invoice entry, the calendar assists you in determining the Void Date.

Status Bars

OneWorld provides a status bar that appears at the bottom of all forms. Status
bars provide information about your current location in OneWorld.

8-10 OneWorld Xe (9/00)
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The following information appears on the status bar of OneWorld forms:

e Descriptions of menu options
e Status of record retrieval and a Stop button to end retrieval

e Error messages

Online Help

Online help provides you with additional information about fields and forms.
This information can be an explanation of a field or a task on how to use a
form. Online help uses hypertext, which allows you to quickly move from one
topic to another, or to display a definition about the term that you selected.
When you are working in an application, you can access online help for either a
specific task or a single field.

There are two types of hypertext:

e Text that directly jumps to another topic. This text highlights as a different
color with a solid underline.

e Pop-up text. This text is usually shown as green text with a broken
underline. Pop-up text displays a form that overlays the existing topic.
Pop-up forms display a brief definition or provide additional clarification.

You can access help from the Help button on the toolbar or from the following
options on the Help menu:

Contents Opens the table of contents for your current system. The
table of contents file organizes topics by guide, section,
and chapter.

How To Displays a task-oriented procedure that is associated with
your current form.

Display Errors Shows the first error or warning message for a form.
Next Error Moves to the subsequent error in a form.
About OneWorld Displays information about the menu or form, including

program and form ID information.
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This topic contains the following:

e Accessing task-level help

e Accessing field-level help

Accessing Task-Level Help

When you need to know the steps to perform a specific task, you can access
task-level help. This help provides brief, conceptual information along with the
steps that you must perform to successfully complete the task.

P To access task-level help

From any application form Help menu, choose How To.

The online help topics for the task appear.

Accessing Field-Level Help

Use field-level help to see a detailed description about a field within a form. The
description includes a definition of the field, and describes valid values and
variables such as field length.

P To access field-level help

1. On any application form, place the cursor in the field about which you
want information.

2. Do either of the following:
e Press F1.
e Click the right mouse button, and from the menu that appears,
choose What’s This.

A pop-up appears with the information about the field.

3. Click the form or press any key to remove the pop-up.

Error Messages

If you enter a value that OneWorld does not recognize, the system highlights the
field in red and displays the following in the status bar:
e A description of the error

e The number of errors and warnings for the current form

8-12 OneWorld Xe (9/00)
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If more than one error or warning exists on a form, you can press F7 to
move to the next error or warning. The description of the error or warning
appears on the status bar at the bottom of the form. You can also access
an error message window to review error messages.

This topic contains the following:
e Reviewing error messages

e Changing the error message window

> To review error messages

1. On any form that displays an error, perform one of the following:
e From the Help menu, choose Display Errors.
e Press F8.
e C(lick the Display Errors button.
e Click the red stop-sign icon at the bottom right of the form.

2. Choose an error in the error message window at the bottom of the form,
click the right mouse button, and choose Full Description from the pop-up
menu.

The cause of the error and how to resolve it appears.

Click anywhere on the desktop, or press any key to close the description.

4. Click the right mouse button, and then choose Detail to review the error
identification number and the functions that the error impacts.

5. On Error and Warning Detail, after reviewing the information, click Close
to exit the error message information.

6. To close the error message window, click the right mouse button and then
choose Close.

Before you close the error message window, you have the option of
activating an audio signal that alerts you with an audible beep when an
error OCCurs.

7. To activate the signal, click the right mouse button and then click Error

Beep. A checkmark appears next to Error Beep on the pop-up window.
Click Error Beep again to remove the checkmark.

> 1o change the error message window

1. On a form with an error message window, click and hold the left mouse
button slightly above the error message window.
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A box appears around the message window.

2. Move the message window to the desired location and then release the
left mouse button.

The message window detaches from the OneWorld form.

3. Resize the window by placing the cursor over the edge of the message
window. When the cursor changes to a double arrow, resize the window.

You can also resize the window while it is still attached to the OneWorld
form. Place the cursor over the dark line between the window and the
form. When the cursor changes to a double arrow, resize the window.

Form Types

Applications use a variety of form types. The characteristics of each form type
remain the same, regardless of the application in which you access the form.

This topic explains the following form types:

e Find/Browse Form

e Search/Select Form

e Header Detail and Headerless Detail Forms
e Fix/Inspect Form

e Parent/Child Form

e Message Box

Find/Browse Form

The Find/Browse form provides the entry point to most applications. It contains
an optional query-by-example (QBE) line so that you can search on any field in
the grid. The standard title for a Find/Browse form begins with Work With
followed by the information specific to the business task. You cannot add or
change existing records on a Find/Browse form.

Find/Browse forms allow you to perform the following:

e Search, view, and select multiple records in a grid
e Exit to another form to add, change, or view a record

The following illustration provides an example of a Find/Browse form where the
only criteria has been to find all names with a search type of E for employee:
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Search/Select Form

Use the Search/Select form to locate a value for a field. The grid displays valid
values that are stored in a database table. When you choose a value from the
grid and click the Select button, that value is automatically placed in the field.
For example, when you need to enter a user defined code into a field, the visual
assist appears, allowing you to access a Search/Select form that displays a list of
user defined codes. You can select an item from the list and place it in the
appropriate field. You cannot edit the information that appears on this form.

The following illustration is

@Wulk with Addresszes - [Select User Define Code] 9= B3

(:l File Edit Preferences Fom  Window Help

an example of a Search/Select form:
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8-16

Header Detail and Headerless Detail Forms

The Header Detail and Headerless Detail forms include a detail area, the OK
button, and the Cancel button. You can change multiple records using these
forms. The Header Detail form includes information from two different business
views to provide more depth on the information that appears on the form. The
Headerless Detail form provides information from only one table. At the top of
the form, data displays that is common to all the records in the grid.

Header Detail and Headerless Detail forms allow you to perform the following:

e Display multiple records

e View records
e Add records
e Change records

e Delete records

The following illustration is an example of a Header Detail form:

@ Enter Sales Orders Detail - [Customer Service Inquirp]
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The following illustration is an example of a Headerless Detail form:
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Fix/Inspect Form

The Fix/Inspect form does not include a detail area. If a record was selected on
a previous form, the Fix/Inspect form displays data for that record. If you are
adding a record, the Fix/Inspect form is empty, except for any default values.

Fix/Inspect forms al

e View a single
e Add a record
[ )

OneWorld Xe (9/00)
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Change a record
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The following illustration is an example of a Fix/Inspect form:

. Work with Addresses - [Address Book Revision]

Abbott, Dominigue

476430269

Parent/Child Form

The Parent/Child form presents parent/child relationships in an application on
one form. The left portion of the form presents a list of items. The right portion
of the form displays information that relates to the selected item in the left
portion of the form. The Parent/Child form supports the ability to drag and drop
items from one area to another. This form includes Select and Close buttons.
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The following illustration is an example of a Parent/Child form:

@ Process Activity Monitor - [Process Activity Monitor]
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B

You can resize the display areas according to your personal preferences.

Message Box

The message box contains information about processing that occurs when you
work with OneWorld. For example, when you delete a record, a Confirm Delete
message box appears to ask if you are sure that you want to delete the object.
The message box might also include information about an event that occurs
while you work with OneWorld. For example, if you try to delete a row in

OneWorld, a Message Box appears to verify that this deletion is what you really
want to do.
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Tab Controls for Forms

Some forms have tabs. Each tab can display a logical grouping of fields. This
grouping occurs within those applications that contain a lot of fields that can be
logically grouped into tabs, for example, the revisions form within the
Manufacturing Constants application. The tabbed groupings make finding and
completing fields easier. See your application guide for information about tabs
within a specific application.

. Manufacturing Constants - [Manufacturing Constants Revigion]

To move between tabs, do one of the following:

e Single-click on a tab header and it appears in front of the others.

e Press the left and right arrow keys on your keyboard when the cursor
focus is on the tab header. You can move the focus to the tab header by
tabbing through the last field on that tab.

e Press the Ctrl + Tab or the Ctrl + Shift + Tab keys.

These tabs should not be confused with OneWorld Explorer tabs and the grid
format tabs that you can create. For information concerning OneWorld Explorer
tabs, see Creating Tabs. For information concerning formatting grids, see
Creating Formals.
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OneWorld provides features that allow you to personalize your application user
interface. Additional features, such as the exit bar and an online calculator,
simplify the processes necessary to complete your daily business requirements.
This topic contains the following:

[L] Changing the display of the toolbar

L] Customizing menu bars and toolbars

] Working with modeless processing

[] Displaying the exit bar

[l Accessing visual assists

Changing the Display of the Toolbar

You can move the Links toolbar to display more of the toolbar or to display
below the main toolbar.

> 1 change the display of the toolbar

1. On a form toolbar, click and hold the left mouse button on Links.
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2. Perform one of the following:

e Move the cursor left or right to display more or less of the links
section.

e Move the cursor down to display the full Links section below the
toolbar buttons.

Customizing Menu Bars and Toolbars

You can customize the appearance and performance of each form by
customizing menu bars and toolbars. When you customize your toolbar, the Hint
box and the Status Bar Help box provide information that describes the help
messages that appear on the actual form for a certain button. The Buttons box
displays the available buttons for each category.

The following restrictions apply when you customize your menus and toolbars:

e You cannot add more than one menu or toolbar.

e Although you can remove menu options and toolbar items at the form
level, you cannot delete an existing menu or toolbar item from the system.

e You cannot duplicate an item that already exists on a menu.

When you see an ampersand (&) on the customize form, the letter that directly
follows the ampersand represents the accelerator key for that menu bar
command.
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This topic contains the following:

e Customizing toolbars

e (Customizing menus

» To customize toolbars

1. On any form with a toolbar, from the Preferences menu, choose
Customize.

i Cuztomize
V Toalhar |%M Menubarl

Catedqories Buttons
Edit v | B | B | @
Preferences
Girid 5| g | =
Tools
Send
Fow
Report
Wiind oy
Help

—Hint

—Status Bar Help

2. On Customize, choose a category from the Categories list.
Click and drag items from the Buttons box onto the toolbar.

To remove a button from the toolbar, click and drag the button off the
toolbar.

» To customize menus

1. On any form with a menu bar, from the Preferences menu, choose
Customize.
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2. On Customize, click the Menubar tab to change the menus.

3. From the Categories list, choose a menu to which you want to add an
item.

The Menu Items list displays the available items and separator bars. The
list to the right of the form shows the items currently on the menu.

4. From the Menu Items list, choose the item that you want to add.

5. In the list box to the right, choose the item below which you want the
new item to appear. If you do not choose an item, your new item appears
at the bottom of the list.

6. Click the top arrow button to add your menu item.

The selected item appears below the highlighted item in the list to the
right. An ampersand before the letter represents the accelerator key. If you
do not choose an item in the list of current menu items below which you
want your new menu item to appear, the new menu item defaults to the
end of the list of current menu items.

7. To remove a list item, choose the item in the list to the right and then click
the bottom arrow button.

Working with Modeless Processing

In certain applications, you can open multiple forms and move between them to
exchange information. For example, in Address Book, you can open the Phones
and Who’s Who forms from the Work with Addresses form to display all three
forms at the same time. You can then verify that the information on each of the
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forms corresponds to the information on the others. The Window menu allows
you to arrange the open forms.

This topic contains the following:

e Moving between forms

e Arranging the forms

’ To move between forms

On a form that supports modeless processing, perform one of the
following:

Click a partially hidden form to bring the form to the front of the
display.
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Click a tab at the bottom of the form to open the form that the tab
represents.

From the Window menu, choose the name of the form to bring the
form to the front.

> To arrange the forms

1.

On a form that supports modeless processing, from the Window menu,
choose one of the following:

e (Cascade
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e Tile Horizontally
e Tile Vertically

2. Move the cursor over the edge of a form until the cursor becomes a
double arrow.

3. Click and hold the left mouse button, then move the cursor until you
achieve the desired width.

Displaying the Exit Bar

You can display the exit bar for an application to provide easy access to other
forms in the application, other applications, an online calendar and calculator,
messaging, and the Internet. Initially, the exit bar appears at the left of the parent
window, but you can move the bar to the right or detach the bar from the form.
If you detach the bar, when you leave the form and then return, the exit bar
appears in its default position at the left of the form. You can also resize the exit
bar. OneWorld saves your exit bar preferences when you sign off OneWorld.

Depending on the current form within an application, you can display the Tools
bar and any menu that appears between the Preferences menu and the Help
menu except for the Window menu. Options do not appear for the Form bar
and the Row bar unless the Form menu or the Row menu appears on the menu
bar for the active form.

This topic contains the following:

e Displaying the exit bar
e Moving the exit bar
e Detaching the exit bar
e Resizing the exit bar

e Opening a function or application with the exit bar

» 1o display the exit bar

In any application, from the Preferences menu, choose Exit Bar.

> To move the exit bar

1. In any application with an exit bar, click and hold the border of the exit
bar.

2. Perform one of the following:

e Drag the box to the right side of the form.
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e Drag the box to the left side of the form.

> To detach the exit bar

In any application with an exit bar, perform one of the following:

e Double-click the border of the exit bar.

e Click and hold the border of the exit bar and drag the gray box to
the middle of the form.

> To resize the exit bar

1. In any application with an exit bar, move the cursor over the right edge of
the exit bar until the cursor becomes a double-arrow.

2. Drag the border until you achieve the desired width.

> 10 open a function or application with the exit bar

1. In any application with an exit bar, click a bar on the exit bar for the
category that you want to display, for example, Tools.

2. On the active exit bar for any given button, click the button for the
appropriate function or application.

Accessing Visual Assists

OneWorld provides tools to help you with certain tasks that you might need to
complete. For example, you can access an online calculator to place the result of
a calculation in a numeric field or you can access an online calendar to enter a
specific date. When a record requires you to place a specific value in a field, you
can use a visual assist to determine the valid values for the field.

This topic contains the following:

e Using the calculator
e Using the calendar
e Using the search button

e Accessing visual assist forms using the right mouse button
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> To use the calculator

Turn on Num Lock before you use the keyboard with the calculator.

1. On any form with a numeric field, access the numeric field.
2. Click the Calculator button.

3. On the calculator, use the mouse or the keyboard to perform the
calculation, and then click OK.

The system displays the calculated value in the selected field.

> To use the calendar

1. On most forms with date fields, access the date field.
2. Click the Calendar button.

3. On the calendar, choose the appropriate year and month from the
drop-down lists.

4. Click the correct date in the calendar and then click OK.

OneWorld displays the date in the selected field.

> To use the search button

1. On any form, when you place the cursor in a field and the search button
appears, click the search button.
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One of the following form types appears:

e A user defined code form:
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8-30

e A record search form:
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2. Choose your selection and then click Select.

The system displays the selection in the selected field on the previous

form.

P To access visual assist forms using the right mouse button

1. In the appropriate field, click the right mouse button.

2. From the pop-up menu, choose Cell and then Visual Assist.

The appropriate visual assist form appears.

To access English documentation updates, see

OneWorld Xe (9/00)

https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



Working with the Grid

The grid includes columns, descriptive column headers, rows, and row headers.
In general, each row represents one record. To customize the grid you can:

e Create multiple views of information in which you can change the format
of the rows and the columns

e Change the font properties

e Change the color properties

e Detach and expand the grid to view more information at the same time
e Adjust the magnification of the grid

e Freeze specific columns or rows of information so that they remain in
place as you scroll through the grid

After you customize your grid, you can create a format to save your changes
that is based on your user ID. The system then loads your specific format
whenever you sign on to the system.
OneWorld allows you to export the contents of the grid into a Windows-based
spreadsheet or word processing application. Conversely, you can import data
from a spreadsheet into a grid in OneWorld.
You can also print the contents of the grid.
This topic contains the following:

[] Creating formats
Formatting the grid
Customizing the appearance of the grid
Freezing columns and rows
Maximizing the grid
Exporting data from the grid

Importing data into the grid

I T R I H A I

Printing the grid
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[] Creating Charts and Graphs

L] Customizing Charts and Graphs

Creating Formats

8-32

You can create grid formats to save the customized changes that you make to
sort order, fonts, colors, and magnification. For example, you can create and
save multiple formats to display different views of the same grid. A tab appears
at the top of each newly created format. If you have multiple formats, you can
move among views by clicking tabs.

After you create your formats, you can rename them or delete them from your
system. Your custom formats load in subsequent sessions on any workstation
when you enter your user ID.

This topic contains the following:

e Creating grid formats
e Renaming formats

e Deleting formats

P 1o create grid formats

If you want to recall the default format, save the original grid format before you
save a new format. Otherwise, you must remove the new format, exit the
application, and then access the application again to view the default grid
format.

1. On any form with a grid, click the right mouse button to display a
pop-up menu.

2. From the pop-up menu, choose Format and then New Format.

oK

Format Type
& Grid Farms ¥ cancel

| ChartiGraph
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3. On Name Format, choose Grid Format as the type and then click OK.
You can accept the name OneWorld provides or enter your own.

4. Click a tab to move to that view of the grid.

> To rename formats

On any grid with format tabs, choose a format tab.
Click the right mouse button to display a pop-up menu.

From the pop-up menu, choose Format and then Rename Format.

LTS A o

On Rename Format, change the name of the format and then click OK.

> To delete formats

1. On any grid with format tabs, choose a format tab.
2. Click the right mouse button to display a pop-up menu.

3. From the pop-up menu, choose Format and then Remove Format.

The system deletes the tab for each format that you remove.

Formatting the Grid

Format your grid to customize the sequence of the columns and rows by
reordering the columns or by sorting the rows differently. For example, you
might want to move a column that you often use from the end to the front. You
can also change the size of columns and rows to display more information, or
determine new sorting criteria to display records in a list more appropriate to
your business needs. You can sort records by any column in the grid. Each
format supports a sort sequence that is unique to the format.

The Auto Return feature allows you to designate a column in the grid that sends
you to the first cell in the next row when you tab out of a cell.

Complete the following tasks:

e Reorder columns

e Change the sorting sequence
e Size columns

e Size rows

e Set up Auto Return
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> To reorder columns

1. On any form with a grid, click and hold down the left mouse button over
the title of the column that you want to move.

2. When the mouse pointer changes to a cursor with a column, drag the
column to the new position.
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c
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& 71 Work With Addresses

3. Release the mouse button.

» 1o change the sorting sequence

1. On any form with a grid, click the right mouse button in the grid to
display a pop-up menu.

2. From the pop-up menu, choose Grid and then Sequence.
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3.  On Select Grid Row Sort Order, to choose which columns that you want
to use to sort your information, complete one of the following:

e From the Columns Available list, choose a column, then click the
right-arrow button at the bottom of the form.

That column appears in the Columns Sorted list.

e If you want to sort all of the columns, click the double-right-arrow
button at the bottom of the form.

All of the columns appear in the Columns Sorted list.

e To remove a column, from the Columns Sorted list, choose a
column and click the left-arrow button (click the double-left-arrow
button to remove all of the columns).

Chosen columns appear in the Columns Available list.

4. To choose the sorting order of the columns, from the Columns Sorted list,
choose a column, then click one of the following buttons:

° Up
Moves that column up in the sort order one column at a time.
e Down

Moves that column down in the sort order one column at a time.
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e Top
Moves that column to the top of the sort order.
e Bottom
Moves that column to the bottom of the sort order.

5. From the Columns Sorted list, click the A or D button to the right of each
column to change how the records for that column appear in the grid:

o A
The records appear in ascending order
e D
The records appear in descending order
6. Click OK.

Your changes appear in the grid.

> To size columns

1. On any form with a grid, click and hold the right edge of the column that
you want to adjust.

The cursor changes to a column sizing tool.
2. Drag the cursor to increase or decrease the width of the column.

3. Release the mouse button.

» To size rows

You can only size rows that have grid row headers. The row headers comprise
the area to the left of the grid where icons appear.

1. On any form with a grid, click and hold between two rows in the grid
row header (the area to the left of the first column).

The cursor changes to a row sizing tool when you place the cursor
between two rows.
2. Drag the cursor to increase or decrease the height of the row.

3. Release the mouse button.
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The following icons appear in the row header column to show specific
information on OneWorld revision forms:

Lock The lock above the first column indicates that you have
moved into a protected field. You cannot change
information in this field

Paper Clip The paper clip indicates that a media object exists as an
attachment to this record

The paper clip icon only appears next to a record with
attachments when you check for attachments

See Also

e Attaching Media Objects to add text, images, object linking and embedding
(OLE) objects, and shortcuts to records

> To set up Auto Return

The Auto Return feature allows you to designate a column in the grid that sends
you to the first cell in the next row when you tab out of a cell. For example, if
you enter similar information into a large number of grid rows but you do not
enter information into each column on the grid, you can format your columns
into a specific order. Then you can set Auto Return on the last column into
which you enter information so that when you tab out of a cell in that column,
you automatically start at the beginning of the next row. You can only activate
Auto Return on a grid into which you can enter information.

1. On any form with an input-capable grid, in a cell in the column that you
want to set as your last column, click the right mouse button to access a
pop-up menu.

2. From the pop-up menu, choose Column and then Auto Return.
A colored line appears at the right edge of the column to mark the Auto

Return at that column. Whenever you tab out of this column, the cursor
moves to the first cell in the next row.

3. To remove Auto Return, repeat the process in the Auto Return column.
The colored line disappears.

Auto Return is no longer set for the grid.
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Customizing the Appearance of the Grid

8-38

You can customize the colors and fonts in the grid. You can do this to highlight
specific information or to adjust for personal preferences. Also, you can change
the magnification of the grid to increase the number of rows that you can view
at the same time or to bring important information into focus.

This topic contains the following tasks:

e Changing fonts
e Changing a background color

e Changing the magnification

» 10 change fonts

You can change the fonts for individual columns or for the entire grid.

1. On any form with a grid, move your cursor into the column in the grid
where you want to change the font, and then click the right mouse
button to display a pop-up menu.

Your cursor can be anywhere within the grid if you are changing the font
for the entire grid.

2. From the pop-up menu, perform one of the following:
e Choose Column and then Font to change column fonts.

e Choose Grid and then Font to change grid fonts.

If your cursor is on the column title, only the column title font changes.
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3. From Font, choose a font and any additional attributes, such as style, size,
color, and effects.

4. Click OK to apply your changes.

» 10 change a background color

You can choose the background color for individual columns or for the entire
grid.

1. On any form with a grid, move your cursor into the column where you
want to change the background, and then click the right mouse button to
display a pop-up menu.

Your cursor can be anywhere within the grid if you are changing the
color for the entire grid.
2. From the pop-up menu, perform one of the following:
e Choose Column and then Color from the menu for column colors.

e Choose Grid and then Color for grid colors.
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3. From Color, choose a color and click OK to apply your changes.
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» 1o change the magnification

1. On any form with a grid, click the right mouse button to display a
pop-up menu.

2. From the pop-up menu, choose Grid, then Zoom.

— M agrification
 200% Ok
e m Cancel |
7%
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& 28x
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3. On Zoom, choose a preset percentage from the Magnification box or
enter your own value in the Custom edit box, and then click OK to apply
your changes.

Freezing Columns and Rows

8-40

Freezing allows you to lock specific columns and rows into place so that they
do not disappear from view while you scroll through long lists. You can also
freeze just the column title so that no actual records freeze. The system shows
the frozen area with a heavy red line.

This topic consists of the following tasks:
e Freezing columns and rows

e Unfreezing columns and rows

> To freeze columns and rows

When you freeze a row, all columns and rows above the row and to the left of
the column also freeze. A red line appears to mark the frozen area. Also, you
can freeze only the columns in the grid by performing the following tasks on
the column title. However, to freeze any number of rows, you must freeze at
least one column.
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1. On any form with a grid, move your cursor into the column and row that
you want to freeze.

2. Click the right mouse button to display a pop-up menu.

3. From the pop-up menu, choose Column and then Freeze/Unfreeze.

A red line appears on the right of the frozen column and below the
frozen row.

4. To test the system, scroll to the right.

The frozen columns remain in view.

> To unfreeze columns and rows

1. On any form with a grid, click the right mouse button to display a
pop-up menu.

2. From the pop-up menu, choose Column and then Freeze/Unfreeze.
The red lines disappear.
3. Test the system by scrolling to the right.

Previously frozen columns now scroll out of the form.

Maximizing the Grid

You can maximize the grid to fill the parent window. The menu bar and toolbar
remain visible above the grid. Restore the grid to return the form to its default
appearance.
This topic consists of the following tasks:

e Maximizing the grid

e Restoring the grid

> To maximize the grid

1. On any form with a grid, click the right mouse button to display a
pop-up menu.

2. From the pop-up menu, choose Grid and then Maximize/Restore.

OneWorld Xe (9/00) 8-41

To access English documentation updates, see
https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



OneWorld Foundation

The maximized grid expands to fill the parent window.
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3. Maximize or resize the parent window to display more of the grid.

P To restore the grid

1. On a form with a maximized grid, click the right mouse button to display
a pop-up menu.

2. From the pop-up menu, choose Grid and then Maximize/Restore.
The form restores its default settings.

Your form also restores its default settings when you close the form and
then reenter.

Exporting Data from the Grid

You can export the contents of the grid into a third-party spreadsheet or word
processing application. You also have the option to establish a hot link between
an input-capable grid and a third-party spreadsheet. A hot link allows you to
update data in two connected applications simultaneously. Thus, when you
update data in your OneWorld grid, your third-party spreadsheet data of that
grid is also updated. If the OneWorld grid does not allow you to enter
information into it, you cannot establish a hot link with it.

OneWorld might offer a third-party application that you do not have installed
on your workstation. If you try to access this application to export data, a
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message box appears to inform you that the application is not available on your
workstation.

» 1o export data from the grid

1. On any form with a grid, click the right mouse button to display a
pop-up menu.
2. From the pop-up menu, choose Export and then choose a third-party

application from the menu.

If you choose a spreadsheet application, the following Export Assistant
form appears.

@ Export Assistant E3
Selectthe range of cells you want to use as

data to export. Then click Continue to export VSC—

the data. x T — |

Mate: First rove will became calumn headers

—Options
2| Estaklish aHot-Link!

* Exportio a Mew Workbook

" Exporttio an Existing YWorkbook I I
Specify a cell address to start the export Im

from (for example A1, BT

Specity a waorkeheet narme to expart o I

If you choose a word processing application, the following Export
Assistant form appears:

ﬂ Export Assiztant Ed

Selectthe range of cells you want to p
use as data to export. Then click _LWEQ
Continue to export the data.

MOTE:
Flease make sure that you hawve
the target application installed.

3. As necessary, complete the following:

e Establish a “Hot Link” to a third-party spreadsheet if the OneWorld
grid is input-capable. Otherwise, the hot link checkbox is disabled.
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e Export to a New Workbook.
e Export to an Existing Workbook.
e Specify a worksheet name to export to.
e Specify a spreadsheet cell address field.
4. On the grid, choose the range of cells to export.

5. Click Continue to begin the application and export the chosen data.

Importing Data into the Grid

8-44

You can import data from third-party spreadsheet and word processing
applications into an input-capable OneWorld grid. You also have the option to
establish a hot link between a third-party spreadsheet and an input-capable
OneWorld grid. A hot link allows you to update data in two connected
applications simultaneously. Thus, when you update data in your third-party
spreadsheet, your OneWorld grid is also updated.

OneWorld might offer a third-party application that you do not have installed
on your workstation. If you try to access this application to import data, a
message box appears to inform you that the application is not available on your
workstation.

You must specify a range of cells to import from the third-party application into
the grid. The convention that you should follow when you specify this range is
“Ax:Bx.” For example, to import a range of cells between cell D3 and cell G6,
you need to type “D3:G6.”

» 1o import data into the grid

1. On any form with an input-capable grid, click the right mouse button on
the grid to display a pop-up menu.

2. From the Import menu, choose a third-party application.
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File name: I.-'l‘n.c:count.:-tls Open

Files of type: IEHCE!' Files LI Cancel

Import Options
[ Establish a "Hot-Link"

Specify a range of cells to imparn fe.q. A1:B10)

T il

Specify a worksheet name to import from

3. On Open, complete the following:
e TFile name
e Specify a range of cells to import
e Specify a worksheet name to import from
4. If necessary, complete the following:
e Files of type
e Establish a “Hot Link”
5. Click Open to send the data to the OneWorld grid.

Locked cells do not accept imported data.
Printing the Grid

You can print the contents of the grid directly to a printer. You can specify
ranges of cells on forms where you can select more than one row. In addition,
you can adjust margins for your printout.

> 1o print the grid

1. On any form with a grid, click the right mouse button to display a
pop-up menu.

2. From the pop-up menu, choose Grid and then Print.
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@ Grid Print Dialog

Print Cell Range

: ¥1 cell |1 w1 cell |1
¥ Draw shadows
¥ Draw calors %2 cell |1 5 w2 cell |1 4

¥ Shaow grid

¥ Shaow column headers

[T Show row headers

Fage margins
& Use maximum data o ’
Left Top

¢ Print current page
Right i Bottam

1
|

 Print cell range

< 0K Setup | $¢  Cancel |

3. On Grid Print Dialog, click one or more of the following printing options:
e Draw border
e Draw shadows
e Draw colors
e Show grid
e Show column headers
e Show row headers

4. Choose the range of data that you want to print from the following
options:

e Use maximum data (default)
e Print current page
e Print cell range

5. If necessary, do the following:

e Click the Setup button to change the default printer or modify
additional printer settings.

e Adjust the page margins.
6. Click OK.
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Creating Charts and Graphs

You can create charts and graphs in the grid of any form to provide a graphical
view of your data. By selecting different types of data to chart, you can easily
view differences and relationships between certain items.

P To create charts and graphs

1. On any grid with an established grid format, click the right mouse button
to display a pop-up menu.
2. From the pop-up menu, choose Format and then New Format.

Enter the name for the format.

Choose Chart/Graph as the type and then click OK.

For each format that you create, a tab appears at the top of the grid.
Chart tabs contain a graphic icon.

The Chart Assistant form appears.

5. On the grid, select the range of cells that you want to use as data to
graph.

Row data in the first column is always used for labelling the X or Y axis.
6. On Chart Assistant, click Continue to draw the graph.
A graph appears.

Grid  Graph |

Wiork With Addresses

Chr
Address Lie 1

. Alpka Mame
Series Labal — e (D Group Label

FoaiNok

%

|R0w:1

=

& Work With Addresses |

Customizing Charts and Graphs

After creating the chart or graph format, it is possible to customize the text
within these formats to make it more meaningful to your business. You cannot
change the label that describes the field that stores the graph information in the
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record. The graphing feature does not create this information. OneWorld copies
the information from this label directly from the grid record.

P To customize charts and graphs

1. On the graph, double-click any text on the graph to access the Chart Text
Attribute form.

2. On Chart Text Attribute, complete the following field:
o Text

3. Click the Font button to access a form where you can change the font
properties for the label.

4. When you finish working on Chart Text Attribute, click OK to return to
the graph.

On the graph, click the right mouse button to display a pop-up menu.

Choose Graph Types. The following graph types are available:

e Line
e 3D
o Area
e Pie

e Histogram

e Percent Bar

e Pie Bar

e Side by Side Bar
e Stacked Bar

e Scatter
For 3D formats, additional formatting choices are available:

e Preset Angles:
e Standard
e Long Narrow
e Bird’s Eye
e Distorted
e Custom Angles (currently inactive)
e Cube Color
e Show 3D Tool
e Hide 3D Tool
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If you choose 3D, the 3D selection form appears.
7. On the 3D selection form, choose Show 3D Tool.

The 3D Tool form displays showing the 3D Rotation controls.

%\%\:

3-D Eotation

¥ Show Graph
Undo | Redraw |

8. On the 3D Tool, click the red arrows to adjust the outline of the graph.

9. Click the Redraw button to apply changes.
The row of buttons at the top provides access to additional controls:

e 3D Movement

3-D Movement

¥ Show Graph
Undo | PRedraw |
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e 3D Zoom, 3D Perspective, and 2D Pan

@ 2-D Pan

3-D Perspective

¥ Show Graph
Undo | Redraw |

e 3D Box Proportions

3-D Box Proportions

¥ Show Graph
Undo | Redraw |
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User Overrides (P98950) allows you to change the appearance of an application
to fit the needs of your business. For some user overrides, such as an object
linking and embedding (OLE) attachment to a form, no consequences exist
when you upgrade your OneWorld software because your user overrides are
merged into the new release. For other user overrides, such as grid or toolbar
formats, OneWorld gives you the option to try to reconcile your user overrides
with the new software, or you can delete your user overrides.

This section contains the following:
L] Understanding user overrides

] Working with user overrides
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A user override changes only the appearance of an application. It does nothing
to the application’s functions. You can set overrides by user ID, group ID, or the
keyword *PUBLIC. If you set your override by user ID, only that user is affected
when he or she signs onto any workstation in the enterprise. If you set your
overrides by group ID, those users who are set up within User Profiles to be
members of that group are affected. If you set your user overrides by *PUBLIC,
all users in the enterprise are affected. After you create an override for a group
ID or *PUBLIC, each employee inherits that override, regardless of the
workstation he or she signs onto. Even with group or *PUBLIC overrides, each
employee can further customize a version to fit individual needs. For example, if
someone in a department has trouble seeing text on a form, he or she can
switch to a larger font. This change applies only to the individual, and not to the
entire group or company.

OneWorld stores these modifications in the User Overrides table (F98950).
Because OneWorld tracks the overrides by your user ID or group ID, the
modifications will appear on any workstation that you sign on to. User Overrides
allows you to make the following modifications:

e Resequencing the grid

e Changing the sort order of rows and columns

e Freezing columns and rows

e Moving and resize columns and rows

e Changing the magnification and font size

e Adding charts and graphs to an application, and embedding third-party

products that support OLE automation

The following overrides are only local. They could be considered workstation
preferences. The system stores these overrides on your workstation. Therefore,
they are accessible only from that particular workstation:

e Sizing of the parent and child windows

e Changing the parent window

e Changing fonts on a form

e Maximizing the form

e Turning on the exit bar

This topic contains the following:
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[] Search Hierarchy

] Cached Override Information

Search Hierarchy

During the execution of an application, the system uses a search hierarchy to
locate a user override. The system searches by user and group for each unique
combination of application, form, version, and language in the following order:

User ID When you access a specific application, the system
searches for an override for the application under your
user ID first.

Group If the system does not find an override under your user ID
for the application, it then searches for it at the group
level. For example, if you are in the Accounts Payable
group, the system searches for an override for that group.

*PUBLIC If the system does not find an override for the application
at the group level, it searches for it under *PUBLIC. If no
override is found at the *PUBLIC level, the system uses the
default No Overrides.

Cached Override Information

The first time that a user brings up a OneWorld application form, the system
reads the User Override table (F98950) and creates a disk cache on the
workstation. This table contains form-specific information such as menus,
buttons, and formats. This cache serves to improve OneWorld network
performance because multiple database fetches are not required to retrieve the
individual form elements.

However, if a system administrator or the user modifies user overrides using the
User Overrides (P98950) application, the override information is written directly
to the F98950 table, and not to the cached table. Because OneWorld always
reads overrides from the cached information, any modified user overrides cannot
become effective until the user exits and reenters OneWorld, causing the cached
table to be refreshed.

For example, assume that you want to modify a journal entry by adding tabs and
having those added tabs associated with your user overrides. First, create the tab
and then use the P98950 application to associate the tab with your user profile.
However, you will not be able to immediately see any records of the journal
entry form because the user override is stored in the User Override table. But
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OneWorld is looking at the cached information. The cached information can
only be refreshed by exiting OneWorld and restarting. This process does not
affect your ability to create and use local form changes, or workstation
preferences, that are not stored in the F98950 User Override table.

If, for some reason, you have two users who share the same user ID, be aware
that OneWorld does not share user override records. If both users sign onto
OneWorld at approximately the same time, the first of these two users to sign on
sees the user overrides while the second user to sign on does not. Furthermore,
the first user to make an override change during simultaneous sessions takes
control of the F98950 record, and all other users signed onto the same user ID
are locked out.
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You can create user overrides for a user ID, group ID, or for *PUBLIC. After you
create a user override, your user override will be available on any workstation
that you sign on to in the enterprise.

If a form for which you have created user overrides has changed after upgrading
your software, OneWorld attempts to merge your user overrides with the
changed form. You might, however, need to reset your user overrides, or at the
least, verify that your user overrides are still intact.

This topic contains the following:

[] Creating user overrides

[] Fixing user overrides after a form change

Creating User Overrides

You can create individual user overrides in which the changes that you make to
an application reside on an enterprise server and are associated with your user
ID. This override is available to you at any workstation that you sign on to. To
create a group override, you first create an individual override, and then you
change that override to a group override, thereby making the override available
to employees within a group or to the entire company (*PUBLIC).

This topic contains the following:
e Creating an individual user override

e Changing an individual override to a group override

> To create an individual user override

1. Choose the application for which you want to create an override (for
example, Voucher Entry).

2. Modify the application (for example, rearrange columns or rows on the
grid). When you exit the application, the preferences that you just set up
are stored in User Overrides under your user ID.

See Application User Interface for more information on how to modify
applications.
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» 10 change an individual user override to a group user override

1. On the System Administration Tools menu (GH9011), choose User
Overrides (P98950).

@ User Dvenides - [Work With User Ovemides]
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* i}
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2. On Work With User Overrides, locate and choose the individual override
record that you wish to make available to a group.

Note: Be sure that you choose the correct type of override. The two types
available are GF for grid tab format overrides, and HC for menu and
toolbar overrides. For example, to deploy a grid tab to other users, you
need to choose a GF record, whereas, to deploy a changed menubar or
toolbar, you need to choose an HC record. On the Work With User
Overrides form, scroll to the right to see the override type.

3. Click Copy.
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. User Overrides - [Copy Overrides]

4. On Copy Overrides, enter information in the following fields:

OneWorld Xe (9/00)

User/Group

Enter either a valid group, which has been set up in User Profiles,
or *PUBLIC to copy the user override to a group or the entire
company.

If you want to change a J.D. Edwards demo version and want the
copied version to use the same user overrides as the demo version,
do not change the User/Group, but name the version to represent
your custom version.

Version (optional)

Enter the version name to copy user overrides set up for one
version to another version. User Overrides does not create versions.

Language (optional)

Enter a valid language code to select the user override language for
the specified user and application.

If you copied and modified the version, delete the individual user record
that you copied. Deleting this record ensures that when you sign in, you
are viewing the overrides for the group that you are in, not the override

that is specific to your user ID.

Note: The system creates a record for each form that you modify.
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Fixing User Overrides after a Form Change

When you install a package on your workstation, you might have a discrepancy
between the changed forms included with the new package and the grid, menu,
or toolbar user overrides that you made before the installation. For example, a
new column might have been added to a grid for which you have user
overrides. After the package installation, the first time that you access the
changed form, OneWorld detects the discrepancy between the newly installed
form and your existing user overrides. OneWorld asks if you want to fix your
user overrides to include the new column or delete your user overrides
altogether. If OneWorld cannot fix the discrepancy between the changed form
and your user overrides, OneWorld automatically deletes your user overrides.

OneWorld performs this fix only for grid, menu, or toolbar user overrides

because all other user overrides, such as an OLE attachment to a form, do not
interfere with changes to a form.

P 1o fix user overrides after a form change

The first time that you access a form after a package installation and have a
discrepancy between the newly installed form and your user overrides, a
message box appears. This box prompts you to either delete your user overrides
for that form or have OneWorld try to fix your user overrides to match the
changed form.

On the message box that appears, perform one of the following:
e To delete your user overrides, click Delete.

OneWorld deletes your user overrides for that form. You can add your
overrides again by following the process of creating user overrides.

e To try to fix your user overrides, click Fix.

OneWorld tries to merge the changes from the newly installed form with
your user overrides for that form. If successful, verify that the form works
properly with your user overrides. If there is anything wrong with the grid
formats or menu and toolbar customization after OneWorld tries to fix the
discrepancy, you should delete your user overrides for that form. On the
Work With User Overrides form, choose your overrides and then click
Delete.

If OneWorld is unable to merge the changes with your user overrides,
OneWorld automatically deletes your user overrides for that form. You can
add your overrides again by following the process of creating user
overrides.
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Records

Databases store information in units called records. Each record might contain
more than one item of information. For example, Dominique Abbott is an item
of information in OneWorld. When you access Dominique Abbott from the
Address Book application, the record that appears may also include her phone
number, address, and other pertinent information. OneWorld might save all of
this information as one record, or it might save some of this information as a
primary record and other information about Dominique Abbott as secondary
records. These types of relationships exist throughout OneWorld.

Database tables store all OneWorld records. Each record must have at least one
key that links the record to a database table. Keys function as unique identifiers
to distinguish one record from another. For example, Address Book uses
Address Number as the key to distinguish each record. Therefore, each Address
Number must be unique. When creating new records, you must enter
information into a key field. If you do not enter information into a key field,
OneWorld displays an error message. Once you have entered information into a
key field, you cannot edit that key field later. To change the key field
information, you need to create a new record.

The Media Objects feature allows you to add notes, graphics, and other objects
to records. For example, you can use a note to explain special circumstances
surrounding a journal entry. You can also attach drawings, animations, and other
types of objects to records.

This section contains the following topics:

L] Locating records

] Working with records
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Locating Records

To locate a record, use the grid on the Find/Browse form. The grid displays one
or more records when you perform a search. By examining the information
displayed in the grid, you can identify the records that you want to review, copy,
update, or delete. Records that match your selection criteria appear in the detail
area below the column titles.

You can locate all associated records from any Find/Browse form by clicking on
the Find button and then scrolling down the list of records. OneWorld loads
records one page at a time to improve performance. Only the records that you
see in the grid have been retrieved. When you scroll down, OneWorld retrieves
new records. Depending on how many records that you have and on your
system resources, loading every record might take a long time. However,
OneWorld allows you to filter your records by narrowing and defining the
criteria for your search. The following list provides examples of how to define
your search criteria:

e Use the filter fields at the top of the form. For example, you can enter
information in a filter field to search only for employee records.

e Use the query-by-example line to search in one or more columns based
on criteria such as a specific name and address number, or a range of
names and numbers.

e Refine your search in the filter fields and the query-by-example line using
a wildcard.

This topic contains the following subjects:
[L] Locating records using specific selection criteria
] Using the query-by-example line

[ Locating records using wildcards and operators

Locating Records Using Specific Selection Criteria

Selection criteria defines your search by specific types of records. For example,
you can include information in filter fields such as Name Search and Search
Type to search for only employees whose names start with the letter “A.”
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P To locate a record using selection criteria

1. For example, on Work With Addresses, complete the following field:

e Search Type

If you do not know the Search Type, use the visual assist Search button to
view a list of user defined codes.

2. Click the Find button.

A list of matching records appears.

Field Explanation

Search Type A user defined code (01/ST) that identifies the kind of
address book record that you want the system to select
when you search for a name or message. Examples
include the following:

Employees

Ex-employees

Suppliers

Customers

Prospects

Mail distribution lists

Tax authority

HZTO < X

See Also

e Accessing Visual Assists for information about the visual assist Search
button

Using the Query-by-Example Line

You can use the query-by-example line to search for records by a grid column.
For example, if you are searching for a person by name, enter all or part of the
name in the query-by-example line directly above the Alpha Name column in
the grid.

The information that you enter in the query-by-example line must be a valid
value for the column. If it is not, the system will not find a match. You cannot
enter values in the disabled (grayed-out) columns because these columns do not
allow searches.

Some query-by-example lines in OneWorld work differently. On certain forms in
OneWorld Tools, after filling in one or more fields, the act of tabbing to the end
of the line acts in the same way as clicking the Find button.
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> To use the query-by-example line

On any Find/Browse form, type the characters on which you want to search in

the corresponding column of the query-by-example line, then click Find.

The record that matches the query criteria appears in the grid.
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Locating Records Using Wildcards and Operators

You can use the asterisk (*) as a wildcard character in place of one or more

letters. Using the asterisk widens your search. For example, you can type “abb*”
in the alpha name column of the query-by-example line to view all records that
begin with the letters “abb.” Or you can type “*bb*” in the query-by-example line
to retrieve records with those letters in the middle of the names.

In addition, you can search for values in a set using operators. For example, in
the Address Number column of the query-by-example line, type “<87” to specify

address numbers less than 87. Type “<b” in the Alpha Name column of the

query-by-example line to specify names beginning with “a”.

The following operators are valid on the query-by-example line:
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< Less than
<= Less than or equal to
> Greater than
>= Greater than or equal to

o

Not equal to

Each time that you enter values in a search, click the Find button to retrieve

matching records.

The following illustration shows the matching records of the operator entered

into the query-by-example line:
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Records are often related to one another within J.D. Edwards applications. Many
of these relationships depend on one another. In other words, you can change
primary records by adding, deleting, and saving the information located on the
secondary records or the records themselves. For example, you can have a
primary or master record that contains an employee’s name and address.
Additional information, such as his or her phone numbers, exists in a secondary
record.

Primary Record
Address Book #0938
Joe Jones
342 Elm

Secondary Record Secondary Record Secondary Record
Phone Numbers Who's Who Category Codes
837-3928 Home Joe Jones Region: DEN

783-9816 Car President

OneWorld is event-driven, which means that actions, such as clicking on a
button, tabbing to a field, or selecting from a menu or list, can alter your data.
However, changes to the database are not saved until you exit a form by clicking
OK or pressing Enter. Information that you change on related forms is not saved
until you enter those changes in the previous form and click OK to accept them.

When you work with records, you should be aware of the following
considerations:

Primary and secondary  When adding records to the database, you add the

relationships primary record first and then add the secondary records. It
is important to remember that primary records must be in
the database before you can add a secondary record to
the database.
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Working with records

Adding

Changing

Copying

Deleting

Dates

10-8

The process for changing, adding, and deleting records is
consistent throughout the system. Two types of forms on
which you can make these types of changes to your
database exist:

e A single-record form, such as Address Book
Revisions
e A multiple-record form, such as Phone Numbers

When adding a record, if it contains a Next Numbers field,
the number is added automatically.

When adding records to a Find/Browse form, you click
Add. Complete the blank form that appears. Click OK
when completed.

Any required field that you do not complete will highlight
in red when you finish adding the record.

If a field is protected, such as Address Number on Work
with Addresses, you cannot change it.

When copying a record, the system does not copy all the
fields to the new record. In order to make the record
unique, the system changes certain fields for the new
record.

In a Find/Browse form, such as Work With Addresses,
choose the row that you want to delete and click Delete.
The system prompts you with a series of confirmation
messages for each row that you select to delete.

In a multiple-record form, such as Phone Numbers, you
must choose the entire row in the grid to remove that
row.

You cannot delete a record from a single-record form
such as Address Book Revisions. You can delete only
from the grid.

Depending upon which application you are in, when you
delete a parent record, the system deletes the information
from related forms. See the application guide for
information about deleting child records.

The system validates dates according to your user profile.
You can assign your user profile either Windows or
OneWorld settings.
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Tabbing out of a field When you tab out of a field, the system validates the field.
If it is not correct, you get an error message.

User defined codes The system validates user defined codes against the user
defined code table.

Account numbers The system validates account numbers against the account
number table.

This topic contains the following:
L] Choosing a record
[ Adding a record
L] Changing a record

L] Deleting a record

Choosing a Record

You choose a record for a variety of reasons. For example, you might need to
change an employee’s address and phone number. You can choose a single
record or multiple records from the Find/Browse form, and then change the
information on a Revision form.

You can choose a record in one of two ways:

e Click the record and then click the Select button to open the
corresponding form.

e Double-click a record to select it and open the corresponding form.

» To choose a record

1. On any Find/Browse form, locate a record.

2. Double-click the record to display it on a revision form.
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. Work with Addresses - [Address Book Revision]

McLind, Rod

204520492

3. On the revisions form, revise the record and then click OK.
If you selected more than one record, your second record might appear
now. If your second record does not appear, click the Next button at the

top of the form. Continue to revise as needed.

4. After you finish, be sure to click OK to save your latest revision and then
click Cancel to exit.

See Also

e [ocating Records for information about the different methods for finding a
record or a set of records

Adding a Record

When adding records to the database, you add the primary record first and then
add the secondary records.

» To add a record

1. On a Find/Browse form, click Add to open a blank revision form.
2. Enter the information for the new record.

3. Click OK.
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When you add records, OneWorld uses the Next Numbers feature to
automatically number Address Book records, journal entries, purchase orders,
and other documents.

Changing a Record

In OneWorld, when you request an application, a Find/Browse form appears.
On the Find/Browse form, you select the action that you wish to perform.
Selecting a button or function that you wish to perform displays, for example, a
Fix/Inspect form on which you can change your record.

As you move from field to field, you can view your changes reflected in the
form. If you type an invalid value in a field, the field highlights red and an error
appears. You must correct the error before you click OK. Clicking OK saves your
changes in the database.

You cannot change information on the Find/Browse form itself. Change
information on the forms appears after you select the appropriate button on the
Find/Browse form.

» 1o change a record

1. On a Find/Browse form, choose a record.

You can double-click a record, or choose a record and then click the
Select button.

2. On the revisions form, revise information as needed.

@ Work with Addresses - [Address Book Revision] [ (O] x]
C:\ File Edit Preferences Form window Help ;IEILI

v x4 \@JLinks
% GED. B A w Displ.. 4mPrevio.. = Mext [BloLE .. [3Intarnet

|»

Address Number 2049
- Mailing | Additional | Related Address | Cat Code1-10 | CatCode 11-30 |

Alpha Marng |McLind, Fod

Long Address Numhber I

Tax D |204920492

Search Type IE Employees

Business Unit I 1

5
4| | 3

£ WinrkWith Addresses & ) Address Book Revision
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3. Click OK to accept the revisions.

Deleting a Record

Occasionally, you might need to remove a record from your database. For
example, you might no longer use a particular supplier. Depending upon the
application, if you delete a primary record, OneWorld may also delete any
secondary records related to the primary record, such as phone numbers. See
the application guide for information about deleting child records.

> To delete a primary record

1. On a Find/Browse form, choose one or more records.

2. Click Delete.

The system prompts you to confirm the deletion.
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Messages and Queues

With OneWorld, you can send and receive electronic mail (e-mail) messages.
OneWorld electronic mail includes messages sent by OneWorld users, people
outside of your OneWorld enterprise, and messages sent by a workflow process.
You can organize your messages by placing them into queues (storage areas for
your messages) provided by OneWorld or by setting up your own queues. The
Employee Work Center is the OneWorld application that manages messages and
allows you to place your messages into queues. This section explains how to
work with your messages and with your queues. In addition, you can also
indicate your work-time location and add remarks to your time log.

This section contains the following:
[ Understanding messages and queues
[ Working with messages
(1 Working with queues

[] Logging time and adding remarks
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Understanding Messages and Queues

The Employee Work Center application provides electronic mail (e-mail) services
within OneWorld. Using this application, you can send and receive e-mail
messages and organize your messages within the storage areas called queues.
This topic contains the following information:

[l Understanding Messages

L] Understanding Queues

Understanding Messages

Messages are electronic mail (e-mail) items that are either internal or external to
OneWorld. Messages can be sent by another person or by an application’s
workflow process.

See the Enterprise Workflow Management Guide for general information about

the workflow process. See your application’s guide for specific information
about a particular workflow process, such as the credit limit approval process.

Internal and External Messages

OneWorld categorizes and processes your e-mail messages in different ways,
depending upon whether the message is OneWorld internal or external.

Internal Messages Internal messages are sent to and received from
individuals within OneWorld using the Employee Work
Center.

External Messages External messages are sent to and received from

individuals either within OneWorld or from outside
OneWorld. External messages are sent and received using
third-party e-mail software packages such as Microsoft
Exchange or Microsoft Outlook.
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Message Routing

The following scenarios explain where database messages are stored, depending
on whether the messages are routed internally or externally from OneWorld.
Internal messages are routed through the OneWorld message system while
external messages are routed through the J.D. Edwards middleware package
called JDEMail, which is Extended MAPI compliant and is used to interface with
third-party external mail products. See Setting Up External Mail Preferences for
information about setting up a third-party mail product for OneWorld messages.

Sender —-> Receiver Description

Internal -> Internal  The system routes a message internally using the OneWorld
Employee Work Center. All of these messages are stored in
the OneWorld database.

Internal -> External  The system stores and routes a message externally using the
Employee Work Center because the receiver has an external
mail preference. The message is stored in the OneWorld
database because it was originally an internal message.

External —> Internal  The system stores and routes a message internally using the
Employee Work Center, even though the sender might have
an external mail preference set up.

The system recognizes that the sender has a OneWorld
address book record and, therefore, bypasses routing the
message unnecessarily through the mail server. The message
is stored in the OneWorld database.

External —> External The system routes the message externally using a third-party
e-mail product. The sender and receiver must each have an
external mail preference set up for a message to be
considered an external e-mail message. The message is stored
in the third-party e-mail database.
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The following graphic shows how OneWorld routes and stores internal and
external messages:

Employee Work Center

Send or receive — =-0 Send or receive
internal message I external message
A
PPAT Message PPAT Media Objects
Control Message Storage
(FO1131) Detail (FO0165)
(FO1133) v
J==0
== Mail Server
| (JDEMail with
Extended
l = MAPI/SMTP)
Third-party

e-maiil Product

Internet

Workflow Messages

The standard internal and external messages are sent by users, but a type of

message called an action message is sent automatically as part of a workflow
process.
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Action Messages Workflow processes sometimes generate messages that
require you to take action, such as approving or rejecting
a change to a customer’s record. A lightning bolt icon
identifies an action message. Action messages can also act
as informational messages that tell you about purchase
orders that need to be approved or accounts receivable
credit checks that need to be researched.

Action messages contain a shortcut icon that links directly
to an application. When you click the shortcut icon, the
system retrieves the most current information from the
database. This purpose ensures that you get accurate
information even if there are changes after an action
message is sent to you.

You can send action messages to specific queues.

Understanding Queues

Queues are storage areas that allow you to organize messages using the
Employee Work Center. For example, messages can be organized into queues for
priority mail, Internet messages, or for submitted jobs. Through a queue, users
can approve or reject certain activities in a workflow process. A queue is actually
a user defined code, and you set up a queue in the same way as you would set
up any user defined code.

Queues Provided with OneWorld

OneWorld provides the following queues:

Sent Messages that you have sent to others.

Deleted Messages that you have deleted. After you delete a
message, you can view it, but you cannot move it to
another queue.

The system administrator has the authority to purge
deleted messages from the system, which is typically done
on a periodic or predetermined schedule. You can also
remove a message from the system by deleting it from
your Deleted queue.

Internet Messages Messages sent to you from an external mail source.

11-6 OneWorld Xe (9/00)
To access English documentation updates, see
https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



Understanding Messages and Queues

Submitted Jobs Messages generated by the system for jobs that you have
submitted for batch processing, such as the General
Ledger Post.

Action System-generated messages, such as purchase order
approvals and General Ledger Post error messages. These
messages require you to take action. The system sends
them directly to an action queue, making them easier to
manage.

Workflow Queues

Workflow includes several predefined queues, but you might want to set up a
custom queue for messages generated by processes that you create. For
example, you might want to set up a queue for messages generated by a credit
limit approval process. This queue would gather any approval or rejection
messages related to credit limits for customers. A user can then open that queue
and act on the message contained within it.

You can set up the following types of custom queues for a workflow process:

e Queues for categorizing and grouping purposes. For example, you can set
up a queue to collect messages regarding credit management information.

e Queues with a shortcut to a OneWorld application. This shortcut opens a
OneWorld application that is assigned to that queue and related to the
function of that queue. For example, you can set up a queue that is linked
to the Over Credit Limit Review form (PO3B31).

Queue Security

You can change the security status for a user or group of users within a queue.
You can either give a user authority to monitor everyone’s queues within a
group, or you can deny users access to certain queues.

You can add security by user, by distribution list, or both. For example, you
might want to set up security so that a manager can monitor all messages within
certain queues. Or you might set up security by distribution list only so that
users within a distribution list have authority to monitor certain queues. If you
want to give only a few people within a distribution list access to certain queues,
you enter the distribution list and the users’ address book numbers to define
which queues those users in a particular distribution list can access.
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Use the Employee Work Center to send and receive internal electronic mail
(e-mail) messages within OneWorld, or to send and receive external messages
within and outside of OneWorld. When sending external messages, you use a
third-party e-mail software product that you access from the Employee Work
Center. You can also revise messages, reassign messages to other users, direct
messages to queues, attach shortcuts to messages, print messages, and delete
messages.
This topic contains the following:

] Accessing the Employee Work Center
Viewing messages
Sending internal messages
Setting up external mail preferences
Sending external messages
Working with shortcuts
Revising messages
Moving a message to another queue
Redirecting messages to the Priority or Secondary queue
Reassigning messages

Deleting messages

I Ty Ay Ay Ny N

Printing messages

OneWorld Xe (9/00) 11-9

To access English documentation updates, see
https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



OneWorld Foundation

Accessing the Employee Work Center

The Employee Work Center is the hub of e-mail within OneWorld. Use the
Employee Work Center to manage your messages and queues. See Working with

Queues for information about queues. You can access the Work Center in one of
the following ways:

e From the Workflow Management menu (G02), choose Employee Work
Center.

The Work Center form appears.

@ Work Center - [work Center] [_ O]
Cl Fil= Edit Preferences Form How ‘Window Help =& x|

B @ x =2 = B &
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: g Il 3in Phone Queue
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Mg VIP Queue
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e From the Tools exit bar in any application, choose Work Center. You must
have the Exit Bar preference turned on for this bar to appear.

e From the hyper-button in any application, click the down arrow on the
hyper-button, choose Tools, and then Work Center.

Viewing Messages

Use the Employee Work Center to view your messages. Messages sent from
other users will appear in either your Personal In-Basket queue, or if you set it
up, your Priority and Secondary queues. See Redirecting Messages to the Priority
or Secondary Queue. Workflow messages, however, can be sent directly to a

specific queue. See the Enterprise Workflow Management guide for information
about workflow messages.
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Sending

OneWorld Xe

Note: If you cannot view messages, make sure that queue security is set up to
allow you to view the Address Book number and queue that you want to view.
See Changing a User’s Queue Security for information about queue security.

4 To view messages

1. From any application, click the down arrow on the hyper-button and
choose Tools, and then Work Center.

2. On Work Center, double-click on one of your queues that contains a
message.
Any messages in that queue appear. New messages appear in bold.

3. Click on the message that you want to view.

The message appears in the right-side view area of the Work Center form.

Internal Messages

When you send internal e-mail messages, you send them to other users within
OneWorld. You can control the time of delivery for a message by assigning a
tickler date to it. A tickler date is a date in the future when OneWorld will
automatically send the message. Assigning a tickler date is especially helpful if
you plan to be out of the office on the day that you want others to receive your
message, or if you want to remind yourself about upcoming meetings or other
obligations.

When you send internal messages, you can also include an attachment.
Attachments allow you to include files, images, or links that conform to the OLE

standard, such as word-processing documents and spreadsheets.

To send a message to more than one person, you can use a quick list or a
predefined distribution list.

This topic consists of the following:

e Sending an internal message
e Sending a message to a quick list

e Sending a message to a distribution list

4 To send an internal message

1. From any application, click the down arrow on the hyper-button, choose
Tools, then Send, and then Internal Mail.

(9/00) 11-11

To access English documentation updates, see
https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



OneWorld Foundation

11-12
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2. On Send Internal Mail, to send a message to one person, complete the
following fields:

e Send To

e Subject

3. The following fields are optional, so you can complete if necessary:

e Typel
o Type?2
e Mail Box

e Marketing

e Lead Source

o Keep Copy

e Receipt Notify
e Address

e Contact

e Tickler Date

e Phone Number

4. Type your message.

5. To include an attachment with your message, right-click the panel with
the Text icon.
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6. Choose Add, then one of the following:

e Image
e OLE
e Shortcut

7. Click OK to send the message.

OneWorld returns you to the previous application. If you choose to keep
a copy of a message that you send, you can view it in the same queue
from which you sent the message.

See Also

o Working with Media Objects for information about attaching media objects

o System Administration Guide for complete information about media
objects

Field Explanation

Send To A number that identifies an entry in the Address Book
system. Use this number to identify employees,
applicants, participants, customers, suppliers, tenants, a
location, and any other address book members.

Subject For World, this is the first 40 characters of the message
text.

For OneWorld, this is a short description or subject of the
message.

Type 1 A code used to classify types of messages. For example:

1 Internal Message - entering message of this type
does not remove customer from credit or
collection review.

P Promises, Promises Message.

F Other Promises, Promises Message - a
secondary classification of Promises, Promises
messages.

1 Call Tracking Message

If using Promises, Promises, you might want the default

to be P, so that you can print your reports using this
code.

Type 2 A code that classifies the type of messages. For example:
S Direct Sale
D Distributor Sale

Mail Box A field that determines the mailbox associated with the
queue that should be used on delivery of the message.

OneWorld Xe (9/00) 11-13

To access English documentation updates, see
https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



OneWorld Foundation

Field Explanation

Marketing One of two reporting codes that you can assign to a
message in the E-mail system.

Lead Source One of two reporting codes that you can assign to a
message in the E-mail system.

Keep Copy Indicates that the system keeps a copy of the message in
your queue for future reference or for subsequent
mailings.

Receipt Notify Indicates that when the message that is sent is read by

the recipient, the system sends a return message to the
Sender indicating that the message was read.

Address The address book number of the parent company. The
system uses this number to associate a particular address
with a parent company or location. For example:

e Subsidiaries with parent companies
e Branches with a home office
e Job sites with a general contractor

This address must exist in the Address Book Master table
(FO101) for validation purposes. Any value you enter in
this field updates the Address Book
Organizational/Structure table (F0150) for the blank
structure type.

The value you enter in the Parent Number field updates
the Address Organization Structure Master table (F0150) if
the Structure Type field is blank.

Contact The associated company name of the individual who is
sending the message.

Tickler Date The future reminder date. The system does not send the
message until this date. The default value is today’s date.

Phone Number The phone number of the individual who is sending the
message.

» Tosenda message to a quick list

1. From any application, click the down arrow on the hyper-button, choose
Tools, then Send, and then Internal Mail.

2. On Send Internal Mail, choose Quick List from the Form menu.
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3.  On Quick List, complete either of the following fields for each person
whom you want on the list, then click OK:

e Alpha Name
e Address Number

4. Follow the steps for sending an internal message.

This process sends your message to the people whom you placed on the quick
list. You cannot save a quick list.

> To send a message to a distribution list

1. From any application, click the down arrow on the hyper-button, choose
Tools, then Send, and then Internal Mail.

2. On Send Internal Mail, enter one of the following in the Send To field:

e Address Number of the distribution list to send the message to all
members in one distribution list.

e Parent Number of the distribution list to send the message to all
members (children) of the parent distribution list. The parent
distribution list might include more than one distribution list.

3. Follow the steps for sending an internal message.

See Also

o Understanding Distribution Lists in the Enterprise Workflow Management
Guide for complete information about distribution lists
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Setting Up External Mail Preferences

Before you can send or receive e-mail that is external to OneWorld, you must
designate which third-party e-mail product to use. When you choose the
External Mail option to send an external message, OneWorld checks your local
address profile for your external mail information. If no preference exists at the
local level, it then checks the Microsoft Exchange or Microsoft Outlook profile.
Finally, it checks the jde.ini file. If no preference exists at any of these levels,
the system then prompts you to set up an external mail preference.

If no external mail preference has been set up for an employee, you can set
one up using Preference within the Employee Queue Manager.

P 1o set up external mail preferences

1. From Workflow Management (G02), choose Employee Queue Manager
(P012501).

2. On Work With Employee Queue Manager, find and choose the address
number for which you want to apply external mail preferences, and then
choose Preference from the Row menu.

. Employee Queue Manager - [Update Mail Preference]

3. On Update Mail Preference, complete the following fields, then click OK:
e E-mail Preference

e E-mail Address
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See Also

o Setting Up Third-Party Mail Systems in the Enterprise Workflow
Management Guide for more information about using third-party e-mail
systems

Field Explanation

E-mail Preference A user defined code (01/EP) that designates from where a
user sends and receives messages. Values include:

Blank Inactive e-mail. Assigned to a user who sends
and receives only internal messages.

1 JDEM Messaging. All messages sent and
received using this preference are local to the
OneWorld database. JDEM messaging does not
allow any access to e-mail (internet).

2 Microsoft Exchange. Assigned to a user who
sends and receives internal and external
messages using Exchange, which is accessed
from the Work Center.

3 Microsoft Outlook. Assigned to a user who
sends and receives internal and external
messages using Outlook, which is accessed
from the Work Center.

4 Other. Assigned to a user who sends and
receives internal and external messages using a
third-party e-mail system other than Exchange
or Outlook, such as Lotus Notes.

E-mail Address A 40-character field that you can use to enter text.
............. Form-specific information . ... ..........

Enter the e-mail address used for sending and receiving
external messages.

Sending External Messages

You use external e-mail for messages sent to people outside of OneWorld, but
you can also use it for people within OneWorld. Your mail preference must be
set up appropriately to send external messages. See Setting Up External Mail
Preferences in this section for information.

When you send external messages, you can include an attachment, such as an
image or an OLE link, to a word-processing document or a spreadsheet.

P 1o send external messages

1. From any application, click the down arrow on the hyper-button and
choose Tools, then Send, then External Mail.
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2. If the Update Mail Preference form appears, you are not set up to send
e-mail. Complete the following:

e Change the E-mail Preference field to an external mail value, such
as 2 for Microsoft Exchange.

e Enter your e-mail address from the address profile set up in your
third-party e-mail product.

@ Employee Queue Manager - [Send External Mail] A= E
C I File Edit Preferences Window Help =181

J-’*a?l@

OK  Can.. Dis.. Abo

JLmks w Displ.. [JJOLE.. [&]Intemet

I]Dhn_smlth@]dedwards.com [ Keep Copy

To |
cc | Il ™ Receipt Motify

Subject I I~ High Priotity

T e ® 7 omdl=

===y | &

o o

| g
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3. On Send External Mail, complete the following field:
e To

4. The following fields are optional, so you can complete them if necessary:
e CC
e Subject

5. Type your message and then click OK to send the message.

Working with Shortcuts

When you send a message to an internal recipient, you can attach a shortcut to
a OneWorld application and preface it with a message for the recipient’s review
and approval. For example, you might want your manager to approve a change
that you made to a customer’s record. After sending a shortcut to your manager,
he or she can view the record immediately by clicking the shortcut icon. When
you send a shortcut, the system sends the key for that particular record to the
recipient. When the recipient clicks the shortcut icon, OneWorld opens the
application and retrieves the record.

When you answer a workflow action message, you can add your own
comments. These comments are not sent back to the person who originally sent
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the message. Instead, they are stored as part of the audit trail data within
OneWorld. This process only applies to workflow messages that have the
generic workflow approval form attached to them. From this approval form,
you can select Audit Trail from the Form menu and enter audit text.

You can attach shortcuts to messages created in Microsoft Exchange or Microsoft
Outlook. You can also create a shortcut to an application on your desktop.

Complete the following tasks:
e Sending a shortcut

e Creating a shortcut on your desktop

» To send a shortcut

1. From the application from which you want to create a shortcut, retrieve
any records you want the recipient to view.

2. Click the down arrow on the hyper-button and choose Send Shortcut.

The Send Internal Mail form appears with a shortcut to the application.

@ woik Center - [Send Intemnal Mail] [_[O] ]
c:l File Edt Pieferences Form  window Help =1
AN . JL. :
inks - =
J QK Can.. Dis. Apo w Quick... [#OLE [@) Internet
Send To |6002 Abbott, Dominique ™ Keep Copy

Twpe 1 I Type 2 Mail Box |n1 ™ Receipt Nofify
Marketing I Lead Source

Call Frarm IKevim Dormbroves ki Address |51 40346
Cantact | Tickler Date Imnnn
Subject INew Employee Informatian Fhone Murmber I

=\ Y&

¢ (= Sl ® - u[m:]= =
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3. On Send Internal Mail, complete the following fields:

e Subject
o Keep Copy
e Receipt Notify
e Address
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e Contact

e Tickler Date

e Phone Number
4. Type your message.

5. Click OK to send the message.

P To create a shortcut on your desktop

You can create a shortcut to a particular record within an application on your
desktop.

From any application, click the down arrow on the Hyper-button and choose
Tools and then Create Shortcut. The system places the shortcut icon on your
Windows desktop. After you create the shortcut, you can drag the shortcut icon
into an internal or external message. You can place shortcuts into messages
created in any third-party e-mail system.

Revising Messages

You can revise the text of messages in any of your queues. This feature opens
up the actual message and allows you to change the text or add new text.

> To revise messages

1. From any application, click the down arrow on the hyper-button, choose
Tools, and then Work Center.

2. On Work Center, choose the message that you want to revise. Then from
the Row menu, choose Message Revisions.

3.  On the Message Revisions form, change any of the following fields and
then click OK:

e From

e Contact

e Phone Number
e Subject

e Tickler Date

e TFree-form text area
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Moving a Message to Another Queue

You can move a message from one queue to another. For example, you might

want to move a message from your Priority queue to your Personal To Do List
queue.

P  Tomovea message to another queue

1. From any application, click the down arrow on the hyper-button, choose
Tools, and then Work Center.

@Wulk Center - [work Center] 9I=] E3
(:l File Edt Preferences Form How ‘Window Help

=181 x]
B @ x I & = &, K J"
inks Intern... OLE .. Ints t

J Find Del.. Close Sec.. [Mew. Mew. Dis.. Abo N @ @ hems

Address Number  [ooz Abbott, Dominigue 7 Al Queues|

Tickler Date 1143199 [~ Message Mode

=4 Queues @ = |

Main Phone Queue
gm Computerized Branch Exch.

5= Voice Msg. Phone bail
gy VIF Queus

Ly o

Row:t i

Delete record

2. On Work Center, click the All Queues option if the target queue to which
you want to move the message does not appear.

3. Click and drag the message to the target queue. To move more than one
message, hold down the Shift key and click on each message, and then

click and drag one of the messages to the target queue. All highlighted
messages move to the queue.

4. To verify the placement of the message, double-click the target queue
and view the contents.
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Redirecting Messages to the Priority or Secondary Queue

You can redirect messages that you receive from an individual to your Priority
queue. When you do this, the system sends all future messages from that
individual directly to your Priority queue. Alternatively, you can redirect
messages from an individual to your Secondary queue.

To redirect messages to the Priority or Secondary queue, you must follow these
steps and not the ones for moving messages. Moving messages only moves
individual messages, whereas redirecting messages to the Priority or Secondary
queue affects all messages from that user until you remove the designation.

Although you can move a message to the Archived or Deleted queue, the
system does not redirect future messages from the sender to that queue. You
must manually move the sender’s message to the Archived or Deleted queue
each time.

You can redirect messages from more than one person to your Priority and
Secondary queues. You can also prevent messages from being delivered to a
specific queue.

This topic consists of the following:

e Redirecting messages to the Priority or Secondary queue

e Canceling the delivery of messages to a specific queue

P To redirect messages to the Priority or Secondary queue

1. From any application, click the down arrow on the hyper-button, choose
Tools, and then Work Center.

2. On Work Center, choose the message that you want to redirect to your
Priority or Secondary queue.

3. From the Row menu, choose one of the following:
e Priority
e Secondary
4. Double-click the target queue to verify the placement of your message.
Any further messages that you receive from this sender will arrive in the

queue which you selected. Repeat these steps for redirecting other users’
messages.
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P To cancel the delivery of messages to a specific queue

If you decide that you no longer want the system to automatically redirect
messages from an individual to a Priority queue, you can cancel the automatic

delivery of messages to your Priority or Secondary queue.

1. From any application, click the down arrow on the hyper-button, choose
Tools, and then Work Center.

2. On Work Center, choose a message from the user for which you want to
cancel automatic delivery.

From the Row menu, choose Remove.

Move any other messages from this particular sender out of the Priority or
Secondary queue. As long as you keep any messages in your Priority or
Secondary queue from the sender whom you removed, future messages
from that sender will still appear in that queue.

Reassigning Messages

OneWorld allows you to reassign a message to another user, after the message
is sent to the original recipient. This process changes whose queue the message
appears in. For example, if you originally sent a message to Jim, you can
reassign that message to Betty. The message will now be in Betty’s queue and
will not be in Jim’s queue. You can also reassign messages that you receive.

You can only reassign messages in other users’ queues if your queue security
allows.

> To reassign messages

1. From any application, click the down arrow on the hyper-button, choose
Tools, and then Work Center.

2. On Work Center, choose the message that you want to reassign, and then
from the Row menu, choose Reassign.

3.  On Assign Message, complete the following fields, then click OK:
e Address Number

e Queue Designator
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Field Explanation

Address Number A number that identifies an entry in the Address Book
system. Use this number to identify employees,
applicants, participants, customers, suppliers, tenants, a
location, and any other address book members.

Queue Designator A field that determines the mailbox associated with the
queue that should be used on delivery of the message.

Deleting Messages

To delete a message, either drag the message to the Deleted queue, or choose
the message and click Delete. To choose more than one message, hold down
the Shift key and click on each message.

You cannot recover a message after you move it to the Deleted queue. It
remains in your Deleted queue until your system administrator purges
messages, which is typically done on a periodic or predetermined schedule.
Alternatively, you can remove a message from the system by deleting it from
your Deleted queue.

Printing Messages

An alternative to viewing messages online is to print them. You can do either of
the following:

e Print a message

e Print a report that lists all messages within a queue

> To print a message

You might find that you want a printed copy of a message for your records. You
can print a message from any of your queues.

1. From any application, click the down arrow on the hyper-button, choose
Tools, and then Work Center.
2. On Work Center, choose the message that you want to print.

3. From the Row menu, choose Print.
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> 1o print a report that lists all messages in a queue

You can print a report that lists all of the messages in a queue. This report
includes a summary for each message. The two types of message reports are:
e Message Center - Summary
e Message Center - Detail

These reports show who sent and received the message, and the subject of the
message. The detail report shows the content of each message.

1. From any application, click the down arrow on the hyper-button, choose
Tools, and then Work Center.

2. On Work Center, choose the message queue that you want to print.
From the Form menu, choose Print.

On Work with Batch Versions, select the version and submit the report.
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Use the Employee Work Center to organize your messages by using queues. This
topic describes how to manage your queues by creating new ones or adding
security. As with a message, you can also add a shortcut to a queue.
This topic contains the following:

[] Setting up a queue

L] Adding a shortcut to a queue

[] Specifying the queues that a user can view

[L] Changing a user’s queue security

Setting Up a Queue

Queues are a way to group related messages together. You set up a queue in the
same way that you would set up a user defined code. Use this task to set up
queues for the first time or to change an existing queue.

> To set up a queue

1. From Workflow User Defined Codes (G02411), choose Employee Task
Queues.
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2. On Work With User Defined Codes, click Add.
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3. On User Defined Codes, complete the following fields in an empty row on
the grid and click OK:

e Codes
Enter a unique number for the queue.

e Description 1

e Description 2
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Specify “HOT” for Description 02 if you intend to attach a shortcut
to this queue. This field is optional unless you attach a shortcut.

e Special Handling
e Hard Coded

Enter N in this field.

Field Explanation

Codes A list of valid codes for a specific user defined code list.
Description 1 A user defined name or remark.

Description 2 Additional text that further describes or clarifies a field in

the J.D. Edwards systems.

Special Handling A code that indicates special processing requirements for
certain user defined code values. The value that you enter
in this field is unique for each user defined code type.

The system uses the special handling code in many ways.
For example, special handling codes defined for Language
Preference specify whether the language is double-byte or
does not have uppercase characters. Programming is
required to activate this field.

Hard Coded A code that indicates whether a user defined code is
hard-coded.

Valid values are:
Y The user defined code is hard-coded
N The user defined code is not hard-coded

For OneWorld, a check indicates that the user defined
code is hard-coded.

Adding a Shortcut to a Queue

You can add a shortcut to a queue to provide a link to a OneWorld application.
You might do this if all messages in the queue pertain to a particular OneWorld
application.

» Toadda shortcut to a queue

1. Ensure that the Description 2 field of the queue has the literal value HOT
(in capital letters). See Setting Up a Queue for information.

2. To add the shortcut, from Workflow Management Setup (G0241), choose
Queue Properties.

3.  On Work With Queues, click Add.
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. Queue Properties - [Queues Property Revisions]

PozaB201
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[

4. On Queues Property Revisions, complete the following fields and click
OK:

e Queues

Enter the code number of the queue to which you want to attach a
shortcut.

e Application

Enter the program number of the application to which you want to
create a shortcut.
e Form Name

e Version
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Field Explanation

Queues A field that determines the mailbox associated with the
queue that should be used on delivery of the message.

Application The OneWorld architecture is object-based. This means
that discrete software objects are the building blocks for
all applications, and that developers can reuse the objects
in multiple applications. Each object is tracked by the
Object Librarian. Examples of OneWorld objects include:

e Batch Applications (such as reports)

Interactive Applications

Business Views

Business Functions

Business Functions Data Structures

Event Rules

Media Object Data Structures

Form Name The unique name assigned to a form.

Version Identifies a specific set of data selection and sequencing
settings for the application. Versions may be named using
any combination of alpha and numeric characters.
Versions that begin with ‘XJDE’ or ‘ZJDE’ are set up by
J.D. Edwards.

Specifying the Queues that a User Can View

When you set up a new user in a distribution list, you must specify which
queues the user can view within that group.

> 1o specify the queues a user can view

1. From Workflow Management Setup (G0241), choose Queue Security.
2. On Work With Workflow Message Security, click Add.
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3. On Workflow Message Security Revisions, complete the following fields:
e User
e Group

4. Specify the queues that a user can view by completing the following field
and clicking OK:

e Authority Y/N

In this example, Dominique Abbott has access to the Electronic
Workbench, Collection Management, Credit Management, Delinquency
Notice Approval, and Delinquency Fee Approval queues. Therefore, she
can monitor all messages within these queues.

Field Explanation
User A user in the workflow system. This can also be a group.
Group A group or list of users in the the workflow system. The

address book number that identifies a list of users in the
workflow system.

Authority Y/N Indicates whether the user is authorized to make changes
to security information.

............. Form-specific information . . . ...........

For workflow, indicates whether the user can view other
queues in the Work Center.
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Changing a User’s Queue Security

You can deny a user access to queues or allow the user to view all of the
messages within certain queues available to the group.

If you choose the Public Security option, all users will have access to queues
that you specify. For example, if you choose the Public Security option and give
authority to the Collection Management queue, all users in the system will be
able to view all messages in that queue.

> To change a user’s queue security

1. From Workflow Management Setup (G0241), choose Queue Security.

2. On Work With Workflow Message Security, find and choose the user’s
record, and click Add.

3. On Workflow Message Security Revisions, complete the following fields
and click OK:

e Public Security
When you choose this option, the system protects the User and
Group fields because you are specifying that you want to give
authority for specific queues to all users in the system.

e Authority Y/N

If you complete the user field, the system protects the Public Security field.

Field Explanation

Public Security Workflow security records can be set up so that all or
*PUBLIC users have access to specific queues. By
choosing this option, any queue that has been selected by
placing a Y next to it will have a *PUBLIC record written
for it. This will allow any user to view any other user’s
messages in this queue.

OneWorld Xe (9/00) 11-33

To access English documentation updates, see
https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



OneWorld Foundation

11-34 OneWorld Xe (9/00)
To access English documentation updates, see
https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



Logging Time and Adding Remarks

The Employee Queue Manager allows you to inform others of your
whereabouts. You can specify when you are in or out of the office by using the
Check In and Check Out options. You can add remarks to your check out to
provide detailed information about where you are. You can view this
information from the Time Log form.

This topic contains the following:
(1 Checking in and out
] Entering remarks

[] Viewing time logs

Checking In and Out

Checking in and out informs others of your whereabouts. When you check out,
you can also enter a remark, return date, and return time. If you do not enter a
remark, the system supplies the word home. If you do not enter a return date,
the system enters the next business day. The check in and out information
appearing on the Time Log form is discussed later in this topic.

» To check in and out

From the Workflow Management menu (G02), choose Employee Queue
Manager.

On Work With Employee Queue Manager, from the Row menu, choose one of
the following:

e Check In

e Check Out

Each time that you choose Check In or Check Out, OneWorld updates your
status, which you can view from the Time Log.
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Entering Remarks

You can enter a remark to provide more information about your whereabouts,
your schedule, and so on. For example, you might enter a remark indicating that
you are in a meeting, on vacation, or can be reached at a particular phone
number. Later, you might need to update your existing remark, for example, if
you are no longer in a meeting or are leaving on a business trip.

’ To enter remarks

1. From the Workflow Management menu (G02), choose Employee Queue
Manager.

2. On Work With Employee Queue Manager, from the Row menu, choose
Remark.

. Employee Queue Manager - [Check In/Dut and Update Remark]

3. On the Check In/Out and Update Remark form, turn on the Update
Remark option.

4. Enter your remark in the following field:
e Remark

5. The following fields are optional; complete if necessary:
e Return Time

e Return Date

To view your remark, click Find on Work With Employee Queue Manager.
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Field Explanation

Remark A generic field that you use for a remark, description,
name, or address.

Time — Scheduled In The specific time that you are scheduled to return. The
time must be entered in HH.MM format where:
HH  hours
MM  minutes

If you do not enter a time, this field remains blank.

Date - Scheduled In The date that you are scheduled to return. If this field is
left blank, today’s date is inserted. The date must be
entered in MM/DD/YY format where:

MM  month
DD day
YY year

Viewing Time Logs

You can view the times when you or other employees check in and out, and
view any remarks.

> To view time logs

1. From the Workflow Management menu (G02), choose Employee Queue
Manager.

2. On Work with Employee Queue Manager, choose the employee record
time log that you want to view.

3. From the Row menu, choose Time Log.
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OneWorld’s Media Objects and Imaging features allow you to attach useful
information to an application, including information that might currently exist as
a paper-based document. The Media Objects feature allows you to attach the
information to OneWorld applications, forms and rows, and Object Librarian
Objects. The Imaging feature, within Media Objects, gives you flexibility to
create a more efficient method of information storage.

Use Media Objects to link information to applications, either to individual rows
in a grid or to a form. The following list describes the types of information that
you can attach to a grid row or form:

Text Media Objects provides a word processor that lets you
create a text-only attachment. For example, you could use
a text attachment to provide specific instructions for a
form or additional information about a record.

Image Images include files such as Windows bitmaps, Graphics
Interchange Format (GIF) files, and Joint Photographic
Experts Group (JPG) files. These files might represent
electronically created files as well as scanned images of
paper-based documents.

Object Linking and Media Objects can be files that conform to the OLE

Embedding (OLE) standard. OLE allows you to create links between different
programs. Using these links, you can create and edit an
object from one program in a different program.
OneWorld provides the links that you need to attach OLE
objects.

You attach OLE media objects at the base form level.
Media objects attached at this level are attached to a form
and not to any data that might appear in the form. You
can attach media objects to a grid row or a form, but the
files themselves exist in separate directories. The only file
information included with the application to which the
OLE links is the path to the supporting file.

You can only use OLE objects that you properly register
and install as OLE objects through Windows.
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JDE Shortcuts A JDE shortcut is a link that opens a OneWorld
application. Within media objects, you can only attach
OneWorld shortcuts, that is, you cannot attach Windows
shortcuts to media objects.

Uniform Resource Media Objects can be links to web page URLs or other

Locators (URL)/Files related files. When a developer attaches a URL media
object to a control object on a form, the web page
appears as part of the form. When a user attaches a URL
to a form or Object Librarian object, the media object acts
as a link to the URL.

System administrators can also set up templates. A template might include
attachments of its own, such as images and shortcuts. For example, you can
create a letterhead and a standard form for a memo. Also, you might create a
shortcut to include in the template to provide access to an application that uses
data specific to the information that you add to the template. See the OneWorld
Development Tools guide for information on creating attachment templates.

For system administration information, see Media Objects and Imaging in the
System Administration guide.
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You can use the Media Objects feature to add text, graphics, and other objects to
forms and records. For example, you can use a text attachment to explain
special circumstances surrounding a journal entry. Or you can attach drawings,
animations, and other types of objects to forms and records. A pop-up menu
provides access to established templates for attachments and an option to set the
properties for the Media Objects form.

When you attach a media object to a form, the attachment might not be available
if you access different data on the form. For example, if you attach a media
object to a detail form that contains data for Order Number 2002, this attachment
does not appear on the detail form that appears when you access data for Order
Number 3003. The base form, which in this case is a detail form, is the same for
both Order Numbers, but the data associated with the form is specific to each
Order Number. The Order Number represents the key to the location where an
attachment is stored.

OneWorld supports Object Linking and Embedding (OLE). OLE allows you to
create links between different programs. Using these links, you can save an
object from one program in a different program. OneWorld provides the links
that you need to attach OLE objects. You can attach OLE objects as media
objects and at the base form level. When you attach an object at the base level
of the form, you attach the object to the form and not to any data that might
appear in the form.

If attachments exist for a form, a paper clip icon appears at the right of the status
bar when you open the form. For an OLE object attached at the base form level,
a document icon appears at the right of the status bar.

When a form first opens, grid rows do not indicate whether attachments exist for
the corresponding records. You can perform a search on every record that
OneWorld loads onto your workstation or search on each record individually to
determine whether attachments exist for records.

The Text feature includes a word processor that lets you create, view, edit, and
delete notes.

When you create a text attachment, you can also set up templates. You can use
templates to create a format for a frequently used media object.

This topic contains the following subjects:

[] Checking for attachments
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[] Attaching media objects

[] Deleting media objects

] Working with templates

] Working with the properties of media objects

] Attaching OLE objects at the base form level

Checking for Attachments

To find out whether an attachment exists for a record, you must first perform a
search on the record. You can perform this search on one record or on a
number of records at the same time. OneWorld only searches for attachments on
records that you load onto your workstation. For example, when you initially
click the Find button to locate a number of records, only the records that appear
in the grid exist on your workstation. Use the page buttons to view more
records.

When you click the Find button to refresh the records in the grid or to display
new records, the form resets the attachments view status. You must again click
the find attachments button to display the attachments for the grid records.

Complete the following tasks:

e Check for all attachments

e Check for attachments for a single row or a range of rows

> To check for all attachments

On a form with the attachments feature available, click the Checking for
Attachments icon on the left of the row of column titles. This icon looks
like a paper clip overlapping a magnifying glass.

A paper clip icon appears in the row header for each loaded record with
an attachment.

P To check for attachments for a single row or a range of rows

1. On a form with the attachments feature available, move and hold the
cursor over the row header for the grid row.

If an attachment exists for the row, a paper clip icon appears in the row
header.
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2. Move the cursor up or down in the row header column to search for
attachments for adjacent rows.

Attaching Media Objects

Use the Attachments feature to attach text, photos, drawings, spreadsheets, video
images, sounds, and application shortcuts to forms and grid rows. For example,
you might attach the image of an invoice to a data entry record, attach a legal
document to a record that describes a contractual agreement, or attach text that
describes a process on a form. The attachments feature is not available on all
forms.

Note: You cannot create attachments until an administrator has established and
mapped media object queues as described in Media Objects and Imaging in the
OneWorld System Administration guide.

When you enter text, you can format the paragraphs and run a spell check.
OneWorld also supports object linking and embedding (OLE).

Complete the following tasks:

e Attach text

e Attach an image

e Attach an OLE object

e Attach a shortcut

e Attach a URL or file

e Search for a media object

e Rename an attachment icon

> To attach text

1. On a form where attachments are available, do one of the following:
e To attach text to a form, from the Form menu, choose Attachments.

If attachments exist for the form, click the paper clip icon to the
right of the status bar.

e To attach text to a grid row, choose the row, and then from the Row
menu, choose Attachments.
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The Media Objects workspace is split into two panels. The left panel is the
icon panel and the right panel is the viewer panel. Icons for any files
previously attached to the record appear in the icon panel.
2. Do one of the following:
e From the File menu, choose New, and then Text.

e In the icon panel, click the right mouse button, choose New, and
then Text from the pop-up menu.

In the viewer panel, type the desired text.

When you finish, from the File menu, choose Save and Exit.

You can use the formatting tools at the top of the viewer panel to format
the text of your note.

4 To attach an image

1. On a form where attachments are available, do one of the following:

e To attach an image to a form, from the Form menu, choose
Attachments.

If attachments exist for the form, click the paper clip icon to the
right of the status bar.

e To attach an image to a grid row, choose the row, and then from
the Row menu, choose Attachments.
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2. On Media Objects, do one of the following:
e From the File menu, choose New and then Image.
e In the icon panel, click the right mouse button, choose New, and
then Images from the pop-up menu.
3. Complete the following options:
e (Queue Name
e Files of Type
The Preview option contains a default checkmark to display a sample of
the selected image. Toggle this option to display or hide the preview
image.
4. Choose an image, and then click OK.
If OneWorld supports the graphic format, the image appears in the viewer
panel.
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5. When you finish, from the File menu, choose Save and Exit.

Field

Explanation

Queue Name

The name of the directory where the image file exists.

Files of Type

The list of file extensions that the system supports. For

example, file types might include .bmp for a Windows
bitmap, .gif for a graphics interchange format file, and .jpg

for a joint

photographic experts group file.
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P 1o attach an OLE object

1. On a form where attachments are available, do one of the following:
e To attach an OLE object to a form, from the Form menu, choose

Attachments.

If attachments exist for the form, click the paper clip icon to the
right of the status bar.

e To attach an OLE object to a grid row, choose the row, and then
from the Row menu, choose Attachments.
2. On Media Objects, do one of the following:
e From the File menu, choose Add and then OLE.

e In the icon panel, click the right mouse button, choose Add, and
then OLE from the pop-up menu.

Inzert Object EE3 |
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¥ Create New : £
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DBA Document
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Hilaak Diraw
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R ezult
|nzertz a new Bitmap Image object into your

=
document.

3.  On Insert Object, to create a new object, choose an object type and then
click OK.

Selections vary from system to system depending on what the system
administrator installs on your workstation and on the network.

4. Create your object.
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5. To attach an existing object, choose Create from File, locate the object on
your system, and then click OK.

Depending on whether you create an object or attach a preexisting object,
the application associated with the object appears in the viewer panel to
display either a blank workspace or the preexisting object.

The menu bar displays the menus for the application from which you call
the object. For example, if you select an Excel document, the menus for
Excel display on the menu bar.
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6. On Media Obijects, edit the object in the viewer panel to your preference.

7. When you finish, from the File menu, choose Save and Exit.
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’ To attach a shortcut

Include a shortcut to provide access directly from a record to an associated
application.
1. On a form where attachments are available, do one of the following:
e To attach a shortcut to a form, from the Form menu, choose

Attachments.

If attachments exist for the form, click the paper clip icon to the
right of the status bar.

e To attach a shortcut to a grid row, choose the row, and then from
the Row menu, choose Attachments.
2. On Media Objects, do one of the following:
e From the File menu, choose Add and then Shortcut.

e In the icon panel, click the right mouse button, choose Add and
then Shortcut from the pop-up menu.

3. On Open, browse through your files and then choose the appropriate
shortcut.

Your shortcut appears in the viewer panel.

{ Media Objects [_ O[]

D
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4. When you finish, from the File menu, choose Save and then Exit.
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’ To attach a URL or file

Attach a URL to provide access to a web page or a file on disk. You can also

attach other
bitmaps.

types of files that cannot be attached as images or OLE files such as

1. On a form where attachments are available, do one of the following:

To attach a URL or file to a form, from the Form menu, choose
Attachments.

If attachments exist for the form, click the paper clip icon to the
right of the status bar.

To attach a URL or file to a grid row, choose the row, and then from
the Row menu, choose Attachments.

2. On Media Objects, do one of the following:

From the File menu, choose Add and then URL/File.

In the icon panel, click the right mouse button, choose Add and
then URL/File from the pop-up menu.

3. On Add URL/Files, browse through your files or queues, and then choose

the appropriate URL or file.
Your URL or file appears in the viewer panel.

@ Media Objects
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4. When you finish, from the File menu, choose Save and then Exit.
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4 To search for a media object

You can search for a specific media object in the system by information such as
creation date, alternate keys, or user-defined codes. Note that you can only
search for media objects that already have codes defined for them and that your
system administrator has made available to all users in the system.
1. On a form where attachments are available, do one of the following:
e To search for a media object to attach to a form, from the Form
menu, choose Attachments.

If attachments exist for the form, click the paper clip icon to the
right of the status bar.

e To search for a media object to attach to a grid row, choose the
row, and then from the Row menu, choose Attachments.
2. On Media Objects, do one of the following:
e From the File menu, choose Add and then Search.

e In the icon panel, click the right mouse button, choose Add, and
then Search from the pop-up menu.

@ Object Management Workbench - [Media Object Search] 1]
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3. On Media Objects Search, complete the following fields and click Find.
e Media Object Status

e Creation Date

Use the QBE row to limit your search, if desired.
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Only attachments with defined metadata appear.
4. Choose an attachment and click select.
Your media object appears in the viewer panel.

5. When you finish, from the File menu, choose Save and then Exit.

> To rename an attachment icon

When you add an attachment, the system displays its filename under its icon in
the icon panel. You can rename the icon to make it more meaningful to other
users if you wish.
1.  On Media Objects, choose an icon and do one of the following:
e From the File menu, choose Rename.

e In the icon panel, click the right mouse button and choose Rename
from the popup menu.

2. Type a new name for the icon and then click anywhere else on the form
when finished.

Deleting Media Objects

When you no longer need an attachment, use the Delete feature on Media
Objects to remove the object. When you delete text, the text is permanently
erased. When you delete images and OLE objects, you remove the attachment of
the file to the record. The system still stores a file for the object.

P 1o delete an object

1. On a form where attachments are available, do one of the following:
e To delete an attachment to a form, from the Form menu, choose

Attachments.

If attachments exist for the form, click the paper clip icon to the
right of the status bar.

e To delete an attachment to a grid row, choose a row with a paper
clip icon, and then from the Row menu, choose Attachments.
2. On Media Objects, choose the appropriate icon in the icon panel and then

choose Delete from the File menu.

The icon disappears from the icon panel.
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3. When you finish, from the File menu, choose Save and Exit.

Working with Templates

On Media Objects, you can access the Media Objects Templates form. On this
form, you can attach create, modify, and delete templates to help you format
your text attachments.

Complete the following tasks:

e Attach a template
e Create a template
e Modify a template
e Delete a template

e Delete a template on Media Objects

4 To attach a template

1. On a form where attachments are available, choose the row to which you
want to attach a template, and then choose Attachments from the Row

menu.

2. On Media Objects, in the icon panel, click the right mouse button and
choose Templates from the pop-up menu.

@W’olk With Media Object Templates H=1E3
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v B O+ T x H L & H ; ;
Links w Displ.. [3]Intemet
Gelect Find Add Dpl. Close Seq.. New.. Die.. Apo.. || ¥ Dishl. [linteme

Template
& Name

: L o

|Find records |

EY

4

3. On Work With Media Objects Templates, click Find.

You can use the query-by-example line to refine your search.
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4. To preview the template, double-click the paper clip icon in the row
header.

5. Choose the grid row for the template that you want to attach, and then
click Select.

6. The template appears in the workspace on Media Objects.

> To create a template

1. On a form where attachments are available, choose the row to which you
want to attach a template, and then choose Attachments from the Row

menu.

2. On Media Objects, in the icon panel, click the right mouse button and
choose Templates from the pop-up menu.

3.  On Media Objects Templates, click Add.
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Fil= Edit Preferences Help

v x & 8 : .
OK Gan.. Dis.. Ago.. Links w Displ..  [@]Intemet

Template Mame I

Description I

@ [couriernew x| x| B| 7| Ul [E =]
Tot -

o o

EY

A

4. On Media Object Template Revisions, complete the following fields, and
then enter your template information into the workspace:

e Template Name

e Description

» 10 modify a template

1. On a form where attachments are available, choose the row from which
you want to delete a template, and then choose Attachments from the
Row menu.
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2. On Media Objects, in the icon panel, click the right mouse button and
then choose Templates from the pop-up menu.

3.  On Media Objects Templates, click Find.
You can use the Query by Example line to refine your search.

4. Choose the grid row for the template that you want to modify and then
click Select.

5. On Media Objects, modify the template as necessary and then click OK.

P 1o delete a template

1. On a form where attachments are available, choose the row from which
you want to delete a template, and then choose Attachments from the

Row menu.

2. On Media Objects, in the icon panel, click the right mouse button and
then choose Templates from the pop-up menu.

3. On Media Objects Templates, click Find.
You can use the Query By Example line to refine your search.

4. Choose the grid row for the template that you want to delete, click Delete,
and then on Confirm Delete, click OK.

P 1o delete a template on Media Objects

1. On a form where attachments are available, choose the row from which
you want to delete a template, and then choose Attachments from the
Row menu.

2. On Media Objects, in the icon panel, choose the text icon for the template,
and then choose Delete from the File menu.

The template and the text icon disappear.

Working with the Properties of Media Objects

The pop-up menu that appears when you click the right mouse button in the
icon panel on Media Objects provides you with the option to view and, for some
objects, to change the properties of an object. Each object has unique properties.

In addition, you can define metadata for an object. Metadata contains
information about the object such as a description of the object, who created it,
and when it was created. Other users can then search for the object based on
this information.
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Complete the following tasks:

e Set Media Objects properties

e Set text properties

e Set image properties

e View OLE properties

e Set shortcut properties

e View and define metadata

P 1o set Media Objects properties

1. On Media Objects, in the icon panel, click the right mouse button and
then choose Properties.

2. On Properties, review the following on the Key Information tab:

Technical information about the key for the form

3. Click the Flags tab to review the following information:

Allow Text Items

Allow Image Items

Allow OLE Items

Allow RTF Text

Show Text Item On Open
Read Only

> To set text properties

1. On Media Objects, in the icon panel, click the right mouse button over a
text icon, and then choose Properties from the pop-up menu.

2. On the text properties form, review the following fields on User Audit
Information:

Created by
Date Created
Time Created
Updated By
Date Updated
Time Updated

3. Click the Printing Information tab and then do the following, if necessary:

OneWorld Xe (9/00)
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e Complete the Effective From field

e Complete the Effective To field

> To set image properties

1.  On Media Objects, in the icon panel, click the right mouse button over an
image icon, and then choose Properties from the pop-up menu.

2. On the Image Properties tab, review the following fields:
e File Name
e (Queue Name
e Queue Path

3. To give the image a title, complete the following field:

e Description

> To view OLE properties

1. On Media Objects, in the icon panel, click the right mouse button over an
OLE object icon, and then choose Properties from the pop-up menu.

2. On the OLE Properties tab, review the following fields:
e TFile Name
e (Queue Name

e Queue Path

P 1o set shortcut properties

1. On Media Objects, in the icon panel, click the right mouse button over an
OLE object icon, and then choose Properties from the pop-up menu.

2. On the shortcut properties form, review the following fields on the
General tab:

e Menu Name
e Selection
e Icon File
e Icon Index
3. Do the following if necessary:
e Click the Colors tab to set the color for the shortcut hypertext.

e Click the Fonts tab to set font properties such as size, family, bold,
italics, underline, and strikeout.
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> To view and define metadata

1. On Media Objects, in the icon panel, click the right mouse button over an
object icon, and then choose Characterize Object from the pop-up menu.
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2. On the Media Object Category Revisions form, click the General tab,
complete the following fields, and click OK:

e Description
e Author

e C(Creation Date

e Status
Field Explanation
Description A short description to describe what the media object is
about.
Author This is the author of the media object document or

attachment.

Creation Date

For World, used in the DDS specifications for IBM’s
file-field reference display.

For OneWorld, the date the object was created.

Status

Indicate if this media object is active or obsolete.
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Attaching OLE Objects at the Base Form Level

At the base level of a standard form, you can attach OLE objects using the OLE
Objects button on the Links toolbar. Menu bars and toolbars appear on all
standard forms. When you attach an OLE object at the base level of a form,
rather than associating the attachment with a record, the OLE object attaches
only to the form. No matter what record appears on the form, the OLE object
that you attach using the OLE Objects button will always appear when you open
the form.

Complete the following tasks:
e Attach OLE objects at the base form level

e Delete OLE objects at the base form level

P 1o attach OLE objects at the base form level

1. On any standard form, do one of the following:
e Click the OLE Objects button on the Links toolbar.
e From the Preferences menu, choose OLE Objects.

e If attachments exist for the form, click the document icon to the
right of the status bar.

2. Choose the appropriate queue from the Choose Queue form.
Note: If you do not know the queue in which the object you want to
attach exists, see your system administrator.
3. On the OLE Objects form, do one of the following:
e From the File menu, choose Add Object.

e In the icon panel, click the right mouse button and then choose Add
Object.
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4. On Insert Object, to create a new object, choose the type of object that

you want to create and then click OK.

Selections vary from system to system depending on what the system
administrator installs on your workstation and on the network.

Create your object.

To attach an existing object, choose Create from File, locate the object on

your system, and then click OK.

Depending on whether you create an object or attach a preexisting object,
the application associated with the object appears in the viewer panel to
display either a blank workspace or the preexisting object.

The menu bar displays the menus for the application from which you call
the object. For example, if you select an Excel document, the menus for

Excel display on the menu bar.

7. Edit the object in the viewer panel to your preference.

8. Click the X button for the OLE Objects form in the application workspace

to return to the main form.

P 1o delete OLE objects at the base form level

1. On any standard form, do one of the following:

Click the OLE Objects button on the Links toolbar.

From the Preferences menu, choose OLE Objects.
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2. On the OLE Objects form, choose the object and do one of the following:
e From the File menu, choose Delete Object.

e In the icon panel, click the right mouse button and choose Delete
Object.

3. Click the X button for the OLE Objects form in the application workspace
to return to the main form.
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MailMerge Workbench

MailMerge Workbench is an application that merges Microsoft Word 6.0 (or
higher) word-processing documents with OneWorld records to automatically
print business documents such as form letters about employment verification.
Certain application suites, such as Human Resource Management, use these
documents within their normal workflow process. See your application guides to
determine which applications use MailMerge documents. In these applications,
OneWorld automatically prints the MailMerge documents as part of the workflow
process, and no user intervention is needed.

You can use MailMerge Workbench to add or change text in the business
documents included with OneWorld, to create entirely new documents, and to
delete documents.
This section contains information on the following subjects:

[ Changing MailMerge documents

] Adding MailMerge documents

L] Deleting MailMerge documents
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Changing MailMerge Documents

Use MailMerge Workbench to change the properties of a MailMerge document
and the Microsoft Word file associated with the MailMerge document. On the
properties form, you can change the document’s description and its queue
(where the document is stored) name. You cannot change the document’s name
nor its data structure. You can, however, create a new MailMerge document with
a different name and data structure as explained in Adding MailMerge
Documents. You can add, change, or delete any text or MailMerge fields in the
Microsoft Word file.

This topic contains information on the following items:
e Changing the properties of a MailMerge document

e Changing the content of a MailMerge document

» 1o change the properties of a MailMerge document

1. On HRM Setup (GO5B4), choose MailMerge Workbench Setup (P980014).
2. On Work With MailMerge Documents, click Find.

@ M ailMerge Workbench Setup - Pwork With MailMerge Documents] [ _ (O] x]
C] File Edit Preferences How ‘indow Help =181 x]

v B O+ @ x I L Aﬁ“unks w EditDoc [|OLE.. [#]Internet

Select Find Add Del.. Close Seg.. New. .. Dis

Document Description Dat::tnguct (E;;f:;l: Mg:itr?ed
COBRA COBRA Letter Dos00ozen OLEQUE T
EECASDAY  Employee Cagual Day Motice DO&000249F OLEQUE Trani
GEMERIC Benefits Statement 083305 OLEQUE THami
HIPAA HIPAA Cerificate 0050002490 OLEQUE T i
REMEWLTR1 |Caontract Renewal Letter D17010104 OLEQUE Tr2ai
SALARYINCR (Confirmation of Salary Change WFDSAOOTE OLEQUE Trani
VOEREQUESTWOE Request Dos00140 OLEQUE TH 9l
W4 FORM -4 Farm DO500170A OLEQUE T i

A list of available MailMerge documents appear in the detail area.
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3.  On Work With MailMerge Documents, choose the document and click
Select.

The MailMerge Document form appears.

4. On MailMerge Document, enter any changes into the following fields and
then click OK:

e Description
Enter a text description of the MailMerge document.
e Queue Name

Enter OLEQUE into this field, which is a path location already set up
for you in OneWorld. This location is where your MailMerge
documents are stored. If you use your own queue, you should set it
up on a central server so that others in the enterprise can access
your MailMerge documents. The path information for OLEQUE is
stored in the Media Object Queues (FOBMOQUE) table.

You cannot change the document name nor its data structure. If you want
either of these to be different, you must add a new MailMerge document.

See Adding MailMerge Documents.

The Work With MailMerge Documents form appears.

Field Explanation

Document The OneWorld architecture is object-based. This means
that discrete software objects are the building blocks for
all applications, and that developers can reuse the objects
in multiple applications. Each object is tracked by the
Object Librarian. Examples of OneWorld objects include:

Batch Applications (such as reports)

Interactive Applications

Business Views

Business Functions

Business Functions Data Structures

Event Rules

Media Object Data Structures

Description A description, remark, name, or address.

Data Structure Name The object name of the data structure used for identifying
the error message substitution variables.
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Field Explanation

Queue Name Identifies the name of a queue for a media object. The
queue name is the first half of a properly defined queue
for a media object. The queue path is the second half of
the queue for a media object.

OLEQUE is a reserved queue name for OneWorld media
objects. You must use this name as the default queue
name in the OLE object attachment mode of Media
Objects. It is mandatory that this queue name be defined
to use OLE object attachments.

The queue path and queue name are stored in the
F98SMOQUE table. Object Configuration Manager controls
the location of this table. The system reads the
FO98MOQUE table to determine name of the queue and the
location of the associated OLE objects, images, or URLs.

Date Modified The date that the object, such as a DREAM Writer version,
Software Versions Repository Record, and so on, was last
modified.

User ID For World, the IBM-defined user profile.

For OneWorld, the identification code for a user profile.

» 1o change the content of the MailMerge document

You must have Microsoft Word 6.0 (or higher) on your local workstation to make
changes to the content of a MailMerge document.

1. On HRM Setup (GO5B4), choose MailMerge Workbench Setup (P980014).
The Work With MailMerge Documents form appears.

2. On Work With MailMerge Documents, click Find. A list of available
MailMerge documents appear in the detail area.

3. On Work With MailMerge Documents, choose the document, and from the
Row menu, choose EditDoc.

The document displays as a OneWorld media object with Microsoft Word
as the editor.
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@ MailMerge Workbench Setup - [Edit MailMerge Document] [_]O]
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4. On Edit MailMerge Document, change the text of your document using
Microsoft Word formatting controls and tools. See Microsoft Word
documentation for information on how to use Microsoft Word.

5. Change MailMerge fields in your document.
You can delete fields as you would delete any other text.

To insert a new field, from the Insert Merge Field drop-down list on the
Microsoft Word toolbar, choose a field.

6. Click OK when you have finished changing text and fields in your
MailMerge document.
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Adding MailMerge Documents

Several predefined MailMerge documents come installed with OneWorld. These
documents should be sufficient for many of your applications. However, if you
need to add your own documents, you will need to use MailMerge Workbench
in conjunction with creating or changing the business function that links the
MailMerge document with the particular application’s workflow process, such as
Human Resource Management. You will also need to understand and use
OneWorld data structures.

Caution: Only system administrators or information technology (IT) personnel
should add MailMerge documents because it involves using OneWorld business
functions and data structures.

This task explains how to add a document using MailMerge Workbench. For

information about business functions and data structures, see the Development
Tools Guide.

»  T1oadd MailMerge documents

1. On HRM Setup (GO5B4), choose MailMerge Workbench Setup (P980014).
2. On Work With MailMerge Documents, click Add.

@ M ailMerge Workbench Setup - [MailMerge Document] [_ O[]
£ File ‘windaw  Help =181 x|
v oox & J Links
J G G Do A w Displ.. [B]OLE.. [&]Internat
Document hNarme
Description Cobra Letter
GQueue Name OLEQUE
Diata Structure Mame 005000290
1
W
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3. On MailMerge Document, complete the following fields, then click OK:

e Document Name

Enter the name that you want for your MailMerge document, which
must be 10 or fewer characters long.

e Description
Enter a text description of the MailMerge document.
e (Queue Name

Enter OLEQUE into this field, which is a path location already set up
for you in OneWorld. This location is where your MailMerge
documents are stored. If you use a queue other than OLEQUE, you
should set it up on a central server so that others in the enterprise
can access your MailMerge documents. The path information for
OLEQUE is stored in the Media Object Queues (FOSMOQUE) table.

e Data Structure Name

Enter the name of the data structure that you want to use with your
MailMerge document. The data structure contains all of the possible
fields that you can use in your MailMerge document.

The Header Record Delimiters form appears. Use this form to specify what
text symbol that OneWorld should recognize as the delimiter between
fields in the header file. MailMerge uses the header file to identify the
fields that you used in your MailMerge document. OneWorld automatically
creates the header file.

Header Record Delimiters EE

Data fields musk be separated From each other by a characker called a Figld
delimiter, Similarly, data records musk be separated by a record delimiter,
Llze the listks below to select the appropriate delimiter,

Eield delimiter: Recard delimiter:
GET— - | [ i) ]
Preview:

mnd ddressIumber|szlame Alpha|jdDate Termmated|jd =
DateEndingEffectrvejdDatelloticeEecerved|szh ddress
Linel|szhddressLine2|szd ddressLine 3| szibtate|szCity sz |

I I Zancel |

4. On Header Record Delimiters, enter the following into the Field delimiter:
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The Data Record Delimiters form appears. Use this form to specify what
text symbol that OneWorld should recognize as the delimiter between data
in the data file. The data file contains the OneWorld record information
that merges with your MailMerge document when it prints. OneWorld
automatically creates the data file.

On Data Record Delimiters, enter the pipe | character into the Field
delimiter field and click OK.

A new Microsoft Word document appears within the Edit MailMerge
Document form.

Type the text of your document using Microsoft Word formatting controls
and tools. See Microsoft Word documentation for information on how to
use Microsoft Word.

Enter MailMerge fields into your document. From the Microsoft Word
toolbar, on the Insert Merge Field menu, choose a field. You can enter
fields as you type the text of your document.

The data structure that you designated for your document determines
what fields are available.

Click OK when you have finished entering text and fields into your
MailMerge document.

For this new MailMerge document to work within your application’s workflow,
you must change the business function associated with the document. See the
Development Tools Guide for information about changing business functions.

OneWorld Xe (9/00)
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Deleting MailMerge Documents

Use MailMerge Workbench to delete MailMerge documents.

Caution: Before you delete a MailMerge document, make sure it is not set up to
print with an application’s workflow process.

P 1o delete MailMerge documents

1. On HRM Setup (GO5B4), choose MailMerge Workbench Setup (P980014).
2. On Work With MailMerge Documents, click Find.

A list of available MailMerge documents appears in the detail area.

3. On Work With MailMerge Documents, choose the document and click
Delete.

A message box appears to verify that you want to delete the selected
document.

4. Click OK.
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Interactive Versions for Applications

In OneWorld, a version is a user-defined set of specifications. These
specifications help to control how interactive applications run. Interactive
versions are associated with applications (usually as a menu selection) and
always run on a OneWorld workstation.

Interactive versions for applications contain processing options with different
sets of data for each version. These processing options are passed to the
application when it runs.

Versions allow you to modify the behavior of applications because they exist
independently of the application. Typically, administrators control the creation,
modification, and location of the actual version files. When you upgrade
OneWorld applications to a new release level, you can apply the existing
versions to the new applications.

When a user starts an interactive application, the user might have the option to
choose from a list of versions. A user only has this option if the application
designer attached processing options to the application. If the system
administrator sets the application for blind execution during menu design, when
the user starts the application, the application uses the default version without
providing a list of versions. Depending on how you assign security to your
OneWorld applications, end users can choose or create different versions based
on business requirements.

For example, on System Administration Tools (GH9011), the Interactive Versions
application (P983051) does not have processing options attached, so a version
does not exist for the application. However, the Work With Servers application
(P986116) has processing options attached so that the system administrator must
attach a version for the application. Otherwise, the application will not open
successfully. For each interactive application, the system administrator can set
up multiple versions that contain different specifications for each version, such
as different levels of security.

How Processing Options Affect Versions

The processing options that you define in versions are a set of parameters that
alter how an application runs. They are similar to initialization (.ini) files and
command-line arguments for a traditional executable. These processing options
let you specify the options that you want when you open an application. For
example, you can specify how certain forms appear, show or hide a field,
change the default status for order activity rules, and set default information to

appear in a field.
HE B
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The following list provides examples of how processing options allow you to
set up run-time overrides for applications:

e Changes the functionality of an application. For example, you can set up
processing options to turn on or off logic in order holds. You can also
specify whether you want to automatically print pick slips after you enter
an order based on a processing option value.

e Changes default values. For example, in Sales Order Entry you can set up
processing options to set defaults for certain document type values (such
as Sales Order or Sales Quote) or line type (such as stock or nonstock
item).

e Controls the display of forms, such as hiding or showing a cost field, a
price field, or a commission field.

Not all OneWorld applications have processing options. If the Prompt for Values
option on the Edit menu is grayed out, no processing options are associated
with the application, or the system administrator has disabled the processing
options. You must first attach processing options to an interactive application to
use versions with the application.

The system administrator can secure a version for an application. In this case,
the Prompt For Versions option on the Edit menu appears grayed out. When a
user opens a secured version from the Interactive Versions application, a
security message appears to alert the user that he or she does not have access
to the version.

How Interactive and Batch Versions Differ

14-2

Interactive versions have processing options and user overrides. Batch versions
have processing options, data selection and sequencing, and template overrides.
You do not check in and out interactive versions, whereas batch versions have
local specifications that must be checked in and out.

See Also

e Security in the System Administration Guide for more information about
securing processing options and versions
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Working with Interactive Versions

When you work with interactive versions, you change processing options,
version detail, and copy or create versions. Interactive versions must be
associated with a menu selection through Menu Revisions so that the system can
run the version.

You can display the available versions for an interactive application from
OneWorld Explorer by choosing Prompt for Versions from the Edit menu, or by
choosing the Interactive Versions menu selection. Filter the versions that you
want to display to show all versions or only your versions. To filter the version
display, choose Display Options from the Form menu.
This topic consists of the following subjects:

] Working with version detail for interactive versions

L] Copying an interactive version

[] Creating (adding) an interactive version

See Also

e Creating Reporis of Processing Options for information about creating
reports that show the processing option text and values for specified
interactive and batch versions

Working with Version Detail for Interactive Versions

You use version detail to change a version’s title, the method of prompting the
user for processing options, or to specify a security level. You can also review
information that includes when the version was last modified and the user who
performed the modification.

> To work with version detail for interactive versions

Depending on your security level and the level of security for the version, you
might not be able to change the version detail information.
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1. On System Administration Tools (GH9011), choose Interactive Versions
(P983051)

2. On Work With Interactive Versions, enter an application ID in the
Interactive Application field and click Find. For example, to locate a
version for the Address Book application, enter “P0101”.

3. In the grid, choose a version with which to work.
From the Row menu, choose Version Detail.
5. On Version Detail, you can modify the following information:

e Version Title
Enter information that describes the use of a version in this field.
e Prompting

The value that you enter in this field determines how the version
assigns processing options or such as no processing options or
blind execution, or prompts the user to choose options at run time.

e Security

The value that you enter in this field determines the security for the
version, ranging from no security to total security. This security is
based on the user and is not related to OneWorld application
security. Depending upon your security level and the level of
security for the version, you may not be able to work with version
detail.

6. Review the additional information that appears on the form as needed.

Field Explanation

Prompting This code specifies how processing options will be
executed based on user defined code table 98/CR. Valid
values are:

Blank Disables the processing options for the version.

1 The application will use existing processing
option without prompting the user. This is
sometimes referred to as blind execution.

2 The application will prompt the user for
processing options at run time.

Application Type The type of object with which you are working. For
example, if you are working with tables the object type is
TBLE, or business functions is BSFN.

Processing Options The character name of the data structure template.
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Field Explanation

Created By For World, the IBM-defined user profile.

For OneWorld, the identification code for a user profile.

Last Modified By Identifies the user ID of the user who last modified the
application or version.

Last Changed Indicates the last time an application or version was
modified by the specified user.

Path Code For World, the Environment name is also called the Plan
Name and is used to uniquely identify an upgrade
environment for Install/Reinstall.

For OneWorld (Install Applications), the environment
name is also called the Plan Name and is used to
uniquely identify an upgrade environment for
Install/Reinstall.

For OneWorld (Environment or Version Applications), this
is the path code that identifies the location of the
application or version specification data.

Copying an Interactive Version

You can copy an existing version and then tailor its information to fit your
needs. The copied version inherits the processing option values of the existing
version.

When you copy a version, you should add security to the new version. Security
settings range from none, which means anyone has the authority to modify or
run a version, to full security, when only the person who last modified a
version can modify and run the version. See the Security field description for
more information.

> To copy an interactive version

Depending on your security level and the level of security for the version, you
might not be able to copy the version.

1. On System Administration Tools (GH9011), Choose Interactive Versions
(P983051)

2. On Work With Interactive Versions, enter an application ID in the
Interactive Application field and click Find. For example, to locate a
version for the Address Book application, enter “P0101 .”

In the grid, choose a version with which to work.

Click Copy.
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The Version Copy form appears.

5. On Version Copy, complete the following information and then click OK:

e New Version

Enter a unique identifier for this version of the application in this
field.

e Version Title
Enter information that describes the use of a version in this field.

e Prompting Options
The value that you enter in this field determines how the version
assigns processing options, such as no processing options or blind
execution, or prompts the user to choose options at run time.

e Security

The value that you enter in this field determines the security for the
version, ranging from no security to total security.

Creating (Adding) an Interactive Version

You can create (add) a new interactive version that is not based on an existing
version. When you create an interactive version, you should add security to the
new version. Security settings range from none, which means anyone has the
authority to modify or run a version, up to full security, when only the person
who last modified a version can modify and run the version. See the Security
field description for more information.

P 1o create (add) an interactive version

1. On System Administration Tools (GH9011), Choose Interactive Versions
(P983051).

2. On Work With Interactive Versions, enter an application ID in the
Interactive Application field and click Add. For example, to add a version
for the Address Book application, enter “P0101”.

Click Add to create a new version.
4. On Version Add, complete the following fields:
e Version

Enter a unique identifier for this version of the application in this
field.
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See Also

OneWorld Xe (9/00)

Version Title

Enter information that describes the use of a version in this field.
Prompting Options

The value that you enter in this field determines how the version
assigns processing options, such as no processing options or blind

execution, or prompts the user to choose options at runtime.

“Blank” is not a valid value when you add a version. All versions
for interactive applications must have processing options attached.

Security

The value that you enter in this field determines the security for the
version, ranging from no security to total security.

Menu Design in the System Administration Guide for information about
how to add a version to a menu selection

Interactive Version Processing Options
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Batch Versions for Reports

In OneWorld, a batch version is a user-defined set of specifications. These
specifications control how batch processes run. Typically, batch versions are
associated with reports or batch processes, and run as batch jobs on a
OneWorld enterprise server.

Batch versions for reports are a predefined set of specifications contained in a
file that is separate from the base report or batch specifications. These
specifications control the logical functions and report appearance. The version
contains the processing instructions, which are a complete set of preselected
processing options and additional characteristics specific to report design.
Depending on how you assign security to your OneWorld applications, end
users can choose or create different versions based on business requirements.

Versions are a powerful and convenient way to modify the behavior of reports.
Typically, administrators control the creation, modification, and location of the
initial batch version files. When you upgrade OneWorld or a specific application
to a new release level, you can apply the existing batch versions without
additional modification.

When you start a batch application (that is, when you submit a batch job) you
must use a batch version. Depending on how the report was designed, you
might have the option to override processing option values for the version.
However, you cannot add or select different processing values from those that
already exist in the version. But you might be able to perform data sequencing
and data selection or override default locations or the basic layout of the base
report.

For example, suppose you have a report that prints the same financial
information to two different audiences: an American subsidiary and a French
subsidiary. You can create an American version, which shows financial
information in dollars for a specific time period and formats the report for
American-sized paper. You can also create a French version, which shows the
financial information in francs for a different time period and formats the report
for European-sized paper. For the French subsidiary, you could also display
additional information on the report by adding data items in the French version.
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Characteristics of Batch Versions

A batch version is defined by the following characteristics:

Data sequencing at the version level. For example, you can sort checks
by date or by check number. Or you can sort address book records by
employee or customer, or sort records alphabetically.

Data selection at the version level. For example, you can specify which
records to fetch, such as Business Unit 10-30 and 70, or all Address Book
records with Category 1=North.

Additions or overrides at the version section level. At the version section
level, report designers can use batch versions to add or override the
functions of the base report sections. These section-level overrides differ
from the version-level overrides because they apply only to individual
sections. At the section level, the report designer can override data
selection, data sequencing, event rules, and database output. You cannot
delete functionality if it exists in the base report.

A specific set of processing option values. For example, you can set a
processing option value to run G/L Post to print a different account
number format on the report.

For batch versions, processing options do the following:

e Change functionality. For example, you can set a processing option
to purge records to a history file after a report runs.

e Change input parameters. For example, you can set a processing
option to specify which category code to use when processing a
report.

e Define data. For example, you can set a processing option to define
the fiscal year for which you want to run a report. You can also
define the number of aging days in an Accounts Receivable aging
report.

Batch versions for reports discusses the following topic:

[ Working with batch versions

See Also

15-2

About Batch Processing in the OneWorld Development Tools guide
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For batch versions, OneWorld uses the same process as the Object Management
Workbench to check in, check out, and erase checkouts for versions. You use
this tool to control the movement of versions between the workstation and the
server. Batch versions are submitted directly from the batch application.

Just like base report specifications, when you create a batch version, the
specification records for that version exist only on your workstation. To make
the version available to other users, you must check the version into the server.
When you check in a version, OneWorld copies the version’s specification
records to the central objects data source (server) according to the path code of
your current environment.

After you check in your version, you can still make certain changes to the
version without checking it out. For instance, a version’s processing options are
stored directly as a field in the version record that is stored in the server Version
List table (F983051). So when you make changes to the processing options,
these changes are effective immediately, even if you have not checked in your
local version.

When you check a batch version into the central objects data source (server),
anyone who installs and runs the version will be ensured of having the updated
version. A version cannot be checked out by more than one user. The Version
Detail form displays the user that has checked out a version.

You can create a new batch version that is not based on an existing version. For
example, you might create a new version because you do not want to use the
layout or data selection of the existing version. When you create a new version,
you use the specifications provided by the base report.

If you make changes to the base (template) report, OneWorld automatically
“pushes” any changes to all of the versions that exist for that base report, unless
you created a version that contains overrides. See Changing the Design of a
Batch Version in this section for information about overrides.

If you copy a version, the copied version inherits the same data selection and
data sequencing as the existing version.
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This topic contains the following tasks:

e Running a batch version

e Accessing the Work With Batch Versions form

e Changing the design of a batch version

e Changing processing options for batch versions

e Accessing data selection and sequencing for batch versions
e Creating reports of processing options

e Accessing properties for table conversion versions

e Working with version detail for batch versions

e Copying a batch version

e Creating (adding) a batch version

e Checking out or checking in a batch version

e Erasing the check-out record of a version

e Changing Batch Versions (P98305) processing options
e Accessing BrowsER for a report or version

e Moving Batch Version Specifications to an Enterprise Server

Running a Batch Version

154

If batch versions are associated with a form, you can access them for viewing
and printing from the form’s Reports menu. Base reports and versions of those
reports are available on menus as icons.

In most cases, you submit batch versions to an enterprise server, which can
more efficiently handle the processing. The OneWorld environment you sign
onto specifies where your batch versions will run, though you can override this
location when you submit a batch version. When you submit your batch job to
the server, you can preview the report and use the Work With Servers form to
monitor the progress of your job on the queue. See The Work with Servers
Program in the OneWorld Configuration Planning and Setup: System
Administration guide for information about the Work With Servers form.

When you submit a report to the enterprise server, if the report specifications
do not currently reside on your workstation, the central objects data source
(server) first performs JITI (just-in-time installation) to transfer the specifications
to your workstation. After the JITI, your workstation continues with the
submission of the report to the enterprise server, and OneWorld transfers the
local version specifications (any changes you made to the version) to the
enterprise server.
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See Also

e Submitting a Report in the Enterprise Report Writing guide for complete
information about running a batch version

Accessing the Work With Batch Versions Form

You can access the Work With Batch Versions form, which is the entry point to
managing batch versions, in one of several ways.

> To access the Work With Batch Versions form

e From any menu with a batch application on it, choose the batch
application, and then from the Edit menu choose Prompt for Versions.

e From any menu with a batch application on it, right-click on the batch
application, and then from the pull-down menu that appears, choose
Prompt for Versions. If no versions are associated with the batch
application, you must copy or add a version and run that version as
explained in this section.

e On the System Administration Tools (GH9011) menu, choose Batch
Versions (P98305).

The Work With Batch Versions form appears.

Changing the Design of a Batch Version

If you want to change the report specifications for a version, you do not need
to change the base (template) report. You can override the report specifications
at the version level as explained in this task. The changes you make to the
report specifications for the version do not affect any other versions associated
with the base report. However, if you make changes to specifications at the
base-report level, those changes will not be pushed down to the version
specifications that you override.

When you make changes to specifications at the version level, you should
include a description of your modifications in the Version Detail field on the
Version Detail form. The description should include any differences between
the base report specifications and the version specifications. See Working with
Version Detail for Batch Versions in this section for more information.

The following can be changed in a report version:

e Section layout

e Section data selection
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Before You

4

m

Section event rules

Section database output

Section sort sequence

Begin

Override specifications only at the version level. To copy or create a
version to override, see Copying a Batch Version or Creating (Adding) a
Batch Version in this section.

Check out the version before you access Report Design to create a
version override; see Checking Out or Checking In a Batch Version in this

section.

Close the Report Design tool if it is open on your computer.

» 10 change the design of a batch version

15-6

From the System Administration Tools menu (GH9011) or the Financial
Reporting Setup menu (G1041), choose Batch Versions (P98305).

The Work With Batch Versions - Available Versions form appears.

On this form you can locate and run versions of reports. Also, you can
modify version detail information, data selection, and data sequencing.

Type an application ID in the Batch Application field. For example, to
locate a version for the One Line Per Address report, type R0O14021.
Click Find to locate the versions available on your workstation.
For alternate lists of versions, from the Form menu, choose Display, then
one of the following:

e Available Versions for the versions available on your workstation

e My Versions for just the versions you created

e All Versions for any version that exists for the batch application

When you view all versions, you can work only with versions that
appear with black text.

You can, however, delete any version (depending upon your application
and user security). If you try to delete a version that is not on your
machine, a warning message appears.

In the detail area, choose a version with which you want to work.

From the Row menu, choose Advanced.
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The Advanced Operations form appears.

Note: Before you can complete the following steps, you must have
already checked out a version of the report; see Checking Out or
Checking In a Batch Version in this section.

6. From the Row menu, choose Design Version.
Report Design opens with the report specifications for the version.

7. Click a section. Then from the Section menu, choose Override Version
Specifications. You cannot make any changes to a section until you access
the Override Version Specifications form and choose which overrides you
want to change.

Depending on the type of section with which you are working, the
Columnar, Tabular, or Group Section - Override form appears.

Any overrides you make to a section are valid only for that section. You
need to override additional sections separately.

8. Select any of the following overrides:

Note: Keep in mind that if you override any version specifications, those
specifications will not be updated if you then make changes to those
specifications in the base (template) report. For example, if you turn on
the Section Data Selection override and make changes to the version’s
data selection, and then later you change the data selection of the base
report, the base-report data selection changes will not be pushed down to
the version.

e Section Layout

Select this override if you need to change section properties or to
delete a column, add a new column, move a column, or make
column heading changes on a report version.

e Section Data Selection

Select this override if you need to have report versions that utilize
specific data selection, such as a version for customer information
only and a version for employee information only.

e Section Event Rules

Select this override if you need a report version that utilizes a
specific event rule, such as a version for employee information with
a calculated percentage raise amount, date title, or Balance Auditor.
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15-8

e Section Database Output

Select this override if you need a report version that prints to a
specific location other than the default printer location. If you want
other sections, such as the page header, to also print to this
location, you need to override the specifications to each of those
sections as well.

e Section Sort Sequence

Select this override if you need a report version that is sorted
differently than the base report. For example, you can have a
version sort by name rather than by address number.

9. The changes you make will affect only the version on your local
workstation. To make these changes available to the enterprise, you must
now check in the version; see Checking Out or Checking In a Batch
Version in this section. If you do not check in the version, make sure you
erase your check out so that others can check out this version; see
Erasing the Check-Out Record of a Version in this section.

Field Explanation

Batch Application The name of the OneWorld batch or interactive
application (interactive or batch object). For example, the
name of the Sales Order Processing interactive application
is P4210, and the name of the Print Invoices batch
process report is R42565.

The name of the program ID is a variable length value.
This value is assigned according to a structured syntax in
the form TSSXXX where:

T The first alphabetic character of the program
name identifies the type such as P for Program,
R for Report, and so on. For example, the value
P’ in the name P4210 indicates that this is a
program.

SS The second and third numeric characters of the
program name identifies the system code. For
example, the value 42’ in the name P4210
indicates that this program belongs to System
42, which is the Sales Order Processing system.

XXX The remaining numeric characters of the
program name identify a unique program or
report. For example, the value "10’ in the name
P4210 indicates that this is the Order Entry
application.

User Identifies the user ID of the user who last modified the
application or version.
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Field

Explanation

Last Modified

Indicates the last time an application or version was
modified by the specified user.

Security

This field allows you to restrict user access for a report
version. Valid values are:

0 No security. Anyone can design, change
processing option values, change detail values,
check in, check out, install, transfer, copy,
delete, or run the version. This is the default
when adding a new version.

1 Medium security. Only the “Last Modified By”
user can design, change processing option
values, change detail values, check in, check
out, or delete the version. Anyone can install,
copy, transfer, or run the version. This is how
the JDE Demo versions are delivered.

2 Medium to full security. Only the “Last Modified
By” user can design, change processing option
values, change detail values, check in, check
out, transfer, delete, or run the version. Anyone
can install or copy the version.

3 Full security. Only the “Last Modified By” user
can design, change processing option values,
change detail values, check in, check out,
install, transfer, copy, delete, or run the version.

Version

A version is a user-defined set of specifications. These
specifications control how applications and reports run.
You use versions to group and save a set of user-defined
processing option values and/or data selection and
sequencing options. Interactive versions are associated
with applications (usually as a menu selection). Batch
versions are associated with batch jobs or reports. To run
a batch process you must choose a version.

Check in Path Code

For World, the Environment name is also called the Plan
Name and is used to uniquely identify an upgrade
environment for Install/Reinstall.

For OneWorld (Install Applications), the environment
name is also called the Plan Name and is used to
uniquely identify an upgrade environment for
Install/Reinstall.

For OneWorld (Environment or Version Applications), this
is the path code that identifies the location of the
application or version specification data.

Location

For World, the Location indicates the machine (server or
client).

For OneWorld, the Location or Machine Key indicates the
name of the machine on the network (server or
workstation).

OneWorld Xe (9/00)
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Field

Explanation

Path Code

For World, the Environment name is also called the Plan
Name and is used to uniquely identify an upgrade
environment for Install/Reinstall.

For OneWorld (Install Applications), the environment
name is also called the Plan Name and is used to
uniquely identify an upgrade environment for
Install/Reinstall.

For OneWorld (Environment or Version Applications), this
is the path code that identifies the location of the
application or version specification data.

Checked Out

Indicates the availability of a version for checkout. Only
one user may have the version checked out.

Y Version is currently checked out.

N Version is not currently checked out.

On Server

OneWorld: This field indicates the availability of a batch
version.

Y Version is available for installation from the
server.

N Version is not available for installation from the
server.

Server Last Updated

This is the date the application or version was checked in
to the server.

Changing Processing Options for Batch Versions

You can change the processing option settings for an existing batch version to
suit your needs. For example, you can change processing option values that
direct the system to show or hide a field or change order activity rules.
However, not all batch versions have processing options associated with them.
For example, a list of addresses might not require special prompting.

Processing option changes are stored for each UBE run. Unlike other changes to
versions, changes to processing option values do not require you to check in or
check out the version. Anyone who uses that version after you make the change
will not be affected by the new processing option values.

Note: You should not modify J.D. Edwards demo versions, which contain ZJDE
or XJDE prefixes. You should either copy these versions or create new versions
to change any values, including the version number, version title, prompting
options, security, and processing options.

15-10
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> 1o change processing options for batch versions

1. From the System Administration Tools menu (GH9011), choose Batch
Versions (P98305).

The Work With Batch Versions - Available Versions form appears. On this
form you can locate and run versions of reports. Also, you can modify
version detail information, data selection, and data sequencing.

2. Type an application ID in the Batch Application field. For example, to
locate a version for the One Line Per Address report, type R014021.

3. Click Find to locate the versions available on your workstation.

For alternate lists of versions, from the Form menu, choose Display, then
one of the following:

e Available Versions for the versions available on your workstation

e My Versions for just the versions you created

e All Versions for any version that exists for the batch application

When you view all versions, you can work only with versions that
appear with black text.

4. In the detail area, choose a version with which you want to work.

The Work With Batch Versions form shows only the versions available to
your workstation, including any versions you create locally. Versions
created on another machine must first be checked in to the central objects
data source (server) before they appear on this form.

5. From the Row menu, choose Processing Options.

If processing options do not exist for this version, or if you have been
secured from changing processing options, a message box appears
informing you of this; otherwise, the Processing Options form appears for
the application. On this form, you can define the values that control how
your report processes.

You can also access the Processing Options form the following ways:

e Choose a batch application, and then choose Prompt for Values
from the Edit menu on OneWorld Explorer.

e Right-click on the batch application name in OneWorld Explorer,
and then choose Prompt for Values from the pull-down menu that
appears.

6. Click each tab to view and change information on that tab.
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If there are numerous tabs and you cannot see all of them, left and right
arrow buttons appear on the form. Click the arrow buttons to view the
other tabs. You can also resize the Processing Options form by pointing
to the edge of the form and dragging, or use the scroll bar to view
additional processing options on a tab.

7. Change the processing option values as appropriate, and then click OK.

Accessing Data Selection and Sequencing for Batch Versions

With batch versions, you can select certain values of your data to narrow the
range of your report. For example, you can select to view only customers from
New York. You can also sequence how you want your data presented in the
report. For example, you can place your search type field first, followed by
your address number, and then employee names.

You can select and sequence your data from one of two places, either from the
Work With Batch Versions form, as explained here, or from the Version
Prompting form, as explained in Submitting a Report. With either method, any
changes you make with selections and sequences remain with that version.
Every successive run (from the same workstation) of that version will use the
changed selection and sequencing.

Before You Begin

15-12

[ If you access data selection and sequencing from the Row menu of the
Work With Batch Versions form, as explained below, you must check out
the version to your machine. See Checking Out or Checking In a Batch
Version in this section.

P To access data selection and sequencing for batch versions

1. From the System Administration Tools menu (GH9011), choose Batch
Versions (P98305).

The Work With Batch Versions - Available Versions form appears. On this
form you can locate and run versions of reports. Also, you can modify
version detail information, data selection, and data sequencing.

2. Type an application ID in the Batch Application field. For example, to
locate a version for the One Line Per Address report, type R0O14021.

3. Click Find to locate the versions available on your workstation.

For alternate lists of versions, from the Form menu, choose Display, then
one of the following:

e Available Versions for the versions available on your workstation
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e My Versions for just the versions you created
e All Versions for any version that exists for the batch application

When you view all versions, you can work only with versions that
appear with black text.

4. In the detail area, choose a version with which you want to work. The
version must be checked out.
5. From the Row menu, choose one of the following:

e Data Selection
The Data Selection form appears.
e Data Sequencing
The Selection Data Sequencing form appears.

When you are working with table conversion batch applications,
OneWorld grays out the Data Selection and Data Sequencing menu
items because they do not apply to table conversions.

6. The changes you make affect only the version on your local workstation.
To make these changes available to the enterprise, you must now check
in the version; see Checking Out or Checking In a Batch Version in this
section. If you do not check in the version, make sure you erase your
check out so that others can check out this version; see Erasing the
Check-Out Record of a Version in this section.

Creating Reports of Processing Options

This task explains how to create reports about processing options for interactive
and batch application versions. This report shows the tab, text, and value of any
processing option attached to an application’s version (not all versions have
processing options).

Caution: Run this process only locally (on your workstation).

> To create reports of processing options

1. From the System Administration Tools (GH9011), choose Batch Versions
(P98305) or choose Interactive Versions (P98301).

The Work With Batch Versions - Available Versions form appears or the
Work With Interactive Versions form appears.
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2. Type an application ID in the Batch Application field or the Interactive
Application field. For example, to locate a version for the General Journal
by Batch report, type R09301 into the Batch Application field.

Click Find to locate the versions available on your workstation.
Do one of the following:

e Choose a version. Then from the Row menu, choose Processing
Options to view the version’s default values.

e Choose a version. Then from the Row menu, choose Print Options.
e Without choosing a version, from the Form menu, choose Print
Options.

The Report Output Destination form appears.

5. Specify one of the following, and then click OK:
e On Screen
e To Printer
e Export to CSV

e OSA Interface Name

The report processes.

Accessing Properties for Table Conversion Versions

This task is only for table conversion batch applications. You can access the
version’s properties from the Table Conversion Prompting form, as explained in
Submitting a Table Conversion in the OneWorld Data Conversion guide. You can
also access properties directly from the Work With Batch Versions form.

Before You Begin

] If you access properties from the Row menu of the Work With Batch
Versions form, as explained below, you must check out the version to
your machine. See Checking Out or Checking In a Batch Version in this
section.

P o access properties for table conversion versions

1. From the System Administration Tools menu (GH9011), choose Batch
Versions (P98305).

The Work With Batch Versions - Available Versions form appears. On this
form you can locate and run versions of table conversions.
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2. Type a table conversion application ID in the Batch Application field.

3. Click Find to locate the versions available on your workstation.

For alternate lists of versions, from the Form menu, choose Display, then
one of the following:

e Available Versions for the versions available on your workstation
e My Versions for just the versions you created

e All Versions for any version that exists for the batch application

When you view all versions, you can work only with versions that
appear with black text.

4. In the detail area, choose a version with which you want to work. The
version must be checked out.

5. From the Row menu, click Properties. This menu selection is enabled
only for table conversions.

The Properties form appears. See Submitting a Table Conversion in the
OneWorld Data Conversion guide for information about changing table
conversion properties.

6. The changes you make will affect only the version on your local
workstation. To make these changes available to the enterprise, you must
now check in the version; see Checking Out or Checking In a Batch
Version in this section. If you do not check in the version, make sure you
erase your check out so that others can check out this version; see
Erasing the Check-Out Record of a Version in this section.

Working with Version Detail for Batch Versions

Use version detail to review information about a version, such as its title, the
prompting options associated with it, or the security level. You can also specify
whether to print a cover page on a report.

Before You Begin

L] Check out the version before you work with version detail; see Checking
Out or Checking In a Batch Version in this section.
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> To work with version detail for batch versions

1. From the System Administration Tools menu(GH9011), choose Batch
Versions (P98305).

The Work With Batch Versions - Available Versions form appears. On this
form you can locate and run versions of reports. Also, you can modify
version detail information, data selection, and data sequencing.

2. Type an application ID in the Batch Application field. For example, to
locate a version for the One Line Per Address report, type R014021.
3. Click Find to locate the versions available on your workstation.
For alternate lists of versions, from the Form menu, choose Display, then
one of the following:
e Available Versions for the versions available on your workstation
e My Versions for just the versions you created
e All Versions for any version that exists for the batch application

When you view all versions, you can work only with versions that
appear with black text.

4. In the grid, highlight a version with which you want to work. The version
must be checked out.

5. From the Row menu, choose Version Detail.
The Version Detail form appears.

On this form, you can change information such as the title of the version,
how the version uses processing options, and the security level for the
version. You can also review background information about the report.
6. Modify or complete the following information:
e Version Title
e Prompting
This option appears only if processing options are attached to this
version.
e Security
e Version Detail
e Print Cover Page

e Job Queue

15-16 OneWorld Xe (9/00)
To access English documentation updates, see
https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



Working with Batch Versions

If you leave the Job Queue field blank, OneWorld reads the setting
in the jde.ini on the enterprise server. If you submit the job to an
AS/400, OneWorld looks to your user profile to determine the job
queue.

7. Review the additional information that appears on the form as needed.
Click OK.

9. Check in this version to make it available to the enterprise; see Checking
Out or Checking In a Batch Version in this section.

Field Explanation

Version Title A description of the version that appears next to the
version number. The version title is different from the
report title.

This field should describe the use of a version. For
example, an application for generating pick slips might
have a version called Pick Slips - Accounting and another
version called Pick Slips - Inventory Management.

Prompting This code specifies how processing options will be
executed based on user defined code table 98/CR. Valid
values are:

Blank Disables the processing options for the version.

1 The application will use existing processing
option without prompting the user. This is
sometimes referred to as blind execution.

2 The application will prompt the user for
processing options at runtime.
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Field Explanation
Security This field allows you to restrict user access for a report
version. Valid values are:
0 No security. Anyone can design, change

processing option values, change detail values,
check in, check out, install, transfer, copy,
delete, or run the version. This is the default
when adding a new version.

1 Medium security. Only the “Last Modified By”
user can design, change processing option
values, change detail values, check in, check
out, or delete the version. Anyone can install,
copy, transfer, or run the version. This is how
the JDE Demo versions are delivered.

2 Medium to full security. Only the “Last Modified
By” user can design, change processing option
values, change detail values, check in, check
out, transfer, delete, or run the version. Anyone
can install or copy the version.

3 Full security. Only the “Last Modified By” user
can design, change processing option values,
change detail values, check in, check out,
install, transfer, copy, delete, or run the version.

Version Detail Use this space to list all the overriding specifications and
differences in functionality between the base report
specifications and the version level report specifications.
The information you provide in this field will allow
version developers to easily see the functional difference
between this version and the base report. Examples of
things you should list includes additions such as sections
that you have added in your version that do not exist in
the base report. You should also list changes in your
version for areas that function differently than the base
report. For example, you should list areas where you use
different criteria for data sequencing or data selection.

Print Cover Page When enabled, produces a cover page for the report.

Job Queue The job queue to which the job was submitted. On the
AS/400 this is an actual system job queue. On other
systems it is a JDE logical queue.
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Copying a Batch Version

You can copy an existing version and then tailor its information to fit your
needs. The copied version inherits all the report and version properties of the
original version, including overrides.

When you copy a batch version, you should add security to the new version.
Security settings range from none, which means anyone has the authority to
modify or run a version, to full security, in which only the person who last
modified a version can modify and run the version. Version security is separate
from Security Workbench, which allows you to set security for different
OneWorld objects, such as applications. For information about Security
Workbench, see Security in the OneWorld Configuration Planning and Setup:
System Administration guide.

» 10 copy a batch version

1. From the System Administration Tools menu (GH9011), choose Batch
Versions (P98305).

The Work With Batch Versions - Available Versions form appears. On this
form you can locate and run versions of reports. Also, you can modify
version detail information, data selection, and data sequencing.

2. Type an application ID in the Batch Application field. For example, to
locate a version for the One Line Per Address report, type R014021.
3. Click Find to locate the versions available on your workstation.
For alternate lists of versions, from the Form menu, choose Display, then
one of the following:
e Available Versions for the versions available on your workstation
e My Versions for just the versions you created
e All Versions for any version that exists for the batch application
When you view all versions, you can work only with versions that
appear with black text.

4. 1In the detail area, choose a version with which to work.

5. Click Copy on the toolbar.

The Version Copy form appears.
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6. Enter the following information:
e New Version
e Security
e Version Title
7. Click OK to save your version and return to the Work With Batch Versions

form.

When you click OK to copy a report version, if the version specifications
do not currently reside on your workstation, the central objects data
source (server) performs JITI (Just-in-time Installation) to transfer the
specifications to your workstation.

8. Check in the new version to make this version available to the enterprise;
see Checking Out or Checking In a Batch Version in this section.

Field Explanation

New Version A sequence number that identifies versions of a menu
selection. For example, where multiple versions of a
report menu selection are set up, this sequence number
identifies each of those versions.

............. Form-specific information . ... ..........

Specifies a unique name that identifies the new version
for the application.

Creating a Batch Version

You can create a new batch version that is based solely on the base version of
an existing report. Unlike copying a version, when you create a batch version,
the new version does not inherit the base version’s overrides. By creating a new
version, you are starting with the specifications provided by the base report.

When you create a batch version, you should add security to the new version.
Security settings range from none, which means anyone has the authority to
modify or run a version, to full security, in which only the person who last
modified a version can modify and run the version. Refer to the Security field
description for more information. Version security is separate from Security
Workbench, which allows you to set security for different OneWorld objects,
such as applications. For information about Security Workbench, see Security in
the OneWorld Configuration Planning and Setup: System Administration guide.
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> To create a batch version

OneWorld Xe (9/00)

From the System Administration Tools menu (GH9011), choose Batch
Versions (P98305).

The Work With Batch Versions - Available Versions form appears. On this
form you can locate and run versions of reports. Also, you can modify
version detail information, data selection, and data sequencing.

In the Batch Application field, enter the batch application upon which
you want to base the new batch version.

Click Add to create a new version.
The Version Add form appears.

On the Version Add form, complete the following information:

e Version

e Version Title

e Prompting Options
If the batch application on which you base your version does not
have any processing options attached, OneWorld leaves the
Prompting Options field inactive. You can attach processing options
only to a batch application template in Report Design.

e Security

e Job Queue

e Version Detail

e Print Cover Page

Click OK to save your version and return to the Work With Batch Versions
form.

Check in the new version to make this version available to the enterprise;
see Checking Out or Checking In a Batch Version in this section.
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Field Explanation

Application The name of the OneWorld batch or interactive
application (interactive or batch object). For example, the
name of the Sales Order Processing interactive application
is P4210, and the name of the Print Invoices batch
process report is R42565.
The name of the program ID is a variable length value.
This value is assigned according to a structured syntax in
the form TSSXXX where:

T The first alphabetic character of the program
name identifies the type such as P for Program,
R for Report, and so on. For example, the value
P’ in the name P4210 indicates that this is a
program.

SS The second and third numeric characters of the
program name identifies the system code. For
example, the value 42’ in the name P4210
indicates that this program belongs to System
42, which is the Sales Order Processing system.

XXX The remaining numeric characters of the
program name identify a unique program or
report. For example, the value "10’ in the name
P4210 indicates that this is the Order Entry
application.

Version A version is a user-defined set of specifications. These

specifications control how applications and reports run.
You use versions to group and save a set of user-defined
processing option values and/or data selection and
sequencing options. Interactive versions are associated
with applications (usually as a menu selection). Batch
versions are associated with batch jobs or reports. To run
a batch process you must choose a version.

Prompting Options

This code specifies how processing options will be
executed based on user defined code table 98/CR. Valid
values are:
Blank Disables the processing options for the version.
1 The application will use existing processing
option without prompting the user. This is
sometimes referred to as blind execution.
2 The application will prompt the user for
processing options at runtime.

Print Cover Page

When enabled, produces a cover page for the report.
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Checking Out or Checking In a Batch Version

To modify a report version using Report Design or to set data selection and
sequencing using the row exits, you must first check out the report version. The
check-out procedure copies the specification records from the central objects
location to your workstation. This is based on your path code. Only versions in
that central objects path code will be visible. You cannot access Report Design
until you check out the version. A version cannot be checked out by more than
one user at a time.

If you have checked out a version but are not going to make changes to it,
erase the check-out record so others can check out that version. You need to
check out a version to make changes that are overrides to the base (template)
report. You do not need to check out a version if you make the following
changes at the time you run the version: data selection, data sequencing,
override location, or processing option values. However, if you make changes
to data selection or data sequencing from the Work With Batch Versions form,
you must check out and check in the version to save those changes and make
them available to the enterprise.

Before you check in a version, make sure that you want to make permanent
changes. When you check in a version, the system copies the report
specifications back to the central objects location. These new specifications will
override the previous specifications for that version. The report specifications on
your workstation remain intact.

You can check batch versions in or out with the Object Management
Workbench or with the Batch Versions application as described in the next task.

> To check out or check in a batch version

1. From the System Administration Tools menu (GH9011), choose Batch
Versions (P98305)

The Work With Batch Versions - Available Versions form appears. On this
form you can locate and run versions of reports. Also, you can modify
version detail information, data selection, and data sequencing.

2. Type an application ID in the Batch Application field, and then click Find.
For example, to locate a version for the One Line Per Address report,
type R0O14021.

In the detail area, choose a version with which to work.
From the Row menu, choose Advanced.
The Advanced Operations form appears. On this form, you can design

report specifications for the version, check in and check out versions, and
erase the check out for a version.
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Choose a version to check out or to check in.

From the Row menu, choose either Check Out Version or Check In
Version.

7. Click Yes.

Erasing the Check-Out Record of a Version

15-24

Batch versions can be checked out by only one person at a time. Erasing the
check out record allows another user to check out the version. After you have
erased a check-out, you cannot check in that version. However, the report
specifications on your workstation remain intact.

The Erase Check-Out procedure changes the status of the server-based record
of version check-in and check-out. When you erase a check-out of a version,
OneWorld updates the Checked Out field in the Versions List table (F983051)
from a Y to an N. OneWorld also updates the version’s Location field in the
Versions List table. This value is changed from the location of the workstation
that checked out the version to the machine name of the central object’s server.

You can erase the check-out of batch versions with the Object Management
Workbench or with the Batch Versions application as described in the next task.

» To erase the check-out record of a version

1. From the System Administration Tools menu (GH9011), choose Batch
Versions (P98305).

The Work With Batch Versions - Available Versions form appears. On this
form you can locate and run versions of reports. Also, you can modify
version detail information, data selection, and data sequencing.

2. Type an application ID in the Batch Application field and click Find. For
example, to locate a version for the One Line Per Address report, type
R014021.

3. In the detail area, choose a version with which to work.
From the Row menu, choose Advanced.
The Advanced Operations form appears. On this form, you can design

report specifications for the version, check in and check out versions and
reports, and erase the check out for a version.

5. On Advanced Operations, choose the check-out record you want to
erase.

6. From the Row menu, choose Erase Check Out.
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Changing Batch Versions (P98305) Processing Options

This task explains how to change the processing options for the Batch Versions
(P98305) application.

Processing option changes are stored for each UBE run. Unlike other changes to
versions, changes to processing option values do not require you to check in or
check out the version. Anyone who uses that version after you make the change
will not be affected by the new processing option values.

See Also

[ Changing Processing Options for Batch Versions for instructions on
changing processing options for batch versions in general

> 10 change Batch Versions (P98305) processing options

1. From the System Administration Tools menu (GH9011), right-click Batch
Versions (P98305), choose Prompt For, and then choose Values from the
resulting pop-up menu.

If you have been secured from changing processing options, a message
box appears informing you of this; otherwise, the Processing Options
form appears.

2. On the Processing Options form, complete the following fields:

OneWorld Xe (9/00)

Option 1: Confirmation Box

Enter a Y or 1 to enable, or enter N or 0 to disable the
overwrite/delete local specifications confirmation box. If you
enable the confirmation box, it appears when OneWorld is about to
overwrite or delete specifications on your local machine. For
example, when enabled, the confirmation box appears when you
check out a batch version.

Option 2: Schedule Job

Enter a 0 (or leave the field blank) to not allow users to schedule
when their batch versions run, meaning their batch version runs as
soon as they submit it; enter a 1 to give the users the option of
scheduling their batch versions; enter a 2 to force the users to
always schedule their batch versions.

See Scheduling Jobs in the OneWorld Configuration Planning and
Setup: System Administration guide for complete information about
how to schedule batch versions.
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Accessing BrowsER for a Report or Version

15-26

BrowsER is an application you can use to view event rules and design layout
for your reports and versions. BrowsER displays the structure of sections within
a batch application. The sections are displayed in a hierarchical structure, with
events and event rules for each section. You can enable or disable one or more
event rules without extensive work in the design tools. This is useful for
debugging specific event rules. For complete information about using BrowsER,
see Working with BrowsER in the OneWorld Development Tools guide.

> To access BrowsER for a report or version

From the System Administration Tools menu (GH9011), choose Batch
Versions (P98305).

The Work With Batch Versions - Available Versions form appears. On this
form you can locate and run versions of reports. Also, you can modify
version detail information, data selection, and data sequencing.

Type an application ID in the Batch Application field. For example, to
locate a version for the One Line Per Address report, type R0O14021.
Click Find to locate the versions available on your workstation.
For alternate lists of versions, from the Form menu, choose Display, then
one of the following:
e Available Versions for the versions available on your workstation
e My Versions for just the versions you created
e All Versions for any version that exists for the batch application
When you view all versions, you can work only with versions that
appear with black text.
In the detail area, choose a version with which you want to work.
From the Row menu, choose Advanced.
The Advanced Operations form appears. On this form, you can design

report specifications for the version, check in and check out versions and
reports, and erase the check out for a version.

From the Form menu, choose either Report BrowsER or Version BrowsER.

If you select Report BrowsER, you can enable or disable event rules for
the report. If you select Version BrowsER, you can enable or disable
event rules for a specific version of the report. When you are working
with table conversion batch applications, OneWorld grays out the Version
BrowsER button because it does not apply to table conversions.
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The BrowsER form appears.

Moving Batch Version Specifications to an Enterprise Server

You can move batch version specifications to an enterprise server without
actually running the batch version. You need to do this only when you have
modified a batch version that is called by another batch version. After you
modify the version, use this option to move its specifications to the same
location as the batch version that calls it. This ensures that the batch version
calls the updated specifications rather than obsolete specifications.

P 1o move batch version specifications to an enterprise server

1. On the ActivEra Solution Explorer, perform one of the following to access
the Work With Batch Versions form:

e From a menu, double-click a report icon.

e From the System Administration Tools menu (GH9011), choose
Batch Versions.

2. On Work With Batch Versions - Available Versions, complete the following
field if necessary:

e Batch Application

3. Click Find to display a list of versions based on the batch application you
enter in the Batch Application field.

4. Choose the report version you want to submit, and then click Select.
The Version Prompting form appears.

5. From the Form menu, choose Advanced.
The Advanced Version Prompting form appears.

6. Turn on the following options, and then click OK:
e Submit Version Specifications Only

Turn this option on to move batch version specifications to an
enterprise server that you specify.

e Override Location

Turn this option on to access the JDE Data Sources form, which
you use to specify the location of the enterprise server to which
you want to move the batch version specifications.
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7. On JDE Data Sources, choose the enterprise server to which you want to
move the batch version specifications, and then click Select.

The batch version that you indicated will not run, but OneWorld moves the
batch version specifications to the enterprise server that you specified. You can
use the Work With Servers form to monitor the progress of your job on the
queue. See The Work with Servers Program in the OneWorld Configuration
Planning and Setup: System Administration guide for information about the
Work With Servers form.

Field Explanation
Submit Version Turn this option on to move specifications of a batch
Specifications Only application version from your workstation to an

enterprise server. The version you are submitting does
not actually run, but OneWorld moves the version’s
specifications to an enterprise server that you specify. Use
the Override Location option to specify which enterprise
server to move the specifications to.

You need to turn this option on only when you have
modified a batch application version that is called by
another batch application. After you modify the version,
use this option to move its specifications to the same
location as the batch application that calls it. This ensures
that the batch application calls the updated specifications
rather than obsolete specifications.
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A processing option is a parameter in which you enter a value to control how an
interactive or batch program runs.

Processing options consists of the following topics:
[_] Processing option functions

Types of processing options

Working with processing options

Interactive version processing options

I T N I

Batch version processing options
[L] Using processing options info master business functions

You use processing options to instruct the system to perform specific functions
to meet your business needs. If a program contains processing options, you set
the required and optional processing options for the program during setup or
before you run or submit a program.

You can create different versions of each program if your business needs require
specific processing for different processes. You can then set these unique
processing options differently in multiple versions of the same application.
Changes to processing options immediately affect that version for every user.
Anyone who uses that version after you make the change uses the new
processing option values. You can also use processing options to access a
version of another program.

Caution: XJDE versions are considered owned by J.D. Edwards. During an
upgrade, J.D. Edwards might overwrite these versions. You should only use
these versions as templates for your own versions.

Caution: ZJDE versions are used for default purposes, and are typically
interactive applications or versions that are called from another application. You
usually attach these versions to a menu. You can set these processing options.
When called from a menu, interactive applications with a version are called with
a blind execution based on predetermined processing option values.
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Processing Option Functions

Use processing options to:

e Set up default values
e Customize an application for different companies or even different users
e Control the format of forms and reports

e Control page breaks and the location where totaling occurs for reports

Processing options appear in the system as a tabbed form. Tabs organize the
processing options by purpose and function. Each processing option tab
contains:

e Standard or unique tab name
e Processing option titles
e Lists of valid values

e Tab-specific help text (enhanced processing options)

You access tab-specific help text using the Help button. This text provides
a brief description of the business purpose of the processing options, the
interdependencies among the processing options, and the consequences
of their use.

e Online help (enhanced processing options)

You access the online help using the F1 key or by right-clicking and
choosing What’s This? from the menu. The glossary text describes the
function of the processing option, and the actions or consequences of
using the valid values.

Types of Processing Options

The two standards for processing options are “enhanced” and “nonenhanced.”

Enhanced processing options provide you with more detailed user information.
For example, the user can glance at the field name and valid values on the tab
and quickly determine how to use the processing option, or the user can access
online help by pressing F1 on the processing option for a detailed explanation.
These processing options have been enhanced to new J.D. Edwards standards.
Enhanced processing option forms have a number, a brief title, and, if
applicable, a concise list of valid values. These processing options have online
help attached to them.

Nonenhanced processing options only provide you with a description in
paragraph form. Sometimes these fields have no title. They are numbered, and
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each number is followed by an explanation of any relevant information (usually
valid values) in paragraph form. The processing option numbers will sometimes
span across all tabs. The fields typically have data items attached but do not
follow the same naming conventions as enhanced processing options

Examples
Enhanced Processing Options:

M Processing Options

Date | Process Enrollment | Flecalculatiun' Flepnrts'

1. Mandatary and Default Plans far Mew
Hires
0=Da Mot Enrall
1 =Enroll

2. Mandatary and Default Plans far
Rehires
0=DaMat Exrall
1 =Enrall

3 Mandatory and Default Plans for
Transfers
0=DoMat Enroll
1 =Enrall

4, Mandatory and Default Plang for
Active
Employees
0=DoMat Enroll
1 =Enrall

I E

Help | ¥ Ccancel |
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Nonenhanced Processing Options:

M Processing Options
Defaults | Eligibility | Run Reports |

1. Enter value to specify first day services are performed for wages. 1'= —
Qriginal Hire date [D51), '2" is Date Started [DST). Default value is '2'
[D5T)

Walue |1

2.. Enter fram and through dates to select newly hired employees.

From Date: |1 1400
Through Date: |12.=’31 /00

3. Enter a'1"ta report on the parent company. ‘0" iz the defaulk and the
employee's home company will be used.

B arnarting Coranann Flan

— -

Help | ¥ cancel |

Working With Processing Options

You have two options for working with processing options:
e Working with processing options from a menu

e Working with processing options from a version list

How Processing Options Work From a Menu

You can access processing options for an object either from the menu bar or by
right-clicking the object. In either case, one of the options is Prompt For. The
Prompt For submenu contains the following options, when available:

Values Choose this option to specify processing option
values.
Version Choose this option to select which version of the

object to run. Depending on how the version was
designed, you might be prompted to enter
processing option values after you select the version,
or you might be able to modify them from the Row
menu.

Data Selection Choose this option to specify which data to use.
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Data Selection and Choose this option to specify which data to use and
Values then to specify processing option values.

If you choose to run processing option from a menu, the processing
details defined at the menu level take precedence. Not all objects allow
you to select from all four of these options.

See Also

o Working With Version Delail for Interactive Versions in the Interactive
Versions section

Interactive Version Processing Options

The processing options that you define in interactive versions are a set of
parameters that alter how an application runs. They are similar to initialization
(.ini) files and command-line arguments for a traditional executable. These
processing options let you specify the options that you want when you open an
application. For example, you can specify how certain forms appear, show or
hide a field, change the default status for order activity rules, and set default
information to appear in a field.

Not all OneWorld applications have processing options. If the Prompt for Value
option on the Edit menu is grayed out, either no processing options are
associated with the application or the system administrator has secured a version
for the application. When you open a secured version from the Interactive
Versions application, a security message appears to inform you that you do not
have access to the version.

You must first set processing options for an interactive application before you
use versions with the application.

Using processing options, you set up interactive programs to suit your business
requirements. Processing options do the following:

e Change functions. For example, you can set a processing option to turn
on or off order holds. You can also specify whether you want to
automatically print pick slips after you enter an order that is based on a
processing option value.

e Change default values. For example, you can set the processing options to
set defaults for document types (such as quote orders or purchase orders)
or line types (such as stock or nonstock items).

e Control the display of forms. For example, you can set the processing
options to hide or show a cost field, a price field, or a commission field.
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» 1o manually launch processing options for interactive versions

1. From an Explorer, highlight the application for which you want to set
processing options.

2. Right-click the application and choose Prompt for Values from the menu.

M Processing Options [X]
Defaults |

1. DBA Points Multiplier

Factor ar Blank |1 .0aoo

2. Plan/Option D'escription

0 = Plan and Option Description IU
1 = Self Service Description

3. Enraliment Event Codes

0 =Da Mot Show ID
1 = Shavw

Help | 3 Cancel |

3. On Processing Options, enter appropriate values where applicable and
click OK.

Batch Version Processing Options

You can change the processing options for an existing batch version to suit your
business requirements. For example, you can change processing option values
that specify a range of dates for a report. However, not all batch versions have
processing options associated with them. For example, a list of addresses might
not require special prompting.

For batch versions, processing options do the following:

e Change functionality. For example, you can set a processing option to
move records to a history file after a report runs.

e Change input parameters. For example, you can set a processing option to
specify which category code to use when processing a report.

e Define data. For example, you can set a processing option to define the
fiscal year for which you want to run a report. You can also define the
employee information included in a report.
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» 10 manually launch processing options for batch versions

1. From an Explorer, choose a report or other batch application for which
you want to set processing options.

2. On Work With Batch Versions, find and highlight a version of the report or
other batch application.

@ Print Pick Slips - [work With Batch Yersions - Available Yersions]
C] File Edit Preferences Form How ‘Window Help =131 x|

v B &+ B @ x & L & A'fJLmks w availa.. [S]OLE.. [#]intemnet

Select Find Add  Copy Del. Close Seq.. bew. . Dis

HatchiAnnlication [Ré2520 [Print Pick Slips
Version Version Title Last -
User Modified Security
MARK Mark Dixon ¥E Test ACCO3 7/19/00i0 N
TMARK REPRIMT PICK SLIPS XE ACCO3 7/19/00i0 N
% JDEO0O Prirt Pick Slips - Batch JKE561755 71251000 N
%JDEODOZ2 54300 i

DES00031

0 i

Print Pick Slips - AWWEES1347 4/28/00:0 i

Print Pick Slips - Subsystem AWWEE51347 4/28/00:0 I

Print Pick Slips - On Demand AYEES1347 4/28/0:0 I

Print Pick Slips - On Line AWYERS1347 4£28/00:0 I

[ »
‘Row:s ﬁ |

3.  On Work With Batch Versions — Available Versions, choose Processing
Options from the Row menu.

M Processing Options
Edits |Disp|ay| Processl Currencyl ‘Jersions'

1. Mest Status From [Required) 520
2. Mext Statuz Thru [Required) R40
3. Owerride Mext Status

4, Updating Mext Statug

LT

Blank = Update line status
1 = Do not update line statuz

Help | R Cancel |
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4. On Processing Options, enter appropriate values where applicable and
click OK.

Using Processing Options for Master Business Functions

The purpose of a master business function (MBF) is to provide a central location
for standard business rules about entering documents such as vouchers,
invoices, and journal entries.

The master business function is composed of processing options that are shared
by certain programs. For example, the processing options for the journal entry
MBF are used by the following journal entry programs:

e Journal Entries (P0911)

e Journal Entries with VAT (P09106)

e Journal Entry Batch processor (R091107)

e Store and Forward Journal Entry Batch Processor (R09110ZS)

e Recurring Journal Entry Compute and Print (R09302)

e Indexed Computations Compute and Print (R093021)

e Variable Numerator Compute and Print (R093022)

To review versions and processing options for a MBF in OneWorld, follow these
steps:

1 From the System Administration Configuration Tools Menu (GH9011),
choose Interactive Versions.

2. On Work with Interactive Versions, type the application number in the
Interactive Application Field and click Find. For example, enter P0900049.

3. Choose a version.

4. To review the processing option settings for the version, choose
processing options from the Row menu.

See Also

e Processing Options in the Development Tools Guide

e For specific master business function information, see the documentation
for the related application
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Menu Word Search

Menu Word Search is an application that you can use to find and open menus
and applications. Enter a single word or a string of words and Menu Word
Search displays all of the menus and applications that match. For example, if
you enter ADDRESS BOOK, Menu Word Search displays menus and applications
that contain that text string, such as the Address Book Category Codes menu
and the Customer Address Book Revisions application. You can also search
using object names (such as P0101) and menu IDs (such as GO1).

You can also use Menu Word Search to edit the following lists of words to help
with your searches:

e The equivalent word list. Use it to add, change, or delete words that are
similar to, but not exactly like, the full name of a menu or application.
You can use an equivalent word to perform a search. For example, if you
established UDC as an equivalent word, you can use those initials instead
of USER DEFINED CODES when performing a search.

e The ignore word list. Use it to add, change, or delete words you want
OneWorld to ignore if you enter them by themselves, such as the word
é(A.77
This section consists of the following subjects:
[ Finding and opening menus and applications
[ Working with equivalent words

L] Working with ignore words

[ Building the Menu Word Search table
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Finding and Opening Menus and Applications

You can use Menu Word Search to find menus and applications by entering
search strings. When you have found the menu or application that you want,
you can display the menu or run the application.

This task explains how to access the Menu Word Search application from
OneWorld Explorer. For information about how to access Menu Word Search
from a particular application within OneWorld, see that application’s guide. Not
all applications have access to Menu Word Search.

» 1o find and open menus and applications

1.  On an Explorer, you can access Menu Word Search in one of two ways:

From the toolbar, click the Word Search button.

From the Menu Word Search (GH9024) menu, choose Menu Word
Search (P95012).

2. On Menu Word Search, type your search criteria in the following fields
and then click Find:

OneWorld Xe (9/00)

Search Code

Enter a specific system code, such as 01 for Address Book or 00 for
the Foundation Environment (entering * by itself also works for the
Foundation Environment).

Search Word / Object / Menu

You can enter a single word, such as ADDRESS, or multiple words,
such as ADDRESS BOOK, or a word equivalent, such as UDC for
user defined codes. See Working with Equivalent Words for detailed
information. You can also search using object names (such as
P0101) and menu IDs (such as GO1).

To eliminate ambiguity, OneWorld edits the Search Word / Object /
Menu field to all uppercase characters. Therefore, the search is not
dependent on case.
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il Menu Word Search - [Meuu Word Search]
fif File Edit. Preferences Form Row Window Help

=181 x|

x
Select Find Cloge

L
Seg.. hew.. Dis.. Abo

L3 JLinks w word . [3)OLE [3)Internet

Search Code

Search Word f Ohject/ Menu

00 Foundation Ensironiment

IUSER DEFINED CODES

Goo
GO2141
Goz¢
G03B41
G441
GOSBCY
GODSBE4
[elila=NES
[elik=RES
GO7BUSP4
GoBA4
GOBBH4
G0EBP4
GD3BR4
[elLEY]
G1241

Selection Ienu Text Object
Number HName
14, General User Defined Codes PoOD4A
10;Rough CutUser Defined Codes GO21411
14 Workflow User Defined Codes Go241

20, User Defined Cadas
18 User Defined Codes
46 User Defined Codes
11 User Defined Codes
30 User Defined Codes

35 Print User Defined Codes RODOSP

20{User Defined Codes
§iUser Defined Codes
4iUserDefined Codes
1iUser Defined Codes
4iUserDefined Codes
22 User Defined Codes

3i Fixed Asset User Defined Codes G1242

FPOO0D4A
POOO4A
FPOO0D4A
POOO4A
POOO4A

POOO4A
POOO4A
POOO4A
POOO4A
POOO4A
POOO4A

3. From the list in the detail area, choose the appropriate list item, and then
perform one of the following:

Either click Select, or from the Row menu, choose Execute to move

directly to the

menu or application that you chose. If you chose a

menu, it appears in the right pane of OneWorld Explorer. If you
chose an application, OneWorld starts that application.

From the Row menu, choose Go to Menu to display the menu that

you chose, or

if you chose an application, the menu that the

application resides on. The appropriate menu appears in the right
pane of OneWorld Explorer.

Field

Explanation

Search Code

A user defined code (98/SY) that identifies a J.D. Edwards
system.

............. Form-specific information . ... ..........

The search code is based upon OneWorld system codes.
All searches will be over search code 00, the Foundation
Environment, whether or not you enter 00 into the Search
Code field. An asterisk in the Search Code field is the
same as entering 00. Enter different search codes if you
want to limit searches when using Word Equivalencies and
Ignore Words. See the topics about equivalent and ignore
words for complete information.
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Finding and Opening Menus and Applications

Field Explanation
Search Word / Object / One or more words used for a search. You must use the
Menu full word. If using a string of words, they must be in the

exact order as what you want to find.
............. Form-specific information . .............

The Menu Word Search application uses this field to find
menus and applications that contain the word(s) you
entered. For example, if you enter ADDRESS BOOK into
the Search Word field, the Menu Word Search application
will display all menus and applications that contain those
two words, such as the Address Book Category Codes
menu and the Customer Address Book Revisions
application. You can also use object names (such as
P0101), menu IDs (such as GO1), and equivalent words.

Menu Id The menu name, which can include up to nine characters.
J.D. Edwards standards are:
Menu numbers are preceded with a G prefix.
The two characters following the prefix are the
system code.
The next characters further identify the menu.
The 4th character specifies a specific skill level.
e The 5th character distinguishes two menus of the
same system with the same skill level.

For example, the menu identification G0911 specifies the
following;:

G Prefix

09 System code

1 Display level/skill level

1 First menu

Selection Number Used to determine the order of menu items and allow
them to be selected by this number.

Menu Text Contains menu titles and menu selection descriptions.

Object Name The OneWorld architecture is object-based. This means
that discrete software objects are the building blocks for
all applications, and that developers can reuse the objects
in multiple applications. Each object is stored in the
Object Librarian. Examples of OneWorld objects include:

e Batch Applications (such as reports)

Interactive Applications

Business Views

Business Functions

Business Functions Data Structures

Event Rules

Media Object Data Structures
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Working with Equivalent Words

With Menu Word Search, you can add, change, or delete from a list of equivalent
words. An equivalent word is one that is similar to, but not exactly like, the full
name of a menu or application. An equivalent word can be a synonym, an
alternative spelling, an alternative phrasing, or any string by which a user is
likely to search for a menu or application. For example, OneWorld has an
application called User Defined Codes, which is also commonly known by its
initials of UDC. If you establish these initials as an equivalent word, you can
enter them into the Search Word field on the Menu Word Search form, rather
than typing out USER DEFINED CODES. For an equivalent word to work on the
Menu Word Search form, it must be in the Word Search Equivalence (F91011)
table. OneWorld comes with a list of equivalent words, and you can add your
own words to this list.

Equivalent words are categorized by search code and search words. A search
code is the highest level. Immediately beneath the search code are search words.
You can only add equivalent words to search words. For example, to create
UDC as an equivalent word, you must first choose under which search code it
will appear. For example, under the 01 (Address Book) search code, you need to
choose a search word for which you want UDC to be the equivalent. In this
example, you would choose USER DEFINED CODES. The hierarchy looks like
this:

e Search code, such as 01
e Search word, such as USER DEFINED CODES

e Equivalent word, such as UDC

Back on the Menu Word Search form, to find applications and menus, you must
search using the specific search code that you entered for the equivalent word.
Using the above example, to find applications and menus using the equivalent
word UDC, you would enter the 01 search code. You need to create UDC as an
equivalent word under each search code for which you want Menu Word Search
to find matches.

Note: You can add or change equivalent words any time that you want to do so,
but Menu Word Search will not recognize the changes until a batch process
updates the main Menu Word Search (F91013) table. Contact your administrator
for the schedule of this batch process, or see Building the Menu Word Search
Table for information about how to run this process.
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This topic contains the following:

e Viewing equivalent words
e Adding equivalent words
e Changing equivalent words

e Deleting equivalent words

P Toview equivalent words

1. From an Explorer, you can access the Work With Word Equivalencies form
in one of the following ways:

e From the toolbar, click the Word Search button. The Menu Word
Search form appears. From its Form menu, choose Word
Equivalencies.

e From the Menu Word Search (GH9024) menu, choose Word Search
Equivalencies (P95012).

e On the Work With Ignore Words form, from the Form menu, choose
Word Equivalencies.

2. On Work With Word Equivalencies, type your search criteria in the
following fields, then click Find:

e Search Code

Enter a specific system code, such as 01 for Address Book or 00 for
the Foundation Environment. You can use * by itself to display all
system codes currently in the Word Search Equivalence (F91011)
table.

e Search Word

Enter the entire string of the “parent” search word. When you add
equivalent words, you must state a search word and its word
equivalence. Using the Work With Word Equivalencies form, you
can only search on the parent search word. For example, if you
want to view any equivalent words for USER DEFINED CODES, you
must enter USER DEFINED CODES, not UDC, unless you added
UDC as a search word and not just as an equivalent.

You can also enter * by itself to display all equivalent words for the
system code entered in the Search Code field.

The system code folder displays any equivalent words that exist for the
system code and search word you entered. Use your mouse to expand
folders to see the search words and equivalent words beneath.
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Working with Equivalent Words

Q Menu Word Search - [wWork With Word Equivalencies] M= &
C:‘ File Edit Preferences Form Bow Window Help -1&1 x|

v B o+ @ 9 x I & # '\@JUHKS
lgnote... FIOLE.. [3]internet
Select Find Add Del. Close Seq Lew. Dis.. Abo it B Bl

Search Code Inn Foundation Environment

SearchWord IUSER DEFINED CODES

=23 Ward Equivalence
523 00 - Foundation Environmment
ENERSER DEFINED C S
L E uoc

]

Row:2

3

»  Toadd equivalent words

1. From an Explorer, you can access the Work With Word Equivalencies form

in one of the following ways:

e From the toolbar, click the Word Search button. The Menu Word

Search form appears. From its Form menu, choose Word

Equivalencies.

e From the Menu Word Search (GH9024) menu, choose Word Search

Equivalencies (P95012).

e On the Work With Ignore Words form, from the Form menu, choose

Word Equivalencies.
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2. On Work With Word Equivalencies, click Add.

. Menu Word Search - [Word Equivalence Revisions]

LUSER DEFINED CODES

3. On the Word Equivalence Revisions form, complete the following fields,
then click OK.

e Search Code

You must enter a specific system code, such as 01 for Address Book
or 00 for the Foundation Environment.

e Search Word

Enter the word or phrase (such as USER DEFINED CODES) for
which you want to create the equivalent word.

e Word Equivalence

Enter the equivalent word, such as UDC for USER DEFINED
CODES.

You can now find your new equivalent word on this form, but you cannot
use the equivalent word on the Menu Word Search form until the system
administrator updates the main Menu Word Search table. See Building the
Menu Word Search Table for more information about this batch process.
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Working with Equivalent Words

Field

Explanation

Search Code

A user defined code (98/SY) that identifies a J.D. Edwards
system.

............. Forme-specific information . . ............

The search code is based upon OneWorld system codes.
Use the search code to categorize additions and revisions
to Word Equivalencies. You must create the equivalent
word within each search code for which you want to use
it. For example, if you create an equivalent word only
within search code 01, you would not get any information
returned if you tried to perform a search using that
equivalent word within search code 03; you would have
to also create the equivalent word within search code 03.
If you want Menu Word Search to use your equivalent
word against every search code, create the equivalent
word under search code 00 (Foundation Environment),
then perform your searches with that equivalent word by
entering 00 into the Search Code field.

Word Equivalence

The equivalence of a search word. An equivalent word
can be a synonym, an alternative spelling, an alternative
phrasing, or any string by which a user is likely to search
for a menu or an application. For example, the User
Defined Codes application is commonly referred to by its
initials of UDC. You can use UDC as an equivalent word
for the search word of User Defined Codes.

> 1 change equivalent words

1. From an Explorer, you can access the Work With Word Equivalencies form
in one of the following ways:

e From the toolbar, click the Word Search button. The Menu Word
Search form appears. From its Form menu, choose Word

Equivalencies.

e From the Menu Word Search (GH9024) menu, choose Word Search
Equivalencies (P95012).

e On the Work With Ignore Words form, from the Form menu, choose
Word Equivalencies.

2. On Work With Word Equivalencies, find the equivalent word you want to

change.

3. Choose the equivalent word and click Select.

On Word Equivalence Revisions, the Search Code and Search Word fields

are grayed out.

OneWorld Xe (9/00)
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Complete the following field and then click OK.

e Word Equivalence
Change the equivalent word.

You can now find your changed equivalent word on this form, but you
cannot use the equivalent word on the Menu Word Search form until the
system administrator updates the main Menu Word Search table. See
Building the Menu Word Search Table for more information about this
batch process.

P 1o delete equivalent words

From an Explorer, you can access the Work With Word Equivalencies form
in one of the following ways:

e From the toolbar, click the Word Search button. On Menu Word
Search, choose Word Equivalencies from its Form menu.

e From the Menu Word Search (GH9024) menu, choose Word Search
Equivalencies (P95012).

e On Work With Ignore Words form, from the Form menu, choose
Word Equivalencies.

On Work With Word Equivalencies, find the equivalent word you want to
delete.

Choose the equivalent word (not the search word “parent”) and click
Delete.

The equivalent word will not be deleted from the main Menu Word Search
table until the system administrator updates the table. See Building the
Menu Word Search Table for more information about this batch process.
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Working with Ignore Words

With Menu Word Search, you can add, change, or delete from a list of words
that you want OneWorld to ignore if you enter them in the Search Word field by
themselves. For example, Menu Word Search already ignores A, ABOUT, and
AFTER; so if you enter one of these words by itself into the Search Word field,
the Menu Word Search application will ignore it. This process prevents
OneWorld from retrieving too many menus and applications, such as all menus
or applications with the word “A” in their title.

Note: You can add or change ignore words any time that you want to do so, but
Menu Word Search will not recognize the changes until a batch process updates
the main Menu Word Search (F91013) table. Contact your administrator for the
schedule of this batch process or see Building the Menu Word Search Table for
information about how to run this process.

This topic contains the following:

e Viewing ignore words
e Adding ignore words
e Changing ignore words

e Deleting ignore words

P To view ignore words

1. From an Explorer, you can access the Work With Ignore Words form in
one of the following ways:

e From the toolbar, click the Word Search button. The Menu Word
Search form appears. From its Form menu, choose Ignore Words.

e From the Menu Word Search (GH9024) menu, choose Word Search
Ignore Words (P95012).

e On the Work With Word Equivalencies form, from the Form menu,
choose Ignore Words.

2. On Work With Ignore Words, complete the following field and then click
Find:

e Search Code
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Enter a specific system code, such as 01 for Address Book or 00 for
the Foundation Environment. You can use * by itself to display all
system codes currently in the Word Search Ignore (F91012) table.

The system code folder displays any ignore words that exist for the system
code that you entered. Use your mouse to expand folders to see the
ignore words beneath Foundation Environment:
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»  Toadd ignore words

1. From an Explorer, you can access the Work With Ignore Words form in
one of the following ways:

e From the toolbar, click the Word Search button. The Menu Word
Search form appears. From its Form menu, choose Ignore Words.

e From the Menu Word Search (GH9024) menu, choose Word Search
Ignore Words (P95012).

e On the Work With Word Equivalencies form, from the Form menu,
choose Ignore Words.

2. On Work With Ignore Words, click Add.

3. On the Ignore Word Revisions form, complete the following fields and
then click OK.

e Search Code

You must enter a specific system code, such as 01 for Address Book
or 00 for the Foundation Environment.

e Ignore Word
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Working with Ignore Words

Enter the word that you want Menu Word Search to ignore if you
enter that word into the Search Word field by itself.

You can now find your new ignore word on Work With Ignore Words, but
Menu Word Search will not ignore this word until the system administrator
updates the main Menu Word Search table. See Building the Menu Word
Search Table for more information about this batch process.

Field Explanation
Search Code A user defined code (98/SY) that identifies a J.D. Edwards
system.

............. Form-specific information . .............

The search code is based upon OneWorld system codes.
Use the search code to categorize additions and revisions
to Ignore Words. You must create the ignore word within
each search code for which you want to use it. For
example, if you create an ignore word only within search
code 01, that word would not be ignored if you then tried
to perform a search using that ignore word within search
code 03; you would have to also create the ignore word
within search code 03. If you want Menu Word Search to
use your ignore word for every search code, create the
ignore word under search code 00 (Foundation
Environment), then perform your searches by entering 00
into the Search Code field.

Ignore Word The words in menus and applications that will be ignored
during a search. For example, some common words to
have on an ignore-word list are A, ABOUT, AFTER. If you
enter one of these words by itself into the Search Word
field, the Menu Word Search application will ignore it.
This prevents OneWorld from retrieving too many menus
and applications, such as all menus or applications with
the word “A” in their title.

» 1o change ignore words

1. From an Explorer, you can access the Work With Ignore Words form in
one of the following ways:

e From the toolbar, click the Word Search button. The Menu Word
Search form appears. From its Form menu, choose Ignore Words.

e From the Menu Word Search (GH9024) menu, choose Word Search
Ignore Words (P95012).

e On the Work With Word Equivalencies form, from the Form menu,
choose Ignore Words.
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2. On Work With Ignore Words, find the ignore word that you want to
change.

3. Choose the ignore word and click Select.
On Ignore Word Revisions, the Search Code field is grayed out.

4. Complete the following field and then click OK.
e Ignore Word

Change the ignore word.

You can now find your changed ignore word on Work With Ignore Words,
but Menu Word Search will not ignore this word until the system
administrator updates the main Menu Word Search table. See Building the
Menu Word Search Table in this section for more information about this
batch process.

P 1o delete ignore words

1. From an Explorer, you can access the Work With Ignore Words form in
one of the following ways:

e From the toolbar, click the Word Search button. The Menu Word
Search form appears. From its Form menu, choose Ignore Words.

e From the Menu Word Search (GH9024) menu, choose Word Search
Ignore Words (P95012).

e On the Work With Word Equivalencies form, from the Form menu,
choose Ignore Words.

2. On Work With Ignore Words, find the ignore word that you want to
delete.

3. Choose the ignore word and click Delete.

The ignore word will not be deleted from the main Menu Word Search

table until the system administrator updates this table. See Building the

Menu Word Search Table in this section for more information about this
batch process.
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Building the Menu Word Search Master Table

System administrators use the batch process explained in this task to build the
Menu Word Search (F91013) table periodically, for example, once a week. For
example, this process updates the main Menu Word Search table with any
changes to menus, equivalent words, or ignore words.

This batch process can take several hours to complete.

> To build the menu word search master table

1. Sign onto the OneWorld environment that points to your pristine or
publisher copy of your menus (such as PROD ADMIN). This environment
would typically map your menus to the data source “Control Tables -
Production,” where the Menu Word Search master table resides. Only use
an environment that points to your local workstation if you have very
recently installed OneWorld. Otherwise, you could be building from
out-of-date menus.

2. On System Administration Tools (GH9011), choose Batch Versions
(P98305).

On Work With Batch Versions, you can locate and run batch processes.

3. Type R95012 into the Batch Application field, which is the name of the
batch process that updates the Menu Word Search table.

4. Click Find to locate the versions that are available on your workstation.

5. In the grid, choose version XJDE0001, Build Menu Word Search Table, and
click Select.

The Version Prompting form appears. You can submit your job without
selecting any options on Version Prompting. However, if you want, from
Version Prompting, you can specify Data Selection and Data Sequencing,
and access the Advanced Version Prompting form.

6. Click Submit to send your job to the report processing location. If you
choose any options on Version Prompting, forms appear that allow you to
modify your report before processing.
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7. On the Processing Options form, complete the following field:
e Option 1.
Enter 1 to clear the Menu Word Search table before you rebuild it (a
recommended procedure), enter 0, or leave the field blank so that

the table is not cleared. Make sure that you have a backup of the
table before you clear it.

The system takes the menu information from the Object Configuration
Management mappings on the environment that you are signed onto and
populates the Menu Word Search table.

This process can take several hours.

See Also

e Batch Versions for Reports

o Object Configuration Manager in the Configurable Network Computing
Implementation Guide
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User Defined Codes

Most OneWorld forms contain fields. Some fields allow you to enter any value,
and some require you to choose from a list of valid values. A user defined code
(UDC) is one value in a set of values that you have assigned as valid for a field.
You can use UDCs to categorize your data and make sure that users provide
consistent input on forms. Because users can choose only values from the list,
UDCs provide a way to simplify, standardize, and validate the data that is
contained in fields.

From any OneWorld application, you can identify fields that have UDCs
attached to them by using the visual assist button that appears when you tab
into or click on a field. If you do not know the value to enter in a field that has
a user defined code attached to it, click on the visual assist button, which
accesses the User Defined Code Search & Select form. This form displays all
valid values in the user defined code tables for this field. You can then choose
the valid value to use.

OneWorld provides predefined UDCs, but many of the UDCs that you need to
use are unique to your enterprise, and your needs are likely to change.
Therefore, OneWorld lets you change, add, and delete UDCs to meet the needs
of your enterprise. When you upgrade OneWorld, your customized UDCs will
remain.

This subject consists of the following tasks:
[] Customizing user defined codes
[ Customizing user defined code types

[] Translating user defined codes into alternate languages

UDCs, UDC Types, and Category Codes

A UDC is one value in a set of values that you have assigned as valid for a field.
A UDC is made up of two parts. The first part is the code, which consists of the
characters that you enter in a field. The second part is the description, which is
text that describes what the code means. For example, on the Address Book
Work With Addresses form, you can enter the code “A” to designate an
“Applicant” in the Search Type field. This code becomes part of the data stored
with a record.

OneWorld Xe (9/00) 18-1
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UDCs

A UDC type is the complete set of UDCs that are allowed as values for a field. A
UDC type is made up of a code type, which is its two-character name, and a
description. Examples of UDC types are “ST - Search Type” and “UM - Units of
Measure.” UDC types are sometimes referred to as UDC lists.

Each UDC type is associated with a OneWorld product code. You can identify
any set of UDCs by its product code and its code type. For example, the
Address Book (product code 01) list of search types (code type ST) is referred
to as UDC 01/ST.

The figure below illustrates the structure of user defined code tables:

Product Code
Address Book (01)

User Defined Code Type User Defined Code Type User Defined Code Type

Search Type LP Language PH Phone Types
Preferences

E Employee F French — CAR Car or

UDCs UDCs Mobile
\Y Vendor Italian — HOM Home
C Customer S Spanish —  FAX FAX

Throughout OneWorld you will see references to category codes. Category
codes are UDC types that OneWorld provides for you to customize according to
your needs. You can change the code type and the description, and you can
redefine the UDCs within it as appropriate for your purposes. For example, you
might see a UDC type called Category Code 01. You can change its description
and define the UDCs within it to suit your business needs.

Example: User Defined Codes in Address Book

18-2

Every OneWorld product uses UDCs. For example, Address Book uses a field
called Search Type to classify the entries in the address book. When you click
the visual assist button on the Search Type field on the Work With Addresses
form, a list of the search types appears. These search types are UDCs. Some of
the search types include:

e A - Applicants
e (C - Customers

e V - Vendors
e E - Employees

OneWorld Xe (9/00)
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You can use these UDCs to classify your address book entries, and you can add
or change UDCs to accommodate your needs. For example, if you need to
categorize some of your address book entries as students, you can add a UDC
to the list: “S - Students.”

UDCs are also used to supply values for:

e State and province codes
e Units of measure

e Document types

e Languages

When you click the visual assist for a field and OneWorld displays the Select
User Defined Code form, you will know you are working with UDCs.

Customizing UDCs and UDC Types

OneWorld provides many UDC types containing predefined UDCs. Some of the
UDCs are hard coded, which means that certain OneWorld applications depend
on specific values, so you should not change them. However, if a UDC is not
hard coded, you can change it to suit your business needs.

You can change, add, and delete UDCs in the following ways:

e You can change the code or the description of a UDC in an existing UDC
type. For example, in UDC 01/ST, a medical institution might change the
UDC for “C - Customers” to “P - Patients” to more accurately describe that
category.

e You can add UDCs to an existing UDC type. For example, in the Search
Type list, you might add a UDC for “S - Students.”

e You can delete UDCs from a UDC type. For example, if you want to
prevent users from choosing a UDC, you can delete it from the UDC type.

You can also change, add, and delete UDC types in the following ways:

e You can change the code type or the description of an existing UDC type,
which is useful if you want to customize one of the generic category code
lists to meet your needs.

e You can create a new UDC type and add UDCs to it. For example, an
educational institution might create a UDC type called “MA - Major Field
of Study” to classify its students and define the following UDCs:

e LA - Liberal Arts
e MA - Mathematics

e (S - Computer Science

OneWorld Xe (9/00) 18-3
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e EN - Engineering
e MD - Medicine
e You can delete a UDC type.

Consequences of Customizing UDCs

Because UDCs can have a significant impact on the integrity of your data, you
should customize them only as part of a coordinated plan within your
enterprise. When you add or change a UDC, you are affecting the set of values
against which OneWorld validates the data entry. However, you are not
affecting the actual content of any existing data records. By changing UDCs
within a working production environment, you might affect the integrity of your
data.

For example, you use Address Book to enter address book records, and you use
search types to classify those records. Suppose that you choose a search type of
“C - Customers” to classify some of the records that you enter. Later, you decide
to change that UDC from “C - Customers” to “P - Patients.” Any address book
records that you entered with the original UDC value “C” will still contain that
value. When Address Book displays these records, you will see an error in the
Search Type field because “C” is no longer a valid value.

OneWorld UDC Tables

18-4

You use the User Defined Code program (P0004A) to create and customize
UDCs and UDC types. The program stores UDC information in the following
tables:

e User Defined Code Types (FO004)

e User Defined Codes (FO005)

OneWorld Xe (9/00)
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Customizing User Defined Codes

Many of the UDCs that you need to use are unique to your enterprise, and your
needs are likely to change. Therefore, OneWorld allows you to change, add,
and delete UDCs. UDCs allow you to customize OneWorld to meet your needs
without having to write complex programs or modify the OneWorld code.
When you upgrade OneWorld, your customized UDCs remain.

Complete the following tasks:
[ Changing a user defined code
] Adding a user defined code

L] Deleting a user defined code

Changing a User Defined Code

A UDC is made up of two parts. The first part is the code, which consists of the
characters that you enter in a field. The second part is the description, which is
text that describes what the code means. You can change both the code and the
description. For example, the UDC list of search types contains the code “C”
which designates “Customers.” A medical facility might change this code and
description to “P” for “Patients.”

> 1o change a user defined code

From a System Setup menu for your product, choose the appropriate program
for changing UDCs.

Alternatively, enter UDC in the Fast Path field.
1. On Work With User Defined Codes, complete the following fields and
click Find:
e Product Code
e User Defined Codes
For example, to display the list of Address Book search types,

which is UDC 01/ST, type 01 in the Product Code field and ST in
the User Defined Codes field.
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@ User Defined Codes - [Work With User Defined Codeg] [_ O]

C,l File Edit Preferences Form Bow  Repot Window Help

=18] x|
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User Defined Codes IST— Search Type
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A Applicants M
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I CMQ Call Management Clueue Y
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i Faciliies N
] | Investors ¥
1 Jabs N
e Junction PointPort N
| 1] tail Distribution List M
I n New Hire N
I 0 Campany M
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2. Choose the code that you want to modify and click Select.
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User Defined Cades Search Type

Special Hard
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To access English documentation updates, see

OneWorld Xe (9/00)

https://knowledge.jdedwards.com/JDEContent/documentationcbt/overview/about_documentation_updates.pdf



Customizing User Defined Codes

3.  On User Defined Codes, change any of the following fields and click OK:

e Codes

e Description 01

e Description 02

e Special Handling

e Hard Coded

Field

Explanation

Product Code

A user defined code (98/SY) that identifies a J.D. Edwards
system.

User Defined Codes

A code that identifies the table that contains user defined
codes. The table is also referred to as a code type.

Special Handling

A code that indicates special processing requirements for
certain user defined code values. The value that you enter
in this field is unique for each user defined code type.

The system uses the special handling code in many ways.
For example, special handling codes defined for
Language Preference specify whether the language is
double-byte or does not have uppercase characters.
Programming is required to activate this field.

Hard Coded

A code that indicates whether a user defined code is
hard-coded.

Valid values are:
Y The user defined code is hard-coded
N The user defined code is not hard-coded

For OneWorld, a check indicates that the user defined
code is hard-coded.

Adding a User Defined Code

Add a UDC to a UDC type when none of the existing codes is appropriate for
your needs. For example, if you need to identify the entries in the address book
that are your business partners, you can add a search type “B - Business

Partners” to UDC 01/ST.

Before You Begin

ve elongs to a type. Verify that a type exists where
Every UDC belong UDC type. Verify th UDC typ i h
you will add the UDC. To create a new UDC type, see Adding a User

Defined Code Type.

OneWorld Xe (9/00)
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18-8

’ To add a user defined code

From a System Setup menu for your product, choose the appropriate program
for changing UDCs.

Alternatively, enter UDC in the Fast Path field.

1. On Work With User Defined Codes, complete the following fields and

click Find:

e Product Code

e User Defined Codes

Enter the UDC type into which you want to add the UDC.

@ User Defined Codes - [Work With User Defined Codes] =

Cl File Edit Preferences Form How Feport Window Help

=18] x|

Select Find  Add

v B £+ @

Del

x

Close Seg.. Mew.. Dis

i & &

Aﬁ“unks w Code.. [#)OLE.. [9]Internet

Product Code Im— addrass Book

Uzer Defined Codes IE,T— Search Type

fh| Codes Description 01 F?;:e:::ﬁ:; Ct']?;:d

A Applicants N
| c Customers ¥
I CMQ Call Management Clueue Ay
I E Emplovees M
I |F Faciliies N
| | Investors ¥
it Jobs N
e Junction PointPort N
[ m Mail Distribution List N
n Mew Hire N
I o] Campany M
I P Prospects M
|ROW:1 B

#

2. On Work With User Defined Codes, click Add.
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On User Defined Codes, scroll to the last empty row of the detail area.

Caution: Be sure to add each new code on the last detail row, so that
you do not inadvertently overwrite a blank code, which might appear in

the first detail row. A blank code might have only a period in the

Description field.

Complete the following fields and click OK:

e Codes

To allow a blank as a valid value, leave this field blank.

e Description 1

To allow a blank as a valid value, type any character (such as a
period) in the last space in this field.

e Special Handling

e Hard Coded

Field

Explanation

Codes

A list of valid codes for a specific user defined code list.

Description 1

A user defined name or remark.

OneWorld Xe (9/00)
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Deleting a User Defined Code

18-10

You can delete UDCs from a UDC type, but do so with caution. Only delete
UDCs as part of a coordinated plan within your enterprise. For example, you
might delete the “F - Facilities” UDC from the list of search types if you do not
want users to choose that UDC.

If you delete a UDC, the system only deletes the code from the UDC type. UDC
values in existing records are not deleted.

Caution: Do not delete hard-coded UDCs because OneWorld applications
might depend on them. Hard-coded UDCs have the value “Y” in the Hard

Coded field on the Work With User Defined Codes form.

’ To delete a user defined code

From a System Setup menu for your product, choose the appropriate program
for changing UDCs.

Alternatively, enter UDC in the Fast Path field.

1. On Work With User Defined Codes, complete the following fields and
click Find:

B’ User Defined Codes - [Work With User Defined Codes] =

Product Code

User Defined Codes

C\l File Edit Pieferences Fomm How Fepot Window Help

=18

Y

Select Find

= W %

i &

Add  Del. Close Seq. New.. Dis.

= Aﬁ”unks w Code.. [§]OLE.. [9]Internet

Product Code

01
User Defined Codes aT

Address Boak

Search Type

fh| Codes

Description 01

Special
Handling

Hard
Coded

Applicants
Customers

Call Management Clueue
Emplovees
Facilities

Investors

Johs

Junction PaintPart
Mail Distribution List
Mew Hire

Company

Frospects

Z =2 2 22 Z =22 == < Z2 =

Row:1

To access English documentation updates, see
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2. On Work With User Defined Codes, in the detail area, choose the UDC
that you want to delete and click Delete.

Caution: Ensure that you want to delete this UDC. The only way to
replace a deleted UDC is to add it back.

3. Click OK to confirm that you want to delete the UDC.

Field Explanation

Product Code A user defined code (98/SY) that identifies a J.D. Edwards
system.

User Defined Codes A code that identifies the table that contains user defined

codes. The table is also referred to as a UDC type.

Processing Options for User Defined Codes Processing Option

Defaults

Enter the desired System Code:

Enter the desired Record Type:

OneWorld Xe (9/00) 18-11
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Customizing User Defined Code Types

A UDC type is the complete set of UDCs that is allowed for a field. A UDC type
is made up of a code type, which is its two-character name, and a description.
Examples of UDC types are search types and units of measure. UDC types are
sometimes referred to as UDC lists.

Each UDC type is associated with a OneWorld product code. You can identify
any set of UDCs by its product code and its code type. For example, the
Address Book (product code 01) list of search types (code type ST) is referred
to as UDC 01/ST.

Complete the following tasks:
[] Changing a user defined code type
L] Adding a user defined code type

[l Deleting a user defined code type

Changing a User Defined Code Type

You can change the code type and the description of an existing UDC type to
meet your needs. Typically, you would change only the description so that it
provides a meaningful description of the UDCs within the UDC type. For
example, to classify your customers according to how much business they
provide, you can change the description for Category Code 01 to Customer
Volume. Then, you can customize the individual UDCs within that UDC type to
describe the following classifications for your customers:

e H - High-volume customer
e M - Medium-volume customer
e L - Low-volume customer
You can change the code type, but you should do so with caution. If you

change a code type, you could invalidate any existing records that use the
original code type.

You can also follow this procedure to see a complete list of UDC types for a
product code.

OneWorld Xe (9/00) 18-13
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» 10 change a user defined code type

From a System Setup menu for your product, choose the appropriate program

for changing UDCs.

Alternatively, enter UDC in the Fast Path field.

1. On Work With User Defined Codes, choose Code Types from the Form

menu.

2. On Work With User Defined Code Types, complete the following field

and click Find:

e Product Code

The system displays the UDC types that already exist for that product

code.
B’ User Defined Codes - [Work With User Defined Code Types] !E
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3. Choose the UDC type that you want to change and click Select.
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Q User Defined Codes - [User Defined Code Types] [_[o] <]
C:‘ File Edit Preferences How Window Help -1&1 x|
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BroducthCade |n1 Address Book
A5
& Code Description Code 2nd Line Humeric
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Autocash Algorithm
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4. On User Defined Code Types, change the values in any of the following
fields and click OK:

e Code Types
Caution: ].D. Edwards suggests not changing code types. If you
change a code type you could invalidate any existing records that
use the original code type.
e Description
e Code Length
e 2nd Line (Y/N)
e Numeric (Y/N)
Field Explanation
Code Types A code that identifies the table that contains user defined

codes. The table is also referred to as a UDC type.

Code Length

The length of the user defined code. It cannot be greater
than 10 characters.

OneWorld Xe (9/00)
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Field Explanation
2nd Line (Y/N) Valid values are:
Y Enables the Select User Defined Code form to
display a second line of description.
M For maintenance only for second line display.

This capability is seldom used, but has
applicability in areas such as inventory product
codes. The M value will not display the second
line of description in the Select User Defined
Code form.

N Allows the Select User Defined Code form to
display only one line of description.

Numeric (Y/N) Determines whether a user defined code is numeric or
alphanumeric.

Valid values are:

Y Indicates that the code is numeric and should
be right-justified.
N Indicates that the code is alphanumeric and

should be left-justified.

Adding a User Defined Code Type

Add a UDC type when you need to categorize your data using UDCs and when
none of the existing UDC types is appropriate. For example, an educational
institution might add a UDC type called “Major” to categorize its students by
their major field of study:

e LA - Liberal Arts

e MA - Mathematics

e (S - Computer Science
e EN - Engineering

e MD - Medicine

When you add a UDC type, you must also modify the OneWorld applications
that use the UDC type. See Creating UDC Edit Controls in the OneWorld
Development Tools Guide for more information about associating a UDC type
with a field.

Note: Because modifying a OneWorld application might require significant
effort, whenever possible, you should change an existing UDC type (such as a
category code) instead of adding a new UDC type. See Changing a User Defined
Code Type.

18-16 OneWorld Xe (9/00)
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P 1o add a user defined code type

From a System Setup menu for your product, choose the appropriate program
for changing UDCs.

Alternatively, enter UDC in the Fast Path field.

1. On Work With User Defined Codes, choose Code Types from the Form

menu.
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2. On Work With User Defined Code Types, complete the following field
and click Find:

e Product Code
3. Click Add.
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4. On User Defined Code Types, scroll to the last empty row of the detail
area.

5. Complete the following fields and click OK:
e Code Types
e Description
e Code Length
e 2nd Line (Y/N)
e Numeric (Y/N)

Deleting a User Defined Code Type

You can delete a UDC type, but you should do so with caution. OneWorld
applications and the integrity of the data within your database might depend on
the existence of UDCs and UDC types. Only delete UDC types as part of a
coordinated plan within your enterprise.

Caution: Do not delete UDC types that contain hard-coded UDCs because
OneWorld applications might depend on them. Hard-coded UDCs have the
value Y in the Hard Coded field on the Work With User Defined Codes form.

Before You Begin

L] Delete all individual UDCs from the UDC type. For information about
deleting UDCs, see Deleting a User Defined Code.
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P 1o delete a user define code type

From a System Setup menu for your product, choose the appropriate program

for changing UDCs.

Alternatively, enter UDC in the Fast Path field.

1. On Work With User Defined Codes, choose Code Types from the Form

menu.
C:\ File Edit Preferences How Report 'window Help ;IEILI
* e
E;gm J%d Ju QE" g;(se s?g. _ N&v __ Dfl‘: Aﬁ J Links w Aftach.. [S]OLE.. [@Internet
Product Code |D1 Address Book
& Code Description Code 2nd Line Humeric
Tyhes Length o) o)

AT Address Type ik I
_CL CIF User Classification Codes LI M
M CM Address No. for Collection Mar 100 I
I |cr Address Mo, for Credit Manager 10y M
et Contact Type 3N M
M DB Dun & Bradstreet Rating 3iM I
T er E-Mail Preference 1N N
I |er Electronic Address Type 4iN M
e Language 2y M
M T Electronic Mail Message Type TiM I
M A Contact Category Code 10 JiM I
1 M1 Contact Category Code 01 3N M
I |nz Contact Category Code 02 3N [

[Raw:1

2. On Work With User Defined Code Types, complete the following field

and click Find:

e Product Code

3.  On Work With User Defined Code Types, choose the code type that you

want to delete and click Delete.

Caution: Ensure that you want to delete this code type. The only way to

replace a deleted UDC type is to add it back.

4. Click OK to confirm that you want to delete the code type.
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Translating User Defined Codes Into Alternate Languages

Multinational enterprises can translate the descriptions for both UDCs and UDC
types into alternate languages. OneWorld displays the descriptions in the
language designated by the user’s language preference. For example, you can
provide a translated description for the following UDC:

e Code: E
e English Description: Employees

e Spanish Description: Empleados

In this way users can choose the same UDCs, regardless of their language
preference.

The User Defined Code Alternate Descriptions program (P0O004D) stores the
translated descriptions in the following tables:

e User Defined Codes - Alternate Language Descriptions (F0004D)
e User Defined Codes - Alternate Language Descriptions (FOO05D)

Complete the following tasks:
e Translate UDC type descriptions into alternate languages

e Translate UDC descriptions into alternate languages

P 1o translate UDC type descriptions into alternate languages

From a System Setup menu for your product, choose the appropriate program
for changing UDCs.

Alternatively, enter UDC in the Fast Path field.

1. On Work With User Defined Codes, choose Code Types from the Form
menu.
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2. On Work With User Defined Code Types, complete the following field
and click Find:

e Product Code

3. Choose the UDC type that you want to translate and then choose
Language from the Row menu.

@ User Defined Codes - [UDC Alternate Languages] M=l
C:I File Edit Preferences Window Help - |5 ll

v M x & P '\@JLinka
S EHL. EEm. M. B, Ao w Displ. [#]OLE.. [3]Intermnet

ErodichCade |[|1
UserDefined Godes |n1 |Elranches
i L Language Description

5] Spanish Susursales

Fow:2

g
i

4. On UDC Alternate Languages, enter information in a blank row for the
following fields and click OK:

e L

e Description

Type the translated description into this field.

Field Explanation

L A user defined code (UDC 01/LP) that specifies a
language to use in forms and printed reports.

Before any translations can become effective, a language
code must exist at either the system level or in your user
preferences.

Description A user defined name or remark.
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4 To translate UDC descriptions into alternate languages

From a System Setup menu for your product, choose the appropriate program
for changing UDCs.

Alternatively, enter UDC in the Fast Path field.

1. On Work With User Defined Codes, complete the following fields and
click Find:
e Product Code
e User Defined Codes
2. Choose the code that you want to translate and then choose Language
from the Row menu.

C] File Edit Preferences “Window Help

=181 x|

RN .
Links Displ... OLE .. Internet
0K Del. Can.. Mew. Dis.. Apo Bl B i
EraduciCode 01
Uger Wefined Code e ST
WeerBefifed Eode/alie IE IEmployees
& LD Description
5 Spanish Empleados

‘Hnw?

3. On UDC Value Alternate Descriptions, enter information in a blank row
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for the following fields and click OK:
e L

e Description

Type the translated description into this field.
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Configurable Network Computing (CNC) is the technical architecture for
OneWorld. CNC allows highly configurable, distributed applications to run on a
variety of platforms without users or analysts needing to know which platforms
or which databases are involved in any given task. CNC insulates the business
solution from the underlying technology. Enterprises can grow and adopt new
technologies without rewriting applications.

OneWorld comprises the following components:

Design Tools OneWorld provides a unified set of tools to create all
interactive applications, batch applications, and reports.

Applications OneWorld provides the interactive and batch applications
that perform your business needs. For example, Purchase
Order Entry and General Ledger Post are applications.

OneWorld Foundation OneWorld provides underlying core processing that both
Code interactive and batch applications depend on in order to
run.

OneWorld Middleware OneWorld provides middleware that insulates your
applications from the underlying database, operating
system, hardware, messaging systems, and
telecommunications protocols. Middleware insulates your
business solution from the platform technology.

For detailed information about Configurable Network Computing, see the
following guides:

e Configurable Network Computing Implementation Guide
e Package Management Guide
o System Administration Guide

o Server and Workstation Administration Guide
This section contains the following:
[] Advantages and recommendations for CNC

L] Configurable Network Computing fundamentals EEE
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Advantages and Recommendations for CNC

The OneWorld Configurable Network Computing architecture provides the
following advantages:

[L] Network-centric software

[] Flexible, leveraged technology

[ Worldwide business support

[[] Custom solutions without consequences

L] Recommendations for Configurable Network Computing

Network-centric Software

Network-centric software allows you to create a uniform interface that supports a
multiplatform network. This compatibility across platforms provides:

e Immediate availability of enhancements to all supported applications.
Changes to the following items are reflected in applications across the
network:

e Business objects

e Business rules

e Modes of processing

e Hardware and database

e OneWorld platform-neutral business specifications, or middleware, that
comprise a common set of Application Program Interfaces (APIs) that
integrate multivendor, multiprotocol differences. This integration insulates
developers from the need to program to a specific platform.

e Support for Internet technology, such as a browser interface.

Flexible, Leveraged Technology

You create your applications using tools that do not require a designer to master
a programming language. OneWorld tools conceal the code and allow the
designer to concentrate on creating applications that are specific to current
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business needs and accommodate changes to business rules without
reprogramming the application source code.

OneWorld is object-based and event-driven to provide you with more efficient
business processes. Developers can reuse objects between applications for
different purposes. This reusability provides consistency throughout all
OneWorld applications.

OneWorld does not rely on one command or keystroke to process information
but, rather, processes information at strategic moments during the use of an
application. For example, when a user moves between fields on any given form,
the system processes the information at the moment when the cursor leaves the
field. OneWorld immediately notes any errors and hides processing, such as an
update of files that might also store information for the field, when the user
moves to the next field on a form.

In addition, OneWorld provides a common interface between applications.
When you move from form to form, you see the same general setup.

Worldwide Business Support

OneWorld provides support for mixed currency and languages. Also, you can
run OneWorld on platforms from servers to laptops. This scalability allows a
travelling consultant to interface with OneWorld and enter records. The
consultant can then send these updated records over the Internet to keep files as
current as possible.

If you already use WorldSoftware, you do not need to completely change your
system to OneWorld. WorldSoftware and OneWorld can coexist by accessing the
same database and supporting the same business task. Your business can
continue its practices without conforming to a single technological direction. You
preserve your existing investment in technology and do not affect end-user
productivity while you explore new business solutions.

Custom Solutions without Consequences

You can make custom solutions to business applications with little or no
consequences when you upgrade to a new release of OneWorld. In other words,
the OneWorld toolset acts as an “idea-enabler” by allowing you to transform a
concept into a viable business solution. You maintain consistency across your
enterprise, retain flexibility to adapt to changing business requirements, and
minimize the time required to implement upgrades. The following list provides
examples of areas in OneWorld that you can customize without consequences
during an upgrade:

e Vocabulary overrides

e User overrides
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e Versions
e Processing options

e Code generator options

Recommendations for Configurable Network Computing

Distributed processing involves the configuration of executable application
components in various modes of operations and the configuration of data tables
that the application components require.

With OneWorld, you can dynamically configure application components and
data tables. This process allows you the most flexibility during the configuration
of your enterprise.

The key to achieving a high level of performance and seemingly boundless
scalability is OneWorld’s dynamic configuration of both hardware and software.
However, the extensive amount of flexibility and options can sometimes appear
contradictory and confusing. Consider the following guidelines for Configurable
Network Computing:

Fewer is Better A thirty-computer network is much more difficult to
manage than a single computer. Although it might be
necessary at times to add computers to your network, try
to use the fewest number necessary.

Homogeneity A homogeneous network is preferred to a heterogeneous
network. Try to have all of one type of server hardware,
one server operating system, and one workstation
operating system. OneWorld supports a heterogeneous
network, but avoid heterogeneity unless it is absolutely
necessary. However as time passes, a mixed hardware and
operating environment is almost unavoidable, and
OneWorld and CNC support it.

Batch Processing Has In general, batch processing is more computer efficient

Some Advantages than interactive or real-time processing. For example,
electronic commerce or electronic data interchange (EDI)
is a superb way to process transactions and keep life
simple.

Store-and-forward processing is another form of batch
processing. It offers most of the advantages of real-time
editing and allows quick response time at workstations.
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Data Warehousing

Processing Mode

Multitiered Networks

Off-loading most reports to a secondary computer or
computers offers the following benefits:

e Relieves the processing burden from the main
server and protects the response time of the
interactive users

e  Offers the full power of the computer to the
report writer function, which provides faster
processing

e Allows you to restructure and simplify data for
ease of use

e Allows you to supplement or enhance data with
exterior database information

e Allows you to analyze data with modern tools
such as online analytical processors (OLAP)

Fifty to seventy percent of computer processing cycles are
used for reporting and data analysis. Off-loading this
processing to a separate data warehouse provides a
substantial opportunity to ensure satisfactory performance
for both the interactive and batch users.

You should use real-time processing for low volume data
entry only. Use store-and-forward processing for high
volume data entry. You can use the batch-of-one concept
(asynchronous processing) as a compromise between
real-time and store-and-forward processing.

You can perform data-entry functions, such as accounts
payable vouchers, payroll time sheets, employee expense
reports, and cash receipts, in a store-and-forward mode
rather than a real-time mode to minimize the impact on
the main server computer.

Third-party database management systems consume a
great deal of computer resources. Separating the J.D.
Edwards applications and all their business objects onto a
separate computer helps ease the burden on a computer.
Splitting these two functions on two different computers
allows optimum computing power for both needs. This
implies a three-tier network. For example, such a network
might consist of hundreds of workstations that direct into
dozens of application servers that direct into a few
database servers. The data warehouse acting on top of this
would create yet a fourth tier. These techniques of
multitiered distribution of work, while complex, offer
considerable opportunity to improve performance and
increase scalability.
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Multiple Servers By
Vertical

Data Replication

Departmental and
Application Work
Groups

Heavy or Light
Workstation Processing

OneWorld Xe (9/00)

OneWorld can work concurrently with mixed databases
across multiple machines. You can access business objects
and data from several databases including Microsoft
Access, Oracle 7 Server, Microsoft SQL Server, and the IBM
DB2/400. You can spread this data over several
computers. For example, you can have separate servers
for manufacturing and logistics, accounts receivable, and
the general ledger and financial applications. You do not
need a single central server. The concept of multiple
servers working in harmony is central to the concept of
CNC.

J.D. Edwards offers several facilities for data replication.
These facilities include:

OneWorld application for data replication
Just-in-time replication

Batch application

Copy table script

In addition, OneWorld can cooperate with several open
systems tools that support the publishing and replication
of data. Although some circumstances might arise when
you need to perform data replication, such as
store-and-forward processing, you should generally
discourage the activity due to the difficulty in coordinating
the replication successfully.

Data replication is simpler when you use fewer
computers. For this reason, it is often preferable to
replicate data to an application server in a single group
that performs the same business functions, such as credit
and collections, accounts payable, sales order processing,
and so on. In a departmental work group, workstations
would have no replicated data. The business objects alone
would be replicated and maintained on the departmental
application server. This setup minimizes the data transfer
between the workstation and the application server, thus
decreasing the amount of data replication. This
configuration represents a classic three-tier architecture.

You can configure either a heavy or a light workstation,
depending on your configuration of business objects, data,
and mode of operation. The decision is entirely up to you.
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This topic provides information about the following fundamentals of
Configurable Network Computing:

L] Object storage

] Environments

[ Path codes

L] Object Configuration Manager (OCM)
[[] Data sources

L] Object deployment

Object Storage

OneWorld provides two general storage formats, central objects and replicated
objects, to accommodate several functions in OneWorld.

Central Objects
Store objects in a central location to allow for the following:

e Deployment
e Redeployment

e Development

Central objects consist of object specifications for each OneWorld object and C
components for code-generated objects. Store your central object specifications
in a relational database on either a deployment server or an enterprise server,
depending on available resources. Store C components for code-generated
objects in directories on the deployment server.
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To deploy objects out to the enterprise, you define a package that OneWorld
creates from central objects. Each package contains a copy of the central objects.
This copy consists of object specifications, and linked and compiled C
components. OneWorld converts the copied object specifications to a format for
storage in a directory. Workstations and enterprise logic servers receive packages
and store them in local directories.

Replicated Objects

19-10

Create replicated objects from central objects. Store a set of replicated objects in
a directory on each workstation, enterprise logic server, or both. At runtime,
OneWorld requires the specifications of the object that the workstation or
enterprise logic server processes. For example, to execute the Address Book
application on a workstation, the workstation needs the object specifications and
the compiled dynamic link library for the Address Book application and for any
object that the application uses, such as data dictionary items, tables, and
business views. You must store a set of objects describing the physical table in a
directory on your workstation or enterprise logic server to run an application
because the physical table that contains the actual data exists in a database on
another platform.

On a OneWorld workstation or enterprise logic server, you can store one set of
replicated objects for each set of central objects. For example, your enterprise
might use separate sets of central objects for a development environment and a
production environment. A separate development environment provides easy
distribution of custom modifications and maintains the integrity of objects in use
by other environments within your enterprise.
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The following illustration provides an example of the relationship between
central objects and replicated objects:

Central
Objects

Replicated Replicated
Objects Objects
/ \ I: 1
. Replicated Replicated .
Workstation Objects Objects Workstation
Replicated
Objects
Workstation % Workstation

Enterprise
Server

Environments

A OneWorld environment is a collection of pointers indicating the location of
data and OneWorld objects. An environment answers three simple questions:
e Where is my data?
e What machine will process my logic?

e What directory contains the object being processed?
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OneWorld answers these questions easily, providing an environment as a pointer
to data and logic objects. For example, in the Purchase Order application:

Where is my data? A user clicks on the Find button to locate a Purchase
Order. The environment determines in which database the
table resides.

What machine will When finished entering an order, the user clicks OK. The

process my logic? environment determines where the logic (a master
business function) necessary to record the transaction will
process and where the transaction tables reside to enter
the order.

What directory contains After entering a user ID and password, a user must choose

my objects? the environment to sign on to. If you have multiple sets of
objects, selecting the environment determines which
objects that OneWorld executes (the directory in which
they reside). This location is called a path code, and
OneWorld defines it in the Object Path Master.

Path Codes

A path code can refer to the central development objects on the deployment
server, or to replicated objects on a workstation or logic server. A path code
exists for each unique set of central objects. For example, you might have a set
of objects reserved for software updates that you can deploy to users and a set
of objects that you reserve for major enhancements.

A set of objects or the path code can reside in the following locations:

Central Server Contains the central set of development objects
specifications. All development occurs in this location. The
path code connects the specifications and the C
components on the deployment server.

Workstation Contains a replicated set of objects that OneWorld uses at
run time.
Logic Server Contains a replicated set of objects that OneWorld uses to

process logic on these servers.

The Object Path Master (F0094) contains path codes that track a set of objects
and their location within OneWorld.
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Object Configuration Manager (OCM)

The Object Configuration Manager is a tool that configures distributed processing
and distributed data at run time without requiring programming. Using the
Object Map table, the Object Configuration Manager points to the correct data,
batch process, or business function for a given environment and user. The
Object Configuration Manager is the control center for your run-time
architecture. OneWorld always uses the Object Configuration Manager to locate
the data and platform needed to execute the distributed logic.

The following illustration provides an example of how the Object Configuration
Manager connects data and logic for processing:

AS/400

HP 9000

RS/6000

Alpha NT
AS/400 = AS/400
HP 9000 HP 9000
RS/6000 RS/6000
Alpha NT Alpha NT

Object

Configuration
Manager

Workstation

Every environment has an associated set of Object Configuration Manager
mappings indicating the distributed data and distributed processing locations for
that environment.

The following equation represents the relationship between the Object
Configuration Manager, a path code, and an environment:

ENVIRONMENT = PATH CODE + OCM MAPPINGS
The path code answers the following question:

e What directory contains the object being processed?
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The OCM mappings answer the following questions:

e What database stores my data?

e Where should the logic object execute?

The following illustration provides an example of how OneWorld uses the
relationship between OCM mappings and path codes to create an environment:

ENVIRONMENT

PATH CODE

OCM

MAPPINGS
Answers: Answers:
"What database “What directory
stores my data?” contains the object to
"Where should the process?”
logic object
execute?”

Data Sources

A data source is the specific location of data or distributed processing. OneWorld
data sources can be:

e An entire database in a specific location, regardless of the type of
database, such as a Microsoft Access database located in a specific
directory or a library in DB2/400

e A specific machine in the enterprise that processes logic

The platform and data sources work together. You must define both the server
that processes the logic and the databases that store the data. If multiple
databases within one database management system (DBMS) reside on a
machine, you must define each database to OneWorld.

Do not confuse Microsoft open database connectivity (ODBC) data sources with
OneWorld data sources. The ODBC data source defines databases to various
third-party communication products such as Client Access, Rumba, SQL Server,
and Access. OneWorld data sources define both databases and logic servers to
OneWorld.
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The following list describes OneWorld data sources that you might use in your

configuration:

Oracle DBMS A OneWorld data source for an Oracle DBMS points to an
Oracle Connect String and a Table Owner.

SQL Server DBMS A OneWorld data source for a SQL Server DBMS points to
a SQL Server Database (ODBC data source) and a Table
Owner.

DB2/400 DBMS A OneWorld data source for a DB2/400 DBMS points to a
RDB directory entry and a Library (ODBC data source).

Access DBMS A OneWorld data source for an Access DBMS points to an

Access database (ODBC data source).

Object Deployment

Deploy OneWorld to your workstations and servers using any of the following
methods:

e Initial installation, for workstations and servers

e Workstation installation, for workstations

e Application installation, for workstations

e Just-in-time installation, for workstations
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Initial Installation

The installation process is based on a centralized deployment server model. The
deployment server installation program copies OneWorld installation software
from the CD-ROM to the deployment server. From the deployment server, you
redistribute the software to the enterprise servers and workstations.

OneWorld
Software

Windows NT
Workstation
Deployment
Server
Windows 95
Windows NT
HP 9000 RS/6000
AS/400
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Workstation Installation

The workstation installation program retrieves software from the package that
you request. A package contains instructions that describe where to find the
necessary components that the workstation installation program deploys to the
local computer.

Windows NT

Workstation

Deployment
Server

Each package represents a record of your central objects at a point in time. Once
you build and test a package, you can safely modify central objects because
users will not receive those objects until you build another package and make it
available to them. Building a package involves copying the central objects to the
package itself. The package then contains replicated objects, which OneWorld
can read at run time.

Application Installation

Application installation can be used to quickly deploy changes to an individual
application. Advantages of application installation are:

e Users do not have to install a complete set of objects but only those
objects that are necessary to capture the changed application.

e You do not need to build a new package and perform a global build
before deploying the application change.

e Developers and testers can use application installation to load changes
that were recently checked into the central objects onto their machine.

Workstation initiates Application Installation

>
»

The Deployment Server responds by

Work Station gathering and delivering all objects SDeerngryment

necessary to run the application
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Just-in-Time Installation

Just-in-time installation installs applications to your workstation the first time you
use them. For example, when you deploy a custom menu that contains a new

application to a workstation, the object automatically installs on the workstation
when a user clicks the menu option for the application.
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Appendix A - Shortcuts

Menu options and buttons throughout the system include key combinations that
perform the same functions as using the mouse. All of the standard push buttons
in the system have accelerator keys associated with them.

You can recognize accelerator keys by the underline on a control or menu. For
example, the “F” on the Find button is underlined. Press Alt + F to use this
control.

Selecting Text

Double-click

Highlight one word

|

Highlight text one character to the right

ﬁP Shift I + II

Highlight text one character to the left

Ué} Shift D + ctrl + II

Highlight text to the end of a word

U A shift + Ctrl + II

Highlight text to the beginning of a word

™ shift + II

Highlight text to the end of a line
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4 shift + Hom

Highlight text to the beginning of a line

4 shift + II

Choose multiple lines, one line up

2o 4]

Choose multiple lines, one line down

4™ shift

Shift Click Method (highlight a range of text): Click at the beginning of the text,
hold down the SHIFT key, then click at the end of the text

Keyboard Shortcuts

II
[ZAN—

Help

4-Backspace

Delete one character to the left of the insertion point

Ctrl + 4 Backspace

Delete one word to the left of the insertion point

II
/TN

Delete one character to the right of the insertion point

e * II

Delete one word to the right of the insertion point
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Cut or delete selected text

|

P a—
N—
l-x
P a—

Ctrl

+
N
L
7

Paste cut or copied text to the new area

Ctrl

+
RN
|-<
7

Repeat previous action

Ctrl

+
N—
Lo
a—

Copy selected text

Ctrl

+
N—
n

Undo last action

Ctrl +

Save work

Moving Around

7
Tab

Move to the next field or button

(You must use Ctrl + Tab to move from the Query by Example line to the grid
and from the grid to the next field or button.)

H% Shift H + TabF

Return to the previous field or button

+
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«—
U Ctrl H + TatLN

Move from the Query by Example line to the grid and from the grid to the next
field or button

—
4P shift +| G+ || Tab

Move backward into the grid or from the grid to the Query by Example line

II o 4’ I
VTN VTN

Move the grid display one column to the left or to the right

[l
VTN VTN

Select the row up or down one row

Page Page|
II or II
VN VTN

Move up or down one screen

II * II
/ TN /TN

Move one word to the left

cu +|H"
=N /N

Move one word to the right

+

Buttons

II * II
/TN

Add
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Alt +

Alt +

N—
IIiiIII

I B
a—

Close or Cancel

Alt .

Delete
At ) . II
Find
A |] . Iﬂl
OK
Alt i s
EN A
Select

Keyboard Shortcuts for the Calendar Tool

Page
Up

I
Or

e || . Il
Yam—

Move to previous month

Page|
Dowi
/TN

Or

cu || . Il
/N

Move to next month
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Lo
/TN /TN

Move through weeks

Keyboard Shortcuts for the Calculator Tool

7 8 9
m 4+ PgUp +
4 5 6
« -+
1 2 3

Enter numerals

Keyboard Shortcuts for Media Object Text

ca || o Iﬂl
| Za— Zam—

Bolds selected text

- i @

Italicizes selected text

cur || 4 Il
| Za— /N

Underlines selected text
Ctrl + Ué} Shift H + II

Creates a bullet

—

Ctrl + Tab—N

Exits the text edit form and displays the next object in the tab sequence
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Appendix B - Moving Around in the Grid

The following keyboard commands are available in the grid:

-

Activates the cell above the active cell. Available in any grid.
L

Activates the cell below the active cell. Available in any grid.
d

In the grid, moves one cell to the right. In a cell, moves the cursor to the right.
Available only in grids where you can enter information.

i
VAN

In the grid, moves one cell to the left. In a cell, moves the cursor to the left.
Available only in grids where you can enter information.

4 shift
+
[l
VN /TN

Use to select multiple rows. Available only in grids where you cannot enter
information.

Page
Dowi

Moves the active cell one page down. Available in any grid.
&

Moves the active cell one page up. Available in any grid.
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B-2

Ctrl Page|
+ | |op

Moves to the first cell in the row. Available in any grid.

Ctrl + Page
Dowr

Moves to the last cell in the row. Available in any grid.

Ctrl + I Hom
|ZA— /N

Activates the cell in the first row and column. Available in any grid.

Tag; Or 4 Enter

Moves to the next cell. The order is right and then down. Available only in grids
where you can enter information.

) —
U% Shift H + Tab ,,

Moves to the previous cell. The order is left and then up. Available only in grids
where you can enter information.

Ctrl + ||Tab

v 1

Exit the grid and move to the next control in the form. Available in any grid.

—
U 4™ shift H +|| cul + || Tab,

Exit the grid to the previous control in the form, or the query-by-example line if
one exists. Available in any grid.

II
|

Places the cursor at the end of text in the active cell. Available only in grids
where you can enter information.
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am—

car || 4 Il
| Za— /N

cu ||, II
| Za— Zam—

Copies the current selection or data in a cell to the Clipboard. Available in any
grid.

ESC I
Y/

Turns edit mode off (the value of the previous cell replaces any changes that
you made). Available only in grids where you can enter information.

4™ shift

+

[Space Bar]

Selects the current row. Available only in grids where you can enter information.
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Appendix C - OneWorld Systems

The following table lists the J.D. Edwards systems in OneWorld:

Number System

00 Foundation Environment

01 Address Book

02 Electronic Mail

03 Accounts Receivable

0301 Credit Management

03B Enhanced Accounts Receivable
03C | ssue Management System

04 Accounts Payable

05 Time Accounting and HRM Base
05A OW HR & PR Foundation

05C OW HR & PR Foundation Canadian
05T Time Entry

05U OW HR & PR Foundation US
06 Do not use

07 Payroll

07S Payroll SUI

o7y U.S. Payroll Year End

08 Human Resources

08B Benefits Administration

OneWorld Xe (9/00)



OneWorld Foundation

Number System

08C OW HR Canadian

08H Health and Safety

08P Position Control

08R Recruitment Management
08U OW HR US

o8w Wage and Salary

09 Genera Accounting

09E Expense Reimbursement

10 Financial Reporting

10C Multisite Consolidations

11 Multicurrency

11C Cash Basis

12 Fixed Assets

13 Plant/Equipment Management
14 Modeling, Planning & Budgeting
15 Property Management

16 Profit Management (EPS)

17 Customer Service Management
17C Call Management

18 Resource Scheduling

19 Utility CIS

30 Product Data M anagement
3010 Process Data M anagement

31 Shop Floor Control
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Number System

3110 Process Control

32 Configuration Management
32C Custom Works

33 Capacity Planning

34 Requirements Planning
34A Advanced Planning & Scheduling
35 Enterprise Facility Planning
36 Forecasting

37 Quality Management

38 Agreement Management

39 Advanced Stock Valuation
40 Inventory/OP Base

4010 Advanced Price Adjustments
41 Inventory Management
41B Bulk Stock Management
42 Sales Management

42A Sales Force Automation
42E ECS Sales Management

43 Procurement

44 Subcontract Management
4401 Homebuilder Management
44H Homebuilder Management
45 Advanced Pricing

46 Warehouse Management
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Number System

47 Electronic Commerce

48 Work Order Processing
48S Service Billing

49 Transportation Management
50 Job Cost Base

51 Job Costing

52 Contract Billing

53 Change Management
55-59 Reserved for Clients

60 — 69 Reserved for JDE Custom
70 Multinational Products

71 Client Server Applications
72 World Vision

73 M & D Complementary Products
74 EMEA Localization

74H Hungary

74 Ireland

74L Portugal

74N Nordics

74P Poland

74R CIS

74S Spain

74T Turkey

747 Czech Republic
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Number

System

75 ASEAN Localization

75H Thailand

75l India

75K Korea

75T Taiwan

76 Latin American Localization
76A Argentina

76C Colombia

76H Chile

76P Peru

76V Venezuela

77 Payroll (Canadian)

7Y Canada Payroll Year End

79 Trandation Tools

80 Business Intelligence

81 DREAM Writer

82 World Writer

83 Management Reporting — FASTR
84 Distributive Data Processing
85 Custom Programming

86 Electronic Doc. Interchange
87 JDE Internal

88 Cautious Purge System

89 Conversion Programs
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Number System

91 Documentation

92 Computer Assisted Design

93 Computer Assisted Programming
94 Security Officer

95 Sleeper—now in system 96

96 Computer Operations

97 Software Installation

98 Technical Tools

98E Electronic Burst and Bind

98FT Form Type

98SA Sample Application

99 Technical Tools— Internal

99D Technical Tools— DASD Sizer
99M Technica Tools-Masters/Update
B LANGUAGE TRANSLATIONS
B1A Chinese— Simple

B1B Chinese — Complex

B1E English

B1F French

B1G German

B1l [talian

B1J Japanese

B1P Portuguese

B1S Spanish

OneWorld Xe (9/00)



Number System
B2A Dutch
B2D Danish
B2F Finnish
B2N Norwegian
B2S Swedish
B3C Czech
B3H Hebrew
B3R Russian
BC1 Chinese — Simple
BC2 Chinese — Complex
BCR Czech
BDN Danish
BDU Dutch

BFI Finnish
BFR French
BGR German
BHE Hebrew
BIT [talian

BJP Japanese
BNO Norwegian
BPO Portuguese
BRU Russian
BSP Spanish
BSW Swedish
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Number System

D3N dcLINK (data collection)

HO1 Address Book (inc. ALL Mail)
HO3 Accounts Receivable

HO3B New Accounts Receivable
HO4 Accounts Payable

HO5 Standalone Time Accounting
HO7 Payroll

HO8 Human Resources

HO9 Genera Accounting

H12 Fixed Assets

H13 Equipment/Plant Management
H15 Commercial Property Management
H30 Product Data M anagement
H301 Process Data M anagement
H31 Shop Floor Control

H311 Process Control

H32 Configuration Management
H33 Capacity Requirements Planning
H34 DRP/MRP/MPS

H35 Enterprise Facility Planning
H36 Advanced Forecasting

H40 Inventory/OP Base

H41 Inventory Management

H415 Bulk Inventory Management
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Number

System

H42 Sales Order Processing

H43 Purchase Order Processing
H44 Contract Management

H44H Homebuilder Management
H45 Sales Analysis

H46 Warehouse Management

H50 Job Cost Base

H72 Client/Server Base

H73 CS—A/P Voucher Entry

H74 CS—Pay Time Entry

H75 CS— Sales Order Entry

H76 CS—Training & Development
H78 CS—Travel Expense Management
H79 CS - Forecasting

H90 ONEWORLD TOOLS

H91 Design Tools

H92 Interactive Engine/OL

H93 Data Base and Communications
H94 Batch Engine

H95 Tech Resources/Applications
H96 Deployment

H97 Benchmarking/Performance
H98 Internet

H99 Product Version Control
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C-10

Number System

H99P Technical Tools-OWPVC Internal
JE42 Sales Order/Pricing

JE44 Distribution Contracts

JE48 Automated Gantry Inter.

KZ1 PC Budget Upload (A3 to A5)
KZ2 PC Data Entry for AP

KZ3 PC Data Entry for Payroll

SY SYSTEM

Z101 MTI Electrical Distribution
2102 CRES

Z91 System/ Product Codes
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Appendix D - J.D. Edwards Worldwide Customer Support

If you cannot resolve software issues by using the online helps or printed guide,
contact J.D. Edwards Worldwide Customer Support for assistance. Customers
subscribe to the support services by paying an annual maintenance fee, which
provides customer-support services and software updates.
This topic contains the following:
[l Questions that Worldwide Customer Support can answer
Worldwide Customer Support phone lines
What happens when you call
Worldwide Customer Support e-mail addresses
Sending e-mail using J.D. Edwards E Response Line
Additional help information

Involving our customers

Accessing menu and form information

I I I N ARy B

Information about software updates
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Questions Worldwide Customer Support Can Answer

J.D. Edwards consultants can assist in resolving the following issues:

e (larification of program function

e Questions regarding system capabilities and features

e Assistance in understanding error messages

e Questions related to system documentation and reference guides
e Assistance in researching suspected program problems

e Software Action Request (SAR) status inquiries

e Clarification of instructions for the install, reinstall, and software
enhancement processes

e Assistance in ordering software enhancements

e Coordination with product development for product enhancements and

corrections

Worldwide Customer Support Phone Lines

J.D. Edwards maintains Worldwide Customer Support phone lines for the
following geographic areas:

7N Europe,
Us. an the Middle b j
Canada East, and 4 gj Asia
Africa 4 Pacific
and South s O
America Q T
v ¥
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Telephone

Worldwide Customer Support can be reached at the following telephone

numbers:
Location Phone Number
U.S. or Canada 1-800-289-2999
Europe, Middle East, 44-1494-682-682
and Africa
33-11-44-74-20-15 - France
49-103-762-110 - Germany
31-35-548-0222 - Holland
38-02-2696-7612 - Italy
44-1494-682-682 - Spain
Asia Pacific 65-895-9656

10-800-650-0099 - China (Beijing, Shanghai)

108-657, or 108-650 - Follow voice prompts to dial
Singapore at 895-9656

1-800-145-200 - Australia

1-800-90-3055 - Hong Kong

1-800-80-1557 - Malaysia

0120-174-074 - Tollfree within Japan (Japanese only)

81-3-3265-7199 - Tollfree outside Japan (Japanese only)
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Location Phone Number

Latin America 1-230-020-5124 - Chile
980-153-560 - Colombia
001-800-784-4260 - Mexico
800-1-2743 - Venezuela

011-800-333-111, then 303-488-4639-9194, then
1-800-784-4260 - Argentina

999-170 then 303-488-4639-9194, then 1-800-784-4260 -
Ecuador

170, then 303-488-4639-9194, then 1-800-784-4260 - Peru
00081-4-550-2779 - Brazil

0800-0120085 - Costa Rica

Worldwide Customer Support can be reached by fax at the following numbers:

Location Fax Number

U.S., Canada, and Latin  303-334-4141
America

Europe, Middle East and 44-1494-682-698

Africa
Asian Pacific 65-227-2698
Japan 81-3-3265-7143

What Happens When You Call

The customer support coordinator enters your information into an online call
tracking system and assigns you a call number. Make note of this number to
ensure that the coordinator can access your call as quickly as possible if you call
back while the call remains active. The coordinator then routes your call to a
product consultant who specializes in addressing your issue.
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If a product consultant is readily available, your call is transferred immediately.
However, if the call queue is unusually busy, a consultant will return your call as
soon as possible.

When you contact Worldwide Customer Support Services, please have the
following information for the customer support coordinator:

e Account number

e Product code or product name

e Call number (if the call is open)

e Release level

e Media type of your software

e Link number

e System serial number

e Your phone number

e Your fax number

e Severity (if the call is open)

e Times when you are available

Worldwide Customer Support E-mail Addresses

Worldwide Customer Support can be contacted via e-mail by using the following
e-mail address:

e denver customer support@dedwards.com

e london_customer support@jdedwards.com

e singapore customer support@jdedwards.com
Please include the following information in your e-mail:

e (Customer name

e Customer number

e Phone number

e Time when we can contact you
When your message is received at one of the e-mail addresses, a call will be
opened with customer support. If you are requesting information, you can ask
for a response by e-mail. If you are experiencing difficulty during an installation

or upgrade, or have another technical issue with OneWorld, it is advisable that a
consultant work with you by telephone rather than through e-mail.
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Sending E-mail Using J.D. Edwards E Response Line

D-6

Use J.D. Edwards E Response Line to send questions or comments via e-mail to
Worldwide Customer Support. You can access E Response Line from any
OneWorld application. You can provide free-form text information about your
question or comment and indicate its priority. Worldwide Customer Support will
reply to your e-mail using the Internet address or phone number that you
provide. You can set up information that appears on the E Response Line form
by entering that information into the E Response Line processing options.

This topic contains the following:

e Sending e-mail using E Response Line

e Setting processing options for E Response Line

P To send e-mail using E Response Line

1. On any OneWorld application form, from the Help menu, choose About

OneWorld.

The On-Line Support Information form appears.

2. Click the E Response Line button.

The E Response Line JDE Request form appears with user information
populated in the upper fields and the information entered into the E
Response Line processing options if you or your company entered this

information.
@ User Defined Codes - [E Rezponze Line JDE Request | [_ o] =]
C,l File Edit Preferences Window Help == x|
v xS, J ) )
Links wr Displ... OLE .. It it
0K Can.. Dis. Abo ol 8 oo
—User
Custarmer Murmber |4245 Request umber I‘1
User Iannz Abbott, Dominigue
Phone Murmber |3n3 |555.1212
Internet Address |d0mm|que_abbon@tourcompany.com
~FProblerm Description
JDE Product Code Iowm Address Book
Priority IQ Priority
@ |[aria HzEl e 7 u[m-]lz== == ==|% (&
|
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3. On the E Response Line JDE Request form, if necessary, change user
information by completing the following fields:

4.

5.

OneWorld Xe (9/00)

Customer Number

Enter the customer number by which J.D. Edwards identifies your
company.

User

OneWorld completes this field with your OneWorld Address Book
number. If you want to change it, enter an Address Book number
into this field.

Phone Number

Enter the complete phone number (include an extension if you
want) of the person or department that you want J.D. Edwards
Worldwide Customer Support to use when replying to your e-mail.
Internet Address

Enter the Internet address of the person or department that you

want J.D. Edwards Worldwide Customer Support to use when
replying to your e-mail.

Inside the Problem Description area of the form, complete the following

fields:

JDE Product Code

Enter the product code for the product about which you have a
comment or question. For example, enter OWO01 to send a message
about Address Book. Add “OW” to the product code to let
Worldwide Customer Support know that your e-mail is referring to
our OneWorld product.

Priority

Enter a number to let us know the priority of your message.

Free-form text area

Type your comment or question into this area. Use the toolbar
controls to help you format the text.

Click OK.

If you send your E Response Line e-mail to J.D. Edwards Worldwide
Customer Support, it becomes an open call and receives the utmost
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attention. If you included a return e-mail address or phone number,
Worldwide Customer Support responds to your e-mail at least three times:
e When the e-mail is first received.

e When the e-mail is assigned to a Worldwide Customer Support
representative.

e When a representative answers your question or comment to your
satisfaction, and the call is closed.

Field Explanation

Issue Priority The values that indicate the severity of the customer issue.
............. Form-specific information . ... ..........

Use the visual assist for the most current values. The
following are examples of the user-defined values:

1 Critical
2 Priority
3 Standard

> To set processing options for E Response Line

This information is optional and appears on the E Response Line JDE Request
form when you access it. You can change this information on the E Response
Line JDE Request form, as explained under Sending E-mail Using E Response
Line.

1. On System Administration Tools (GH9011), choose Interactive Versions
(P983051).

2. On Work With Interactive Versions, enter P17503 into the Interactive
Application field and then click Find.
P17503 is the Fast Path code for the E Response Line application.

3. Choose a version, and from the Row menu, choose Processing Options.
On the Processing Options form, complete the following fields:
e Enter your JDE Customer Number
e Enter the Internet Address for your internal Call Center
Complete this field if you want E Response Line e-mail sent to an
Internet address that is internal to your company. If you leave this

field blank, the E Response Line messages are sent to J.D. Edwards
Worldwide Customer Support.
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e Enter the Internet Address for return messages from J.D. Edwards

Enter the Internet address of the person or department that you
want J.D. Edwards Worldwide Customer Support to use when
replying to your e-mail.

e Enter the preferred JDE Response Line

Enter the J.D. Edwards Worldwide Customer Support office to which
your E Response Line e-mail will be sent.

e Enter the area code and phone number to which the help request
should respond

Enter the complete phone number (include an extension if you
want) of the person or department that you want J.D. Edwards
Worldwide Customer Support to use when replying to your e-mail.

5. Click OK.

Additional Help Information

Your area account representatives are available to help you with the following
issues:

e Setup questions

e ‘Training

e Custom modifications

e Programming consultation

e Data balancing and integrity issue resolution

Involving Our Customers

Worldwide Customer Support randomly chooses customers who have called and
sends them a survey about their experience. You are asked to rate the consultant
with whom you talked. Sample questions are: Was the consultant helpful and
knowledgeable? Was your issued resolved accurately and in a timely manner?

Twice a year, J.D. Edwards sends a satisfaction survey to every customer. The
survey is distributed at random intervals to various contacts within each

organization. You are asked to rate our software product, classroom training,
on-site consulting, customer support, employee integrity, and overall quality.

Additionally, J.D. Edwards customers have the opportunity to participate in a
variety of user groups, both internationally and locally. FOCUS is an international
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user conference that is held annually in Denver, Colorado, in the United States.
J.D. Edwards also solicits information by forming customer focus groups. The
focus groups help identify industry trends, and software strengths and
weaknesses. These groups provide recommendations for functional software
changes.

Accessing Menu and Form Information

D-10

Throughout OneWorld, you can locate information about menus and forms from
the Help menu. This information is especially helpful when contacting
Worldwide Customer Support. When you provide the menu and application
information, the customer support consultant can expedite your call.

To locate the necessary information, complete the following tasks:
e Access menu information

e Access application form information

» To access menu information

1. On any OneWorld menu, from the Help menu, choose About J.D.
Edwards OneWorld.

Q P00890 - [About Dne'W orld] _ (O]
C:I File Edit Preferences Window Help _|ﬁl il
I A J Li -
inks
J . B w Displ.. [#]OLE.. [9]Intemet

D

Cnevorld

Copytight J.D Edwards World Source Company
1996 - 2000

~Release Information

Release Iayggg ActivEra Content————————————————
Revisions Mumber ln—
Service Pack |13

Warning: This computer program is protected by copyright law and
international freaties. Unauthorized use, reproduction or distribution of this
program, or any portion of it, may result in severe civil and criminal penalties,
and will he prosecuted to the maximum extent possible under the law.

CONFIDEMTIAL. This information is confidential and a proprietary trade
secret of J.0. Edwards World Source Company, One Technology YWay
Denver, Colorado 80237, USA. This information may not he copied or
distributed without express prior written permission.

Subject to patent protection under one or more of the following LS. patents
5,828,376;5,950,010; 5,960,204; 5,987 487; and 5,995,372, Other Patents
Pending

Click"Products” for additional copyright attribute information. Details | =

2. On about OneWorld, review the following information:
e Software License Information

e Release Information
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3. Click the Details button.

. P0O0890 - [About OneWarld]

4. On About OneWorld, review the following information and then click
Cancel.

e Current Environment
e Current Menu Information
e Package Information

5. Click the Products button.

B F00390 - [Products]
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The Products form displays copyright information about products.

> To access application form information

1. On any OneWorld application form, from the Help menu, choose About
OneWorld.

. User Defined Codes - [Dn-Line Support Information]
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3. On Advanced Information, review the appropriate information and then
click Cancel.

Information About Software Updates

J.D. Edwards software is continually updated in light of customer needs and new
technologies. In addition to Response Line support, customers who purchase a
maintenance agreement also receive software updates. Software updates are
categorized as follows:

Major Release A major release includes enhancements and database
changes to several systems and enhancements to
important files that are shared by many systems.

J.D. Edwards targets delivery of a new major release for
every 12 to 19 months.

Cumulative Update A cumulative update is issued periodically and contains
multiple error corrections to a single release. Each
cumulative update contains new changes, plus the
contents for the prior update. It does not include
enhancements. To facilitate an easy installation, database
changes and application-specific instructions are avoided
whenever possible.

Untested Quick Fix An untested quick fix is created to ship fixes to critical
errors when a customer cannot wait for the next
cumulative update. Due to the urgency of these fixes, they
are not routed through our normal quality assurance
process.
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Appendix E - Customer Knowledge Garden

The Customer Knowledge Garden provides customers with access to product
support information, such as support news, product issues, and software
updates, all in one place. The Knowledge Garden is available to all customers
with a maintenance agreement. It is accessed through the Internet and is
available 24 hours-a-day. The Customer Knowledge Garden is an enhanced
self-help tool that replaces the Internet Customer Solution Center (CSC). It is a
subset of the same knowledge database and Web repository that J.D. Edwards
employees use.

Some of the features of the Customer Knowledge Garden are:

e TFull text search over software action requests (SARs)

e Full text search over a knowledge database, including common product
questions and issues such as FAQs

e Breaking news about products and programs
e Electronic Software Update downloads

e Printable manual Code Change Documents (previously known as paper
fixes)

e Access to product documentation

e Software shipment status and airbill numbers, including a link to Federal
Express and DHL delivery information

e Availability schedules for new releases and cumulative updates
e Access to training schedules and class registration

e Descriptions of minimum technical requirements

e An online form to log product issues with Customer Support

e Verification of your customer information including your software shipping
address, media, contact names, and e-mail addresses
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Accessing the Customer Knowledge Garden

A user name and password are required to access the Customer Knowledge
Garden. For customers, a single Knowledge Garden account is set up and shared
by everyone at your organization. For partners and employees, a Knowledge
Garden account is set up for each individual.

If your organization does not have a user name and password for the Customer
Knowledge Garden, visit www.jdedwards.com or contact Worldwide Customer
Support. To learn more about the Knowledge Garden, begin at the J.D. Edwards
home page www.jdedwards.com, open the blue bar labeled Services, select
Customer News, and then visit the Knowledge Garden links on the right side of
the screen.

To access the Customer Knowledge garden, you will need the following:

e A valid user name and password
e Internet access

e A Web browser-either Microsoft Internet Explorer 4.0 or above, or
Netscape Navigator 4.06 or above

e Some of the information available on the site requires Adobe Acrobat,
Microsoft Word, or Microsoft Excel in order to view the content.

P To access the Customer Knowledge Garden

1. From the J.D. Edwards home page, click Knowledge Garden Customer
Logon, located in the top right corner.

2. On the Password screen, fill in your user name and password, and click
OK.

If you do not know the user name and password for your company, you will
need to contact the Knowledge Garden Administrator at your organization. If
you do not know who the administrator is at your company, please contact
Worldwide Customer Support and you will be directed to your company’s
customer Knowledge Garden Administrator.
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Online Helps/Feedback

The Knowledge Garden includes online help to assist you in learning more
about using the site. You are encouraged to review the online helps. The help
information is accessed by using the Help icon at the top of each page.

New features are periodically added to the Customer Knowledge Garden that are
based on feedback from our customers. We are dedicated to continually
improving both the content and the organization of the Knowledge Garden. You
are encouraged to provide your feedback and suggestions. A Feedback Form
can be accessed by using the Feedback icon at the top of each Knowledge
Garden page.

See Also

e |.D. Edwards Worldwide Customer Support for information about how to
contact Worldwide Customer Support
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Glossary

AAI. See automatic accounting instruction.

action message. With OneWorld, users can
receive messages (system-generated or
user-generated) that have shortcuts to OneWorld
forms, applications, and appropriate data. For
example, if the general ledger post sends an
action error message to a user, that user can
access the journal entry (or entries) in error
directly from the message. This is a central
feature of the OneWorld workflow strategy.
Action messages can originate either from
OneWorld or from a third-party e-mail system.

activator. In the Solution Explorer, a parent task
with sequentially-arranged child tasks that are
automated with a director.

ActiveX. A computing technology, based on
object linking and embedding, that enables Java
applet-style functionality for Web browsers as
well as other applications. (Java is limited to
Web browsers at this time.) The ActiveX
equivalent of a Java applet is an ActiveX control.
These controls bring computational,
communications, and data manipulation power
to programs that can “contain” them. For
example, certain Web browsers, Microsoft Office
programs, and anything developed with Visual
Basic or Visual C++.

advance. A change in the status of a project in
the Object Management Workbench. When you
advance a project, the status change might
trigger other actions and conditions such as
moving objects from one server to another or
preventing check-out of project objects.

alphanumeric character. A combination of
letters, numbers, and symbols used to represent
data. Contrast with numeric character and
special character.

API. See application programming interface.
APPL. See application.

applet. A small application, such as a utility
program or a limited-function spreadsheet. It is
generally associated with the programming
language Java, and in this context refers to
Internet-enabled applications that can be passed
from a Web browser residing on a workstation.
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application. In the computer industry, the same
as an executable file. In OneWorld, an
interactive or batch application is a DLL that
contains programming for a set of related forms
that can be run from a menu to perform a
business task such as Accounts Payable and
Sales Order Processing. Also known as system.

application developer. A programmer who
develops OneWorld applications using the
OneWorld toolset.

application programming interface (API). A
software function call that can be made from a
program to access functionality provided by
another program.

application workspace. The area on a
workstation display in which all related forms
within an application appear.

audit trail. The detailed, verifiable history of a
processed transaction. The history consists of the
original documents, transaction entries, and
posting of records, and usually concludes with a
report.

automatic accounting instruction (AAI). A
code that refers to an account in the chart of
accounts. AAIs define rules for programs that
automatically generate journal entries, including
interfaces between Accounts Payable, Accounts
Receivable, Financial Reporting, General
Accounting systems. Each system that interfaces
with the General Accounting system has AAIs.
For example, AAls can direct the General Ledger
Post program to post a debit to a specific
expense account and a credit to a specific
accounts payable account.

batch header. The information that identifies
and controls a batch of transactions or records.

batch job. A task or group of tasks you submit
for processing that the system treats as a single
unit during processing, for example, printing
reports and purging files. The computer system
performs a batch job with little or no user
interaction.

batch processing. A method by which the
system selects jobs from the job queue,



OneWorld Foundation

processes them, and sends output to the
outqueue. Contrast with interactive processing.

batch server. A server on which OneWorld
batch processing requests (also called UBEs) are
run instead of on a client, an application server,
or an enterprise server. A batch server typically
does not contain a database nor does it run
interactive applications.

batch type. A code assigned to a batch job that
designates to which J.D. Edwards system the
associated transactions pertain, thus controlling
which records are selected for processing. For
example, the Post General Journal program
selects for posting only unposted transaction
batches with a batch type of O.

batch-of-one immediate. A transaction method
that allows a client application to perform work
on a client workstation, then submit the work all
at once to a server applicationfor further
processing. As a batch process is running on the
server, the client application can continue
performing other tasks. See also direct connect,
store and forward.

BDA. See Business View Design Aid.

binary string (BSTR). A length prefixed string
used by OLE automation data manipulation

functions. Binary Strings are wide, double-byte
(Unicode) strings on 32-bit Windows platforms.

Boolean Logic Operand. In ].D. Edwards
reporting programs, the parameter of the
Relationship field. The Boolean logic operand
instructs the system to compare certain records
or parameters. Available options are:

EQ  Equal To.

LT Less Than.

LE Less Than or Equal To.

GT  Greater Than.

GE  Greater Than or Equal To.

NE  Not Equal To.

NL Not Less Than.

NG  Not Greater Than.

browser. A client application that translates
information sent by the World Wide Web. A
client must use a browser to receive,
manipulate, and display World Wide Web
information on the desktop. Also known as a
Web browser.

BSEN. See business function.

BSTR. See binary string.

BSVW. See business view.

business function. An encapsulated set of
business rules and logic that can normally be
reused by multiple applications. Business
functions can execute a transaction or a subset
of a transaction (check inventory, issue work
orders, and so on). Business functions also
contain the APIs that allow them to be called
from a form, a database trigger, or a
non-OneWorld application. Business functions
can be combined with other business functions,
forms, event rules, and other components to
make up an application. Business functions can
be created through event rules or
third-generation languages, such as C. Examples
of business functions include Credit Check and
Item Availability.

business function event rule. See named
event rule.

business view. Used by OneWorld applications
to access data from database tables. A business
view is a means for selecting specific columns
from one or more tables whose data will be
used in an application or report. It does not
select specific rows and does not contain any
physical data. It is strictly a view through which
data can be handled.

Business View Design Aid (BDA). A OneWorld
GUI ool for creating, modifying, copying, and
printing business views. The tool uses a
graphical user interface.

category code. In user defined codes, a
temporary title for an undefined category. For
example, if you are adding a code that
designates different sales regions, you could
change category code 4 to Sales Region, and
define E (East), W (West), N (North), and S
(South) as the valid codes. Sometimes referred
to as reporting codes.

central objects. Objects that reside in a central
location and consist of two parts: the central
objects data source and central C components.
The central objects data source contains
OneWorld specifications, which are stored in a
relational database. Central C components
contain business function source, header, object,
library, and DLL files and are usually stored in
directories on the deployment server. Together
they make up central objects.
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check-in location. The directory structure
location for the package and its set of replicated
objects. This is usually
\\deploymentserver\release\path_code\packag
e\ packagename. The sub-directories under this
path are where the central C components
(source, include, object, library, and DLL file) for
business functions are stored.

child. See parent/child form.

client/server. A relationship between processes
running on separate machines. The server
process is a provider of software services. The
client is a consumer of those services. In
essence, client/server provides a clean
separation of function based on the idea of
service. A server can service many clients at the
same time and regulate their access to shared
resources. There is a many-to-one relationship
between clients and a server, respectively.
Clients always initiate the dialog by requesting a
service. Servers passively wait for requests from
clients.

CNC. See configurable network computing.

component. In the ActivEra Portal, an
encapsulated object that appears inside a
workspace. Portal components

configurable client engine. Allows user
flexibility at the interface level. Users can easily
move columns, set tabs for different data views,
and size grids according to their needs. The
configurable client engine also enables the
incorporation of Web browsers in addition to
the Windows 95- and Windows NT-based
interfaces.

configurable network computing. An
application architecture that allows interactive
and batch applications, composed of a single
code base, to run across a TCP/IP network of
multiple server platforms and SQL databases.
The applications consist of reusable business
functions and associated data that can be
configured across the network dynamically. The
overall objective for businesses is to provide a
future-proof environment that enables them to
change organizational structures, business
processes, and technologies independently of
each other.

constants. Parameters or codes that you set and
the system uses to standardize information
processing by associated programs. Some
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examples of constants are: validating bills of
material online and including fixed labor
overhead in costing.

control. Any data entry point allowing the user
to interact with an application. For example,
check boxes, pull-down lists, hyper-buttons,
entry fields, and similar features are controls.

core. The central and foundation systems of J.D.
Edwards software, including General
Accounting, Accounts Payable, Accounts
Receivable, Address Book, Financial Reporting,
Financial Modeling and Allocations, and Back
Office.

CRP. Conference Room Pilot.

custom gridlines. A grid row that does not
come from the database, for example, totals. To
display a total in a grid, sum the values and
insert a custom gridline to display the total. Use
the system function Insert Grid Row Buffer to
accomplish this.

data dictionary. The OneWorld method for
storing and managing data item definitions and
specifications. J.D. Edwards has an active data
dictionary, which means it is accessed at
runtime.

data mart. Department-level decision support
databases. They usually draw their data from an
enterprise data warehouse that serves as a
source of consolidated and reconciled data from
around the organization. Data marts can be
either relational or multidimensional databases.

data replication. In a replicated environment,
multiple copies of data are maintained on
multiple machines. There must be a single
source that “owns” the data. This ensures that
the latest copy of data can be applied to a
primary place and then replicated as
appropriate. This is in contrast to a simple
copying of data, where the copy is not
maintained from a central location, but exists
independently of the source.

data source. A specific instance of a database
management system running on a computer.
Data source management is accomplished
through Object Configuration Manager (OCM)
and Object Map (OM).

data structure. A group of data items that can
be used for passing information between
objects, for example, between two forms,
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between forms and business functions, or
between reports and business functions.

data warehouse. A database used for
reconciling and consolidating data from multiple
databases before it is distributed to data marts
for department-level decision support queries
and reports. The data warehouse is generally a
large relational database residing on a dedicated
server between operational databases and the
data marts.

data warehousing. Essentially, data
warehousing involves off-loading operational
data sources to target databases that will be used
exclusively for decision support (reports and
queries). There are a range of decision support
environments, including duplicated database,
enhanced analysis databases, and enterprise data
warehouses.

database. A continuously updated collection of
all information a system uses and stores.
Databases make it possible to create, store,
index, and cross-reference information online.

database driver. Software that connects an
application to a specific database management
system.

database server. A server that stores data. A
database server does not have OneWorld logic.

DCE. See distributed computing environment.
DD. See data dictionary.

default. A code, number, or parameter value
that is assumed when none is specified.

detail. The specific pieces of information and
data that make up a record or transaction.
Contrast with summary.

detail area. A control that is found in OneWorld
applications and functions similarly to a
spreadsheet grid for viewing, adding, or
updating many rows of data at one time.

direct connect. A transaction method in which
a client application communicates interactively
and directly with a server application. See also
batch-of-one immediate, store and forward.

director. An interactive utility that guides a user
through the steps of a process to complete a
task.

distributed computing environment (DCE).
A set of integrated software services that allows

software running on multiple computers to
perform in a manner that is seamless and
transparent to the end-users. DCE provides
security, directory, time, remote procedure calls,
and files across computers running on a
network.

DLL. See dynamic link library.
DS. See data structure.
DSTR. See data structure.

duplicated database. A decision support
database that contains a straightforward copy of
operational data. The advantages involve
improved performance for both operational and
reporting environments. See also enhanced
analysis database, enterprise data warehouse.

dynamic link library (DLL). A set of program
modules that are designed to be invoked from
executable files when the executable files are
run, without having to be linked to the
executable files. They typically contain
commonly used functions.

dynamic partitioning. The ability to
dynamically distribute logic or data to multiple
tiers in a client/server architecture.

embedded event rule. An event rule that is
specific to a particular table or application.
Examples include form-to-form calls, hiding a
field based on a processing option value, and
calling a business function. Contrast with
business function event rule. See also event rule.

employee work center. This is a central
location for sending and receiving all OneWorld
messages (system and user generated) regardless
of the originating application or user. Each user
has a mailbox that contains workflow and other
messages, including Active Messages. With
respect to workflow, the Message Center is
MAPI compliant and supports drag and drop
work reassignment, escalation, forward and
reply, and workflow monitoring. All messages
from the message center can be viewed through
OneWorld messages or Microsoft Exchange.

encapsulation. The ability to confine access to
and manipulation of data within an object to the
procedures that contribute to the definition of
that object.

enhanced analysis database. A database
containing a subset of operational data. The data
on the enhanced analysis database performs
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calculations and provides summary data to
speed generation of reports and query response
times. This solution is appropriate when external
data must be added to source data, or when
historical data is necessary for trend analysis or
regulatory reporting. See also duplicated
database, enterprise data warehouse.

enterprise data warehouse. A complex
solution that involves data from many areas of
the enterprise. This environment requires a large
relational database (the data warehouse) that is
a central repository of enterprise data, which is
clean, reconciled, and consolidated. From this
repository, data marts retrieve data to provide
department-level decisions. See also duplicated
database, enhanced analysis database.

enterprise server. A database server and logic
server. See database server. Also referred to as
host.

ER. See event rule.
ERP. See enterprise resource planning.

event. An action that occurs when an interactive
or batch application is running. Example events
are tabbing out of an edit control, clicking a
push button, initializing a form, or performing a
page break on a report. The GUI operating
system uses miniprograms to manage user
activities within a form. Additional logic can be
attached to these miniprograms and used to give
greater functionality to any event within a
OneWorld application or report using event
rules.

event rule. Used to create complex business
logic without the difficult syntax that comes with
many programming languages. These logic
statements can be attached to applications or
database events and are executed when the
defined event occurs, such as entering a form,
selecting a menu bar option, page breaking on a
report, or selecting a record. An event rule can
validate data, send a message to a user, call a
business function, as well as many other actions.
There are two types of event rules:

1 Embedded event rules.

2 Named event rules.

executable file. A computer program that can
be run from the computer’s operating system.
Equivalent terms are “application” and
“program.”.
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exit. 1) To interrupt or leave a computer
program by pressing a specific key or a
sequence of keys. 2) An option or function key
displayed on a form that allows you to access
another form.

facility. 1) A separate entity within a business
for which you want to track costs. For example,
a facility might be a warehouse location, job,
project, work center, or branch/plant. Sometimes
referred to as a business unit. 2) In Home
Builder and ECS, a facility is a collection of
computer language statements or programs that
provide a specialized function throughout a
system or throughout all integrated systems. For
example, DREAM Writer and FASTR are facilities.

FDA. See Form Design Aid.

find/browse. A type of form used to:
1 Search, view, and select multiple
records in a detail area.

2 Delete records.
3 Exit to another form.
4 Serve as an entry point for most

applications.

firewall. A set of technologies that allows an
enterprise to test, filter, and route all incoming
messages. Firewalls are used to keep an
enterprise secure.

fix/inspect. A type of form used to view, add,
or modify existing records. A fix/inspect form
has no detail area.

form. An element of OneWorld’s graphical user
interface that contains controls by which a user
can interact with an application. Forms allow the
user to input, select, and view information. A
OneWorld application might contain multiple
forms. In Microsoft Windows terminology, a
form is known as a dialog box.

Form Design Aid (FDA). The OneWorld GUI
development tool for building interactive
applications and forms.

form interconnection. Allows one form to
access and pass data to another form. Form
interconnections can be attached to any event;
however, they are normally used when a button
is clicked.

form type. The following form types are
available in OneWorld:

1 Find/browse.
2 Fix/inspect.
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3 Header detail.

4 Headerless detail.
5 Message.

6 Parent/child.

7 Search/select.

fourth generation language (4GL). A
programming language that focuses on what
you need to do and then determines how to do
it. Structured Query Language is an example of a
4GL.

graphical user interface (GUI). A computer
interface that is graphically based as opposed to
being character-based. An example of a
character-based interface is that of the AS/400.
An example of a GUI is Microsoft Windows.
Graphically based interfaces allow pictures and
other graphic images to be used in order to give
people clues on how to operate the computer.

grid. See detail area.
GUI. See graphical user interface.

header. Information at the beginning of a table
or form. This information is used to identify or
provide control information for the group of
records that follows.

header/detail. A type of form used to add,
modify, or delete records from two different
tables. The tables usually have a parent/child
relationship.

headerless detail. A type of form used to work
with multiple records in a detail area. The detail
area is capable of of receiving input.

hidden selections. Menu selections you cannot
see until you enter HS in a2 menu’s Selection
field. Although you cannot see these selections,
they are available from any menu. They include
such items as Display Submitted Jobs (33),
Display User Job Queue (42), and Display User
Print Queue (43). The Hidden Selections
window displays three categories of selections:
user tools, operator tools, and programmer
tools.

host. In the centralized computer model, a large
timesharing computer system that terminals
communicate with and rely on for processing. In
contrasts with client/server in that those users
work at computers that perform much of their
own processing and access servers that provide

services such as file management, security, and
printer management.

HTML. See hypertext markup language.

hypertext markup language. A markup
language used to specify the logical structure of
a document rather than the physical layout.
Specifying logical structure makes any HTML
document platform independent. You can view
an HTML document on any desktop capable of
supporting a browser. HITML can include active
links to other HTML documents anywhere on
the Internet or on intranet sites.

index. Represents both an ordering of values
and a uniqueness of values that provide efficient
access to data in rows of a table. An index is
made up of one or more columns in the table.

inheritance. The ability of a class to recieve all
or parts of the data and procedure definitions
from a parent class. Inheritance enhances
developement through the reuse of classes and
their related code.

install system code. See system code.

integrated toolset. Unique to OneWorld is an
industrial-strength toolset embedded in the
already comprehensive business applications.
This toolset is the same toolset used by J.D.
Edwards to build OneWorld interactive and
batch applications. Much more than a
development environment, however, the
OneWorld integrated toolset handles reporting
and other batch processes, change management,
and basic data warehousing facilities.

interactive processing. Processing actions that
occur in response to commands you enter
directly into the system. During interactive
processing, you are in direct communication
with the system, and it might prompt you for
additional information while processing your
request. See also online. Contrast with batch
processing.

interface. A link between two or more
computer systems that allows these systems to
send information to and receive information
from one another.

Internet. The worldwide constellation of
servers, applications, and information available
to a desktop client through a phone line or
other type of remote access.
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interoperability. The ability of different
computer systems, networks, operating systems,
and applications to work together and share
information.

intranet. A small version of the Internet usually
confined to one company or organization. An
intranet uses the functionality of the Internet and
places it at the disposal of a single enterprise.

IP. A connection-less communication protocol
that by itself provides a datagram service.
Datagrams are self-contained packets of
information that are forwarded by routers based
on their address and the routing table
information contained in the routers. Every node
on a TCP/IP network requires an address that
identifies both a network and a local host or
node on the network. In most cases the network
administrator sets up these addresses when
installing new workstations. In some cases,
however, it is possible for a workstation, when
booting up, to query a server for a dynamically
assigned address.

IServer Service. Developed by J.D. Edwards,
this internet server service resides on the web
server, and is used to speed up delivery of the
Java class files from the database to the client.

ISO 9000. A series of standards established by
the International Organization for
Standardization, designed as a measure of
product and service quality.

J.D. Edwards Database. See JDEBASE Database
Middleware.

Java. An Internet executable language that, like
C, is designed to be highly portable across
platforms. This programming language was
developed by Sun Microsystems. Applets, or
Java applications, can be accessed from a web
browser and executed at the client, provided
that the operating system or browser is
Java-enabled. (Java is often described as a
scaled-down C++). Java applications are
platform independent.

Java Database Connectivity (JDBC). The
standard way to access Java databases, set by
Sun Microsystems. This standard allows you to
use any JDBC driver database.

JavaScript. A scripting language related to Java.
Unlike Java, however, JavaScript is not an
object-oriented language and it is not compiled.
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jde.ini. J.D. Edwards file (or member for
AS/400) that provides the runtime settings
required for OneWorld initialization. Specific
versions of the file/member must reside on
every machine running OneWorld. This includes
workstations and servers.

JDEBASE Database Middleware. J.D. Edwards
proprietary database middleware package that
provides two primary benefits:

1. Platform-independent APIs for
multidatabase access. These APIs are
used in two ways:

a. By the interactive and batch engines to
dynamically generate platform-specific
SQL, depending on the datasource
request.

b. As open APIs for advanced C business
function writing. These APIs are then
used by the engines to dynamically
generate platform-specific SQL.

2. Client-to-server and server-to-server
database access. To accomplish this
OneWorld is integrated with a variety
of third-party database drivers, such as
Client Access 400 and open database
connectivity (ODBC).

JDECallObject. An application programming
interface used by business functions to invoke
other business functions.

JDENET. ].D. Edwards proprietary middleware
software. JDENET is a messaging software
package.

JDENET communications middleware. J.D.
Edwards proprietary communications
middleware package for OneWorld. It is a
peer-to-peer, message-based, socket based,
multiprocess communications middleware
solution. It handles client-to-server and
server-to-server communications for all
OneWorld supported platforms.

job queue. A group of jobs waiting to be batch
processed. See also batch processing.

just in time installation (JITI). OneWorld’s
method of dynamically replicating objects from
the central object location to a workstation.

just in time replication (JITR). OneWorld’s
method of replicating data to individual
workstations. OneWorld replicates new records
(inserts) only at the time the user needs the
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data. Changes, deletes, and updates must be
replicated using Pull Replication.

KEY. A column or combination of columns that
identify one or more records in a database table.

leading zeros. A series of zeros that certain
facilities in J.D. Edwards systems place in front
of a value you enter. This normally occurs when
you enter a value that is smaller than the
specified length of the field. For example, if you
enter 4567 in a field that accommodates eight
numbers, the facility places four zeros in front of
the four numbers you enter. The result appears
as: 00004567.

level of detail. 1) The degree of difficulty of a
menu in J.D. Edwards software. The levels of
detail for menus are as follows:

Major Product Directories.

Product Groups.

Basic Operations.

Intermediate Operations.

Advanced Operations.

Computer Operations.

Programmers.

Advanced Programmers Also known as
menu levels.

SNV, ISV SIS VR

2) The degree to which account information in
the General Accounting system is summarized.
The highest level of detail is 1 (least detailed)
and the lowest level of detail is 9 (most
detailed).

MAPI. See Messaging Application Programming
Interface.

master table. A database table used to store
data and information that is permanent and
necessary to the system’s operation. Master
tables might contain data such as paid tax
amounts, supplier names, addresses, employee
information, and job information.

menu. A menu that displays numbered
selections. Each of these selections represents a
program or another menu. To access a selection
from a menu, type the selection number and
then press Enter.

menu levels. See level of detail.

menu masking. A security feature of J.D.
Edwards systems that lets you prevent individual
users from accessing specified menus or menu
selections. The system does not display the

menus or menu selections to unauthorized
users.

Messaging Application Programming
Interface (MAPI). An architecture that defines
the components of a messaging system and how
they behave. It also defines the interface
between the messaging system and the
components.

middleware. A general term that covers all the
distributed software needed to support
interactions between clients and servers. Think
of it as the software that’s in the middle of the
client/server system or the “glue” that lets the
client obtain a service from a server.

modal. A restrictive or limiting interaction
created by a given condition of operation.
Modal often describes a secondary window that
restricts a user’s interaction with other windows.
A secondary window can be modal with respect
to it’s primary window or to the entire system. A
modal dialog box must be closed by the user
before the application continues.

mode. In reference to forms in OneWorld,
mode has two meanings:

e An operational qualifier that governs
how the form interacts with tables and
business views. OneWorld form modes
are: add, copy, and update.

e An arbitrary setting that aids in
organizing form generation for different
environments. For example, you might
set forms generated for a Windows
environment to mode 1 and forms
generated for a Web environment to
mode 2.

modeless. Not restricting or limiting interaction.
Modeless often describes a secondary window
that does not restrict a user’s interaction with
other windows. A modeless dialog box stays on
the screen and is available for use at any time
but also permits other user activities.

multitier architecture. A client/server
architecture that allows multiple levels of
processing. A tier defines the number of
computers that can be used to complete some
defined task.

named event rule. Encapsulated, reusable
business logic created using through event rules
rather than C programming. Contrast with
embedded event rule. See also event rule.
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NER. See named event rule.

network computer. As opposed to the
personal computer, the network computer offers
(in theory) lower cost of purchase and
ownership and less complexity. Basically, it is a
scaled-down PC (very little memory or disk
space) that can be used to access network-based
applications (Java applets, ActiveX controls) via
a network browser.

network computing. Often referred to as the
next phase of computing after client/server.
While its exact definition remains obscure, it
generally encompasses issues such as
transparent access to computing resources,
browser-style front-ends, platform
independence, and other similar concepts.

next numbers. A feature you use to control the
automatic numbering of such items as new G/L
accounts, vouchers, and addresses. It lets you
specify a numbering system and provides a
method to increment numbers to reduce
transposition and typing errors.

non-object librarian object. An object that is
not managed by the object librarian.

numeric character. Digits 0 through 9 that are
used to represent data. Contrast with
alphanumeric characters.

object. A self-sufficient entity that contains data
as well as the structures and functions used to
manipulate the data. For OneWorld purposes, an
object is a reusable entity that is based on
software specifications created by the OneWorld
toolset. See also object librarian.

object configuration manager (OCM).
OneWorld’s Object Request Broker and the
control center for the runtime environment. It
keeps track of the runtime locations for business
functions, data, and batch applications. When
one of these objects is called, the Object
Configuration Manager directs access to it using
defaults and overrides for a given environment
and user.

object embedding. When an object is
embedded in another document, an association
is maintained between the object and the
application that created it; however, any changes
made to the object are also only kept in the
compound document. See also object linking.
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object librarian. A repository of all versions,
applications, and business functions reusable in
building applications. You access these objects
with the Object Management Workbench.

object librarian object. An object managed by
the object librarian.

object linking. When an object is linked to
another document, a reference is created with
the file the object is stored in, as well as with
the application that created it. When the object
is modified, either from the compound
document or directly through the file it is saved
in, the change is reflected in that application as
well as anywhere it has been linked. See also
object embedding.

object linking and embedding (OLE). A way
to integrate objects from diverse applications,
such as graphics, charts, spreadsheets, text, or
an audio clip from a sound program. See also
object embedding, object linking.

object management workbench (OMW). An
application that provides check-out and check-in
capabilities for developers, and aids in the
creation, modification, and use of OneWorld
Objects. The OMW supports multiple
environments (such as production and
development).

object-based technology (OBT). A technology
that supports some of the main principles of
object-oriented technology: classes,
polymorphism, inheritance, or encapsulation.

object-oriented technology (OOT). Brings
software development past procedural
programming into a world of reusable
programming that simplifies development of
applications. Object orientation is based on the
following principles: classes, polymorphism,
inheritance, and encapsulation.

OCM. See object configuration manager.
ODBC. See open database connectivity.
OLE. See object linking and embedding.
OMW. Object Management Workbench.

OneWorld. A combined suite of
comprehensive, mission-critical business
applications and an embedded toolset for
configuring those applications to unique
business and technology requirements.
OneWorld is built on the Configurable Network
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Computing technology- J.D. Edwards’ own
application architecture, which extends
client/server functionality to new levels of
configurability, adaptability, and stability.

OneWorld application. Interactive or batch
processes that execute the business functionality
of OneWorld. They consist of reusable business
functions and associated data that are platform
independent and can be dynamically configured
across a TCP/IP network.

OneWorld object. A reusable piece of code
that is used to build applications. Object types
include tables, forms, business functions, data
dictionary items, batch processes, business
views, event rules, versions, data structures, and
media objects. See also object.

OneWorld process. Allows OneWorld clients
and servers to handle processing requests and
execute transactions. A client runs one process,
and servers can have multiple instances.
OneWorld processes can also be dedicated to
specific tasks (for example, workflow messages
and data replication) to ensure that critical
processes don’t have to wait if the server is
particularly busy.

OneWorld Web development computer. A
standard OneWorld Windows developer
computer with the additional components
installed:

e JFC (0.5.1).
e Generator Package with Generator.Java
and JDECOM.dIIL.

e R2 with interpretive and apllication
controls/form.

online. Computer functions over which the
system has continuous control. Users are online
with the system when working with J.D.
Edwards system provided forms.

open database connectivity (ODBC). Defines
a standard interface for different technologies to
process data between applications and different
data sources. The ODBC interface is made up of
a set of function calls, methods of connectivity,
and representation of data types that define
access to data sources.

open systems interconnection (OSI). The
OSI model was developed by the International
Standards Organization (ISO) in the early 1980s.
It defines protocols and standards for the

interconnection of computers and network
equipment.

operand. See Boolean Logic Operand.

output. Information that the computer transfers
from internal storage to an external device, such
as a printer or a computer form.

output queue. See print queue.

package. OneWorld objects are installed to
workstations in packages from the deployment
server. A package can be compared to a bill of
material or kit that indicates the necessary
objects for that workstation and where on the
deployment server the install program can find
them. It is a point-in-time “snap shot” of the
central objects on the deployment server.

package location. The directory structure
location for the package and it’s set of replicated
objects. This is usually \\deployment
server\release\path_code\package\ package
name. The sub-directories under this path are
where the replicated objects for the package will
be placed. This is also referred to as where the
package is built or stored.

parameter. A number, code, or character string
you specify in association with a command or
program. The computer uses parameters as
additional input or to control the actions of the
command or program.

parent/child form. A type of form that
presents parent/child relationships in an
application on one form. The left portion of the
form presents a tree view that displays a visual
representation of a parent/child relationship.
The right portion of the form displays a detail
area in browse mode. The detail area displays
the records for the child item in the tree. The
parent/child form supports drag and drop
functionality.

partitioning. A technique for distributing data
to local and remote sites to place data closer to
the users who access. Portions of data can be
copied to different database management
systems.

path code. A pointer to a specific set of objects.
A path code is used to locate:

1. Central Objects.

2. Replicated Objects.

platform independence. A benefit of open
systems and Configurable Network Computing.
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Applications that are composed of a single code
base can be run across a TCP/IP network
consisting of various server platforms and SQL
databases.

polymorphism. A principle of object-oriented
technology in which a single mnemonic name
can be used to perform similar operations on
software objects of different types.

portability. Allows the same application to run
on different operating systems and hardware
platforms.

portal. A configurable Web object that provides
information and links to the Web. Portals can be
used as home pages and are typically used in
conjunction with a Web browser.

primary key. A column or combination of
columns that uniquely identifies each row in a
table.

print queue. A list of tables, such as reports,
that you have submitted to be written to an
output device, such as a printer. The computer
spools the tables until it writes them. After the
computer writes the table, the system removes
the table identifier from the list.

processing option. A feature of the J.D.
Edwards reporting system that allows you to
supply parameters to direct the functions of a
program. For example, processing options allow
you to specify defaults for certain form displays,
control the format in which information prints
on reports, change how a form displays
information, and enter beginning dates.

program temporary fix (PTF). A
representation of changes to J.D. Edwards
software that your organization receives on
magnetic tapes or diskettes.

project. An Object Management Workbench
object used to organize objects in development.

published table. Also called a “Master” table,
this is the central copy to be replicated to other
machines. Resides on the “Publisher” machine.
the Data Replication Publisher Table
(F98DRPUB) identifies all of the Published
Tables and their associated Publishers in the
enterprise.

publisher. The server that is responsible for the
Published Table. The Data Replication Publisher
Table (F98DRPUB) identifies all of the Published
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Tables and their associated Publishers in the
enterprise.

pull replication. One of the OneWorld
methods for replicating data to individual
workstations. Such machines are set up as Pull
Subscribers using OneWorld’s data replication
tools. The only time Pull Subscribers are notified
of changes, updates, and deletions is when they
request such information. The request is in the
form of a message that is sent, usually at startup,
from the Pull Subscriber to the server machine
that stores the Data Replication Pending Change
Notification table (FOSDRPCN).

purge. The process of removing records or data
from a system table.

QBE. See query by example.

query by example (QBE). Located at the top
of a detail area, it is used to search for data to
be displayed in the detail area.

redundancy. Storing exact copies of data in
multiple databases.

regenerable. Source code for OneWorld
business functions can be regenerated from
specifications (business function names).
Regeneration occurs whenever an application is
recompiled, eitherfor a new platform or when
new functionality is added.

relationship. Links tables together and
facilitates joining business views for use in an
application or report. Relationships are created
based on indexes.

release/release update. A “release” contains
major new functionality, and a “release update”
contains an accumulation of fixes and
performance enhancements, but no new
functionality.

replicated object. A copy or replicated set of
the central objects must reside on each client
and server that run OneWorld. The path code
indicates the directory the directory where these
objects are located.

run. To cause the computer system to perform a
routine, process a batch of transactions, or carry
out computer program instructions.

SAR. See software action request.

scalability. Allows software, architecture,
network, or hardware growth that will support
software as it grows in size or resource
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requirements. The ability to reach higher levels
of performance by adding microprocessors.

search/select. A type of form used to search
for a value and return it to the calling field.

selection. Found on J.D. Edwards menus,
selections represent functions that you can
access from a menu. To make a selection, type
the associated number in the Selection field and
press Enter.

server. Provides the essential functions for
furnishings services to network users (or clients)
and provides management functions for network
administrators. Some of these functions are
storage of user programs and data and
management functions for the file systems. It
may not be possible for one server to support all
users with the required services. Some examples
of dedicated servers that handle specific tasks
are backup and archive servers, application and
database servers.

servlet. Servlets provide a Java-based solution
used to address the problems currently
associated with doing server-side programming,
including inextensible scripting solutions.
Servlets are objects that conform to a specific
interface that can be plugged into a Java-based
server. Servlets are to the server-side what
applets are to the client-side.

software. The operating system and application
programs that tell the computer how and what
tasks to perform.

software action request (SAR). An entry in the
AS/400 database used for requesting
modifications to J.D. Edwards software.

special character. A symbol used to represent
data. Some examples are *, &, #, and /. Contrast
with alphanumeric character and numeric
character.

specifications. A complete description of a
OneWorld object. Each object has its own
specification, or name, which is used to build
applications.

Specs. See specifications.

spool. The function by which the system stores
generated output to await printing and
processing.

spooled table. A holding file for output data
waiting to be printed or input data waiting to be
processed.

SQL. See structured query language.

static text. Short, descriptive text that appears
next to a control variable or field. When the
variable or field is enabled, the static text is
black; when the variable or field is disabled, the
static text is gray.

store and forward. A transaction method that
allows a client application to perform work and,
at a later time, complete that work by
connecting to a server application. This often
involves uploading data residing on a client to a
server.

structured query language (SQL). A fourth
generation language used as an industry
standard for relational database access. It can be
used to create databases and to retrieve, add,
modify, or deleta data from databases. SQL is
not a complete programming language because
it does not contain control flow logic.

subfile. See detail.
submit. See run.

subscriber. The server that is responsible for
the replicated copy of a Published Table. Such
servers are identified in the Subscriber Table.

subscriber table. The Subscriber Table
(F98DRSUB), which is stored on the Publisher
Server with the Data Replication Publisher Table
(F98DRPUB) identifies all of the Subscriber
machines for each Published Table.

subsystem job. Within OneWorld, subsystem
jobs are batch processes that continually run
independently of, but asynchronously with,
OneWorld applications.

summary. The presentation of data or
information in a cumulative or totaled manner in
which most of the details have been removed.
Many of the J.D. Edwards systems offer forms
and reports that are summaries of the
information stored in certain tables. Contrast
with detail.

system. See application.

System Code. System codes are a numerical
representation of J.D. Edwards and customer
systems. For example, 01 is the system code for
Address Book. System codes 55 through 59 are
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reserved for customer development by
customers. Use system codes to categorize
within OneWorld. For example, when
establishing user defined codes (UDCs), you
must include the system code the best
categorizes it. When naming objects such as
applications, tables, and menus, the second and
third characters in the object’s name is the
system code for that object. For example, G04 is
the main menu for Acounts Payable, and 04 is
its system code.

system function. A program module, provided
by OneWorld, available to applications and
reports for further processing.

table. A two-dimensional entity made up of
rows and columns. All physical data in a
database are stored in tables. A row in a table
contains a record of related information. An
example would be a record in an Employee
table containing the Name, Address, Phone
Number, Age, and Salary of an employee. Name
is an example of a column in the employee
table.

table design aid (TDA). A OneWorld GUI tool
for creating, modifying, copying, and printing
database tables.

table event rules. Use table event rules to
attach database triggers (or programs) that
automatically run whenever an action occurs
against the table. An action against a table is
referred to as an event. When you create a
OneWorld database trigger, you must first
determine which event will activate the trigger.
Then, use Event Rules Design to create the
trigger. Although OneWorld allows event rules
to be attached to application events, this
functionality is application specific. Table event
rules provide embedded logic at the table level.

TAM. Table Access Management.
TBLE. See table.
TC. Table conversion.

TCP/IP. Transmission Control Protocol/Internet
Protocol. The original TCP protocol was
developed as a way to interconnect networks
using many different types of transmission
methods. TCP provides a way to establish a
connection between end systems for the reliable
delivery of messages and data.
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TCP/IP services port. Used by a particular
server application to provide whatever service
the server is designed to provide. The port
number must be readily known so that an
application programmer can request it by name.

TDA. See table design aid.
TER. See table event rules.

Terminal Identification. The workstation ID
number.Terminal number of a specific terminal
or IBM user ID of a particular person for whom
this is a valid profile.Header Field: Use the Skip
to Terminal/User ID field in the upper portion of
the form as an inquiry field in which you can
enter the number of a terminal or the IBM user
ID of a specific person whose profile you want
the system to display at the top of the list. When
you first access this form, the system
automatically enters the user ID of the person
signed on to the system.Detail Field: The
Terminal/User ID field in the lower portion of
the form contains the user ID of the person
whose profile appears on the same line.A code
identifying the user or terminal for which you
accessed this window.

third generation language (3GL). A
programming language that requires detailed
information about how to complete a task.
Examples of 3GLs are COBOL, C, Pascal and
FORTRAN.

token. A referent to an object used to determine
ownership of that object and to prevent
non-owners from checking the object out in
Object Management Workbench. An object
holds its own token until the object is checked
out, at which time the object passes its token to
the project in which the object is placed.

trigger. Allow you to attach default processing
to a data item in the data dictionary. When that
data item is used on an application or report,
the trigger is invoked by an event associated
with the data item. OneWorld also has three
visual assist triggers: calculator, calendar and
search form.

UBE. Universal batch engine.

UDC Edit Control. Use a User-Defined Code
(UDC) Edit Control for a field that accepts only
specific values defined in a UDC table. Associate
a UDC edit control with a database item or
dictionary item. The visual assist Flashlight
automatically appears adjacent to the UDC edit
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control field. When you click on the visual assist
Flashlight, the attached search and select form
displays valid values for the field. To create a
UDC Edit Control, you must:
e Associate the data item with a specific
UDC table in the Data Dictionary.
e Create a search and select form for
displaying valid values from the UDC
table.

uniform resource identifier (URI). A
character string that references an internet object
by name or location. A URL is a type of URL

uniform resource locator (URL). Names the
address (location) of a document on the Internet
or an intranet. A URL includes the document’s
protocol and server name. The path to the
document might be included as well. The
following is an example of a URL:

http://www .jdedwards.com. This is J.D. Edwards
Internet address.

URI. See uniform resource identifier.
URL. See uniform resource locator.

user defined code (type). The identifier for a
table of codes with a meaning you define for
the system, such as ST for the Search Type
codes table in Address Book. J.D. Edwards
systems provide a number of these tables and
allow you to create and define tables of your
own. User defined codes were formerly known
as descriptive titles.

user defined codes (UDC). Codes within
software that users can define, relate to code
descriptions, and assign valid values. Sometimes
user defined codes are referred to as a generic
code table. Examples of such codes are
unit-of-measure codes, state names, and
employee type codes.

UTB. Universal Table Browser.

valid codes. The allowed codes, amounts, or
types of data that you can enter in a field. The
system verifies the information you enter against
the list of valid codes.

visual assist. Forms that can be invoked from a
control to assist the user in determining what
data belongs in the control.

vocabulary overrides. A feature you can use
to override field, row, or column title text on
forms and reports.

wchar_t. Internal type of a wide character. Used
for writing portable programs for international
markets.

web client. Any workstation that contains an
internet browser. The web client communicates
with the web server for OneWorld data.

web server. Any workstation that contains the
IServer service, SQL server, Java menus and
applications, and Internet middleware. The web
server receives data from the web client, and
passes the request to the enterprise server.
When the enterprise server processes the
information, it sends it back to the web server,
and the web server sends it back to the web
client.

WE. See workflow.
window. See form.

workflow. According to the Workflow
Management Coalition, worlflow means “the
automation of a business process, in whole or
part, during which documents, information, or
tasks are passed from one participant to another
for action, according to a set of procedural
rules.”.

workgroup server. A remote database server
usually containing subsets of data replicated
from a master database server. This server does
not performance an application or batch
processing. It may or may not have OneWorld
running (in order to replicate data).

workspace. In the ActivEra Portal, the main
section of the Portal. A user might have access
to several workspaces, each one configured
differently and containing its own components.

worldwide web. A part of the Internet that can
transmit text, graphics, audio, and video. The
World Wide Web allows clients to launch local
or remote applications.

z file. For store and forward (network
disconnected) user, OneWorld store and forward
applications perform edits on static data and
other critical information that must be valid to
process an order. After the initial edits are
complete, OneWorld stores the transactions in
work tables on the workstation. These work
table are called Z files. When a network
connection is established, Z files are uploaded
to the enterprise server and the transactions are
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edited again by a master business function. The
master business function will then update the
records in your transaction files.
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A

About OneWorld foundation, 1-4
Accessing BrowsER for a report or version,
15-26
Accessing data selection and sequencing for
batch versions, 15-12
Accessing properties for table conversion
versions, 15-14
Accessing task-level help, 8-12
Accessing the ActivEra Portal, 5-5
Accessing the customer Knowledge Garden,
E-2, E-3
Accessing the employee work center, 11-10
Accessing the Internet, 4-31
Accessing the Work With Batch Versions
form, 15-5
Accessing visual assist, 8-29
Action messages, 11-5
ActivEra Portal, 5-1
accessing the ActivEra Portal, 5-5
changing the appearance, 5-6
create a new workspace, 5-9
delete a workspace, 5-9
creating a new workspace, 5-8
logging off to the ActivEra Portal, 5-6
logging on to the ActivEra Portal, 5-6
opening menus and applications, 5-11
Using the Favorites task view, 5-13
working with task views, 5-12
ActivEra Portal interface, 5-3
components, 5—4
toolbars, 5-3
workspace, 5-4
Add equivalent words, 17-9
Add ignore words, 17-14
Adding a record, 10-10
Adding a shortcut to a queue, 11-29
Adding a user defined code, 18-7
Adding a user defined code type, 18-16
Adding MailMerge documents, 13-7
Advantages and recommendations for CNC,
19-3
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Application or function, open with the exit
bar, 8-29
Application suite, system integration, 1-1
Application user interface, 8-1, 8-23
accessing visual assist, 8-29
changing the display of the toolbar, 8-23
customizing menu bars and toolbars,
8-24
displaying the exit bar, 8-28
error messages, 8—12
error messages - HTML, 6-12
exit bar, 8-7
form types, 8-14
menu bar, 8-4
online help, 8-11
pop-up menus, 8-9
review error messages, HTML, 6—12
scroll bar, 8-9
status bar, 8-10
tab controls for forms, 8-21
toolbar, 8-5
toolbar - HITML, 6-10
visual assist, 8—10
visual assist - HTML, 6-12
visual assist - Java, 7-12
working with modeless processing, 8-26
Application workspace, 6-9
Applications
interactive versions, 14-1
launching, 7-8
open from a desktop shortcut, 4-31
open from a OneWorld Explorer menu,
4-30
open from the Applications menu, 4-31
open using menu word search, 4-30
opening menu options, 4-30
sharing of data and logic, 1-2
Attach OLE objects at the base form level,
12-20
Attaching media objects, 12-5
Attaching OLE objects at the base form
level, 12-20
Attachments
metadata, 12-19
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Renaming an icon, 12-13
status, 12-19

B

Back button, 4-11
Batch version processing options, 167
Batch versions, 15-3
access BrowsER, 15-26
access data selection and sequencing,
15-12
accessing the Work With Batch Versions
form, 15-5
change Batch Versions (P98305)
processing options, 15-25
change processing options, 15-10
change the design, 15-5
characteristics, 15-2
check in or out, 15-23
copy, 15-19
create, 15-20
erase the check-out record, 15-24
move specifications to an enterprise
server, 15-27
reports, 15-1
run, 15-4
version detail, 15-15
Before You Begin tab, 3-26
Bookmarks
add a Web bookmarks, 7-13
modify a Web bookmarks, 7-14
using Web bookmarks, 7-13
BrowsER, access for a report or version,
15-26
Building the menu word search table,
17-17
Button shortcuts, A—4

C

Cached override information, 9-4
Calculator, 8-30

Calendar, 8-30

Cancel the delivery of a message to a
specific queue, 11-23

Category codes, 18-1

Central objects, 19-9

Change equivalent words, 17-11
Change ignore words, 17-15
Change the content of the MailMerge
document, 13-5
Change the menu selection view
detail, 4-16
large icon, 4-15
list, 4-16
refresh your view, 4-17
small icons, 4-15
web, 4-17
Change the properties of MailMerge
documents, 13-3
Changing a record, 10-11
Changing a user defined code, 18-5
Changing a user defined code type, 18-13
Changing a user’s queue security, 11-33
Changing Batch Versions (P98305)
processing options, 15-25
Changing MailMerge documents, 13-3
Changing processing options for batch
versions, 15-11
Changing the appearance of OneWorld
explorer, 4-13
Changing the appearance of the ActivEra
Portal, 5-6
create a new workspace, 5-8, 5-9
delete a workspace, 5-9
Changing the design of a batch version,
15-6
Changing the display of the toolbar, 8-23
Changing user overrides, changing
individual to group user overrides, 9-8
Changing your password, 3-10, 4-20
Changing your user options, 3-9, 4-18
Checking for attachments, 12—4
Checking in and out, 11-35
Checking out or checking in a batch
version, 15-23
Choosing a record, 10-9
Components, ActivEra Portal interface, 5-4
Configurable network computing, 19-1
advantages and recommendations, 19-3
advantages of CNC
custom solutions without
consequences, 19-4
flexible, leveraged technology, 19-3
network-centric software, 19-3
supports worldwide business
requirements, 19-4
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recommendations, 19-5
Configurable network computing
foundation

environments, 19-11

object storage

central objects, 19-9
replicated objects, 19-10

path codes, 19-12
Configurable network computing
fundamentals, 19-9

data sources, 19-14

object configuration manager, 19-13

object deployment, 19-15

object storage, 19-9
Consequences of customizing UDCs, 18-4
Copying a batch version, 15-19
Copying an interactive version, 14-5
Create a new workspace, 5-9
Creating a batch version, 15-21
Creating a new workspace, 5-8
Creating charts and graphs, 8-49
Creating formats, 8-34
Creating reports of processing options,
15-13
Creating Tabs, 4-22
Creating tabs

new menu tab, 4-22

object tab, 4-24

web browser tab, 4-25
Creating user overrides, 9-7
Custom solution without consequences,
19-4
Custom tab, 3-27
Customer Knowledge Garden, E-1

accessing the customer Knowledge

Garden, E-2, E-3
Customizing charts and graphs, 8-50

graph types, 8-50
Customizing menu bars and toolbars, 8-24
Customizing the appearance of the grid,
8-40
Customizing UDCs and UDC types, 18-3
Customizing user defined code types, 18-13
Customizing user defined codes, 18-5
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D

Data
exporting data from the grid, 8-45
importing data from the grid, 8-46
Data and logic, sharing between
applications, 1-2
Data selection, accessing for batch versions,
15-12
Data sources, 19-14
Database, records, 10-1
Database messages, message routing, 11-4
Database tables, records, 10-1
Delete a tab, 4-27
Delete a workspace, 5-9
Delete equivalent words, 17-12
Delete ignore words, 17-16
Delete OLE objects at the base form level,
12-21
Deleting a record, 10-12
Deleting a user defined code, 18-10
Deleting a user defined code type, 18-18
Deleting MailMerge documents, 13-11
Deleting media objects, 12-13
Deleting messages, 11-24
Deliverables tab, 3-27
Detail button, 4-10
Detail tab, 3-26
Display options, changing the appearance,
4-14
Displaying the exit bar, 8-28
Distributed data, 19-13
Distributed processing, 19-13
Distribution list
send a message, 11-15
send a message to a distribution list,
11-15
Documents, creating tabs, 4-22

E

e-mail, 11-1
cancel delivery to a specific queue,
11-23
deleting messages, 11-24
external mail preferences, 11-16
internal and external messages, 11-3
message routing, 11-4
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moving message to another queue,
11-21
printing messages, 11-24
reassigning messages, 11-23
redirecting messages, 11-22
revising messages, 11-20
sending external messages, 11-17
sending internal messages, 11-11
distribution list, 11-15
quick list, 11-14
understanding messages, 11-3
workflow messages, 11-5
working with shortcuts, 11-18
Electronic mail. See e-mail
E-mail, Worldwide Customer Support, D-5
E-mail support, D-5
Employee queue manager, logging time
checking in and out, 11-35
entering remarks, 11-36
viewing time logs, 11-37
employee queue manager, time entry,
11-35
Employee Work Center, messages, 11-1
Employee work center
accessing the employee work center,
11-10
sending internal messages, 11-11
distribution list, 11-15
quick list, 11-14
setting up a queue, 11-27
adding a shortcut, 11-29
changing a user’s queue security,
11-33
specifying which queue a user can
view, 11-31
understanding queues, 11-6
viewing messages, 11-10
working with messages, 11-9
working with queues, 11-27
End-User Tasks task view, 3—-16
Entering remarks, 11-36
Entry points, 2-1
Environments, 19-11
Equivalent words
add equivalent words, 17-9
change equivalent words, 17-11
delete equivalent words, 17-12
view equivalent words, 17-8
Erasing the check-out record of a version,
15-24

Error messages, 8-12
HTML, 6-12
review error messages, HTML, 6-12
Exit bar, 8-7, 8-28
detach the exit bar, 8-29
display the exit bar, 8-28
move the exit bar, 8-28
open a function or application, 8-29
resize the exit bar, 8-29
Explorer (OneWorld), 4-1, 4-7
changing the appearance, 4-13
changing the display options, 4-14
changing user options, 4-18
menu bar, 4-9
menu selections, 4-8
status bar, 4-11
toolbar, 4-10
tree structure, 4-8
working with OneWorld Explorer, 4-13
Exporting data from the grid, 8-45

F98950 (User Overrides), 9-3
Fast Path, HTML, 6-9
Fast path
ActivEra Portal, 5-14
Solution Explorer, 3-8
Fast path - Java, 7-9, 7-10
Fast Path button, 4-11
Favorites task view, 3—-17, 5-13
Find/Browse form, 8-14
Finding and opening menus and
applications, 17-3
Fix/Inspect form, 8-18
Fixing user overrides after a form change,
9-10
Form information, access, D-10
Form types, 8-14
find/browse form, 8-14
fix/inspect form, 8-18
header detail and headerless detail form,
8-16
message box, 8-20
parent/child form, 8-19
search/select form, 8-15
Formatting the grid, 8-35
change the sorting sequence, 8-36
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reorder columns, 8-36
set up auto return, 8-39
size columns, 8-38
Forms
About OneWorld, D-10
Advanced Information, D-13

Check In/Out and Update Remark, 11-36

customize, Toolbar, 8-25
Processing Options, 15-11

Select Grid Row Sort Order, 8-37
Send External Mail, 11-18

Work With Batch Versions, 15-14, 15-21,

15-23

Work With Workflow Message Security,

11-31
Forward button, 4-11
Freezing columns and rows, 8-43

Function or application, open with the exit

bar, 8-29

G

Graphical User Interface, Explorer
(OneWorld), 4-1
Graphs
creating charts and graphs, 8-49
customizing charts and graphs, 8-50
Grid, customizing the appearance, 840
Grid formats
delete formats, 8-35
rename grid formats, 8-35
Grid options, 8-33
creating charts and graphs, 8-49

maximizing the grid, 8-44
printing the grid, 8-48
rename grid formats, 8-35
restore the grid, 8-44

Grids, keyboard commands, B-1

H

Header detail and headerless detail forms,

8—

16

Help information, Worldwide Customer
Support, D-1
Help line

E-mail, D-5
telephone numbers, D-2

Home button, 4-10

How are interactive and batch versions
different, 14-2

How processing options affect versions,
14-1

HTML

signing off OneWorld, 6-6
signing on and off OneWorld, 6-3
signing on to OneWorld, 6-3

Ignore words, 17-13

add ignore words, 17-14
change ignore words, 17-15
delete ignore words, 17-16
view ignore words, 17-13

creating formats, 8-34
customizing charts and graphs, 8-50
customizing the appearance, 8-40
change background color, 8-41
change fonts, 8-40
change the magnification, 8-42
delete formats, 8-35
exporting data from the grid, 8-45
formatting the grid, 8-35
change the sorting sequence, 8-36
reorder columns, 8-36
set up auto return, 8-39
size columns, 8-38
freezing columns and rows, 8-43
importing data from the grid, 8-46
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Imaging, overview, 12-1

Importing data from the grid, 8-46
Integrated environments, OneWorld
Foundation, 1-4

Interactive version processing options, 16-5

manually launch, 16-6
Interactive versions, 14-3
copy an interactive version, 14-5
creating (adding) an interactive version,
14-6
version detail, 14-3
Interactive versions for applications, 14-1
Internal and external messages, 11-3
Internal messages
send to a distribution list, 11-15
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send to one person, 11-12
Internet, accessing the Internet, 4-31
Introduction to OneWorld, 1-1

J.D. Edwards Education task view, 3—-17
J.D. Edwards OneWorld systems, C-1
J.D. Edwards worldwide customer support,
D-1
Java
add a Web bookmarks, 7-13
modify a Web bookmarks, 7-14
OneWorld Menu Console, tree structure,
7-7
signing off OneWorld, 7-6
signing on and off OneWorld, 7-3
signing on to OneWorld, 7-3
using keyword search, 7-10
using the fast path, 7-9
using Web bookmarks, 7-13
visual assist, 7-12

K

Keyboard commands, moving around in
the grid, B-1
Keyboard shortcuts, A-2

calculator tool, A-6

calendar tool, A-5

media object text, A-6

Large Icons button, 4-10

Launching applications, 7-8

List button, 4-10

Locating records, 10-3

Locating records using specific selection
criteria, 10-3

Locating records using wildcards and
operators, 10-5

Logging off to the ActivEra Portal, 5-6
Logging on to the ActivEra Portal, 5-6
Logging time and adding remarks, 11-35

M

MailMerge documents, 13-3
MailMerge Workbench, 13-1
add documents, 13-7
change document properties, 13-3
delete documents, 13-11
MailMerge workbench, change content of
MailMerge document, 13-5
Maximizing the grid, 8-44
Media objects, 12-3
attach a template, 12-14
attach OLE objects at the base form level,
12-20
attaching a shortcut, 12-10, 12-11
attaching an image object, 12-6
attaching an OLE object, 12-8
attaching media objects, 12-5
attaching OLE objects at the base form
level, 12-20
attaching text objects, 12-5
checking for attachments, 12—4
create a template, 12-15
delete a template, 12-16
delete a template on media objects,
12-16
deleting media objects, 12-13
deleting OLE objects at the base form
level, 12-21
image files, 12-1
modify a template, 12-15
object linking and embedding (OLE),
12-1
properties of media objects, 12-16
set image properties, 12-18
set media object properties, 12—17
set media object text properties, 12—17
set shortcut properties, 12-18
templates, 12-14
text files, 12—1
view OLE properties, 12-18
Media objects and imaging, overview, 12-1
Menu bar, 3-4, 4-9, 8-4
Applications, 3-5, 4-9
Edit, 3-5, 4-9
File, 3-5, 4-9
Help, 3-5, 4-9
Tools, 3-5, 4-9
View, 3-5, 4-9
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Menu information, access, D-10
Menu select, opening menus, 4-28
Menu selections, 4-8
Menu tab
create a new menu tab, 4-22
delete a tab, 4-27
Menu word search, 17-1
add equivalent words, 17-9
add ignore words, 17-14
building the Menu Word Search Table,
17-17
change equivalent words, 17-11
change ignore words, 17-15
delete equivalent words, 17-12
delete ignore words, 17-16
equivalent words, 17-7
finding and opening menus and
applications, 17-3
ignore words, 17-13
opening menus, 3-13, 4-29
view equivalent words, 17-8
view ignore words, 17-13
Menus
open menus using desktop shortcut,
4-29
open menus using fast path, 4-29
HTML, 6-9
opening menus, 3-12, 4-27
opening menus in the ActivEra Portal,
5-12
opening menus in the ActivEra Task
Explorer, 5-11
opening menus using a tree structure,
3-13, 4-27
opening menus using menu select, 4-28
opening menus using menu word search,
3-13, 4-29
pop-up menu, 8-9
Menus and applications, menu word
search, 17-1
Message box, 8-20
Message routing, 11-4
Messages
accessing the employee work center,
11-10
cancel delivery to a specific queue,
11-23
deleting messages, 11-24
external mail preferences, 11-16
internal and external messages, 11-3
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internal message
send to distribution list, 11-15
send to one person, 11-12
message routing, 11-4
moving message to another queue,
11-21
moving to another queue, 11-21
print a report of all messages in a queue,
11-25
print messages, 11-24
printing messages, 11-24
reassigning messages, 11-23
redirecting messages, 11-22
revising messages, 11-20
send shortcut, 11-19
sending external messages, 11-17
sending internal messages, 11-11
distribution list, 11-15
quick lists, 11-14
understanding messages, 11-3
understanding queues, 11-6
viewing messages, 11-10
workflow messages, 11-5
working with messages, 11-9
working with shortcuts, 11-18
Messages and queues, 11-1
Modeless processing, 8-26
arranging the forms, 8-27
moving between forms, 8-27
Moving a message to another queue, 11-21
Moving around in the grid, B-1
Moving batch version specifications to an
enterprise server, 15-27

N

Navigate through the OneWorld Master
Directory, 6-8

Network-centric software, 19-3

New Tab button, 4-10

Notes tab, 3-27

@)

Object, create a tab for an object, 4-24
Object configuration manager, 19-13
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Object deployment, 19-15
application installation, 19-17
initial installation, 19-16
just-in-time installation, 19-18
workstation installation, 19-17
Object storage, 19-9
central objects, 19-9
replicated objects, 19-10
OLE objects
as media objects, 12-5
attach at the base form level, 12-20
attaching at the base form level, 12-20
delete at the base form level, 12-21
OneWorld
entry points, 2-1
signing off OneWorld - HTML, 6-6
signing off OneWorld - Java, 7-6
signing on and off OneWorld - HTML,
0-3
signing on and off OneWorld - Java, 7-3
signing on to OneWorld - HTML, 6-3
signing on to OneWorld - Java, 7-3
OneWorld Access, 2-1
OneWorld application suites, 1-1
OneWorld applications, user interface, 8-1
OneWorld Explorer, 4-1
working with OneWorld Explorer, 4-13
OneWorld explorer
changing the appearance, 4-13, 4-14
changing user options, 4-18
menu bar, 4-9
menu selections, 4-8
status bar, 4-11
toolbar, 4-10
tree structure, 4-8
OneWorld features, 1-1
adaptability, 1-1
integrated supply chain, 1-1
interoperability, 1-1
multiplatform computing, 1-1
user-friendly, 1-1
OneWorld HTML, 6-1
open menus using fast path, 6-9
OneWorld Master Directory, 6-1, 6-7
navigation, 6-8
OneWorld Menu Console, 7-1, 7-7
OneWorld Menus task view, 3—-16
OneWorld revision forms, 8-39
OneWorld systems, C-1

OneWorld UDC tables, 18-4
Online help, 8-11

accessing help, 8-11

task-level help, 8-12
Open an application from a desktop
shortcut, 4-31
Open an application from a OneWorld
Explorer menu, 4-30
Open an application from the applications
menu, 4-31
Open an application using a OneWorld
Explorer menu, 4-30
Open an application using keyword search
- Java, 7-10
Open an application using the fast path -
Java, 7-9
Open button, 4-10
Open menus using a desktop shortcut,
4-29
Open menus using fast path, 7-9
Open menus using keyword search - Java,
7-10
Opening applications, 4-30
Opening menus, 3-12, 4-27

menu select, 4-28

tree structures, 3—13, 4-27

P

Parent/child form, 8-19
Path codes, 19-12
Phone numbers, Worldwide Customer
Support, D-2
Pop-up menus, 8-9
Position shortcuts, A-3
Printing messages, 11-24
Printing the grid, 8-48
Priority or secondary queue
cancel delivery to a specific queue,
11-23
redirecting messages, 11-22
Processing option functions, 16-2
Processing options, 16-1
batch version processing options, 16-7
change for batch versions, 15-10, 15-11
change for Batch Versions (P98305),
15-25
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create reports, 15-13

interactive processing options, 16-5
manually launch, 16-6

master business functions, 16-8

processing option functions, 16-2

types of processing options, 16-2

working with processing options, 16—4
from a menu, 16-4

Programs and IDs

P00890 (On-Line Support Information),

Advanced Information, D-13

P0112 (Time Log Ledger Update), Check

In/Out and Update Remark, 11-36

P012501 (Work Center), Send External

Mail, 11-18

P98305 (Batch Versions), Work With

Batch Versions, 15-11, 15-12, 15-14,

15-21, 15-23

Q

Query-by—-example line, 10-4
Questions Worldwide Customer Support
can answer, D-2
Queue security, 11-7
Queues
cancel delivery to a specific queue,
11-23
moving a message to another queue,
11-21
redirecting messages, 11-22
security, 11-7
workflow queues, 11-7
Quick list, send a message to a quick list,
11-14

R

Reassigning messages, 11-23
Recommendations for configurable network
computing, 19-5
Records, 10-1

adding a record, 10-10

changing a record, 10-11

checking for attachments, 12-4

choosing a record, 10-9

considerations, 10-7
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deleting a record, 10-12
locating records, 10-3
query-by-example line, 10-4
search selection criteria, 10-3
wildcards and operators, 10-5
working with records, 10-7
Redirecting messages to the priority or
secondary queue, 11-22
Refresh button, 4-10
Remove Tab button, 4-10
Renaming an attachment icon, 12-13
Replicated objects, 19-10
Report, batch versions, 15-1
Reports
access BrowsER, 15-26
print report that lists all messages in a
queue, 11-25
view report output, 3—-12, 4-21
Response line
e-mail, D-5
telephone numbers, D-2
Restore the grid, 8-44
Revising messages, 11-20

S

Save Object button, 4-10
Scroll bar, 8-9
Search button, 8-30
Search criteria
query-by-example line, 10-4
search selection criteria, 10-3
wildcards and operators, 10-5
Search hierarchy, 9-4
Search/Select form, 8-15
Security
changing a user’s queue security, 11-33
queue security, 11-7
sending external messages, 11-17
Sending internal messages, 11-11
distribution list, 11-15
quick list, 11-14
Sequencing, accessing for batch versions,
15-12
Set image properties, 12-18
Set media object properties, 12-17
Set shortcut properties, 12-18
Set text properties, 12-17
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Setting up a queue, 11-27
Setting up external mail preferences, 11-16
Shortcuts, A—1
button shortcuts, A—4
keyboard
calculator tool, A-6
calendar tool, A-5
media object text, A-6
keyboard shortcuts, A-2
media object, 12-2
moving around shortcuts, A-3
selecting text, A-1
send shortcut, 11-19
Show/Hide Menu Tree button, 4-10
Signing off of OneWorld, 4-5
Signing off OneWorld - HTML, 6-6
Signing off OneWorld - Java, 7-6
Signing on and off OneWorld, 4-3
Signing on and off OneWorld — HTML, 6-3
Signing on and off OneWorld - Java, 7-3
Signing on to OneWorld, 4-3
Signing on to OneWorld - HTML, 6-3
Signing on to OneWorld - Java, 7-3
Small Icons button, 4-10
Solution Explorer
changing user options, 3-9
menu bar, 3—4
status bar, 3-8
toolbar, 3-6
Solution Explorer content, task
documentation window content, 3-25
Before You Begin tab, 3-26
Custom tab, 3-27
Deliverables tab, 3-27
Detail tab, 3-26
Notes tab, 3-27
Summary tab, 3-26
Solution Explorer task view configuration.
See Configuring task views
Specifying the queues a user can view,
11-31
Spreadsheets, creating tabs, 4-22
Status bar, 3-8, 4-11, 8-10
display as of release, 3-8
Summary tab, 3-26
System Integration, 1-1

Tab
create a new menu tab, 4-22
create a tab for an object, 4-24
create a web browser tab, 4-25
creating tabs, 4-22
delete a tab, 4-27
Tab controls for forms, 8-21
Table Conversion versions, access
properties, 15-14
Tables, User Overrides (F98950), 9-3
Task documentation window content, 3-25
Before You Begin tab, 3-26
Custom tab, 3-27
Deliverables tab, 3-27
Detail tab, 3-26
Notes tab, 3-27
Summary tab, 3-26
Task links. See Working with task
relationship variants
Task view content
End-User Tasks task view, 3-16
Favorites task view, 3-17, 5-13
J.D. Edwards Education task view, 3—17
OneWorld Menus task view, 3-16
Task-level help, 8-12
Telephone support, D-2
Text shortcuts, A-1
Time entry
checking in and out, 11-35
entering remarks, 11-36
logging time and adding remarks, 11-35
viewing time logs, 11-37
Toolbar, 3-6, 4-10, 8-5
adjust the appearance, 4-17
adjust the width of the panes, 4-18
back button, 4-11
changing the display of the toolbar, 8-23
customizing menu bars and toolbars,
8-24
details button, 4-10
fast path field, 4-11
forward button, 4-11
home button, 4-10
HTML, 6-10
hyper-button, 8-6
large icon button, 3-7, 4-10
list button, 4-10
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new tab button, 3-6, 4-10, 6-10
open button, 4-10
refresh button, 3-7, 4-10
remove tab button, 3-7, 4-10
save object button, 4-10
show/hide menu tree button, 4-10
small icon button, 3-7, 4-10
web button, 3-7, 4-10
word search button, 4-11
Toolbars, ActivEra Portal interface, 5-3
Translate UDC descriptions into alternate
languages, 18-23
Translate UDC type descriptions into
alternate languages, 18-21
Translating user defined codes into
different languages, 18-21
Tree structure, 4-8
Java, 7-7
opening menus, 3-13, 4-27
opening menus in the ActivEra Portal,
5-12
Types of processing options, 16-2

U

UDC lists. See UDC types
UDC types, 18-1

customizing UDCs and UDC types, 18-3
UDCs, UDC types, and category codes,
18-1
Understanding messages, 11-3
Understanding messages and queues, 11-3
Understanding OneWorld Explorer, 4-7
Understanding OneWorld Menu Console,
7-7

tree structure, 7-7
Understanding queues, 11-6
Understanding the ActivEra Portal interface,
5-3
Understanding the application user
interface, 8-3
Understanding the user interface, status bar,
3-8
User defined code program, create and
customize UDCs and UDC types, 18—4
User defined code types

adding a user defined code type, 18-16
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changing a user defined code type,
18-13
customizing user defined code types,
18-13
deleting a user defined code type, 18-18
translate descriptions into alternate
languages, 18-21
User Defined Codes, UDCs, UDC types, and
category codes, 18-1
User defined codes, 18-1
adding a user defined code, 18-7
blank as a valid value, 18-9
changing a user defined code, 18-5
consequences of customizing, 18—4
customizing UDCs and UDC types, 18-3
customizing user defined codes, 18-5
deleting a user defined code, 18-10
example, 18-2
hard coded, 18-3
queues, 11-6
translate descriptions into alternate
languages, 18-23
translating into different languages,
18-21
User ID and password, signing on and off
OneWorld, 4-3
User interface, OneWorld application user
interface, 8-1
User options, 3-9, 4-18
change user password, 3-10, 4-20
view report output, 3—-12, 4-21
User overrides, 9-1, 9-7
cached override information, 9-4
changing user overrides, 9-8
copy overrides
language, 9-9
user/group, 9-9
version, 9-9
creating user overrides, 9-7
deleting user overrides, 9-10
fixing user overrides, 9-10
search hierarchy, 9-4
User Overrides (F98950), 9-3
Using keyword search - Java, 7-10
Using OneWorld fast path - HTML, 6-9
Using processing options for master
business functions, 16-8
Using the fast path - Java, 7-9
Using the query-by-example line, 10-4
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Using Web bookmarks, 7-13
add a bookmark, 7-13
modify a bookmark, 7-14

V

Version detail, batch versions, 15-15
Version detail for interactive versions, 14-3
Versions
interactive and batch versions
differences, 14-2
processing options, 14-1
View equivalent words, 17-8
View ignore words, 17-13
View OLE properties, 12-18
Viewing and defining metadata for an
attachment, 12-19
Viewing logs, 11-37
Viewing messages, 11-10
Visual assist, 8-10, 8-29
access using the right mouse button,
8-32
calculator, 8-30
calendar, 8-30
HTML, 6-12
search button, 8-30
Visual assist - Java, 7-12

w

Web bookmarks - Java, 7-13

add a bookmark, 7-13

modify a bookmark, 7-14
Web browser, create web browser tab, 4-25
Web button, 4-10
Web-based framework, ActivEra Portal
interface, 5-3
Wildcards and operators, locating records,
10-5
Word Search button, 4-11
Work With Workflow Message Security,
forms, 11-31
Workflow messages, 11-5
Workflow queues, 11-7
Working with ActivEra Portal, Opening
menus and applications, 5-11
Working with equivalent words, 17-7

Working with interactive versions, 14-3
Working with media objects, 12-3
Working with messages, 11-9
Working with modeless processing, 8-26
arranging the forms, 8-27
moving between forms, 8-27
Working with OneWorld Explorer, 4-13
accessing the Internet, 4-31
open an application from a desktop
shortcut, 4-31
open an application from a OneWorld
Explorer menu, 4-30
open an application from the
applications menu, 4-31
open an application using a OneWorld
Explorer menu, 4-30
open menus using a desktop shortcut,
4-29
open menus using fast path, 4-29
Working with OneWorld Master Directory,
6-7
Working with processing options, 16—4
from a menu, 16-4
Working with Queues, 11-27
Working with records, 10-7
Working with shortcuts, 11-18
Working with tasks using Solution Explorer.
See Configuring task views
Working with templates, 12-14
attach a template, 12-14
create a template, 12-15
delete a template, 12-16
delete a template on media objects,
12-16
modify a template, 12-15
Working with the ActivEra Portal, 5-3
working with task views, 5-12
Working with the application user interface,
8-23
Working with the Grid, 8-33
Working with the properties of media
objects, 12-16
Working with user overrides, 9-7
Working with version detail for batch
versions, 15-16
Workspace, Activera Portal interface, 5—4
World Wide Web, ActivEra Portal, 5-1
Worldwide Customer Support, D-1
E-mail, D-5
phone numbers, D-2

OneWorld Xe (9/00)



Index

questions they can answer, D-2
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